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Phone: 888-451-5171 (toll free in the U.S.) 

  802-655-4740 (outside the U.S.) 

Fax:  802-655-7941 

E-Mail:  customercare@biotek.com 

Service/TAC 

Phone: 800-242-4685 (toll free in the U.S.) 

  802-655-4740 (outside the U.S.) 

Fax: 802-655-3399 

E-Mail: tac@biotek.com 

European Coordination Center/Authorized European 
Representative  

BioTek® Instruments GmbH 

Kocherwaldstrasse 34 

D-74177 Bad Friedrichshall 

Germany 

Internet: www.biotek.de 

Phone: +49 (0) 7136 9680 

Fax: +49 (0) 7136 968 111 

E-Mail: info@biotek.de
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Document Conventions 

This manual uses the following typographic conventions: 

Example Description 

 
This icon calls attention to important safety notes. 

Warning! A Warning indicates the potential for bodily harm and tells you 
how to avoid the problem. 

Caution A Caution indicates potential damage to the instrument and tells 
you how to avoid the problem. 

DEFINE Text in COURIER font represents menu options as they appear on 
the display of the µFill™ Microplate Dispenser or ELx405™ 
Microplate Washer during operation with the Bio-Stack™. 

Note: Bold text is primarily used for emphasis. 

L This icon calls attention to important information. 

About This Manual  

The intent of this Operator’s Manual is to instruct the new user how to set up and 
operate BioTek’s Bio-Stack. To help you read and understand this manual, certain 
document conventions have been used. 

Major topic headings start a new page (such as Document Conventions, above) 
to give you a visual and style clue that a new major subject is being introduced. 
One or more subheadings may appear below each major heading. 
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Revision History  

 
Revision Date  Changes 

A 11/02 First Release. 

B 05/03 • Added a Caution concerning the Waste Monitor 
Sensor Connector on the ELx405™, in the Cautions 
section of  the Preface. 

• Updated TAC information in the Preface and 
Chapter 1, and Customer Service and European 
contact information, Safety Symbols, and Warranty 
in the Preface. 

• Updated Package Contents, Chapter 1, and 
Repackaging the Instrument, Chapter 2. 

• Clarified the compatibility of the ELx405 with the 
Bio-Stack™ by specifying the Washer’s Auto Plate 
and Select models only in the Preface, Chapters 1 
through 5, and Appendices C, D, and E. 

• Removed steps 10 and 11 regarding the aerosol 
cover in “ELx405 Aligning Plate Instructions,” 
Appendix C. 

• Updated Appendix E with additional error code 
probable causes and new tables E-3, E-4, and E-5 
for Bio-Stack motor numbers, sensor numbers, and 
interfacing instrument numbers referenced in Table 
E-2. 

C 10/03 • Updated the Intended Use statement to distinguish 
between the European Union and all other 
jurisdictions. 

D 06/04 • Re-formatted the manual in the new template and 
according to the format designated in TP01, 
Structure for Operator Manuals/User Guides. 

• Added references throughout manual about 
compatibility of the Bio-Stack™ with the ELx405™ 
HT and ELx405™ Select CW Microplate Washers. 

• Added new sections throughout manual about 
compatibility, installation, operation, alignment, 
etc., of the Precision™ XS Microplate Sample 
Processor and Precision™ Microplate Pipetting 
System with the Bio-Stack, controlled by Precision 
Power™ Software. 

• Revised the Technical Support section and added 
new sections on Depot Service Contracts and 
Applications Support. Enhanced Introduction, 
Installation, Operation, and Maintenance chapters 
of the manual. 
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Revision History, Cont’d  

 
Revision Date  Changes 

E 06/05 • Added text to all sections of the manual about the 
Bio-Stack™ enhancements: new barcode scanner 
and USB port. Added new Appendix B, Barcode 
Scanner.  

• Restructured manual: moved instructions from  
previous Appendix B, Serial Cable Connections and 
Appendix C, Mounting the Aligning Plates and Posts 
into Chapter 3, Installation.  

• Applied current product name configuration for 
ELx405™ standard model: changed “Auto” to 
“ELx405.”  

• Simplified/clarified IQ and OQ sections in Chapter 
5, Qualification Tests. 

• Enhanced Chapter 7, Troubleshooting and Error 
Codes with KC4™ error codes for Bio-Stack 
operation with readers, and Bio-Stack barcode 
scanner error codes. 

F 05/06 • Added Gen5™ references and instructions wherever 
KC4 references or instructions were present. 

• Updated safety information and removed Warranty, 
Registration Card, and Registration Online sections 
in Preface. 

• Added laser beam warning to the Preface and to 
Appendix B, Bio-Stack Barcode Scanner. 

G 07/06 • Added references to the Synergy™ 2 throughout 
the manual, and artwork and instructions for 
installation/alignment of the reader with the 
Bio-Stack™. 

H 12/06 • Added references to the NanoQuot™ Microplate 
Dispenser throughout the manual, instructions/ 
artwork for installation, operation, and qualification 
of the NanoQuot (Chapters 3, 4, & 5), and 
troubleshooting/error codes information for the 
NanoQuot (Chapter 7). 

• Added the Bio-Stack Barcode Scanner Test as an 
optional IQ and OQ test (for the readers and 
Precision instruments) in Chapter 5, and added 
instructions for performing the Scanner Test in 
Appendix B.  
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Revision History, Cont’d  

 
Revision Date  Changes 

I 06/07 • Added references to the Synergy™ 4 throughout 
the manual. 

• Updated Chapter 7, Troubleshooting and Error 
Codes, with several new error codes. 

• Incorporated manual update revision H1 as 
Appendix C, Reconfiguration of the Bio-Stack. 

• Added Appendix D, Required Software Versions. 

J 08/07 • Added references to the Liquid Handling Control™ 
(LHC) Software throughout the manual, and 
instructions for installation/operation of the 
software for PC control of the Bio-Stack and 
ELx405. 

K 10/07 • Added references to BioTek’s new MicroFlo™ Select 
Microplate Dispenser throughout the manual. Added 
instructions for installation/operation of the 
MicroFlo with the Bio-Stack, via instrument control 
(using the MicroFlo keypad) and PC control (using 
the LHC Software).  
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Intended Use Statement 

• The Bio-Stack™ Microplate Stacker is an automated microplate stacking 
system that is designed to systematically transfer a stack of microplates to 
BioTek laboratory products wherever washing, dispensing, pipetting, or 
reading of multiple microplates is performed.  

• The Bio-Stack can be computer-controlled  

¾ via BioTek’s Bio-Stack™ PC Control Software, when used with BioTek’s 
PowerWave™ /PowerWave™ XS Microplate Spectrophotometers or 
Synergy™ HT/Synergy™ 2/Synergy™ 4 Multi-Detection Microplate 
Readers,   

¾ via BioTek’s Precision Power™ Software when used with BioTek’s 
Precision™ XS Microplate Sample Processor or Precision™ Microplate 
Pipetting System, or  

¾ via BioTek’s Liquid Handling Control™  (LHC)  Software, when used with 
BioTek’s ELx405™ Microplate Washer or MicroFlo™ Select Microplate 
Dispenser.  

• The Bio-Stack can be instrument-controlled by BioTek’s µFill™, NanoQuot™, 
and MicroFlo Select Microplate Dispensers, and by the ELx405. 

• In the European Union:  This product may only be used for Research and 
Development and other nonclinical uses. 

• In all other jurisdictions:  This product may be used for Research and 
Development and in vitro Diagnostic Use. 

� ELx405 Washer:  The Bio-Stack with the ELx405 may be either 
computer controlled using the LHC Software, or instrument controlled 
using the keypad on the ELx405. 
 
All ELx405 models except the Magna support the Bio-Stack.  

� MicroFlo Select Dispenser: The Bio-Stack with the MicroFlo Select 
may be either computer controlled using the LHC Software, or 
instrument controlled using the keypad on the MicroFlo Select. 
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Quality Control  
It is considered good laboratory practice to run laboratory samples according to 
instructions and specific recommendations included in the assay package insert for the 
test to be conducted.  Failure to conduct Quality Control checks could result in 
erroneous test data. 

Repackaging and Shipping 

L
If you need to ship the instrument to BioTek for service or repair, 
contact BioTek for a Return Materials Authorization (RMA) 
number, and be sure to use the original packing. Other forms of 
commercially available packing are not recommended and can void 
the warranty. If the original packing materials have been damaged 
or lost, contact BioTek for replacement packing. 
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Warnings 

 

Operate the instrument on a flat surface and away from excessive 
humidity. 

Hazards and Precautions 

Hazards 

  

Warning! Power Rating.  The power supply for the Bio-Stack™ 
must be connected to a power receptacle that provides voltage and 
current within the specified rating for the system. Use of an 
incompatible power receptacle may produce electrical shock and fire 
hazards. 

 Warning! Internal Voltage.  Always turn off the power switch 
and unplug the power supply before cleaning the outer surface of the 
instrument.  

 
Warning! Liquids.  Avoid spilling liquids on the Bio-Stack; fluid 
seepage into internal components creates a potential shock hazard. 
Wipe up all spills immediately.  Do not operate the instrument if 
internal components have been exposed to fluid. 

 
Warning! Potential Biohazards.  Some assays or specimens may 
pose a biohazard.  Adequate safety precautions should be taken as 
outlined in the assay’s package insert.  Always wear safety glasses 
and appropriate protective equipment, such as chemically resistant 
rubber gloves and apron.  

 
Warning! Unspecified Use. Failure to operate this equipment 
according to the guidelines and safeguards specified in this manual 
could result in a hazardous condition. 

 
Warning! Pinch Hazard. Some areas of the Bio-Stack can present 
pinch hazards when the unit is operating. These areas are marked 
with the symbol shown in the Safety Symbols section of this Preface. 
Keep hands/fingers clear of these areas when the unit is operating. 

 
Warning! Laser Beam (Barcode Scanner). Serious eye injury 
may occur if you stare directly into the laser beam of the Bio-Stack’s 
barcode scanner during operation of the scanner. This hazard is 
noted by the warning label attached to the scanner’s cover and shown 
in the Safety Symbols section of this Preface. Do not look directly 
into the laser beam during operation of the scanner.  
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Precautions 

  

Caution: Service.  The Bio-Stack™ should be serviced by BioTek 
authorized service personnel. Only qualified technical personnel 
should perform troubleshooting and service procedures on internal 
components. 

 Caution: Environmental Conditions.  Do not expose the 
instrument to temperature extremes. For proper operation, ambient 
temperatures should remain between 15° to 35°C (59° to 95°F). 
Performance may be adversely affected if temperatures fluctuate 
above or below this range.   

 Caution: Power Supply. Only use the correct line voltage when 
operating the Bio-Stack. 

 Caution: Shipping Panel, Shipping Block, and Carrier 
Shipping Screw. The shipping panel, shipping block, and carrier 
screw must be removed prior to operating the Bio-Stack, and 
reinstalled before repackaging the instrument for shipment. See 
Chapter 3, Installation, for instructions.  

 Caution: Aligning Posts. When installing the Bio-Stack’s four 
aligning posts, use caution not to cross thread these parts. 
Finger-tighten only!  See Chapter 3, Installation. 

 Caution: Bio-Stack Barcode Scanner Mirror.  Be very careful 
not to scratch or damage the mirror when unpacking or installing the 
barcode scanner!  

 Caution: Warranty. Failure to follow preventive maintenance 
protocols may void the warranty. See Chapter 6, Preventive 
Maintenance. 

 Caution: Disposal. This instrument contains printed circuit boards 
and wiring with lead solder. Dispose of the instrument according to 
Directive 2002/96/EC, “on waste electrical and electronic equipment 
(WEEE).” 
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 Caution: Waste Sensor Port.  (For all customers who have 

purchased the Bio-Stack™ Microplate Stacker for use with the 
ELx405™ Microplate Washer.) Although the port on the back of all 
ELx405 Washers for the waste sensor is the same type as the 24-VDC 
power connector on the back of the Bio-Stack, if an external 24-VDC 
power supply is plugged into this waste sensor port, it will 
permanently damage components on the PCB inside the 
ELx405.   

 
 

L 
Important!  DO NOT plug the external 24-VDC power 
supply that came with your Bio-Stack into the waste sensor 
port on the ELx405! 
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Based on the testing described below and information contained 
herein, this instrument bears the CE mark.

 

EC Directive 73/23/EEC Low Voltage (Safety) 

The system has been type tested by an independent testing laboratory and was 
found to meet the requirements of EC Directive 73/23/EEC for Low Voltage. 
Verification of compliance was conducted to the limits and methods of the 
following: 

EN 61010-1 (2001) 2nd Edition 

“Safety requirement for electrical equipment for measurement, control and 
laboratory use. Part 1, General requirements.” 

EMC EC Directive 89/336/EEC Electromagnetic Compatibility 

Emissions - CLASS A 

The system has been type tested by an independent, accredited testing 
laboratory and found to meet the requirements of EN 61326-1:2002 for 
Radiated Emissions and Line Conducted Emissions. Verification of compliance 
was conducted to the limits and methods of the following: 

CISPR 16-1:1993, CISPR 16-2:1999, and EN 55022 

Immunity 

The system has been type tested by an independent, accredited testing 
laboratory and found to meet the requirements of EN 61326-1:2002 for 
Immunity. Verification of compliance was conducted to the limits and methods 
of the following: 

EN 61000-4-2:1998 Electrostatic Discharge   

EN 61000-4-3:1998 Radiated EM Fields  

EN 61000-4-4:1995 Electrical Fast Transient/Burst  

EN 61000-4-5: 1995 Surge Immunity  

EN 61000-4-6:1996  Conducted Disturbances 

EN 61000-4-11:1994  Voltage Dips, Short Interruptions and Variations 
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Directive 2002/96/EC Waste Electrical and Electronic Equipment 

Disposal Notice 

This instrument contains printed circuit boards and wiring with lead solder. 
Dispose of the instrument according to Directive 2002/96/EC, “on waste 
electrical and electronic equipment (WEEE).” 
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Electromagnetic Interference and Susceptibility 

USA FCC CLASS A  

Warning:  Changes or modifications to this unit not expressly approved by the 
manufacturer could void the user's authority to operate the equipment. 

This equipment has been tested and found to comply with the limits for a Class A 
digital device, pursuant to Part 15 of the FCC Rules.  

These limits are designed to provide reasonable protection against harmful 
interference when the equipment is operated in a commercial environment. Like 
all similar equipment, this equipment generates, uses, and can radiate radio 
frequency energy and, if not installed and used in accordance with the instruction 
manual, may cause harmful interference to radio communications. Operation of 
this equipment in a residential area is likely to cause interference, in which case 
the user will be required to correct the interference at his own expense. 

Canadian Department of Communications Class A  

This digital apparatus does not exceed Class A limits for radio emissions from 
digital apparatus set out in the Radio Interference Regulations of the Canadian 
Department of Communications. 

Le present appareil numerique n'met pas du bruits radioelectriques depassant les 
limites applicables aux appareils numerique de la Class A prescrites dans le 
Reglement sur le brouillage radioelectrique edicte par le ministere des 
Communications du Canada. 
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User Safety  

This device has been type tested by an independent laboratory and found to meet the 
requirements of the following: 

North America 

• Underwriters Laboratories UL 61010A-1:2002 

“Electrical Equipment for Laboratory Use; Part 1: General Requirements.” 

• Canadian Standards Association CAN/CSA C22.2 No. 1010.1-1992 

“Safety Requirements for Electrical Equipment for Measurement, Control and 
Laboratory Use, Part 1:  General Requirements.” 

International 

• EN 61010-1  

“Safety Requirements for Electrical Equipment for Measurement, Control and 
Laboratory Use, Part 1:  General Requirements.” 
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Safety Symbols 

Some of these symbols may appear on the instruments. 

 
Alternating current 
Courant alternatif 
Wechselstrom 
Corriente alterna 
Corrente alternata 

 
Direct current 
Courant continu  
Gleichstrom 
Corriente continua 
Corrente continua 

 
Both direct and alternating current 
Courant continu et courant alternatif 
Gleich - und Wechselstrom  
Corriente continua y corriente alterna 
Corrente continua e corrente alternata 

 

Earth ground terminal 
Borne de terre 
Erde (Betriebserde) 
Borne de tierra 
Terra (di funzionamento) 

 

Protective conductor terminal 
Borne de terre de protection 
Schutzleiteranschluss 
Borne de tierra de protección 
Terra di protezione 

 

On (Supply) 
Marche (alimentation) 
Ein (Verbindung mit dem Netz) 
Conectado 
Chiuso 

 

Off (Supply) 
Arrêt (alimentation) 
Aus (Trennung vom Netz) 
Desconectado 
Aperto (sconnessione dalla rete di alimentazione)  
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Caution (refer to accompanying documents) 
Attention (voir documents d’accompanement) 
Achtung siehe Begleitpapiere 
Atención (vease los documentos incluidos) 
Attenzione, consultare la doc annessa 

 

Warning, risk of electric shock 
Attention, risque de choc électrique 
Gefährliche elektrische Schlag 
Precaución, riesgo de sacudida eléctrica 
Attenzione, rischio di scossa elettrica  

 

Warning, risk of crushing or pinching 
Attention, risque d’écrasement et pincement 
Warnen, Gefahr des Zerquetschens und Klemmen 
Precaución, riesgo del machacamiento y sejeción 
Attenzione, rischio di schiacciare ed intrappolarsi 

 

Warning, hot surface 
Attention, surface chaude 
Warnen, heiße Oberfläche 
Precaución, superficie caliente 
Attenzione, superficie calda 

 

Laser radiation: Do not stare into beam 
Rayonnement laser: Ne pas regarder dans le faisceau 
Laserstrahlung: Nicht in den strahl blicken 
Radiación de láser: No mire fijamente al rayo  
Radiazione di laser: Non stare nel fascio 

 

 

Consult instructions for use 
Consulter la notice d’emploi 
Gebrauchsanweisung beachten 
Consultar las instrucciones de uso 
Consultare le istruzioni per uso 
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In vitro diagnostic medical device 
Dispositif médical de diagnostic in vitro  
Medizinisches In-Vitro-Diagnostikum 
Dispositivo médico de diagnóstico in vitro 
Dispositivo medico diagnostico in vitro 

 

Separate collection for electrical and electronic 
equipment  
Les équipements électriques et électroniques font l’objet 
d’une collecte sélective 
Getrennte Sammlung von Elektro- und Elektronikgeräten 
Recogida selectiva de aparatos eléctricos y electrónicos  
Raccolta separata delle apparecchiature elettriche ed 
elettroniche 
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Introduction 

This chapter introduces the Bio-Stack™ and describes its hardware 
and software features and technical specifications. Instructions on 
how to contact BioTek for Product Support & Service are included 
on page 19. 
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Introducing the Bio-Stack™ 

Compact, fast, and easy to use, the Bio-Stack Microplate Stacker can efficiently and 
repeatedly transfer a stack of microplates to a wide variety of BioTek instruments. The 
Bio-Stack’s seamless operation and rugged construction guarantee walk-away 
automation wherever washing, dispensing, pipetting, and/or reading of multiple 
microplates is performed.  

Features include: 

• Two easily removable, interchangeable stacks (one input and one output)  

• Optional automatic re-stacking of plates in original order 

• Delivery or retrieval of a microplate in less than 8 seconds 

• Flexibility to be PC-controlled or instrument-controlled 

• Universal design for operation with BioTek’s  

¾ PowerWave™ and PowerWave™ XS Microplate Spectrophotometers  

¾ Synergy™ HT/Synergy™ 2/Synergy™ 4 Multi-Detection Microplate 
Readers 

¾ Precision™ Microplate Pipetting System 

¾ Precision™ XS Microplate Sample Processor 

¾ µFill™ , NanoQuot™ , and MicroFlo™ Select Microplate Dispensers 

¾ ELx405™ Microplate Washer   

• Cams actuated by stepper motors for quiet and reliable operation  

• Onboard diagnostics 

• Durable precision-ground aluminum base 

• Sensors to ensure completion of each plate movement 

• Gripper spring pre-loaded to maintain grip on plate in event of power loss 

• Rack and pinion drive for synchronous movement 

• Microplate addressed from below for reliable transport 

• Linear mechanisms built around proven BioTek technology 

• Extremely small footprint that saves bench space 

• Accommodation of SBS compliant standard-height microplates as well as 
low-profile microplates 

• Optional barcode scanner   

� SBS = Society for Biomolecular Screening. 
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Figure 1: The Bio-Stack™ and PowerWave™, Synergy™ HT, ELx405™, and µFill™ 
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PC Control of the Bio-Stack™ 

Bio-Stack with the PowerWave™ or Synergy™ Readers  

In this configuration, BioTek’s Bio-Stack™ PC Control Software and Gen5™ 
or KC4™ Software are installed on a host computer equipped with at least two 
communication ports.  

The Bio-Stack PC Control Software uses 

• one serial port to control the PowerWave/PowerWave XS or  Synergy HT/ 
Synergy 2/Synergy 4 (with the help of Gen5 or KC4 running in the 
background), and  

• another communication port (serial or USB) to control the Bio-Stack. 

� In the configuration described above, the Bio-Stack PC Control Software 
uses Gen5 only to control the Synergy 2/Synergy 4 readers. KC4 
software does not support the Synergy 2/Synergy 4.  

 

� For operation of the reader with the Bio-Stack: All Gen5 software 
versions may be used with the Bio-Stack; however, you will need versions 
of the Bio-Stack PC Control Software and Bio-Stack basecode software that 
are appropriate for Gen5. For example, the Synergy 4 reader uses Gen5 
version 1.04.x, which requires a Bio-Stack PC Control Software version of 
at least 2.00.7 and a Bio-Stack basecode version of at least 1.27.1 for all 
plate types. 
 
If you are using KC4 software, you will need KC4 v. 3.3, Rev. 9 or greater. 

� For operation of the Bio-Stack barcode scanner: Contact BioTek to 
determine if your Bio-Stack supports the barcode scanner. 
 
All Gen5 software versions support the scanner. 
 
If you are using KC4 software, you will need KC4 v. 3.4, Rev. 16 for the 
scanner. If you wish to have Bio-Stack scanned barcodes appear in KC4 
plate description dialogs, you will need KC4 v. 3.4, Rev. 22. 

� Refer to Appendix D, Required Software Versions, for more information 
on required software versions for the Bio-Stack and readers, or contact 
BioTek Instruments. 

 

� Some Synergy HT readers may also need to be upgraded with a Bio-Stack 
compatible carrier. See Upgrade Information on page 14 for more 
information.  
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 Bio-Stack™ with the Precision™/XS 

In this configuration, BioTek’s Bio-Stack™ PC Control Software and 
Precision Power™ Software are installed on a host computer equipped with at 
least two communication ports.   

Precision Power software uses  

• one serial port to control all functions of the Precision™ Microplate 
Pipetting System/Precision™ XS, and  

• another communication port (serial or USB) and a component of the 
Bio-Stack PC Control Software to control all functionality of the Bio-Stack.  

  

� For operation of the Precision with the Bio-Stack, you will need 
Precision Power Software v. 2 or greater.  
 
Precision XS instruments do not need to be upgraded for operation with 
the Bio-Stack, however, some Precision Microplate Pipetting Systems may 
need an upgrade. Refer to Upgrade Information on page 14 for more 
information. 

� For operation of the Bio-Stack barcode scanner: Contact BioTek to 
determine if your Bio-Stack supports the barcode scanner. You will also 
need Precision Power Software, v. 2.xx or greater if you will be using the 
scanner during operation of the Bio-Stack with the Precision. 

� Refer to Appendix D, Required Software Versions, for more information 
on required software versions for the Bio-Stack and Precision instruments, 
or contact BioTek Instruments. 

 

� Precision instruments that are Bio-Stack compatible may also be operated 
with two Bio-Stacks. In this configuration, you will need a computer 
equipped with three communication ports.  
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Bio-Stack™ with the ELx405™ 

� The Bio-Stack with the ELx405 may be either computer controlled using the 
Liquid Handling Control (LHC) Software, or instrument controlled using the 
keypad on the ELx405. (See Instrument Control of the Bio-Stack™ on 
page 8.) 

In this configuration, BioTek’s Liquid Handling Control™ (LHC) Software,  
ELx405™ Interface Software, and Bio-Stack™ PC Control Software are 
installed on a host computer equipped with at least two communication ports (one 
serial port and a second serial or USB port).  

LHC Software uses 

• one serial port and the ELx405 Interface Software to control all 
functions of the ELx405, and  

• another communication port (serial or USB) and a component of the 
Bio-Stack PC Control Software to control all functionality of the  
Bio-Stack.  

  
� For operation of the ELx405 with the Bio-Stack using the LHC 

Software, you will need any version of the LHC Software and the following 
minimum software versions: v. 2.00.4 of the ELx405 Interface Software,  
v. 2.02.1 of the ELx405 basecode software (PN 7100227), v. 2.00.10 of the 
Bio-Stack PC Control Software, and v. 1.24.1 of the Bio-Stack basecode 
software. 
 
Refer to Appendix D, Required Software Versions, or contact BioTek 
Instruments for more information on required software versions for the  
Bio-Stack and ELx405 using LHC. 

� Some ELx405 washers may need to be upgraded to support the Bio-Stack. 
For example, if the ELx405 is not equipped with the robot compatible 
microplate carrier, you will need to upgrade the washer. Refer to Upgrade 
Information on page 14, or contact BioTek for more information. 

� The ELx405 does not support the Bio-Stack barcode scanner, and the 
Magna model of the ELx405 washer is not compatible with the  
Bio-Stack. 

 
� The LHC Software also allows you to operate two Bio-Stacks simultaneously 

with two ELx405 washers. In this configuration, you will need a computer 
equipped with at least four communication ports and two washers that are 
Bio-Stack and LHC compatible. 
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Bio-Stack™ with the MicroFlo™ Select  

� The Bio-Stack with the MicroFlo Select Microplate Dispenser may be 
either computer controlled using the Liquid Handling Control (LHC) 
Software, or instrument controlled using the keypad on the MicroFlo 
Select. (See Instrument Control of the Bio-Stack™ on page 8.) 

In this configuration, BioTek’s Liquid Handling Control™ (LHC) Software,  
MicroFlo™ Select Interface Software, and Bio-Stack™ PC Control 
Software are installed on a host computer equipped with at least two 
communication ports (one serial port and a second serial or USB port).   

LHC Software uses 

• one communication port (serial or USB) and the MicroFlo Select 
Interface Software to control all functions of the MicroFlo Select, and  

• another communication port (serial or USB) and a component of the 
Bio-Stack PC Control Software to control all functionality of the  
Bio-Stack.  

  

� For operation of the MicroFlo Select with the Bio-Stack using the LHC 
Software, you will need any version of the LHC Software and the following 
minimum software versions: v. 1.01.0 of the MicroFlo Select Interface 
Software, v. 1.04.0 of the MicroFlo Select basecode software, v. 2.00.10 of 
the Bio-Stack PC Control Software, and v.1.24.1 (96-/384-well plates) or 
v.1.25.1 (1536-well plates) of the Bio-Stack basecode software. 

� The MicroFlo Select does not support the Bio-Stack barcode scanner. 

� Refer to Appendix D, Required Software Versions, or contact BioTek 
Instruments for more information on required software versions for the  
Bio-Stack and MicroFlo Select using LHC. 
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Instrument Control of the Bio-Stack™ 

Bio-Stack with the µFill™, NanoQuot™, ELx405™, or MicroFlo™ 
Select 

In this configuration, the Bio-Stack is controlled serially by the µFill, NanoQuot, or 
MicroFlo Select Dispenser, or by the ELx405 Washer.  A serial cable must be used; 
the µFill, NanoQuot, and ELx405 do not currently support the USB cable. A serial 
cable must also be used for instrument control of the Bio-Stack by the MicroFlo. 
The MicroFlo only supports USB cable connection to a host computer during PC 
control of the Dispenser. 

� Some µFill and ELx405 instruments may need to be upgraded to be 
Bio-Stack compatible. Refer to Upgrade Information on page 14 for more 
information. Note: The Magna model of the ELx405 washer is not 
compatible with the Bio-Stack.  

� The NanoQuot does not need to be upgraded to be Bio-Stack compatible, 
however, you will need a Bio-Stack basecode software version of at least 
1.24.1 for 96-/384-well standard height plates and 1.25.1 for 1536-well 
plates. 

� The MicroFlo Select does not need to be upgraded to be Bio-Stack 
compatible, however, you will need a Bio-Stack basecode software version 
of at least 1.24.1 for 96-/384-well standard height plates and 1.25.1 for 
1536-well plates. 

� During installation of the Bio-Stack with the NanoQuot, the Bio-Stack must 
be temporarily connected to a host computer that has version 2.00.4 or 
greater of the Bio-Stack™ PC Control Software installed. The PC Software 
is used to align the Bio-Stack’s claw/gripper with the Dispenser’s plate 
carrier, and to obtain software versions for the Bio-Stack.  

� Refer to Appendix D, Required Software Versions, for more information 
on required software versions for the Bio-Stack and µFill, NanoQuot, and 
ELx405, or contact BioTek Instruments. 

� The µFill, NanoQuot, ELx405, and MicroFlo Select do not support the  
Bio-Stack barcode scanner.  
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Hardware Features 

• Microprocessor-driven device with adequate memory for performing all 
functions 

• Two removable, interchangeable upright stacks (one input and one output) 
that can accommodate a variety of microplate types, including 96-, 384-, and 
1536-well plates    

• A carrier to transfer plates one at a time from the input stack (holds incoming 
plates) and to the output stack (holds processed plates) 

• A claw/gripper mechanism for securely lowering plates to, and lifting them 
from, the plate carrier and the interfacing instrument 

• Two stack lifters to lift and lower the stack of plates within the input and 
output stacks 

• Two stack locks to secure the stacks during operation of the instrument 

• Two dogs in each stack to hold a set of plates within the stack and to lower a 
single plate down to the carrier 

• Compatible with 100 to 240 V~ ± 10% @ 50-60 Hz; an external 24-VDC power 
supply is supplied 

• (Optional) barcode scanner   
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Software Features 

Functionality of the Bio-Stack™ is controlled by the Bio-Stack’s basecode 
software, as well as by serial messages transmitted either from the  

¾ Bio-Stack™ PC Control Software, Precision Power™ Software, or LHC™ 
Software during PC control of the Bio-Stack, or from the  

¾ basecode software of the µFill™, NanoQuot™, or MicroFlo™ Select, or the 
ELx405™ Washer, during instrument control of the Bio-Stack. 

• The Bio-Stack PC Control Software is an efficient design that works with 
BioTek’s Gen5™ or KC4™ Software to send serial commands for the transfer 
of plates to and from the Bio-Stack and the PowerWave™/XS or  
Synergy™ HT/Synergy™ 2/Synergy™ 4 Readers. 

¾ The operator may initially run Gen5 or KC4 as a stand-alone application to 
create Gen5 protocols and experiments or KC4 protocols, and later to review 
plate results or manually export the results. During actual processing of the 
plates, the Bio-Stack PC Control Software automatically runs Gen5 or KC4 in 
the “background” to send serial commands to the reader, while sending its 
own set of serial commands to the Bio-Stack to control plate transfers. 

� Gen5 experiments may also be created from within the Bio-Stack PC 
Control Software. Note: Gen5 software must be used with the 
Synergy 2/Synergy 4 readers (KC4 does not support the Synergy 2/ 
Synergy 4). 

• Precision Power Software controls all functions of the Precision™/XS, and 
uses a component of the Bio-Stack PC Control Software to control all 
functionality of the Bio-Stack. 

¾ For high-throughput fluid-transfer programs, up to two Bio-Stacks may 
be used with the Precision instruments.  

• Liquid Handling Control (LHC) Software uses  

¾ the ELx405 Interface Software to control all functions of the ELx405, 
and a component of the Bio-Stack PC Control Software to control all 
functionality of the Bio-Stack; or 

¾ the MicroFlo™ Select Interface Software to control all functions of the 
MicroFlo Select, and a component of the Bio-Stack PC Control Software 
to control all functionality of the Bio-Stack. 

• The basecode software on the µFill and ELx405 (ELx405, Select, HT, and 
Select CW models) has been modified so their normal operating displays now 
accommodate instructing the operator to place plates on the  
Bio-Stack, and identifying how many plates have been processed. The 
basecode software on the NanoQuot and MicroFlo Select includes a  
Bio-Stack mode for running and re-stacking plates, and homing the  
Bio-Stack.  
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• Additional software features include: 

¾ A utility for aligning the Bio-Stack-to-instrument interface height (µFill™, 
MicroFlo™ Select, and ELx405™) (Note: The NanoQuot™ requires the  
Bio-Stack™ PC Control Software for this.) 

¾ The ability to home both instruments 

¾ The ability to continue processing a stack of plates, following the 
aborting/failure of one plate (µFill and ELx405)  

¾ The ability to pause processing to add more plates to the input stack or to 
remove some from the output stack (µFill and ELx405). 

Package Contents 

• Bio-Stack™ Microplate Stacker 

• Two microplate stacks  (PN 7310008) 

• 24 VDC power supply, 48 watts minimum (PN 61062) 

• Plate Stacking Pedestal (PN 7312083)  

• Grease kit (PN 7110017)  

• Unpacking (PN 7311003) and packing (PN 7311002) instructions 

• Operator’s Manual (PN 7311000) on CD (PN 7311033) 

• Set of shipping materials (PN 7313002 for Bio-Stack; PN 7313001 for stacks)  

• Shipping document (PN 94075) that includes a Warranty Statement and 
Certificate of Compliance and Calibration  

• Declaration of Conformity (PN 7311001) 
 

� Part numbers are subject to change over time. Please contact BioTek 
Customer Care if you have any questions. 
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Optional Accessories 

• Spare set of two microplate stacks (PN 7310008S) 

• Instrument Qualification package (PN 7310530) 

• Bio-Stack™ Service Manual (PN 7311018) 

• Barcode scanner and installation kit (PN 7310017) for scanner-compatible 
Bio-Stack units  

� The Bio-Stack barcode scanner is compatible only with Bio-Stack 
instruments that include the necessary hardware and basecode software 
version. Contact BioTek to determine if your Bio-Stack supports the 
barcode scanner.  
 
Interfacing instruments that support the scanner include the 
PowerWave™/XS and Synergy™ HT with Gen5™ Software (all versions) or 
KC4™ Software (v. 3.4, Rev. 16), Synergy™ 2 with Gen5 v. 1.01.x, 
Synergy™ 4 with Gen5 v. 1.04.x, and Precision™/XS instruments with 
Precision Power™ (v. 2.xx). The µFill™, ELx405™, NanoQuot™, and 
MicroFlo™ Select do not support the Bio-Stack barcode scanner.  

• Bio-Stack alignment kits (PN’s listed in the chart on the following page) for the 
interfacing instruments, that may consist of the following: 

¾ 2 aligning plates (1 for the Bio-Stack (PN 7312052), and 1 for the 
interfacing instrument), to prevent the instrument from sliding around and 
becoming misaligned with the Bio-Stack 

¾ 2 aligning caps for elevating the interfacing instrument to the correct 
height and for positioning in the alignment plate (not necessary for the µFill 
or NanoQuot)  

¾ 4 aligning posts (“feet”) for elevating the Bio-Stack to the correct height 
and for positioning in the alignment plate  

¾ Other hardware:  Left and right roller extensions (PN’s 7110544 and 
7110556) to extend the supply platform on the Precision instruments  

¾ Bio-Stack PC Control Software (PN 7310204) (not included for the µFill)  

¾ 2 RS-232 serial cables: 9-pin to 9-pin (PN 75034 or 75110), 9-pin to 
25-pin (PN 75053 or 75111), and/or 25-pin to 25-pin (PN 75106) 

¾ 1 USB cable (PN 75108) and driver software (PN 7090204) (not included 
for the µFill or NanoQuot)  

� Some instruments may need to be upgraded before their 
alignment kit hardware and software can be installed. Refer to the 
Upgrade Information section on page 14 or contact BioTek.  
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Bio-Stack™ Alignment Kits for Interfacing Instruments 
 
 

Contains the following:  

This  
Alignment Kit 

 

2 Plates 

 

2 Caps 

 

4 Posts* 
(“feet”) 

 

Other 
Hardware 

PC 
Control 

Software 

2 
Serial 
Cables 

USB 
Cable/ 

Software 

7310011 
PowerWave™ and 
PowerWave™ XS  

7312047;  

7312052 

7312075 7310523 
(66 mm) 

N/A 7310204 75034 

75053 

75108/ 
7090204 

7310009  
Synergy™ HT 

7312048; 

7312052 

7312073 7310523 
(66 mm) 

N/A 7310204 75034 

75053 

75108/ 
7090204 

7310019  
Synergy™ 2 and 
Synergy 4 

7132153 

7312052 

7312073 7130559 

(73 mm) 

N/A 7310204 75034 

75053 

75108/ 
7090204 

7110004 
Precision™ XS and 
Precision™ 
Microplate 
Pipetting System  

7112139; 

7112140 

7312074 7110542 
(33 mm) 

7110544; 
7110556 

7310204 75034 

75053 

75108/ 
7090204 

7310012   
µFill™ 

7312049;  

7312052 

N/A 7310524 
(14 mm) 

N/A N/A 75106 

75111 

N/A 

7310010   
ELx405™ 
(Excludes Magna) 

7312050; 

7312052 

7312074 7310524 
(14 mm) 

N/A 7310204 75106 

75111 

75108/ 
7090204 

7150001 
NanoQuot™ 

7152000; 

7312052 

N/A 7310524 
(14 mm) 

N/A 7310204 75110 

75111 

N/A 

7310020 
MicroFlo™ Select 

7172125 

7312052 

7170527 

(4 caps 
instead 
of 2) 

7310524 
(14 mm)  

N/A 7310204 75110 

75111 

75108/ 
7090204 

*  The lengths listed for the posts include the rubber bits, but do not include the threaded portions.  

   

� Part numbers are subject to change over time. Please contact BioTek 
Customer Care if you have any questions. 

� ELx405 and MicroFlo Select Alignment Kits: PN’s 7310204 and 
75108/7090204 are for users who have purchased the Liquid Handling 
Control (LHC) Software for computer control of the Bio-Stack with 
the ELx405 or MicroFlo Select. 
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Upgrade Information 

Upgrade Kits 

Upgrade kits are available for customers with existing BioTek instruments that 
may be interfaced with the Bio-Stack™. Please refer to the chart in Figure 2 on the 
next page or contact BioTek’s Technical Assistance Center (tac@biotek.com) to 
determine whether your instrument must be upgraded to be compatible with the 
Bio-Stack.   

The following upgrade kits are available: 

• Synergy™ HT Multi-Detection Microplate Reader (PN 7310007) 

¾ Bio-Stack compatible microplate carrier 

� The Synergy HT must be returned to BioTek TAC for installation 
of the Bio-Stack compatible carrier.  

• µFill™ Microplate Dispenser (PN 7310015) 
¾ Disk with latest µFill basecode software (PN 7140200) 

¾ CD with BioTek’s Download Utility (PN 8300200) and disk with µFill 
ActiveX (PN 7140202); both used for downloading the latest µFill 
basecode software  

• ELx405™ Microplate Washer (PN 7310006) 
¾ Bio-Stack compatible microplate carrier 

¾ Disk with latest ELx405 basecode software (PN 7100227) 

¾ CD with BioTek’s Download Utility (PN 8300200) for downloading the 
basecode software 

� The ELx405 must be returned to BioTek TAC for installation of 
the Bio-Stack compatible carrier. 

• ELx405 Microplate Washer Software Upgrade Only (PN 7310013) 
¾ Disk with latest ELx405 basecode software (PN 7100227) 

¾ CD with BioTek’s Download Utility (PN 8300200) for downloading the 
basecode software 

� The Magna models of the ELx405 are not Bio-Stack compatible. 
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Synergy™ HT 

S/N <181151 
 
- Contact BioTek     
  TAC 
 
- Order Upgrade kit 
  P/N 7310007 
  
- Return instrument 
  to BioTek for 
  carrier installation 

S/N >= 181151 
 
- No upgrade 
  necessary 

Precision™ XS 

  - No upgrade necessary 

S/N >=187931  
 
- May need upgrades 
  for basecode software  
 
- Contact BioTek TAC 
 

Precision™ Microplate 
Pipetting System 

S/N <185105 
 
- Contact BioTek 
  TAC 
 
- Order Upgrade kit 
  P/N 7310015 
 
- Field  installation  
  possible  

  S/N >= 185105 
 
- No upgrade 
  necessary 

S/N =<182187 
 
- Contact BioTek 
  TAC 
 
- Order Upgrade kit 
  P/N 7310006 
 
- Return washer 
  to BioTek for 
  carrier installation 

S/N >= 182188 
and < 185301 
 
- Contact BioTek 
  TAC 
 
- Order upgrade kit 
  P/N 7310013  
 
- Field installation  
  possible 

S/N 183514 
S/N 184197 
S/N >= 185301 
 
- No upgrade 
  necessary 

Synergy™ 2 
Synergy™ 4 

- No upgrade 
necessary 

µFill™ PowerWave™ 
PowerWave™ XS 

- No upgrade necessary 

MicroFlo™ 
Select 

- No upgrade 
necessary 

NanoQuot™ 

- No upgrade 
necessary 

ELx405™ 

ELx405 with LHC™ 
Software 

ELx405 basecode (7100227) 
version less than v. 2.02.1 
 
- Contact BioTek TAC 

Bio-Stack™ 
Microplate Stacker 

 
Figure 2: Criteria Chart for Upgrading Bio-Stack Interfacing Instruments   

� The following Precision Microplate Pipetting Systems are not Bio-Stack 
compatible and cannot be upgraded:  
 
-  Instruments with serial numbers < 187931 
-  All 12-Channel models 
-  Universal 8-/12-Channel models in 12-channel mode 
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Specifications 

Bio-Stack™ 

Electrical 

External Power Supply: Compatible with 100 to 240 V~ ± 10% @ 50-60 Hz 

Power Consumption: 40 watts maximum 

Physical 

Display: None 

Dimensions: Length:  18.5” (46.9 cm)   Width:   7” (17.8 cm)     

Height when aligned with the following instruments:  

PowerWave™, PowerWave™ XS, Synergy™ HT,  
Synergy™ 2*, Synergy™ 4*  

      25” (63.5 cm) with stacks and long aligning posts 
      16” (40.6 cm) without stacks 

* The Bio-Stack is taller with the Synergy 2/Synergy 4 than 
with the other readers: .28” (.71 cm) higher with/without 
the stacks. 

Precision™ XS, Precision™ Microplate Pipetting System       

      24” (61.1 cm) with stacks and medium aligning posts 
      15” (37.0 cm) without stacks  

µFill™, ELx405™, NanoQuot™, MicroFlo™ Select 

      23” (58.4 cm) with stacks and short aligning posts 
      14” (35.6 cm) without stacks 

Weight: 24 lbs (10.9 kg) 

Environmental 

Operating Temperature: 15°C to 35°C (59°F to 95°F)  

Humidity: Maximum relative humidity of 80% at temperatures up to 31°C 
(87.8°F) decreasing linearly to 50% relative humidity at 40°C 
(104°F)  
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Microplates   

Dimensions: Society for Biomolecular Screening (SBS) compliant standard-height  
96- and 384-well microplates     

Other laboratory microplates, which conform to the following standardized 
dimensions: 

Width:   3.365” (85.48 mm) ± 0.020” (0.5 mm) 

Length:  5.030” (127.76 mm) ± 0.020” (0.5 mm) 

Height:  0.565” (14.35 mm) ± 0.030” (0.76 mm) 

Shorter profile plates: 1536-well and low volume 384-well microplates 
are shorter than standard-height plates, and can be processed in the  
Bio-Stack™. These plates have a minimum height of 0.400” (10.16 mm). 

The maximum rim height for plates with an overall height that is less than 
0.450” (11.43 mm) is 0.100” (2.54 mm). 

To run plates shorter than 0.565” (14.35 mm), you will need Bio-Stack 
basecode software version 1.25.1 or greater installed in the Bio-Stack.  
Some half-height plates may require Bio-Stack basecode version 1.27.1 or 
greater, as well as reconfiguration of the Bio-Stack. See Appendix C, 
Reconfiguration of the Bio-Stack and Appendix D, Required Software 
Versions. 

Standards: 

  

With the exception of 1536-well and low volume 384-well microplates, 
BioTek recommends that you use microplates that comply with the 
following American National Standards Institute (ANSI)/Society for 
Biomolecular Screening (SBS) dimensional standards:  

ANSI/SBS 1-2004 “for Microplates – Footprint Dimensions” 

ANSI/SBS 2-2004 “for Microplates – Height Dimensions” 

ANSI/SBS 3-2004 “for Microplates – Bottom Outside Flange Dimensions” 

ANSI/SBS 4-2004 “for Microplates – Well Positions” 

Note: Microplates that do not meet these requirements may cause 
functional problems. Plastic “flash” (burrs and extra plastic) on the edges 
of plates, and strip plates that are not as rigid or flat, may also cause 
problems. 
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PC Software  

For PC control of the Bio-Stack™, you will need a computer equipped with at least two 
communication ports. If you are operating two Bio-Stack’s with a Precision™ instrument, you 
will need a PC with three com ports. If you are operating two Bio-Stack’s with two ELx405 
washers, controlled by the LHC™ Software, you will need a PC with four com ports. 

Bio-Stack™ PC Control 
Software 

(v. 1.02.8 with KC4) 
(v. 2.00.x with Gen5) 
(v. 2.00.4 or greater for the 
NanoQuot™; you do not need 
to install KC4 or Gen5 for the 
NanoQuot) 
(v. 2.00.7 or greater for the 
Synergy™ 4) 
(v. 2.00.10 or greater for the 
LHC Software) 

Intel Pentium processor / 266 MHz (or compatible) 

Microsoft® Windows™ 2000, XP, or Vista operating system 

64 MB of RAM (minimum), 128 MB recommended  

60 MB of available hard drive space 

CD ROM drive 

Color monitor, 800x600 resolution with 256 colors minimum 
(1024x768 resolution with 32-bit color recommended) 

Keyboard, mouse, and serial or USB ports 

Gen5™ Software 

(Any version for the 
PowerWave™/XS or  
Synergy™ HT) 
(v. 1.01.x or greater for the 
Synergy™ 2) 
(v. 1.04.x or greater for the 
Synergy 4) 

Refer to the Gen5 Getting Started Guide or Help system 
for system requirements. 

KC4™ Data Analysis 
Software  

(v. 3.3, Rev. 9 or greater) 
(v. 3.4, Rev. 16 or greater for 
Bio-Stack™ barcode scanner) 

Refer to the KC4 User’s Guide for system requirements.  

  

 

Precision Power™ Software 

(v. 2 or greater) 
(v. 2.xx or greater for  
Bio-Stack barcode scanner) 

Refer to the Precision Power User’s Guide for system 
requirements. 

Liquid Handling Control™ 
(LHC) Software 

(Any version of the LHC and v. 
2.00.4 of the ELx405 Interface 
Software for the ELx405 or 
v.1.01.0 of the MicroFlo™ 
Select Interface Software for 
the MicroFlo) 

Refer to the Liquid Handling Control Software 
Installation Guide for system requirements. 

Refer to Appendix D for more information on required software versions. 
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Product Support & Service 

All of BioTek’s products are backed by a superior support staff. If your instrument ever 
fails to function perfectly, if you have questions about how to use or maintain it, or if 
you need to send the instrument to BioTek for service or repair, please contact our 
Technical Assistance Center (TAC). 

Contacting the Technical Assistance Center  

Our Technical Assistance Center is open from 8:30 AM to 5:30 PM (EST), Monday 
through Friday, excluding standard U.S. holidays. You can send a fax or an e-mail 
any time. 

Phone: 800-242-4685 (in the U.S.) or 802-655-4740 (outside the U.S.) 

Fax: 802-655-3399 

E-Mail: tac@biotek.com

Please be prepared to provide the following information: 

• Your name and company information  

• A daytime phone or fax number, and/or an e-mail address  

• The product name, model, and serial number  

• The software part number and basecode versions for the Bio-Stack™ and 
interfacing instrument, and, if applicable, the software versions for the 
Bio-Stack™ PC Control Software Installation CD, StackerContainer.exe, and 
BTIAutoStackerActiveX. 

• For troubleshooting assistance or instruments needing repair:  the specific 
steps that produce your problem, and any error codes displayed (see also 
Chapter 7, Troubleshooting and Error Codes).  

Returning Instruments for Service/Repair 

If you need to return an instrument to BioTek for service or repair, please contact 
the TAC for a Return Materials Authorization (RMA) number before shipping the 
instrument. Repackage the instrument properly (see Chapter 3, Installation), 
write the RMA number on the shipping box, and ship to this address: 

BioTek Instruments, Inc. 
Technical Assistance Center 
100 Tigan Street 
Highland Park 
Winooski, Vermont  05404  USA 
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Chapter 2 

Instrument Description 

This chapter describes the important external components of the 
Bio-Stack™.  
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Review the Major Components of the Bio-Stack™ 

Before you install the Bio-Stack according to the instructions in Chapter 3, please take 
a few minutes to become familiar with the Bio-Stack components described in this 
chapter.  

� Refer to Figure 3 on the next page for an illustration of the Bio-Stack 
components. 

The Bio-Stack’s major external components consist of the microplate stacks (“input 
stack” and “output stack”), carrier, claw/gripper, stack lifters, stack locks, 
stack dogs, and LED.  

There is no onboard display or keypad, because the Bio-Stack is either  

• computer-controlled  
¾ via the Bio-Stack™ PC Control Software (when used with the 

PowerWave™/PowerWave™ XS or Synergy™ HT/Synergy™ 2/ 
Synergy™ 4 Readers), or 

¾ via Precision Power™ Software, (when used with the Precision™ 
Microplate Pipetting System/Precision™  XS instruments), or 

¾ via Liquid Handling Control™ (LHC) Software (when used with the 
ELx405™ Washer or MicroFlo™ Select Dispenser). 

• instrument-controlled by the µFill™, NanoQuot™, or MicroFlo Select 
Dispenser, or ELx405 Washer. 

� ELx405 Washer:  The Bio-Stack with the ELx405 may be either 
computer controlled using the LHC Software, or instrument controlled 
using the keypad on the ELx405. Note: The Magna model of the 
ELx405 does not support the Bio-Stack.  

� MicroFlo Select Dispenser:  The Bio-Stack with the MicroFlo Select 
may be either computer controlled using the LHC Software, or 
instrument controlled using the keypad on the dispenser. 

Stacks 

The two microplate stacks are for storing plates to be processed (input stack) and 
for storing plates after they have been processed (output stack). The stacks are 
mechanically identical and interchangeable, and can hold up to 30 standard-height 
plates and at least 40 of the shorter profile plates.    
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Figure 3: External Components of the Bio-Stack™ 
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Carrier 

The carrier transfers one plate at a time from the input stack to the extended 
carrier position, and then back to the output stack. The carrier can also transfer a 
plate from the output stack to the input stack, if the optional re-stacking 
feature is requested.  

Claw/Gripper 

The claw/gripper  

• lifts the plate off the carrier at the extended carrier position and places it on 
the instrument, and  

• lifts the plate off the instrument and places it back on the carrier.  

The gripper has a sensor that indicates when the grip arms are at their closest 
position. The sensor is triggered when there is no plate within the gripper arms. 

The two sides of the gripper are spring-loaded so that if the power goes off, the 
gripper still holds the plate. 

Stack Lifters 

The two stack lifters lift and lower the stack of plates contained within the input 
and output stacks.  

Stack Locks 

The two stack locks (one on the left side, one on the right side of the Bio-Stack™) 
prevent the stacks from accidentally getting knocked over during operation of the 
instrument. A magnetic latch holds the locks in place. 

Stack Dogs 

There are two dogs per stack to hold a set of plates within the stack, and to aid the 
stack lifters in the process of lowering a plate down to the carrier.  

LED 

A green LED on the back of the Bio-Stack indicates the current state of the 
instrument. The light will turn on when the power-up and homing sequence 
begins (System Self-Test), and will remain constant if the instrument is functioning 
properly. A flashing light indicates an error that requires user intervention. (Refer 
to Chapter 7, Troubleshooting and Error Codes.) Any other state indicates either 
loss of power or, possibly, a defective LED. 
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Optional Barcode Scanner   

The Bio-Stack™ barcode scanner may be installed by the operator 

• on either the left side or right side of the Bio-Stack for operation with the 
Synergy™ HT/Synergy™ 2/Synergy™ 4 and Precision™/XS, or  

• on the left side only for operation with the PowerWave™/XS   

The scanner automatically scans barcode labels on plates at the Bio-Stack’s 
extended carrier position during plate transfers between the Bio-Stack and 
interfacing instrument. 

Barcode values returned from the scanner may be displayed in the Bio-Stack™ PC 
Control Software if the operator selects the option to display barcode information. 
The barcode value is then passed into Gen5™ or KC4™ Software for storage in the 
Gen5 experiment or KC4 output file, and optionally, as part of the output filename 
(KC4 only).  

Barcode scanner options are also available in Precision Power™ Software through 
the Supply Command and To-Do List features. 

 
� The µFill™, NanoQuot™, ELx405™, and MicroFlo™ Select do not support 

the Bio-Stack barcode scanner. 
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Before You Begin the Installation 

� For your convenience, an Installation Checklist is provided in 
Chapter 5, Instrument Qualification. The Checklist is a one-page 
form that you can use to check off each of the installation tasks you 
will be performing in this chapter. 

� If you have purchased the Bio-Stack’s optional barcode scanner, 
install the Bio-Stack™ with the interfacing instrument first, before you 
install the scanner. 

� You will need a flat-blade screwdriver, 7/64” hex wrench, and 
9/64” hex wrench to perform some of the Installation tasks. 

Tips for Easier Installation 

It may be easier to install the Bio-Stack with the instruments listed below, if you 
remove the following components from these instruments before installation. After 
you have completed installation and alignment of the Bio-Stack with the 
instrument, re-install the components that you removed. 

• Synergy™ HT/Synergy™ 2/Synergy™ 4 with injectors:  If equipped 
with injectors, and the dispense module is in use, disconnect the cable and 
tubing from the back of the reader and set the module aside. 

• Precision™/Precision™ XS:  Remove any supplies from the platform. If 
installed, remove the optional aerosol cabinet; the cabinet is not designed to 
be used in a robotic environment. Disconnect the tubing and remove the 
manifold and manifold priming trough.  

• ELx405™:  Remove the microplate carrier. Disconnect the tubing, vacuum 
pump cable, and waste sensor cable from the back of the washer. 
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Unpack and Inspect the Bio-Stack™ 

 

L 
Save all packaging materials! If you need to ship the 
instrument to BioTek for repair or replacement, you must use the 
original packaging. Using other forms of commercially available 
packaging is not recommended and can void the warranty. 

If the shipping box has been damaged, inspect the instrument for 
visible dents and scratches as you unpack it. If the instrument is 
damaged, notify the carrier and your BioTek sales representative. 
Keep the shipping cartons and the packing material for the 
carrier’s inspection. BioTek will arrange for the repair or 
replacement of your instrument immediately. 

See Repackaging and Shipping at the end of this chapter for 
complete shipping instructions. 

 
Perform these steps to unpack and inspect the instrument: 

1. Open the outer shipping container and remove the top foam shipping blocks 
from the inner box (see Figure 4 on the following page). 

2. Lift the inner box out of the bottom foam shipping blocks and outer shipping 
container, and place the box on a level surface. 

3. Remove all accessories from the inner sleeve, and then remove the inner sleeve 
(see Figure 5 on the following page). 

4. Carefully pull the Bio-Stack™ out of the inner box by lifting on the handles of 
the shipping panel. Place the instrument on a level surface. 

5. Place all packing materials back into the shipping container for reuse if the 
instrument needs to be shipped again.  

6. Unpack the two microplate stacks, which are shipped in a smaller, separate 
container. Save this container with the other packaging materials for the 
Bio-Stack and its accessories (see Figure 6 on page 31). 
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Figure 4: Opening the Outer Shipping Container  
 
 

 

Figure 5: Removing the Bio-Stack™ from the Inner Box 
 

BioTek Instruments, Inc. 



Unpack and Inspect the Bio-Stack™  |  31 

 

Figure 6: Unpacking the Microplate Stacks 
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Check the Components 

Required Components 

Confirm that all required components are included. If any are missing or 
damaged, contact your BioTek sales representative.  

� Chapter 1, Introduction, contains BioTek part numbers for the 
components listed below. 

• Two microplate stacks 

• Power supply 

• Plate stacking pedestal 

• Grease kit 

• Unpacking and packing instructions 

• Bio-Stack™ Operator’s Manual (on CD after January 2007) 

• Declaration of Conformity, Warranty Statement, and Certificate of 
Compliance and Calibration 

• Bio-Stack Alignment Kit for one of the following instruments: 

¾ PowerWave™/PowerWave™ XS Reader 

¾ Synergy™ HT Reader 

¾ Synergy™ 2/Synergy™ 4 Reader 

¾ Precision™ Microplate Pipetting System/Precision™ XS 

¾ µFill™ Dispenser 

¾ ELx405™ Washer 

¾ NanoQuot™ Dispenser 

¾ MicroFlo™  Select Dispenser 

� Refer to Appendix B, Bio-Stack Barcode Scanner, for a complete 
list of the components contained in the Bio-Stack’s optional barcode 
scanner installation kit. 

Optional Components 

Confirm that all purchased optional components are included (they should be 
documented on the packing list). If any are missing or damaged, contact your 
BioTek sales representative. 
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Set Up the Bio-Stack™ 

 Select an Appropriate Location  

For optimal operation, install the Bio-Stack on a clean, level surface in an area 
where ambient temperatures between 15ºC (59°F) and 35ºC (95°F) can be 
maintained.  

Conditions to avoid are: 

• Excessive humidity: Condensation directly on the sensitive electronic 
circuits can cause the instrument to fail internal self-checks. The Bio-Stack 
requires a maximum relative humidity of 80% at temperatures up to 31°C 
(87.8°F), decreasing linearly to 50% relative humidity at 40°C (104°F). 

• Dust:  Efficient microplate transporting may be affected by extraneous 
particles (such as dust) on the carrier’s linear ways. A clean work area is 
necessary to ensure smooth plate transporting. 

Remove the Shipping Hardware 

 

L 
The Bio-Stack is shipped with a shipping panel, shipping 
block, and carrier shipping screw that must be removed 
before the instrument can be used. Do not throw these 
components away! Save them in case the instrument 
needs to be repackaged for shipment. 

 

Perform these steps to remove the shipping hardware: 

1. Carefully set the instrument on its side with the bottom of the shipping 
panel facing you and hanging over the edge of a flat surface (see Figure 7 
on the following page). 

2. Using a screwdriver, remove the four shipping panel mounting screws. 
Remove the shipping panel and set it aside. 

3. Carefully lift the Bio-Stack and set it upright. 

4. Locate the shipping block and carrier shipping screw inside the Bio-Stack 
(see Figure 8 on the following page). 

5. Remove the four shipping block mounting screws and the shipping block. 

6. Remove the carrier shipping screw. 

7. Keep all screws together, and store them with the shipping panel, shipping 
block, and all other packaging materials in the shipping container. 
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Figure 7: Removing the Shipping Panel  
 
 

 

Figure 8: Removing the Shipping Block and Carrier Shipping Screw 

BioTek Instruments, Inc. 



Set Up the Bio-Stack™  |  35 

Connect the Power Supply  
 

 
Warning! Power Rating. The Bio-Stack’s power supply 
must be connected to a power receptacle that provides 
voltage and current within the specified rating for the 
system. Use of an incompatible power receptacle may 
produce electrical shock and fire hazards. 

Warning! Electrical Grounding. Never use a two-prong 
plug adapter to connect primary power to the Bio-Stack™.  
Use of a two-prong adapter disconnects the utility ground, 
creating a severe shock hazard. Always connect the power 
supply cord directly to a three-prong receptacle with a 
functional ground. 

 

Perform these steps to connect the power supply to the Bio-Stack: 

1. Connect the power cord to the external 24-volt power supply. 

2. Locate the power inlet on the rear of the Bio-Stack, above the power on/off 
switch (see Figure 9 on the next page). Plug the rounded end of the power 
supply’s line cord into the power inlet. Be sure to tighten the knurled nut. 

3. Plug the 3-prong end of the power cord into an appropriate power 
receptacle. 

� Do not turn on the Bio-Stack! Aligning posts (“feet”) need to be 
attached to the Bio-Stack before power-up. You will perform this step 
during installation of the Bio-Stack with the interfacing instrument. 
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Figure 9: Location of the Power Supply Inlet and Serial/USB Ports on the Bio-Stack™ 
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Where To Go From Here 

Installation of the Bio-Stack™ with the Interfacing Instrument 

Before the Bio-Stack can operate with the interfacing instrument, the two 
instruments must be mechanically aligned with each other, serial or USB 
cables need to be attached, and instruments that are computer-controlled require 
installation of software on the PC. Refer to the following sections in this 
chapter for instructions: 

• Install the Bio-Stack with the PowerWave™/XS or  
Synergy™ HT/Synergy™ 2/Synergy™ 4, page 39   

• Install the Bio-Stack with the Precision™/XS, page 65     

• Install the Bio-Stack with the µFill™ or ELx405™, page 85     

• Install the Bio-Stack with the NanoQuot™, page 111  

• Install the Bio-Stack with the MicroFlo™ Select, page 129  

Installation of the Bio-Stack Barcode Scanner  

Install the Bio-Stack with the interfacing instrument first, then refer to  
Appendix B, Bio-Stack Barcode Scanner for instructions on installing the 
barcode scanner. It will be easier to install the Bio-Stack if the barcode scanner is 
not attached. 

Bio-Stack Operator's Manual  



38  | Chapter 3: Installation 

 

BioTek Instruments, Inc. 



Install the Bio-Stack™ with the PowerWave™ or Synergy™ Readers  |  39 

Install the Bio-Stack™ with the PowerWave™ or 
Synergy™ Readers 

Lay Out the Alignment Hardware 

You will need the alignment hardware from the Bio-Stack Alignment Kits for the 
PowerWave/PowerWave XS (PN 7310011), illustrated below, or the Synergy HT 
(PN 7310009) or Synergy 2/Synergy 4 (PN 7310019), illustrated on the 
following pages. 

PowerWave/XS Alignment Kit 7310011 

   
  

       

 

Four aligning posts (PN 7310523) 
for elevating the Bio-Stack to the 
correct height and for seating in the 
aligning plate. 

Two aligning caps (PN 7312075) for 
elevating the PowerWave/XS to the 
correct height and for seating in the 
aligning plate. 

  

PowerWave/XS aligning plate  
(PN 7312047) for preventing the 
instrument from sliding around and 
being misaligned with the Bio-Stack. 

Bio-Stack aligning plate  
(PN 7312052) for attachment to the 
PowerWave/XS aligning plate.  

Includes two each of mounting 
hardware: pan head screws (PN 12028), 
lock washers (PN 16017), and flat 
washers (PN 16068). 
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Synergy™ HT Alignment Kit 7310009 

    
  

       

 

 

Four aligning posts (PN 7310523) 
for elevating the Bio-Stack™ to the 
correct height and for seating in the 
aligning plate. 

Two aligning caps (PN 7312073) for 
elevating the Synergy HT to the correct 
height and for seating in the aligning 
plate. 

 

 

 
 

Synergy HT aligning plate  
(PN 7312048) for preventing the 
instrument from sliding around and 
being misaligned with the Bio-Stack. 

Bio-Stack aligning plate (PN 7312052) 
for attachment to the Synergy HT 
aligning plate.  

Includes two each of mounting hardware: 
pan head screws (PN 12028), lock 
washers (PN 16017), and flat washers 
(PN 16068). 

 

� Synergy HT readers with serial numbers < 181151 may need to 
be factory upgraded with a Bio-Stack compatible carrier. Please 
contact your BioTek sales representative for details. 
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Synergy™ 2/Synergy™ 4 Alignment Kit 7310019 

    
  

       

 

 

Four aligning posts (PN 7130559) 
for elevating the Bio-Stack™ to the 
correct height and for seating in the 
aligning plate. 

Two aligning caps (PN 7312073) for 
elevating the Synergy 2/Synergy 4 to the 
correct height and for seating in the 
aligning plate. 

 

 

 
 

Synergy 2/Synergy 4 aligning 
plate (PN 7132153) for preventing 
the instrument from sliding around 
and being misaligned with the 
Bio-Stack. 

Bio-Stack aligning plate (PN 7312052) 
for attachment to the Synergy 2 or 
Synergy 4 aligning plate.  

Includes two each of mounting hardware: 
pan head screws (PN 12028), lock 
washers (PN 16017), and flat washers 
(PN 16068). 
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Attach the Aligning Posts and Caps 

L 
Important!  When attaching the four aligning posts (“feet”) 
to the Bio-Stack™, do not over-tighten the posts! 
Finger-tighten only! 

To avoid scratches to the Bio-Stack or to the reader, place a 
towel down before laying the instrument on its side or back. 

 

L 
Important!  The Synergy™ 2/Synergy™ 4 are very heavy 
instruments; use extra care when laying one of these 
readers on its side or when returning it to the upright 
position. 

 

Perform these steps to attach the aligning posts to the Bio-Stack and the aligning 
caps to the reader: 

1. Carefully lay the Bio-Stack on its side so the bottom is facing you (see 
Figure 10 on the following page). 

2. Screw in all four aligning posts as shown. 

3. Return the Bio-Stack to the upright position. 

4. If the reader is on, turn it off and disconnect the power supply. 

5. Attach the aligning caps: 

PowerWave™/XS:   

• Carefully lay the reader on its side so the bottom is facing you. 

• Using a 9/64” hex wrench, remove the mounting hardware on the 
reader and replace the flat washers with the aligning caps as shown in 
Figure 11 on the following page. 

• Reinstall the hardware that was removed (except the flat washers). 

 Synergy™ HT/Synergy™ 2/Synergy™ 4: 

• Carefully lay the reader on its back (Synergy HT) or on its side 
(Synergy 2/Synergy 4) so the bottom is facing you. 

• Screw in the two aligning caps as shown in Figure 12 (Synergy HT) or 
Figure 13 (Synergy 2/Synergy 4) on page 44. 

6. Return the reader to the upright position. 
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Figure 10:  Attaching the Aligning Posts to the Bio-Stack™ 
 

 

Figure 11: Attaching the Aligning Caps to the PowerWave™/XS Reader 
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Figure 12: Attaching the Aligning Caps to the Synergy™ HT Reader 
 

 

Figure 13: Attaching the Aligning Caps to the Synergy™ 2/Synergy™ 4 Reader 

(The Synergy 2 is shown.) 

BioTek Instruments, Inc. 



Install the Bio-Stack™ with the PowerWave™ or Synergy™ Readers  |  45 

Seat the Instruments in the Aligning Plates 

L 
Important!  The Synergy™ 2/Synergy™ 4 are very heavy 
instruments; use extra care when lifting or moving one of 
these readers. The following instructions require two people 
when seating the Synergy 2/Synergy 4 in the aligning plate, 
to ensure that the reader’s aligning caps/legs are properly 
positioned in the slots provided on the plate.   

Perform these steps to seat the Bio-Stack™ and reader in the aligning plates: 

1. Place the reader’s aligning plate on a level surface. 

2. Loosely attach the Bio-Stack aligning plate to the reader’s aligning plate by 
screwing in the pan head screw, lock washer, and flat washer only halfway. 
See Figures 14 through 16 on the following pages. 

3. Seat the reader in its aligning plate: 

PowerWave™/XS and Synergy™ HT: 

• Slide the reader’s two front aligning caps and two front legs into the 
slots provided on the reader’s plate (Figure 14 and Figure 15). 

Synergy 2/Synergy 4 (two people are required): 

• Lift the front of the reader slightly while another person slides the 
reader’s aligning plate in place under the reader, so the slots on the 
plate are lined up with the reader’s aligning caps and legs. 

• Carefully lower the reader’s aligning caps/legs into the slots  
(Figure 16). 

4. Slide the Bio-Stack’s two front aligning posts into the slots provided on the 
Bio-Stack’s plate. 

5. Move both instruments back and forth in their slots until you are satisfied 
that they are positioned correctly next to each other (approximately). 
Ensure that all posts and caps are properly seated (not resting on top of the 
plates), and that the instruments are level. 
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 Figure 14: Seating the Bio-Stack™ and PowerWave™/XS in the Aligning Plates 
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Figure 15: Seating the Bio-Stack™ and Synergy™ HT in the Aligning Plates 
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Figure 16: Seating the Bio-Stack™ and Synergy™ 2/Synergy™ 4 in the Aligning Plates 

(The Synergy 2 is shown.) 
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Turn on the Bio-Stack™ and Run a Self-Test 

 
Warning! Keep your hands away from the claw/gripper and 
carrier while the Bio-Stack is being powered up. The carrier 
and claw/gripper move quickly during the homing sequence. 

L 
The Bio-Stack must pass the Self-Test for installation with 
the PowerWave™/XS or Synergy™ HT/Synergy™ 2/ 
Synergy™ 4. 

 

� The Bio-Stack does not need to be connected to a host computer for 
this test. 

Locate the Bio-Stack’s power switch and turn on the instrument (see Figure 9 on 
page 36 for the location of the switch). The Bio-Stack will home all axes 
(claw/gripper, carrier, input and output stack lifts) and then perform a system 
Self-Test.   

• If the Self-Test passes, the green light will turn on and remain on.  

• If the Self-Test fails, the green light will flash. If this happens, turn off 
the Bio-Stack and check for any obstructions. Ensure that all of the shipping 
hardware has been removed. If you cannot resolve the problem, contact 
BioTek’s Technical Assistance Center for guidance. 

Leave the Bio-Stack powered up for the next section, Align the Bio-Stack with 
the Reader. 
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Align the Bio-Stack™ with the Reader 

Perform these steps to align the Bio-Stack™ with the PowerWave™/XS or 
Synergy™ HT/Synergy™ 2/Synergy™ 4 reader: 

1. Ensure that the Bio-Stack has been homed according to the instructions in 
the previous section. 

2. PowerWave/XS: Reconnect the power supply to the reader. 

Synergy HT/Synergy 2/Synergy 4: Reconnect the power supply and 
serial or USB cable to the reader. 

3. Turn on the reader. The carrier should be in the “out” position. Leave the 
reader powered up. 

4. Turn the Bio-Stack off. 

5. Manually pull the Bio-Stack carrier all the way out and position it below 
the claw assembly. Refer to Figure 17 or Figure 18 on pages 51 and 52.  

� PowerWave/XS: The Bio-Stack’s carrier should not touch the front of 
the reader. 

6. Place a microplate on the Bio-Stack carrier. 

7. Manually lower the claw assembly down to the microplate and pick up the 
microplate (manually open the gripper to get around the plate and close it 
to pick up the plate). Raise the claw assembly carefully to ensure that the 
microplate does not change positions in the claw. 

8. Slide the Bio-Stack carrier out of the way. 

9. Lower the claw assembly until the microplate is just above the carrier of the 
reader.  

10. Manually adjust the Bio-Stack on the tabletop so the microplate can be 
lowered onto the carrier of the reader. The microplate carrier should be 
positioned as if it was just homed by the reader. If the reader’s carrier or 
microplate has been moved, home the instruments, remove the microplate 
from the Bio-Stack claw, then repeat steps 4 through 10. 

11. When you are satisfied with the microplate positioning relative to the 
carrier of the reader (look carefully at the top-down drawing in Figure 17 
for the PowerWave/XS or Figure 18 for the Synergy HT/Synergy 2/ 
Synergy 4, to see how the plate should fit in the carrier), finger-tighten the 
aligning plate locking hardware in both places. 

12. Repeat all of the steps a couple times to ensure that the microplate does not 
change position and that it rides smoothly in and out of the carriers. 
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Figure 17: Aligning the Bio-Stack™ with the PowerWave™/XS Reader 
 

Bio-Stack Operator's Manual  



52  | Chapter 3: Installation 

 

 

Figure 18: Aligning the Bio-Stack™ with the Synergy™ HT/Synergy™ 2/Synergy™ 4 Reader 
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Install the Plate Stacks 

Locate the stack locks on the side of the Bio-Stack™.  Make sure the locks are both 
in the “unlocked” position. Install the stacks as shown in Figure 19 below and 
then close the stack locks. 

 

 

Figure 19: Installing the Plate Stacks 
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Connect the Host Computer to the Bio-Stack™ and Reader 

  

L The host computer must be equipped with at least two 
serial ports or one serial port and one USB port. 

 

� The Bio-Stack™ Alignment Kits for the PowerWave™/XS,   
Synergy™ HT, and Synergy™ 2/Synergy™ 4 include two serial cables 
(a 9-pin to 9-pin female/male cable and 9-pin to 25-pin female/female 
cable), a USB cable, and USB Virtual COM Driver Software CD.  
 
The shipping accessories for the PowerWave/XS include a 9-pin to 
25-pin female/female serial cable.    
 
The shipping accessories for the Synergy HT/Synergy 2/Synergy 4 
include a 9-pin to 9-pin female/male serial cable, USB cable, and USB 
Virtual COM Driver Software CD.   

 
Perform these steps to connect the host computer to both the Bio-Stack and the 
interfacing reader (refer to Figure 9 on page 36 for an illustration of the serial and 
USB ports): 

1. If the Bio-Stack is on, turn it off. 

2. Place the computer in a location adjacent to the Bio-Stack and the reader. 

3. Connect the computer to the Bio-Stack, using the supplied serial cable or 
USB cable: 

Connect the serial cable:

• Using the appropriate serial cable, attach one end of the cable to a serial 
port on the computer.  

• Attach the other end of the cable to the serial port on the rear of the 
Bio-Stack.  

• Tighten the securing screws on both ends of the cable. 

Connect the USB cable and install the USB driver:

• Attach one end of the supplied USB cable to a USB port on the 
computer. Attach the other end of the cable to the USB port on the rear 
of the Bio-Stack. 

• Turn the computer on.   
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• Place the USB Virtual COM Driver Software CD in the computer’s CD 
ROM drive. 

• Using Microsoft® Explorer or other file management software, find the 
installation guide appropriate for your computer’s operating system 
(e.g., WXPInstall.pdf). 

• Follow the directions provided within the document to install the driver 
software. 

� In the instructions on the following pages you will need to know 
which COM number is associated with the USB port on your 
computer. (You’ll select this number in the Gen5™ or KC4™ 
Software and Bio-Stack™ PC Control Software port selection 
dialogs.) The COM port can be customized to use any number 
port that is not currently defined by the System. For 
customization instructions, consult the ComPortGuide.doc or 
ComPortGuide.pdf file on the USB driver CD. 

4. Turn the computer off. 

5. Attach the reader to the computer using the appropriate serial cable or the 
USB cable (Synergy™ HT/Synergy™ 2/Synergy™ 4 only).   

6. If the serial cable was used, tighten the securing screws on both ends of the 
cable.    
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Install Gen5™ Software and Test Communication with the Reader 

 

L 
All Gen5 software versions support the Bio-Stack™, however, you will 
need versions of the Bio-Stack™ PC Control Software and the Bio-Stack 
basecode software that are appropriate for the Gen5 version you are 
using with your reader. See Appendix D, Required Software 
Versions.  

Perform these steps to install the Gen5 software, and then test communication 
with the interfacing reader: 

1. Follow the instructions provided in Gen5’s Getting Started Guide or Help 
system for installing and registering Gen5.  

• If you purchased the Diagnostics Utility and Test Plate Package  
(PN 7770042), install the Diagnostics Utility. 

2. Turn on the reader and allow the system Self-Test to complete. 

3. Launch Gen5. Login if prompted to do so (Gen5 Secure); the default 
password is admin. 

4. At the Welcome screen, select System Menu. 

5. At Gen5’s main screen, select System > Reader Configuration to open 
the ‘Reader Configuration’ dialog. 

6. Click the Add button to open the ‘Reader Settings’ dialog.  

• Gen5 and Gen5 Secure: Up to two readers may be added in Gen5. 

7. Use the drop-down list in Reader Type to select the correct reader. 

8. Enter the reader’s Com Port. 

9. Select a Baud Rate (9600 is recommended for most BioTek readers). 

10. Click Test Comm. to establish communication. If any informational 
messages appear, read them carefully and follow the instructions provided 
by Gen5. 

• If you receive “The Reader is communicating!” message, click OK and 
then OK again to save the settings. 

• If you receive an error message, check the serial cable connections or 
refer to the Troubleshooting section of the Help system for assistance. 

11. Click Close at the Reader Configuration dialog to return to the main menu. 

� Gen5 Secure: An ‘Audit Trail’ dialog will appear after closing Reader 
Configuration. Enter any comments, if desired, then click Close. Note 
also that when Gen5 Secure is used in the Bio-Stack operating 
environment, Audit Trail events are identified by the user “OLE User.” 
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Install KC4™ Software and Test Communication with the Reader 

 

L 
You will need KC4 software v. 3.3, Rev. 9 or greater for operation of 
the reader with the Bio-Stack™. If you do not have this software, 
please contact your BioTek sales representative for more information. 

For operation of the Bio-Stack’s optional barcode scanner, you will need 
KC4 v. 3.4, Rev. 16 or greater. (You will need v. 3.4, Rev. 22 if you 
wish to have Bio-Stack scanned barcodes appear in KC4 plate 
description dialogs.) 

See Appendix D, Required Software Versions. 

Perform these steps to install the KC4 software, and then test communication with 
the interfacing reader: 

1. Follow the instructions provided in the KC4 User’s Guide for installing and 
registering the software. 

2. Turn on the reader and allow the system Self-Test to complete. 

3. Launch KC4. Login if prompted to do so. 

4. From KC4’s main menu, select System > Readers to open the ‘Reader 
Selection’ dialog. 

5. Carefully review the list of Available Readers. Click once to highlight the 
correct reader model. 

� BioTek’s Synergy™ 2/Synergy™ 4 readers are not included in 
the list of Available Readers; KC4 does not support the Synergy 
2 or Synergy 4. 

6. Click Port and select the reader’s COM port#. 

7. Click Setup and set the Transmission Speed (Baud Rate), Data Bits, 
Parity, and Stop Bits to 9600, 8, No, and 2. 

8. Click OK, OK to return to the Reader Selection dialog. 

9. Click Current Reader to establish communication. If any informational 
messages appear, read them carefully and follow the instructions provided 
by KC4. 

• If asked, “Do you want to update the software wavelength table?” click 
Yes. 

• If a “No reader response” message appears, you may have selected the 
wrong COM port in step 6.  

10. Click Close to return to KC4’s main screen. 
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Run the Checksum Test for the Reader  

Perform these steps to run the Checksum Test and record the software versions for 
Gen5™ or KC4™ Software and for the reader: 

� For your convenience, Software Data Sheets are provided in  
Chapter 5, Instrument Qualification, for recording the software 
versions for Gen5 or KC4 and for the PowerWave™/XS or 
Synergy™ HT/Synergy™ 2/Synergy™ 4. 

Gen5: 

1. At Gen5’s main screen, select Help > About Gen5. 

2. Record Gen5’s Installation Version, Build Version, Reader Control Version, 
and Diagnostics Version (if the Diagnostics Utility was installed). Record 
the serial number listed on the Gen5 software package. 

3. Return to the main menu and select System > Reader Control, then 
click the appropriate reader to open the ‘Reader Control’ dialog.  

4. At the Reader Control dialog, select the Information tab to display the 
reader’s basecode software information. If software version information is 
displayed and no errors occurred, the Checksum Test completed 
successfully. 

5. Record the reader’s basecode part number, version number, and checksum. 
Record the serial number listed on the reader. 

KC4: 

1. At KC4’s main screen, select About > About KC4. 

2. Record KC4’s version and revision numbers. Record the serial number 
listed on the KC4 software package. 

3. Click OK to return to the main screen, then select System > Reader 
Control. If software version information is displayed and no errors 
occurred, the Checksum Test completed successfully. 

4. Record the reader’s basecode part number, version number, and checksum. 
Record the serial number listed on the reader. 
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Install Bio-Stack™ PC Control Software and Test Communication 
with the Bio-Stack™ 

 
Warning! Keep your hands away from the claw/gripper and 
carrier while the Bio-Stack is being powered up. The carrier 
and claw/gripper move quickly during the homing sequence. 

� A CD containing the Bio-Stack PC Control Software and an 
installation guide are included in the Bio-Stack Alignment Kits for the 
readers.  

Perform these steps to install the Bio-Stack PC Control Software on the computer, 
and then test communication with the Bio-Stack: 

1. Turn the computer and the Bio-Stack on. Allow the Bio-Stack to complete 
its Self-Test. 

2. Follow the instructions provided in the Bio-Stack PC Control Software 
Installation Guide to install the software on the computer.  

3. Launch the Bio-Stack PC Control Software.  

4. From the software main screen, select Gen5™ or KC4™, as appropriate, for 
the Reader Control Software. 

5. Click the Configure Instruments button.  

6. When the ‘Instrument Configuration’ dialog appears, select the appropriate 
COM Port for the Bio-Stack Configuration and then click Test 
Communications. 

• If the test is not successful, ensure that the cable is properly connected 
and you have correctly identified the COM port number. 

• (Optional) If you installed Gen5, you may also test communication with 
the reader in the Instrument Configuration dialog. Select the 
appropriate Instrument, COM Port, and BAUD Rate (9600 is 
recommended) for the Instrument Configuration, then click Test 
Communications. 

7. If the test is successful, return to the main screen. 
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Run the Checksum Test for the Bio-Stack™  

Perform these steps to run the Checksum Test for the Bio-Stack and record the 
software versions for the Bio-Stack™ PC Control Software and for the Bio-Stack:  

� For your convenience, Software Data Sheets are provided in  
Chapter 5, Instrument Qualification, for recording the Bio-Stack 
software versions. 

1. From the top menu bar in the Bio-Stack PC Control Software, select Help > 
About Bio-Stack. 

2. The ‘About Bio-Stack Software’ dialog will open. Record the Bio-Stack PC 
Software Versions for the Installation CD, StackerContainer.exe, and 
BTIAutoStackerActiveX. Record the serial number listed on the Bio-Stack 
PC Control Software package. 

3. Click Get On-board values now. If software version information is 
displayed and no errors occurred, the Checksum Test completed 
successfully. 

4. Record the Bio-Stack onboard software versions for the basecode software, 
interface definition, and checksum. Record the serial number listed on the 
Bio-Stack. 

� When you have Gen5™ or KC4™ software installed on your PC, the 
Bio-Stack PC Control Software retrieves and displays the Gen5 or 
KC4 software versions in the ‘About Bio-Stack Software’ dialog. 
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Align the Claw/Gripper with the Reader’s Plate Carrier 

The Bio-Stack’s claw/gripper mechanism must now be aligned vertically with the 
reader’s plate carrier. The Bio-Stack™ PC Control Software has an Instrument 
Alignment Utility for this task. 

Perform these steps to run the Instrument Alignment Utility: 

1. Launch the Bio-Stack PC Control Software. 

2. From the main screen, click the Configure Instruments button. 

3. When the ‘Instrument Configuration’ dialog appears, select the appropriate 
Instrument (reader). 

� KC4™: Select “PowerWave” for any PowerWave™ model, and 
“Synergy” for any Synergy™ model (excludes the Synergy 2/ 
Synergy 4 readers). 

4. Click the Instrument Alignment Utility button. 

5. Use the Re-Alignment Control buttons to position the Bio-Stack’s 
claw/gripper mechanism to the desired height relative to the reader’s plate 
carrier. To aid in this activity, place a microplate on the reader’s carrier. 
Lower the claw/gripper so that the gripper’s “fingers” rest approximately 
50-60 thousandths of an inch (1.3-1.5 mm) below the plate bottom or carrier 
surface (see Figure 20 on the following page).  

� If the Bio-Stack and reader are located on an uneven surface, 
the gripper’s fingers should rest below the lowest point of the 
plate bottom, to ensure proper plate delivery. 

• Begin with the Down radio button selected.  To avoid collision of the 
gripper with the reader’s carrier, click the 20 Step button first, to see 
how far that goes, before clicking the 400 Step button. Use the 
400/20/1 Step buttons to gradually lower the claw/gripper 
mechanism to the desired height.  

If you go down too far, click the Up radio button and step up a bit. 

� If the alignment is interrupted, and you receive an error code 
such as 2500, the Bio-Stack™ will have to be homed to resolve 
the error. Click the Home the Bio-Stack button (in the 
Instrument Alignment Utility dialog) to home all axes on the 
Bio-Stack, then repeat step 5 above.  

6. When you are satisfied with the position, click the Save Position button.  

7. Remove the plate from the carrier. 
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Figure 20: Position of the Bio-Stack’s Gripper Fingers Below the Plate Bottom 
(on the Reader’s Plate Carrier) 

BioTek Instruments, Inc. 



Install the Bio-Stack™ with the PowerWave™ or Synergy™ Readers  |  63 

Verify the Alignment  

Perform the following test to verify alignment of the Bio-Stack™ with the reader: 

1. Place a dry microplate in the Bio-Stack’s input stack. 

2. If you have not already done so, launch the Bio-Stack™ PC Control 
Software. 

3. Click Configure Instruments to open the ‘Instrument Configuration’ 
dialog, then select the appropriate Instrument (reader).  

4. Click Instrument Alignment Utility, then click the Verify button. 

5. Watch closely to confirm the following behavior (the claw/gripper will 
pause periodically; this is the expected behavior): 

• The Bio-Stack will transfer the plate from the input stack to the 
Bio-Stack plate carrier, and then eject the plate carrier. 

• The claw/gripper will pick up the plate, lower it toward the reader’s 
plate carrier, and then smoothly place the plate on the carrier. 

� If the plate drops onto the carrier, the claw interface position 
has been set too high. Repeat the steps in the previous section: 
Align the Claw/Gripper with the Reader’s Plate Carrier. 

• The claw/gripper will come up a short distance. The gripper will then 
power-down, allowing its spring mechanism to tighten the gripper 
“fingers.” 

� If the gripper fingers catch on the top of the microplate, the 
claw interface position is set too low. An error code will appear 
in the software. Repeat the steps in Align the Claw/Gripper 
with the Reader’s Plate Carrier. 

• If the gripper fingers did not catch on the plate, the “Verify plate 
placement” message will appear. Click OK to continue. 

• The claw/gripper will lower, pick up the plate, place the plate on the 
Bio-Stack’s carrier, and then store the plate in the output stack. 

6. If the alignment verification completed successfully and you have 
determined that the gripper fingers are positioned correctly, the Bio-Stack 
is now ready for operation with the reader. 

• If the gripper fingers are not positioned correctly, perform the steps in 
Align the Claw/Gripper with the Reader’s Plate Carrier again, and 
then re-run the Verify Test. 

� The Verify Test must pass before the Bio-Stack can be used to 
transfer microplates. 

Bio-Stack Operator's Manual  



64  | Chapter 3: Installation 

 

BioTek Instruments, Inc. 



Install the Bio-Stack™ with the Precision™/XS  |  65 

Install the Bio-Stack™ with the Precision™/XS 

Lay Out the Alignment Hardware  

You will need the alignment hardware from the Bio-Stack Alignment Kit for the 
Precision/XS (PN 7110004) illustrated below: 
 

    

 

Four aligning posts  (PN 7110542) for 
elevating the Bio-Stack to the correct 
height and for seating in the aligning 
plate. (You will need two sets of 7110542 
if you will be using 2 Bio-Stack’s.) 

Two aligning caps (PN 7312074) for 
elevating the Precision/XS to the 
correct height and for seating in the 
aligning plate. 

 

 

 

Left and right roller extensions  
(PN’s 7110544 and 7110556) for 
extending the Precision supply platform 
forward for alignment with the 
Bio-Stack. 

Four each of mounting hardware: lock 
washer (PN 16003), screw (PN 19055), 
and flat washer (PN 17003). 

Precision aligning plate (PN 7112139) 
for preventing the instrument from 
sliding around and being misaligned with 
the Bio-Stack. 

Bio-Stack aligning plate (PN 7112140)
for attachment to the Precision aligning 
plate. Includes two each of mounting 
hardware:  pan head screws (PN 12028),
lock washers (PN 16017), and flat 
washers (PN 16068). (You will need two 
sets of 7112140 if you will be using 2 
Bio-Stack’s.) 

� If you are using two Bio-Stack’s with the Precision, you will need two sets of the 
Bio-Stack’s alignment hardware (PN’s 7110542 and 7112140). 

� Some Precision Microplate Pipetting Systems with serial numbers ≥ 187931 
may need to be upgraded; contact BioTek for details. The following Precision 
Microplate Pipetting Systems cannot be upgraded or are not Bio-Stack 
compatible: instruments with serial numbers < 187931, all 12-Channel models, 
and Universal 8-/12-Channel models in 12-Channel mode. 
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 Attach the Aligning Posts and Caps  
 

L 
Important!  When attaching the four aligning posts (“feet”) to 
the Bio-Stack™, do not over-tighten the posts! Finger-tighten 
only! 

To avoid scratches to the Bio-Stack or to the Precision™, place 
a towel down before laying the instrument on its side or back. 

 
Refer to Figure 21 on the next page for the following instructions. Perform these 
steps to attach the aligning posts to the Bio-Stack and the aligning caps to the 
Precision.   

1. Carefully lay the Bio-Stack on its side, so the bottom of the instrument is 
facing you. 

2. Screw in all four aligning posts as shown. Return the Bio-Stack to the 
upright position. 

3. If you are using two Bio-Stacks with a Precision instrument, repeat steps 1 
through 2 for the second Bio-Stack. 

4. Turn off the Precision instrument and disconnect it from the power supply 
cord and serial or USB cable. 

5. Carefully lay the Precision on its back so that the bottom surfaces of the left 
and right supports are facing you. 

6. Using a 9/64” hex wrench, remove the stop from the bottom of one support 
first. Install the aligning cap, using a flat blade screwdriver. 

7. Repeat Step 6 for the other support on the Precision. Return the Precision to 
the upright position. 

Attach the Roller Extensions to the Supply Platform 

Refer to Figure 22 on page 68 for the following instructions. Perform these steps 
to attach the left and right roller extensions to the Precision supply platform: 

1. If you haven’t already done so, install the supply platform (refer to the 
Installation chapter in the Precision Operator’s Manual). 

2. Using a 7/64” hex wrench, loosely attach the left roller extension to the left 
support by screwing in the screw, lock washer and flat washer only 
halfway. 

3. Slide the extension up until it touches the bottom of the supply platform 
without raising the platform. 

4. Tighten the mounting hardware of the extension. 

5. Repeat steps 2 through 4, using the right roller extension, mounting 
hardware, and the right support. 
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Figure 21: Removing the Stops and Attaching the Aligning Posts (Bio-Stack™)  
and Caps (Precision™/XS) 

 
� The Precision™ XS is illustrated in Figure 21. 
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Figure 22: Attaching the Roller Extensions to the Precision™/XS 
 

� The Precision™ XS is illustrated in Figure 22. 
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Seat the Instruments in the Aligning Plates   

� The Precision’s aligning plate contains slots for aligning the Bio-Stack™ with 
any one of the supply stations A, B, or C, located on the front row of the 
supply platform. Figure 24 on page 71 illustrates the Bio-Stack aligned with 
station C.  

� If you are using two Bio-Stacks with a Precision™ instrument, align one 
Bio-Stack with supply station A, and the other Bio-Stack with supply station C, 
in order to allow adequate spacing between the two Bio-Stacks. You will need 
two sets of part numbers 7110542 (Bio-Stack aligning posts) and 7112140 
(Bio-Stack aligning plate), and three communication ports on the host PC. 

Refer to Figure 23 and Figure 24 on pages 70 and 71 for the following 
instructions. Perform these steps to seat the Precision and Bio-Stack in the aligning 
plates:  

1. With the Precision still in the upright position, slide the Precision’s two 
front aligning caps into the slots provided on the Precision aligning plate  
(Figure 23). 

2. Loosely attach the Bio-Stack aligning plate to the Precision aligning plate in 
front of the supply station (A, B, or C) that the Bio-Stack will be aligned 
with, by screwing in the pan head screw, lock washer, and flat washer only 
half-way.  

3. Slide the Bio-Stack’s two front aligning posts into the slots provided on the 
Bio-Stack aligning plate (Figure 24). 

4. Move both instruments back and forth in their slots until you are satisfied 
that they are positioned correctly next to each other (approximately). 
Ensure that all posts and caps are properly seated (not resting on top of the 
plates), and that the instruments are level. 
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Figure 23: Attaching the Aligning Plates (Precision™/XS) 
 

� The Precision™ XS is illustrated in Figure 23. 
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Figure 24: Seating the Bio-Stack™ and Precision™/XS in the Aligning Plates 
 

� The Precision™ XS is illustrated in Figure 24. 
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Turn on the Bio-Stack and Run a Self-Test 
 

 
Warning! Keep your hands away from the claw/gripper and 
carrier while the Bio-Stack™ is being powered up. The 
carrier and claw/gripper move quickly during the homing 
sequence. 

L The Bio-Stack must pass the Self-Test for installation with 
the Precision/XS. 

� The Bio-Stack does not need to be connected to a host computer for 
this test. 

Locate the Bio-Stack’s power switch and turn on the instrument (see Figure 9 on 
page 36 for the location of the switch). The Bio-Stack will home all axes 
(claw/gripper, carrier, input and output stack lifts) and then perform a system 
Self-Test.   

• If the Self-Test passes, the green light will turn on and remain on.  

• If the Self-Test fails, the green light will flash. If this happens, turn off 
the Bio-Stack and check for any obstructions. Ensure that all of the shipping 
hardware has been removed. If you cannot resolve the problem, contact 
BioTek’s Technical Assistance Center for guidance. 

Connect the Host Computer to the Bio-Stack™ and Precision™/XS 
 

L The host computer must be equipped with at least two 
serial ports or one serial port and one USB port. 

 
� The Bio-Stack Alignment Kits for the Precision™/XS include two 

serial cables (9-pin to 9-pin female/male cable and 9-pin to 25-pin 
female/female cable), a USB cable, and USB driver software CD.  
 
The shipping accessories for the Precision/XS include a 9-pin to 
25-pin female/female serial cable.   

Perform these steps to connect the host computer to both the Bio-Stack and the 
interfacing Precision instrument (refer to Figure 9 on page 36 for an illustration of 
the serial and USB ports): 

1. If the Bio-Stack is on, turn it off. 

2. Place the computer in a location adjacent to the Bio-Stack and the Precision. 
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3. Connect the computer to the Bio-Stack™, using a serial cable or USB cable: 

Connect the serial cable: 

• Using the appropriate serial cable, attach one end of the cable to a serial 
port on the computer.  

• Attach the other end of the cable to the serial port on the rear of the 
Bio-Stack.  

• Tighten the securing screws on both ends of the cable. 

Connect the USB cable and install the USB driver: 

• Attach one end of the supplied USB cable to a USB port on the 
computer. Attach the other end of the cable to the USB port on the rear 
of the Bio-Stack. 

• Turn the computer on.   

• Place the USB Virtual COM Driver Software CD in the computer’s CD 
ROM drive. 

• Using Microsoft® Explorer or other file management software, find the 
installation guide appropriate for your computer’s operating system 
(e.g., WXPInstall.pdf). 

• Follow the directions provided within the document to install the driver 
software. 

� In the instructions on the following pages you will need to 
know which COM number is associated with the USB port on 
your computer. (You’ll select this number in the Precision 
Power™ Software port selection dialog.) The COM port can 
be customized to use any number port that is not currently 
defined by the System. For customization instructions, 
consult the ComPortGuide.doc or ComPortGuide.pdf file 
on the USB driver CD. 

4. Turn the computer off. 

5. Attach the Precision™ to the computer using the appropriate serial cable. 

6. Tighten the securing screws on both ends of the cable. 
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Install the Bio-Stack™ PC Control Software 

 
Warning! Keep your hands away from the claw/gripper and 
carrier while the Bio-Stack™ is being powered up. The 
carrier and claw/gripper move quickly during the homing 
sequence. 

� A CD containing the Bio-Stack PC Control Software and an installation 
guide are included in the Bio-Stack Alignment Kit (PN 7110004) for the 
Precision™. 

� Since Precision Power™ Software controls the Bio-Stack via a component 
of the Bio-Stack PC Control Software, it is not necessary to test 
communication between the Bio-Stack and the Bio-Stack PC Control 
Software. There is a step to test communication between the Bio-Stack 
and Precision Power in Configure Precision Power for Bio-Stack 
Operation and Test Communication on page 76. 

 Perform these steps to install the Bio-Stack PC Control Software on the computer: 

1. Turn the computer and the Bio-Stack on.   

2. Follow the instructions in the Bio-Stack PC Control Software 
Installation Guide for installation of the software. 

3. Launch the Bio-Stack PC Control Software. 

Run the Checksum Test for the Bio-Stack  

Perform these steps to run the Checksum Test and record the software versions for 
the Bio-Stack PC Control Software and for the Bio-Stack: 

� For your convenience, Software Data Sheets are provided in Chapter 5, 
Instrument Qualification, for recording the Bio-Stack software versions. 

1. From the top menu bar in the Bio-Stack PC Control Software, select Help > 
About Bio-Stack. 

2. The ‘About Bio-Stack Software’ dialog will open. Record the Bio-Stack PC 
Software Versions for the Installation CD, StackerContainer.exe, and 
BTIAutoStackerActiveX. Record the serial number listed on the Bio-Stack 
PC Control Software package. 

3. Click Get On-board values now. If software version information is 
displayed and no errors occurred, the Checksum Test completed 
successfully. 

4. Record the Bio-Stack onboard software versions for the basecode software, 
interface definition, and checksum. Record the Bio-Stack’s serial number. 
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Install Precision Power™ Software and Test Communication 

 

L 
A CD containing Precision Power Software, v. 2 or greater is 
included in the package contents with the Precision™ XS. 

If you are operating with the Precision™ Microplate Pipetting 
System, please contact BioTek for more information. 

 

Perform these steps to install Precision Power software on the computer, and 
then test communication with the Precision instrument:  

1. Follow the instructions provided in the Precision Power User’s Guide to 
install and register the software. 

2. Turn on the Precision instrument.  

� The Precision Microplate Pipetting System will perform a system 
self-test upon startup, however, this feature has been disabled in 
the Precision XS as a precaution to avoid shattering any breakable 
supplies that may be present on the platform during power-up. 

3. Launch Precision Power.   

• If you haven’t registered the software, the first time you launch 
Precision Power and each time you run it before it is registered (i.e., 
running in Demo mode), the Program Registration screen opens. 
Click Demo to run Precision Power in trial mode. 

• If you have already registered the software, an introductory screen will 
appear. After a few moments (or if you press any key or click the mouse 
on the image), Precision Power’s main screen will appear. 

4. At the main screen, select Instrument > Precision Series 
Configuration to open the ‘Precision Series Instrument Configuration 
dialog’. 

5. If the COM port that is highlighted is not the correct port, click the Modify 
button. At the ‘Modify Instrument’ dialog, select the correct Com Port, 
then click OK.    

6. At the Precision Series Instrument Configuration dialog, click Test Comm. 

• If the test fails, ensure that the cable is properly connected and you 
have correctly identified the COM port number. 

7. If the test is successful, return to Precision Power’s main screen.  

You must now configure Precision Power for operation with the 
Bio-Stack™ before you can test communication with the Bio-Stack. (See the 
next topic.) 
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Configure Precision Power™ for Bio-Stack™ Operation and Test 
Communication 

Perform these steps to configure Precision Power for Bio-Stack operation, and then 
test communication with the Bio-Stack: 

1. For the Precision™ Microplate Pipetting System only:   

Prepare the Precision for operation with the Bio-Stack:  

• Select Instrument > Precision Series Configuration > Settings. 
Precision Power will attempt to communicate with the instrument.  
(If an error is displayed, click OK to get to the dialog.) 

• Under For Non-Precision XS Models, select Operating adjacent 
to Bio-Stack to prepare the instrument to function with the Bio-Stack. 
This prevents the Precision from performing its normal homing routine 
(Self-Test) at startup – avoiding any hardware collisions with the 
Bio-Stack. 

• Click Exit and then OK to return to Precision Power’s main screen. 

2. For the Precision Microplate Pipetting System and Precision™ XS:  

Add a Bio-Stack to Precision Power’s Instrument Configuration:     

• Select Instrument > Bio-Stack Configuration > Add. Enter a 
unique Name for the Bio-Stack, using up to 16 alphanumeric 
characters.  

• Use the up/down arrow keys to select a Com Port, or enter the desired 
number directly in the field. 

• Select the supply Station where the Bio-Stack will interface with the 
Precision instrument.  

• Click OK to save the settings and return to the Configuration dialog. 

• At the Configuration dialog, click Test Comm. If the test is a success, 
Precision Power and the Bio-Stack are communicating properly. If the 
test fails, an error code will be provided for troubleshooting.   

• Return to Precision Power’s main screen. 
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Run the Checksum Test for the Precision™/XS 

Perform these steps to run the Checksum Test and record the software versions for 
Precision Power™ Software and for the Precision™/XS: 

� For your convenience, Software Data Sheets are provided in  
Chapter 5, Instrument Qualification, for recording the software 
versions for Precision Power and the Precision instruments. 

1. At Precision Power’s main screen, select Help > About Precision Power. 

2. Record the Precision Power software versions for the Installation CD, 
PrecisionPower#.exe, and BTIAutoDispenserActiveX. Click OK to return to 
the main screen. Record the serial number listed on the Precision Power 
Software package. 

3. Select Instrument > Precision Series Configuration > Test Comm, 
then select ActiveX/Instrument Versions > Instrument Version. If 
software version information is displayed and no errors occurred, the 
Checksum Test completed successfully. 

4. Record the Precision instrument’s basecode part number, Function Version, 
and Structure Version. Record the serial number listed on the Precision 
instrument. 
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Align the Bio-Stack™ with the Precision™/XS 

Refer to Figure 25 on the next page for the following instructions (the Precision™ 
XS is illustrated). Perform these steps to align the Bio-Stack with the desired 
supply station on the Precision:  

1. Reconnect the power supply and turn on the Bio-Stack. The carrier will 
home and the claw assembly will move up. 

2. To home all components on the Precision, select Instrument > Precision 
Series Configuration > Utilities > Home All Axis.  

3. After all axes have been homed, keep the ‘Utilities’ dialog open and 
prepare the supply platform for alignment with the Bio-Stack by clicking 
Position Platform for Bio-Stack. The platform will move forward. 
Click Exit, then OK to return to the main screen. 

4. Leave the Precision powered up, however, turn the Bio-Stack off. 

5. Manually pull the Bio-Stack carrier all the way out and position it below 
the claw assembly.  

6. Place a microplate on the Bio-Stack carrier, and a microplate holder on the 
supply station that the Bio-Stack is aligned with. 

7. Manually lower the claw assembly down to the microplate and pick up the 
microplate (open the gripper to get around the plate and close it to pick up 
the plate). Raise the claw assembly carefully to ensure that the microplate 
does not change positions in the claw. 

8. Slide the Bio-Stack carrier out of the way. 

9. Lower the claw assembly until the microplate is just above the microplate 
holder on the supply station of the Precision.   

10. Manually adjust the Bio-Stack on the tabletop so the microplate can be 
lowered onto the microplate holder on the supply station. If the supply 
platform has been repositioned or the microplate has been moved, home 
the instruments, remove the microplate from the Bio-Stack claw, then 
repeat steps 3 through 10. 

11. When you are satisfied with the microplate positioning relative to the 
supply station (refer to the top-down drawing in Figure 25 to see how the 
plate should fit into the holder on the supply station), finger-tighten the 
aligning plate locking hardware in both places. 

12. Repeat all of the steps a couple of times to ensure that the microplate does 
not change positions and that it rides smoothly in and out of the holder on 
the supply station. 

13. If you are using two Bio-Stacks with a Precision instrument, power down 
the first Bio-Stack. Power up the second Bio-Stack to home the instrument, 
and repeat steps 4 through 12 for the second Bio-Stack. 
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Figure 25: Aligning the Bio-Stack™ with the Precision™ Instruments 
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Install the Plate Stacks 

Locate the stack locks on the side of the Bio-Stack™.  Make sure the locks are both 
in the “unlocked” position. Install the stacks as shown in Figure 26 below and 
then close the stack locks. 

 

 

Figure 26: Installing the Plate Stacks 
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Align the Claw/Gripper with the Precision’s Supply Station 

The Bio-Stack’s claw/gripper mechanism must now be aligned vertically with the 
Precision™ supply station. Precision Power™ Software has an Instrument  
Alignment Utility for this task.  

Perform these steps to run the Instrument Alignment Utility: 

1. At Precision Power’s main screen, select Instrument > Bio-Stack 
Configuration. 

2. Click Utilities. 

3. Click Alignment Utility. 

4. To configure the alignment of the Bio-Stack™ to the Precision, begin with 
the Home the Bio-Stack function.  

5. After all axes have been homed on the Bio-Stack, place a microplate in the 
microplate holder on the Precision’s supply station. Then use the 
Re-alignment Control buttons to position the Bio-Stack’s claw/gripper 
so that the gripper “fingers” rest approximately 50-60 thousandths of an 
inch (1.3-1.5 mm) below the plate bottom: click Begin. The gripper’s jaws 
open. (See Figure 27 on the next page.) 

� If the Bio-Stack and Precision instrument are located on an 
uneven surface, the gripper’s fingers should rest below the 
lowest point of the plate bottom, to ensure proper plate 
delivery. 

• Begin with the Down radio button selected. To avoid collision of the 
gripper with the Precision supply station, click the 20 Step button first, 
to see how far that goes, before clicking the 400 Step button. Use the 
400/20/1 Step buttons to gradually lower the claw/gripper to the 
desired height.  

If you have moved the gripper too far below the plate bottom, click the 
Up radio button and step up a bit. 

� If the alignment is interrupted, and you receive an error code 
such as 2500, the Bio-Stack will have to be homed to resolve 
the error. Click the Home the Bio-Stack button (in the 
Instrument Alignment Utility) to home all axes on the 
Bio-Stack, then repeat step 5 above.  

6. When you’re satisfied with the positioning of the gripper, click Save 
Position. 

7. Remove the microplate from the station. 
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Figure 27: Position of the Bio-Stack’s Gripper Fingers Below the Plate Bottom 
(on the Precision™ Supply Station) 
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Verify the Alignment 

Perform the following test to verify alignment of the Bio-Stack™ with the 
Precision™: 

1. Place a dry microplate in the Bio-Stack’s input stack. 

2. In Precision Power™, select Instrument > Bio-Stack Configuration. 

3. Click Utilities > Alignment Utility. 

4. At the ‘Bio-Stack Instrument Alignment Utility’ dialog, click the Verify 
button. 

5. Watch closely to confirm the following behavior (the claw/gripper will 
pause periodically; this is the expected behavior): 

• The Bio-Stack will transfer the plate from the input stack to the 
Bio-Stack plate carrier, and then eject the plate carrier. 

• The claw/gripper will pick up the plate, lower it toward the supply 
station, and then smoothly place the plate on the station. 

� If the plate drops onto the station, the claw interface position 
has been set too high. Repeat the steps in the previous section 
Align the Claw/Gripper with the Precision’s Supply Station. 

• The claw/gripper will come up a short distance. The gripper will then 
power-down, allowing its spring mechanism to tighten the gripper 
“fingers.” 

� If the gripper fingers catch on the top of the microplate, the 
claw interface position has been set too low. An error code will 
appear in the software. Repeat the steps in the previous section 
Align the Claw/Gripper with the Precision’s Supply Station. 

• If the gripper fingers did not catch the plate, Precision Power issues a 
“Verify the placement” message and delays the Bio-Stack’s movement 
to give you time to observe the action. Click OK to continue. 

• The claw/gripper will lower, pick up the plate, place the plate on the 
Bio-Stack’s plate carrier, and then store the plate in the output stack. 

• If the gripper fingers are not positioned correctly, repeat the steps in 
Align the Claw/Gripper with the Precision’s Supply Station and 
then re-run the Verify Test. 

6. Click OK, Exit, then OK. Close Precision Power Software. 

� The Verify Test must pass before the Bio-Stack can be used to 
transfer microplates. 
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Install the Bio-Stack™ with the µFill™ or ELx405™ 

Lay Out the Alignment Hardware  

You will need the alignment hardware from the Bio-Stack Alignment Kits for the 
µFill (PN 7310012), illustrated below, or for the ELx405 (PN 7310010), 
illustrated on the following page. 

µFill Alignment Kit  7310012 

      
       

 
 

Four aligning posts  
(PN 7310524) for elevating the 
Bio-Stack to the correct height and 
for seating in the aligning plate. 

µFill aligning plate (PN 7312049) for 
preventing the instrument from sliding 
around and being misaligned with the 
Bio-Stack. 

  
Bio-Stack aligning plate (PN 7312052) 
for attachment to the µFill aligning plate.  
Includes two each of mounting 
hardware: pan head screws (PN 12028), 
lock washers (PN 16017), and flat 
washers (PN 16068). 

 

� µFill Dispensers with serial numbers ≥ 185105 have been installed 
with the latest basecode software for Bio-Stack compatibility. 
Dispensers with serial numbers < 185105 may need the µFill Upgrade 
Kit (PN 7310015), which contains the latest µFill basecode software for 
Bio-Stack compatibility. Contact BioTek for details. 
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ELx405™ Alignment Kit  7310010 

    
  

       
 
 

Four aligning posts  
(PN 7310524) for elevating the 
Bio-Stack™ to the correct height and 
for seating in the aligning plate. 

Two aligning caps (PN 7312074) for 
elevating the ELx405 to the correct 
height and for seating in the aligning 
plate. 

  

ELx405 aligning plate  
(PN 7312050) for preventing the 
instrument from sliding around and 
being misaligned with the Bio-Stack. 

Bio-Stack aligning plate (PN 7312052) 
for attachment to the ELx405 aligning 
plate.  
Includes two each of mounting 
hardware: pan head screws (PN 12028), 
lock washers (PN 16017), and flat 
washers (PN 16068). 

  

� ELx405 washers with serial numbers 183514, 184197, or with serial 
numbers ≥ 185301 have been installed with the latest ELx405 
basecode software for Bio-Stack compatibility. 

� Washers with serial numbers >=182188 and <185301 may need the 
software Upgrade Kit (PN 7310013), which contains the latest 
ELx405 basecode software.  Contact BioTek. 

� Washers with serial numbers =<182187 may need to be factory 
upgraded with Upgrade Kit PN 7310006, which includes a Bio-Stack 
compatible carrier and the latest ELx405 basecode software.  Contact 
BioTek.  

� The Magna model of the washer is not Bio-Stack compatible. 

� PC Control of the Bio-Stack and ELx405 using the Liquid Handling 
Control™ (LHC) Software: Some washers may need their basecode 
software upgraded to be compatible with the LHC Software. Contact 
BioTek for more information.  
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Attach the Aligning Posts and Caps   

 

L 
Important!  When attaching the four aligning posts (“feet”) 
to the Bio-Stack™, do not over-tighten the posts! 
Finger-tighten only! 

To avoid scratches to the Bio-Stack or to the ELx405™, 
place a towel down before laying the instrument on its side. 

 

Perform these steps to attach the aligning posts to the Bio-Stack and the aligning 
caps to the ELx405 (refer to Figure 28 on the following page):  

� The µFill is already at the correct height for operation with the 
Bio-Stack, and does not need aligning caps attached to it. 

1. Carefully lay the Bio-Stack on its side so the bottom is facing you. 

2. Screw in all four aligning posts as shown. 

3. Return the Bio-Stack to the upright position. 

4. Turn off the µFill or ELx405. Disconnect the power supply cord from the  
µFill and the power cord from the ELx405. 

ELx405 only:  

• Carefully lay the washer on its side so the bottom is facing you. 

• Remove the mounting hardware. Replace the flat washers with the 
aligning caps. 

• Reinstall the hardware that was removed (except the flat washers). 

• Return the washer to the upright position. 

Bio-Stack Operator's Manual  



88  | Chapter 3: Installation 

 

   Figure 28: Attaching the Aligning Posts to the Bio-Stack™ and the Caps to the ELx405™ 
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Seat the Instruments in the Aligning Plates  

Perform these steps to seat the Bio-Stack™ and the µFill™ or ELx405™ in the 
aligning plates:   

1. Place the µFill or ELx405 aligning plate on a level surface. 

2. Attach the Bio-Stack aligning plate as follows: 

µFill (see Figure 29 on the next page):   

� Note: The mist shield is not illustrated in Figure 29. 

• Loosely attach the Bio-Stack aligning plate to the µFill aligning plate by 
screwing in the pan head screw, lock washer, and flat washer only 
halfway. 

• Unscrew the two thumbscrews that attach the mist shield to the µFill.  
• Holding the µFill’s aligning plate against the mist shield, loosely screw 

in the two thumbscrews. 

ELx405 (see Figure 30 on page 91):  
• Loosely attach the Bio-Stack aligning plate to the ELx405 aligning plate 

by screwing in the pan head screw, lock washer, and flat washer only 
halfway. 

• Slide the ELx405’s two front aligning caps into the slots provided on the 
ELx405 aligning plate. 

3. Slide the Bio-Stack’s two front aligning posts into the slots provided on the 
Bio-Stack’s plate. 

4. Move both instruments back and forth in their slots until you are satisfied 
that they are positioned correctly next to each other (approximately). 
Ensure that the posts and caps (ELx405 only) are properly seated (not 
resting on top of the plates), and that the instruments are level. 
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Figure 29: Seating the Bio-Stack™ and µFill™in the Aligning Plates 
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Figure 30: Seating the Bio-Stack™ and the ELx405™ in the Aligning Plates 

Bio-Stack Operator's Manual  



92  | Chapter 3: Installation 

Turn on the Bio-Stack™ and Run a Self-Test 

 
Warning! Keep your hands away from the claw/gripper and 
carrier while the Bio-Stack is being powered up. The carrier 
and claw/gripper move quickly during the homing sequence. 

L The Bio-Stack must pass the Self-Test for installation with 
the µFill™ or ELx405™. 

 

� The Bio-Stack does not need to be connected to a host computer for 
this test. 

Locate the Bio-Stack’s power switch and turn on the instrument (see Figure 9 on 
page 36 for the location of the switch). The Bio-Stack will home all axes 
(claw/gripper, carrier, input and output stack lifts) and then perform a system 
Self-Test.   

• If the Self-Test passes, the green light will turn on and remain on.  

• If the Self-Test fails, the green light will flash. If this happens, turn off 
the Bio-Stack and check for any obstructions. Ensure that all of the shipping 
hardware has been removed. If you cannot resolve the problem, contact 
BioTek’s Technical Assistance Center for guidance. 
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Align the Bio-Stack™ with the µFill™ or ELx405™ 

Perform these steps to align the Bio-Stack with the µFill or ELx405:  

1. Ensure that the Bio-Stack is powered up and homed. If the Bio-Stack is off, 
turn it on to home all axes. 

2. Reconnect the power supply cord to the µFill or the power cord to the 
ELx405 and turn the instrument on. The carrier should be in the “out” 
position. Leave the µFill or ELx405 powered up. 

3. Turn the Bio-Stack off. 

4. Manually slide the Bio-Stack carrier all the way out and position it below 
the claw assembly. Refer to Figure 31 or Figure 32 on the following pages. 

5. Place a microplate on the Bio-Stack carrier. 

6. Manually lower the claw assembly down to the microplate and pick up the 
microplate (open the gripper to get around the plate and close it to pick up 
the plate). Raise the claw assembly carefully to ensure that the microplate 
does not change positions in the claw. 

7. Slide the Bio-Stack carrier out of the way. 

8. Lower the claw assembly until the microplate is just above the carrier of the 
µFill or ELx405.  

9. Manually adjust the Bio-Stack on the tabletop so the microplate can be 
lowered into the carrier of the µFill or ELx405. The microplate carrier 
should be positioned as if it was just homed by the µFill or ELx405. If the 
µFill or ELx405’s carrier or the microplate has been moved, home the 
instruments, remove the microplate from the Bio-Stack claw, then repeat 
steps 3 through 9. 

10. When you are satisfied with the microplate positioning relative to the 
carrier of the µFill or ELx405 (look carefully at the top-down drawing in 
Figure 31 on the next page for the µFill or Figure 32 on page 95 for the 
ELx405, to see how the plate should fit in the carrier), finger-tighten the 
aligning plate locking hardware in both places. 

11. Repeat all of the steps a couple of times to ensure that the microplate does 
not change positions and that it rides smoothly in and out of the carriers. 
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Figure 31: Aligning the Bio-Stack™ with the µFill™ 
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Figure 32: Aligning the Bio-Stack™ with the ELx405™ 
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Install the Plate Stacks 

Locate the stack locks on the side of the Bio-Stack™.  Make sure the locks are both 
in the “unlocked” position. Install the stacks as shown in Figure 33 below and 
then close the stack locks. 

 

 

 Figure 33: Installing the Plate Stacks 
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Instrument Control of the Bio-Stack Using the Instrument Keypad 
(Pages 97 through 102) 

L For instrument control of the Bio-Stack and µFill or ELx405 using 
the µFill/ELx405 keypad: 

• Perform the steps in the sections below and on pages 98 
through 102.  

 
For PC control of the Bio-Stack and ELx405 using the Liquid Handling 
Control (LHC) Software: 

• Perform the steps in the sections on pages 103 through 110. 

Connect the Bio-Stack™ to the µFill™ or ELx405™ 

� The Bio-Stack Alignment Kits for the µFill and ELx405 include two 
serial cables: a 25-pin to 25-pin female/female cable and a 9-pin to 
25-pin male/female cable. ELx405 Kits also include a USB cable and 
USB driver software CD. The USB cable may only be used for 
connection of the Bio-Stack to a host computer, for instance, if you will 
be using the Liquid Handling Control (LHC) Software to control the  
Bio-Stack and ELx405 washer. 

Perform these steps to connect the serial cable between the Bio-Stack and the µFill 
or ELx405: 

1. Make sure that the Bio-Stack and µFill or ELx405 are turned off. 

2. Attach one end of the appropriate cable to the serial port on the rear of the 
Bio-Stack (refer to Figure 9 on page 36 for an illustration of the serial port 
on the Bio-Stack). 

3. Attach the other end of the cable to the serial port on the rear of the µFill or 
ELx405. 

4. Tighten the securing screws on both ends of the cable. 
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Run the Checksum Test for the µFill or ELx405 

Perform these steps to run the Checksum Test and record the basecode software 
versions for the µFill or ELx405, and the assay configuration software information 
for the ELx405: 

� For your convenience, Software Data Sheets are provided in Chapter 5, 
Instrument Qualification, for recording the software versions for the µFill 
or ELx405. 

1. Turn on the µFill or ELx405 and allow the self-test to complete. 

2. From the instrument’s keypad, select UTIL > TESTS > CHKSUM.  

3. The first screen will display the µFill or ELx405 basecode software part 
number, version number, and checksum. Record this information.  

� If the µFill or ELx405 displays an error code preceded by the letter 
“B”, this means that the instrument is already configured to 
recognize the Bio-Stack (see Configure the µFill or ELx405 for the 
Bio-Stack below) and it is trying unsuccessfully to communicate with 
the Bio-Stack. This is not a problem. Press the Stop key and 
continue with the procedure. 

4. ELx405 only: After a few seconds, a second screen will display the assay 
configuration information. Record the ELx405 configuration software part 
number and version number. 

5. µFill only: After a few seconds, a second screen will display “Default 
Config Data.” This information does not need to be recorded. 

6. Record the serial number listed on the µFill or ELx405. 

7. Return to the µFill or ELx405 main menu. 
 

Configure the µFill or ELx405 for the Bio-Stack™ 

Perform these steps to configure the µFill™ or ELx405™ to recognize the Bio-Stack: 

1. µFill: From the main menu, select: 
      UTIL > SETUP > BIOSTACK > CONF > BIOSTACK 

 ELx405: From the main menu, select: 
      UTIL > SETUP > MORE > BIOSTACK > CONF > BIOSTACK

2. When the selection sequence is complete, the RE-STACK? screen will 
appear. 

3. Press the Main Menu key. 
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Test Communication with the Bio-Stack™ 

 
Warning! Keep your hands away from the claw/gripper and 
carrier while the Bio-Stack is being powered up. The carrier 
and claw/gripper move quickly during the homing sequence. 

Perform these steps to test communication between the Bio-Stack and the  
µFill™ or ELx405™ and (optionally) to record the software versions for the 
Bio-Stack: 

� For your convenience, Software Data Sheets are provided in 
Chapter 5, Instrument Qualification, for recording the software 
versions for the Bio-Stack. 

1. Important: Turn off the µFill or ELx405. 

2. Turn on the Bio-Stack and allow its self-test to complete. 

3. Turn on the µFill or ELx405 and allow its self-test to complete. 

4. From the µFill or ELx405 main menu, select UTIL > TESTS > CHKSUM. 

5. Examine the screens as they are displayed.  The first two screens contain the 
basecode software information for the µFill or ELx405 (first screen) and 
“Default Config Data” for the µFill or assay configuration software 
information for the ELx405 (second screen). These screens appear regardless 
of configuration. 

Two additional screens will appear, if the instrument is able to 
communicate with the Bio-Stack: 

 

          

P L E A S E  W A I T . . .      

 

B I O - S T A C K :  X . X X ,  X . X X   

C O D E  C H E C K S U M :  ( X X X X )   

 

6. If communication is successful, record the Bio-Stack basecode software 
version (the first X.XX), the interface definition version (the second X.XX), 
and the checksum. Record the serial number listed on the Bio-Stack. 

7. If the µFill or ELx405 cannot communicate with the Bio-Stack, an error code 
will be displayed. Consult Chapter 7, Troubleshooting and Error 
Codes for guidance. 

Bio-Stack Operator's Manual  



100  | Chapter 3: Installation 

Align the Claw/Gripper with the µFill or ELx405 Plate Carrier 

The Bio-Stack’s claw/gripper mechanism must now be aligned vertically with the 
microplate carrier on the µFill or ELx405. The µFill™ and ELx405™ have an  
on-board Instrument Alignment Utility for this task.  

Perform these steps to align the Bio-Stack™ claw/gripper with the µFill or ELx405 
microplate carrier: 

1. µFill: From the main menu, select: 
      UTIL > SETUP > BIOSTACK > ALIGN > C-POS. 

ELx405: From the main menu, select: 
      UTIL > SETUP > MORE > BIOSTACK > ALIGN > C-POS.

2. The FIND CLAW INTERFACE POS menu will appear on the display with 
the following four selections:   

            -/+             +1             +20          +400 

3. Use the four softkeys on the µFill or ELx405 keypad to position the 
Bio-Stack’s claw/gripper mechanism to the desired height relative to the 
plate carrier on the µFill or ELx405. To help in this activity, place a 
microplate on the carrier of the µFill or ELx405 (optional). Lower the 
mechanism so that the gripper’s “fingers” rest approximately 50-60 
thousandths of an inch (1.3-1.5 mm) below the plate bottom or carrier 
surface (see Figure 34 on the next page).  

� If the Bio-Stack and µFill or ELx405 are located on an uneven 
surface, the gripper’s fingers should rest below the lowest point of 
the plate bottom, to ensure proper plate delivery. 

• To avoid collision of the gripper with the carrier on the µFill or ELx405, 
press the +20 key first, to see how far that goes, before pressing the 
+400 key. Use the 1/20/400 softkeys to gradually lower the 
claw/gripper mechanism to the desired height.  

• If you go too far, press the -/+ softkey to step up a bit. 

� If the alignment is interrupted, and you receive an error code such as 
2500, the Bio-Stack will have to be homed to resolve the error. To 
home the Bio-Stack, select UTIL > SETUP > BIOSTACK > ALIGN 
> HOME > BIOSTACK, then repeat steps 1 through 3 above.  

4. When you are satisfied with the position, press the PREVIOUS SCREEN 
key to return to the Alignment screen and select SAVE.   

5. At the OK TO SAVE LOCATION? screen, press YES, and then ENTER. 

6. Remove the plate from the carrier on the µFill or ELx405. 
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Figure 34: Position of the Bio-Stack’s Gripper Fingers Below the Plate Bottom 
(on the µFill™ or ELx405™ Plate Carrier) 
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Verify the Alignment 

Perform the following test to verify alignment of the Bio-Stack™ with the µFill™ or 
ELx405™: 

1. Ensure that both instruments are turned on. 

2. Place a dry microplate in the Bio-Stack’s input stack. 

3. From the µFill or ELx405 main menu, select UTIL > SETUP >  
MORE (ELx405 only) > BIOSTACK > VERIFY. Press the Enter key.  

4. Watch closely to confirm the following behavior (the claw/gripper will 
pause periodically; this is the expected behavior): 

• The Bio-Stack will transfer the plate from the input stack to the 
Bio-Stack plate carrier, and then eject the plate carrier. 

• The claw/gripper will pick up the plate, lower it toward the µFill’s or 
ELx405’s plate carrier, and then smoothly place the plate on the carrier. 

� If the plate drops onto the carrier, the claw interface position is set too 
high. Repeat the instructions in Align the Claw/Gripper with the µFill 
or ELx405 Plate Carrier on page 100. 

• The claw/gripper will come up a short distance. The gripper will then 
power-down, allowing its spring mechanism to tighten the gripper 
“fingers.”  

� If the gripper fingers catch on the top of the microplate, the claw 
interface position is set too low. An error code will display on the µFill 
or ELx405. Repeat the instructions in Align the Claw/Gripper with 
the µFill or ELx405 Plate Carrier on page 100.  

• If the gripper fingers did not catch on the plate, the µFill or ELx405 will 
display VERIFY PLATE PLACEMENT. Press Enter to continue. 

• The claw/gripper will lower, pick up the plate, place the plate on the 
Bio-Stack’s plate carrier, and then store the plate in the output stack. 

• The µFill or ELx405 will display BIOSTACK UTILITIES. From here 
you can select VERIFY to run the program again, or press Main Menu. 

5. If the alignment verification completed successfully and you have 
determined that the gripper fingers are positioned correctly, return to the 
instrument’s main menu. 

• If the gripper fingers are not positioned correctly, repeat the instructions 
in Align the Claw/Gripper with the Plate Carrier, and then re-run 
the Verify Test. 

� The Verify Test must pass before the Bio-Stack can be used to transfer 
microplates. 
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PC Control of the Bio-Stack Using the LHC Software (Pages 103 
through 110)  

L 
For computer control of the Bio-Stack™ and ELx405™ using the Liquid 
Handling Control™ (LHC) Software, you will need appropriate 
versions of the ELx405™ Interface Software, washer basecode software,  
Bio-Stack™ PC Control Software, and Bio-Stack basecode software. 
Note: Any version of the LHC Software may be used to control the  
Bio-Stack and ELx405.  

Refer to Appendix D, Required Software Versions, or contact BioTek 
for more information on required software versions. 

During PC control of the Bio-Stack and ELx405, both instruments are controlled by 
BioTek’s Liquid Handling Control (LHC) Software running on a host computer. 
The LHC Software uses the ELx405 Interface Software to control all functions of the 
ELx405, and uses a component of the Bio-Stack PC Control Software to control all 
functionality of the Bio-Stack.  

� The LHC Help system contains a detailed description of the LHC 
Software, and how it interacts with the ELx405 Interface Software and 
Bio-Stack PC Control Software to control the instruments.   

Perform the instructions below and on the following pages, for computer control of 
the Bio-Stack and ELx405 using the LHC Software. 

Prerequisites 

• Verify that the host PC meets the minimum system requirements specified 
in the Liquid Handling Control Software Installation Guide and  
Bio-Stack PC Control Software Installation Guide.    

• Verify Administrator privileges. BioTek software requires the user who is 
installing the software application to have Administrator privileges for the 
Windows® 2000/XP/Vista systems. If a user with restricted access attempts 
to install the application, errors may occur. Contact your organization’s 
system administrator if you are uncertain about your privileges. 

Bio-Stack Operator's Manual  



104  | Chapter 3: Installation 

Connect the Host Computer to the Bio-Stack™ and ELx405™ 

L For operation of one Bio-Stack with one ELx405 washer: 
The host computer must be equipped with at least two 
communication (COM) ports.  

For operation of two Bio-Stacks with two ELx405 
washers: The host computer must be equipped with at least 
four COM ports. 

  

� The Bio-Stack Alignment Kit for the ELx405 includes two RS-232 serial 
cables (25-pin to 25-pin female/female cable and 9-pin to 25-pin 
male/female cable). The kit also include a USB cable, and USB driver 
software CD. The USB cable may be used instead of a serial cable for 
connection of the Bio-Stack to the host computer. 

� The shipping accessories for the ELx405 include a 9-pin to 25-pin 
female/female serial cable.  

Perform these steps to connect the host computer to both the Bio-Stack and the 
ELx405 washer (refer to Figure 9 on page 36 for an illustration of the serial and 
USB ports): 

1. If the Bio-Stack is on, turn it off. 

2. Place the computer in a location adjacent to the Bio-Stack and the ELx405. 

3. Connect the computer to the Bio-Stack™, using a serial cable or USB cable. 

Connect the serial cable: 

• Using the appropriate serial cable, attach one end of the cable to a serial 
port on the computer. 

• Attach the other end of the cable to the serial port on the rear of the  
Bio-Stack. 

• Tighten the securing screws on both ends of the cable. 

Connect the USB cable and install the USB driver: 

• Attach one end of the supplied USB cable to a USB port on the 
computer. Attach the other end of the cable to the USB port on the rear 
of the Bio-Stack. 

• Turn the computer on. 

• Place the USB Virtual COM Driver Software CD in the computer’s CD 
ROM drive. 

BioTek Instruments, Inc. 



Install the Bio-Stack™ with the µFill™ or ELx405™  |  105 

• Turn on the Bio-Stack. Instructions should appear on the screen for 
performing the installation. 

• If necessary, using Microsoft® Explorer or other file management 
software, find the installation guide appropriate for your computer’s 
operating system (e.g., WXPInstall.pdf). Follow the directions provided 
within the document to install the driver software. 

� In the section Test Communication on page 106, you will need to 
know which COM number is associated with the USB port on your 
computer. You’ll select this number in the Liquid Handling Control™ 
(LHC) Software port selection dialog for the Bio-Stack™. The COM 
port can be customized to use any number port that is not currently 
defined by the System. For customization instructions, consult the 
ComPortGuide.doc or ComPortGuide.pdf file on the USB driver 
CD. 

4. Turn the computer off. 

5. Attach the ELx405™ to the computer using the appropriate serial cable. 

6. Tighten the securing screws on both ends of the cable. 
 

Install the Liquid Handling Control (LHC) Software 

� A CD containing the Liquid Handling Control Software and an 
installation guide are included in the LHC Software package  
(part number LHC405) for the ELx405. The package also includes a CD 
containing version 2.00.4 or greater of the ELx405 Interface 
Software and instructions for installing the software. 

� ELx405 basecode software PN 7100227, version 2.02.1 or greater, is 
required for use of the LHC Software.    

There is a certain sequence of events that must be followed to ensure that the 
Liquid Handling Control Software is properly installed and configured on the host 
PC. You will also need to install the ELx405 Interface Software on the PC, and, 
depending upon when you purchased your ELx405, you may need to download 
upgraded basecode software to the washer.   

Please follow the instructions provided in the Liquid Handling Control™ 
Software Installation Guide to install and configure the Liquid Handling 
Control Software and any other necessary software components. Record the serial 
number listed on the software package. 
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Install the Bio-Stack™ PC Control Software 

� A CD containing version 2.00.10 or greater of the Bio-Stack PC 
Control Software and an installation guide are included in the  
Bio-Stack™ Alignment Kit for the ELx405™ (PN 7310010). Version 
2.00.10 (or greater) is required for compatibility with the Liquid 
Handling Control™ Software.         

There is a certain sequence of events that must be followed to ensure that the  
Bio-Stack PC Control Software is properly installed and configured on the host PC. 
Please follow the instructions provided in the Bio-Stack PC Control Software 
Installation Guide to install the software. Record the serial number listed on the 
software package. 
 

Test Communication  

Perform these steps to test communication between the LHC Software and the  
instruments: 

1. Turn the ELx405 and Bio-Stack on. 

2. Launch the LHC Software. 

3. Test communication between the LHC Software and the ELx405: 

• When the LHC main screen opens, click Name in the Instrument 
field. The ‘ELx405 Communications’ dialog will appear. 

� If more than one instrument’s interface software is found on 
your PC by the LHC Software, clicking Name will open the 
‘Installed Instruments’ dialog. Select ELx405 and click OK. The 
‘ELx405 Communications’ dialog will then appear.   

• Select the correct COM Port for the serial cable connection to the 
ELx405, and then click Test Communications. 

If the test passes, click OK. The ‘Instrument Settings Dialog’ will then 
open.  

� If the test fails, check the serial cable connections or try a 
different serial port.  

• At the ‘Instrument Settings Dialog,’ select the correct washer Model 
(Auto, Magna, or Select) and Manifold Type (96 well or 192 well) 
and then click OK.   

4. Test communication between the LHC Software and the  
Bio-Stack: 

• Click the Bio-Stack box. 
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• Click Port to open the ‘Bio-Stack Communications’ dialog. Select the 
correct COM Port for the serial or USB connection to the Bio-Stack, and 
then click Test Communications. 

If the test passes, click OK. If the test fails, check the serial/USB cable 
connections or try a different COM port. 

Run the Checksum Test for the ELx405 

Perform these steps to run the Checksum Test and record the software versions for 
the Liquid Handling Control™ Software and for the ELx405: 

� For your convenience, Software Data Sheets are provided in 
Chapter 5, Instrument Qualification, for recording the ELx405 
software versions. 

1. Make sure that the washer is powered on, and the cable connected from the 
PC to the washer. 

2. At the LHC Software’s main screen, select Help > About Liquid 
Handling Control. 

3. The ‘Help About’ dialog will open. Record the Liquid Handling Control 
Build Version and Installation Version. 

4. Click Close to return to the main screen. 

5. Select Tools > Instrument Utilities.  The ‘ELx405 Washer Utilities’ 
screen will open.  

6. Click Test Communications. If software version information is displayed 
and no errors occurred, the Checksum Test completed successfully.  

7. Record the ELx405 Interface Software Version, Interface Functional Version, 
Basecode SW Version, and Basecode SW Checksum. Record the washer’s 
serial number (listed on the ELx405). 

8. Close the LHC Software. 
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Run the Checksum Test for the Bio-Stack 

Perform these steps to run the Checksum Test and record the software versions for 
the Bio-Stack™ PC Control Software and for the Bio-Stack™: 

� For your convenience, Software Data Sheets are provided in 
Chapter 5, Instrument Qualification, for recording the Bio-Stack 
software versions. 

1. Make sure that the Bio-Stack is powered on, and the cable connected from 
the PC to the Bio-Stack. 

2. Launch the Bio-Stack PC Control Software. 

3. Click the Configure Instruments button. 

4. Set the COM Port and click Test Communications. If the test fails, check 
the cable and/or try another Com port. Return to the main screen. 

5. From the top menu bar in the Bio-Stack PC Control Software, select  
Help > About Bio-Stack. The ‘About Bio-Stack Software’ dialog will open. 

6. Record the Bio-Stack PC Software Versions for the Installation CD, 
StackerContainer.exe, and BTIAutoStackerActiveX. Record the serial 
number listed on the Bio-Stack PC Control Software package. 

7. Click Get On-board values now. If software version information is 
displayed and no errors occurred, the Checksum Test completed 
successfully. 

8. Record the Bio-Stack onboard software versions for the basecode software, 
interface definition, and checksum. Record the Bio-Stack’s serial number 
listed on the Bio-Stack. 

9. Close the Bio-Stack PC Control Software. 
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Align the Claw/Gripper with the ELx405™ Plate Carrier 

The Bio-Stack’s claw/gripper mechanism must now be aligned vertically with the 
microplate carrier on the ELx405. The Liquid Handling Control™ Software has an 
Instrument Alignment Utility for this task. 

Perform these steps to align the Bio-Stack™ claw/gripper with the ELx405 
microplate carrier: 

1. Start the LHC Software and select Tools > Bio-Stack Utilities. 

2. Click Alignment Utility. 

3. From the ‘Bio-Stack Instrument Alignment Utility,’ use the drop-down 
arrow in the Selected Instrument field to select the ELx405 Washer. 

4. To configure the alignment of the Bio-Stack to the ELx405, begin with the 
Home the Bio-Stack function. 

5. After all axes have been homed on the Bio-Stack, place a microplate on the 
ELx405’s plate carrier. Then use the Re-alignment Control buttons to 
position the Bio-Stack’s claw/gripper so that the gripper “fingers” rest 
approximately 50-60 thousandths of an inch (1.3-1.5 mm) below the plate 
bottom or carrier surface: click Begin. 

The gripper’s fingers open. (See Figure 34 on page 101.) 

� If the Bio-Stack and ELx405 washer are located on an uneven surface, 
the gripper’s fingers should rest below the lowest point of the plate 
bottom, to ensure proper plate delivery. 

• Begin with the Down radio button selected. To avoid collision of the 
gripper with the carrier on the ELx405, click the 20 Steps button first, 
to see how far that goes, before clicking the 400 Steps button. Use the  
400 Steps, 20 Steps, and 1 Step buttons to gradually lower the 
claw/gripper to the desired height. 

• If you have moved the gripper too far below the plate bottom, click the 
Up radio button and step up a bit. 

� If the alignment is interrupted, and you receive an error code such as 
2500, the Bio-Stack will have to be homed to resolve the error. Click 
the Home the Bio-Stack button to home all axes on the Bio-Stack, 
then repeat step 5 above. 

6. When you’re satisfied with the positioning of the gripper, click Save 
Position. 

7. Remove the microplate from the washer’s carrier. 
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Verify the Alignment 

Perform the following test to verify alignment of the Bio-Stack™ with the 
ELx405™: 

1. Place a dry microplate in the Bio-Stack’s input stack. 

2. At the Liquid Handling Control™ Software’s main screen, select Tools > 
Bio-Stack Utilities. 

3. Click Alignment Utility. 

4. From the ‘Bio-Stack Instrument Alignment Utility,’ click the Verify button. 

5. Watch closely to confirm the following behavior (the claw/gripper will 
pause periodically; this is the expected behavior): 

• The Bio-Stack will transfer the plate from the input stack to the  
Bio-Stack plate carrier, and then eject the plate carrier. 

• The claw/gripper will pick up the plate, lower it toward the ELx405’s 
plate carrier, and then smoothly place the plate on the carrier. 

� If the plate drops onto the carrier, the claw interface position is set 
too high. Repeat the steps in the preceding section, Align the 
Claw/Gripper with the ELx405 Plate Carrier. 

• The claw/gripper will come up a short distance. The gripper will then 
power-down, allowing its spring mechanism to tighten the gripper 
“fingers.” 

� If the gripper fingers catch on the top of the microplate, the claw 
interface position is set too low. An error code will be displayed in the 
LHC Software. Repeat the steps in the preceding section. 

• If the gripper fingers did not catch on the plate, the LHC Software issues 
a “Verify plate placement” message and delays the Bio-Stack’s 
movement to give you time to observe the action. Click OK to continue. 

• The claw/gripper will lower, pick up the plate, place the plate on the 
Bio-Stack’s plate carrier, and then store the plate in the output stack. 

• If the gripper fingers are not positioned correctly, repeat the steps in the 
preceding section and then re-run the Verify Test. 

6. Click OK, then Exit to return to the main screen. 

� The Verify Test must pass before the Bio-Stack can be used to 
transfer microplates. 
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Install the Bio-Stack™ with the NanoQuot™ 

 

Lay Out the Alignment Hardware  

You will need the alignment hardware from the Bio-Stack Alignment Kit for the 
NanoQuot (PN 7150001), illustrated below. 

 

NanoQuot Alignment Kit 7150001 

    
  

       
 
 

Four aligning posts  
(PN 7310524) for elevating the 
Bio-Stack to the correct height and 
for seating in the aligning plate. 

NanoQuot aligning plate  
(PN 7152000) for preventing the 
instrument from sliding around and 
being misaligned with the Bio-Stack. 

  
Bio-Stack aligning plate (PN 7312052) 
for attachment to the NanoQuot aligning 
plate.  

Includes two each of mounting 
hardware: pan head screws (PN 12028), 
lock washers (PN 16017), and flat 
washers (PN 16068). 
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Attach the Aligning Posts to the Bio-Stack™ 

 

L 
Important!  When attaching the four aligning posts (“feet”) 
to the Bio-Stack, do not over-tighten the posts! 
Finger-tighten only! 

To avoid scratches to the Bio-Stack, place a towel down 
before laying the instrument on its side. 

 

Perform these steps to attach the aligning posts to the Bio-Stack (refer to Figure 35 
on the following page):  

1. Carefully lay the Bio-Stack on its side so the bottom is facing you. 

2. Screw in all four aligning posts, as shown. 

3. Return the Bio-Stack to the upright position. 

4. If the NanoQuot™ is on, turn it off and disconnect the power supply. 
 

Seat the Instruments in the Aligning Plates 

Perform these steps to seat the Bio-Stack and the NanoQuot in the aligning plates 
(refer to Figure 36 on page 114): 

1. Place the NanoQuot’s aligning plate on a level surface. 

2. Loosely attach the Bio-Stack aligning plate to the NanoQuot aligning plate 
by screwing in the pan head screw, lock washer, and flat washer only 
halfway. 

3. Slide the NanoQuot into its aligning plate until the two thumbscrew holes 
in the rear panel of the NanoQuot are aligned with the two holes in the back 
of the aligning plate. Screw in the thumbscrews halfway. 

4. Slide the Bio-Stack’s two front aligning posts into the slots provided on the 
Bio-Stack’s plate. 

5. Move both instruments back and forth until you are satisfied that they are 
positioned correctly next to each other (approximately). Ensure that the 
Bio-Stack’s posts are properly seated (not resting on top of the plates), and 
that the instruments are level. 
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Figure 35: Attaching the Aligning Posts to the Bio-Stack™ 
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Figure 36: Seating the Bio-Stack™ and the NanoQuot™ in the Aligning Plates 
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Turn on the Bio-Stack™ and Run a Self-Test 

 

 
Warning! Keep your hands away from the claw/gripper and 
carrier while the Bio-Stack is being powered up. The carrier 
and claw/gripper move quickly during the homing sequence. 

L The Bio-Stack must pass the Self-Test for installation with 
the NanoQuot™. 

 

� The Bio-Stack does not need to be connected to a host computer for 
this test. 

Locate the Bio-Stack’s power switch and turn on the instrument (see Figure 9 on 
page 36 for the location of the switch). The Bio-Stack will home all axes 
(claw/gripper, carrier, input and output stack lifts) and then perform a system 
Self-Test.   

• If the Self-Test passes, the green light will turn on and remain on.  

• If the Self-Test fails, the green light will flash. If this happens, turn off 
the Bio-Stack and check for any obstructions. Ensure that all of the shipping 
hardware has been removed. If you cannot resolve the problem, contact 
BioTek’s Technical Assistance Center for guidance. 

Leave the Bio-Stack powered up for the next section, Align the Bio-Stack™ with 
the NanoQuot. 
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Align the Bio-Stack™ with the NanoQuot™ 

Perform these steps to align the Bio-Stack with the NanoQuot: 

1. Ensure that the Bio-Stack has been homed according to the instructions in 
the previous section. 

2. Reconnect the power supply to the NanoQuot. 

3. Turn on the Dispenser. The carrier should be in the home position. Leave 
the NanoQuot powered up. 

4. Turn the Bio-Stack off. 

5. Manually slide the Bio-Stack carrier all the way out and position it below 
the claw assembly. Refer to Figure 37 on the following page. 

6. Place a microplate on the Bio-Stack carrier. 

7. Manually lower the claw assembly down to the microplate and pick up the 
microplate (open the gripper to get around the plate and close it to pick up 
the plate). Raise the claw assembly carefully to ensure that the microplate 
does not change positions in the claw. 

8. Slide the Bio-Stack carrier out of the way. 

9. Lower the claw assembly until the microplate is just above the carrier of the 
NanoQuot. 

10. Manually adjust the Bio-Stack on the tabletop so the microplate can be 
lowered into the carrier of the NanoQuot. The microplate carrier should be 
positioned as if it was just homed by the NanoQuot. If the NanoQuot’s 
carrier or the microplate has been moved, home the instruments, remove 
the microplate from the Bio-Stack claw, then repeat steps 4 through 10. 

11. When you are satisfied with the microplate positioning relative to the 
carrier of the NanoQuot (look carefully at the top-down drawing in  
Figure 37 on the next page, to see how the plate should fit in the carrier), 
finger-tighten the aligning plate locking hardware in both places. 

12. Repeat all of the steps a couple of times to ensure that the microplate does 
not change positions and that it rides smoothly in and out of the carriers. 
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Figure 37: Aligning the Bio-Stack™ with the NanoQuot™ 
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Install the Plate Stacks 

Locate the stack locks on the side of the Bio-Stack™. Make sure the locks are both 
in the “unlocked” position. Install the stacks as shown in Figure 38 below and 
then close the stack locks. 

 

Figure 38: Installing the Plate Stacks 
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Connect the Host Computer to the Bio-Stack™ 

� To obtain software versions for the Bio-Stack (Checksum Test) and to 
vertically align the Bio-Stack’s claw/gripper with the NanoQuot’s 
microplate carrier, you must temporarily connect the Bio-Stack to a 
host computer that has the Bio-Stack™ PC Control Software installed. 

� The Bio-Stack Alignment Kit for the NanoQuot™ includes two serial 
cables: a 9-pin to 9-pin male/male cable and 9-pin to 25-pin 
male/female cable. The DB9M end of either cable must be connected 
to the serial port on the Bio-Stack. 

Perform these steps to connect the host computer to the Bio-Stack: 

1. If the Bio-Stack is on, turn it off. 

2. Turn off the host computer. Place the computer in a location that is adjacent 
to both the Bio-Stack and the NanoQuot. 

3. Using the appropriate serial cable, attach the DB9M end of the cable to the 
serial port on the rear of the Bio-Stack (refer to Figure 9 on page 36 for an 
illustration of the serial port on the Bio-Stack). 

4. Attach the other end of the cable to a serial port on the computer. 

5. Tighten the securing screws on both ends of the cable. 
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Install the Bio-Stack™ PC Control Software and Test 
Communication   

 
Warning! Keep your hands away from the claw/gripper and 
carrier while the Bio-Stack is being powered up. The carrier 
and claw/gripper move quickly during the homing sequence. 

� A CD containing the Bio-Stack PC Control Software and an 
installation guide are included in the Bio-Stack Alignment Kit for the 
NanoQuot™.  

Perform these steps to install the Bio-Stack PC Control Software on the computer, 
and then test communication with the Bio-Stack: 

1. Turn the computer and the Bio-Stack™ on.  Allow the Bio-Stack to complete 
its Self-Test. 

2. Follow the instructions provided in the Bio-Stack PC Control Software 
Installation Guide to install the software on the computer. 

3. Launch the Bio-Stack PC Control Software.  

4. From the software’s main screen, click the Configure Instruments button. 

5. When the ‘Instrument Configuration’ dialog appears, select the appropriate 
COM Port for the Bio-Stack Configuration and then click Test 
Communications. 

• If the test is not successful, ensure that the cable is properly connected 
and you have correctly identified the COM port number. 

� The Bio-Stack and the Bio-Stack PC Control Software must be 
communicating before you can continue with the Installation 
Qualification. 

6. If the test is successful, return to the main screen. 
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Run the Checksum Test for the Bio-Stack™ 

Perform these steps to run the Checksum Test for the Bio-Stack and to record the 
software versions for the Bio-Stack™ PC Control Software and for the Bio-Stack: 

� For your convenience, Software Data Sheets are provided in 
Chapter 5, Instrument Qualification, for recording the Bio-Stack 
software versions. 

1. From the top menu bar in the Bio-Stack PC Control Software, select Help > 
About Bio-Stack. 

2. The ‘About Bio-Stack Software’ dialog will open. Record the Bio-Stack PC 
Software Versions for the Installation CD, StackerContainer.exe, and 
BTIAutoStackerActiveX. Record the serial number listed on the  
Bio-Stack PC Control Software package. 

3. Click Get On-board values now. If software version information is 
displayed and no errors occurred, the Checksum Test completed 
successfully. 

4. Record the Bio-Stack onboard software versions for the basecode software, 
interface definition, and checksum. Record the serial number listed on the 
Bio-Stack. 
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Align the Claw/Gripper with the NanoQuot’s Plate Carrier 

The Bio-Stack’s claw/gripper mechanism must now be aligned vertically with the 
NanoQuot’s plate carrier. The Bio-Stack™ PC Control Software has an 
Instrument Alignment Utility for this task. 

Perform these steps to run the Instrument Alignment Utility: 

1. Launch the Bio-Stack PC Control Software. 

2. At the software’s main screen, click the Configure Instruments button. 

3. When the ‘Instrument Configuration’ dialog appears, select PowerWave.  

� For the purpose of alignment only, the user must select 
‘PowerWave’ for the NanoQuot™, since the NanoQuot uses 
the same Bio-Stack™ alignment scheme as the PowerWave™. 

4. Click the Instrument Alignment Utility button. 

5. Use the Re-Alignment Control buttons to position the Bio-Stack’s 
claw/gripper mechanism to the desired height relative to the NanoQuot’s 
plate carrier. To aid in this activity, place a microplate on the Dispenser’s 
carrier. Lower the claw/gripper so that the gripper’s “fingers” rest 
approximately 50-60 thousandths of an inch (1.3-1.5 mm) below the plate 
bottom or carrier surface (see Figure 39 on the following page).  

� If the Bio-Stack and Dispenser are located on an uneven 
surface, the gripper’s fingers should rest below the lowest 
point of the plate bottom, to ensure proper plate delivery. 

• Begin with the Down radio button selected.  To avoid collision of the 
gripper with the Dispenser’s carrier, click the 20 Step button first, to 
see how far that goes, before clicking the 400 Step button. Use the 
400/20/1 Step buttons to gradually lower the claw/gripper 
mechanism to the desired height.  

If you go down too far, click the Up radio button and step up a bit. 

� If the alignment is interrupted, and you receive an error code 
such as 2500, the Bio-Stack™ will have to be homed to 
resolve the error. Click the Home the Bio-Stack button (in 
the Instrument Alignment Utility dialog) to home all axes 
on the Bio-Stack, then repeat step 5 above.  

6. When you are satisfied with the position, click the Save Position button.  

7. Remove the plate from the carrier. 
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Figure 39: Position of the Bio-Stack’s Gripper Fingers Below the Plate Bottom 
(on the NanoQuot’s Plate Carrier) 
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Verify the Alignment  

Perform the following test to verify alignment of the Bio-Stack™ with the 
NanoQuot™: 

1. Place a dry microplate in the Bio-Stack’s input stack. 

2. Launch the Bio-Stack™ PC Control Software. 

3. Click Configure Instruments to open the ‘Instrument Configuration’ 
dialog, then select PowerWave for the NanoQuot. 

4. Click Instrument Alignment Utility, then click the Verify button. 

5. Watch closely to confirm the following behavior (the claw/gripper will 
pause periodically; this is the expected behavior): 

• The Bio-Stack will transfer the plate from the input stack to the 
Bio-Stack plate carrier, and then eject the plate carrier. 

• The claw/gripper will pick up the plate, lower it toward the Dispenser’s 
plate carrier, and then smoothly place the plate on the carrier. 

� If the plate drops onto the carrier, the claw interface position has been 
set too high. Repeat the steps in the previous section: Align the 
Claw/Gripper with the NanoQuot’s Plate Carrier. 

� It may also be necessary to adjust the NanoQuot’s microplate carrier so 
the plate can move freely in the carrier. Using your fingers, loosen the 
screws that attach the two adjustable brackets to the carrier, then 
adjust the brackets to allow clearance for the microplate. Finger-tighten 
the screws in the brackets. 

• The claw/gripper will come up a short distance. The gripper will then 
power-down, allowing its spring mechanism to tighten the gripper 
“fingers.” 

� If the gripper fingers catch on the top of the microplate, the claw 
interface position is set too low. An error code will appear in the 
software. Repeat the steps in Align the Claw/Gripper with the 
NanoQuot’s Plate Carrier. 

• If the gripper fingers did not catch on the plate, the “Verify plate 
placement” message will appear. Click OK to continue. 

• The claw/gripper will lower, pick up the plate, place the plate on the 
Bio-Stack’s carrier, and then store the plate in the output stack. 

6. If the alignment verification completed successfully and you have 
determined that the gripper fingers are positioned correctly, the Bio-Stack is 
now ready for operation with the NanoQuot. 

7. If the gripper fingers are not positioned correctly, perform the steps in 
Align the Claw/Gripper with the NanoQuot’s Plate Carrier again, and 
then re-run the Verify Test. The Verify Test must pass before the Bio-Stack 
can be used to transfer microplates. 
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Connect the Host Computer to the NanoQuot™ 

� To obtain software versions for the NanoQuot you must temporarily 
connect the NanoQuot to a host computer that has the NanoQuot™ PC 
Control Software installed. 

� The NanoQuot is shipped with a 9-pin to 9-pin female/male serial 
cable, for connection to a host computer. The DB9M end of the cable 
must be connected to the serial port on the NanoQuot. 

Perform these steps to connect the host computer to the NanoQuot: 

1. Turn off the Bio-Stack™ and computer.  

2. Disconnect the serial cable between the Bio-Stack and computer. 

3. Turn off the NanoQuot. 

4. Using the supplied DB9F to DB9M serial cable, attach the DB9F end of the 
cable to a serial port on the computer. 

5. Attach the DB9M end of the cable to the serial port on the rear of the 
NanoQuot. Refer to Chapter 2, Installation, in the NanoQuot Operator’s 
Manual (on CD part number 7151008) for a photo of the serial port on the 
Dispenser.    

6. Tighten the securing screws on both ends of the cable. 

Bio-Stack Operator's Manual  



126  | Chapter 3: Installation 

Install the NanoQuot™ PC Control Software and Test 
Communication 

� The NanoQuot™ is shipped with a CD containing the NanoQuot PC 
Control Software (PN 7150202). 

Perform these steps to install the NanoQuot PC Control Software, and then test 
communication with the NanoQuot: 

1. Turn on the computer and NanoQuot. Allow the NanoQuot to complete its 
Self-Test. 

2. Follow the instructions provided in Chapter 2, Installation, of the 
NanoQuot Operator’s Manual on CD for installation of the software on the 
computer. 

3. Launch the NanoQuot PC Control Software. When the software’s main 
screen appears, verify that the Dispenser’s Serial No. and Instrument 
Software information (basecode part number and version) are displayed 
and that the correct COM Port is selected. 

4. Click Test Communications. 

• If the software does not display the serial number and instrument 
software version, verify that the instrument is turned on and the serial 
cable is connected properly. Click ‘Test Communications’ again. 

• If you receive the ‘Communication test was successful’ dialog, click OK. 

• If the test is not successful, try a different COM port or check the serial 
cable connections. Refer also to the Troubleshooting section of the PC 
Software’s Help system for assistance. 
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Record Software Information for the NanoQuot™ 

Perform these steps to record the software versions for the NanoQuot™ PC 
Control Software and for the NanoQuot: 

� For your convenience, Software Data Sheets are provided in Chapter 5, 
Instrument Qualification, for recording the NanoQuot software versions. 

� The NanoQuot basecode software does not include a Checksum. 

1. From the top menu bar in the NanoQuot PC Control Software, select  
Help > About NanoQuot PC Software. 

2. The ‘About NanoQuot PC Control’ dialog will open. Record the NanoQuot 
PC Control version as well as the three Component Software versions, 
then click OK to close the dialog. Record the serial number listed on the 
NanoQuot PC Control Software package. 

3. At the software’s main screen, record the NanoQuot’s Instrument 
Software (basecode part number and version) and Serial No. 

� The serial number displayed in the PC Software should match 
the serial number listed on the Dispenser. 

Connect the Bio-Stack™ to the NanoQuot™ 

� The Bio-Stack Alignment Kit for the NanoQuot, includes two serial 
cables: a 9-pin to 9-pin male/male cable and 9-pin to 25-pin 
male/female cable. The DB9M to DB9M cable must be used to connect 
the Bio-Stack to the NanoQuot. 

Perform these steps to connect the Bio-Stack to the NanoQuot: 

1. Turn off the computer and the NanoQuot. 

2. Disconnect the serial cable between the computer and the NanoQuot. 

3. Connect the DB9M to DB9M serial cable between the Bio-Stack and 
NanoQuot. 

4. Turn on the Bio-Stack and allow the Self-Test to complete.  

� It is recommended that the Bio-Stack be powered up before the 
NanoQuot. 

5. Turn on the NanoQuot and allow the Self-Test to complete. 
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Test Communication with the Bio-Stack™ 

Perform these steps to test communication between the Bio-Stack and the 
NanoQuot™, by using the NanoQuot’s Initialization (Init) feature to home all axes 
on the Bio-Stack: 

1. Set the Mode rocker switch on the NanoQuot to Bio-Stack. 

2. Press the Init key. 

• If the communication test passes, the Bio-Stack will home all axes.  The 
carrier will home and the claw assembly will move up. 

• If the communication test fails, the Bio-Stack will fail to home all axes, 
and the green light on the Bio-Stack may flash. If this happens, turn off 
the Bio-Stack and check the serial cable connection between the 
Bio-Stack and NanoQuot. If you cannot resolve the problem, contact 
BioTek’s Technical Assistance Center for guidance.  
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Install the Bio-Stack™ with the MicroFlo™ Select 

 

Lay Out the Alignment Hardware  

You will need the alignment hardware from the Bio-Stack Alignment Kit for the 
MicroFlo Select Microplate Dispenser (PN 7310020), illustrated below. 

 

MicroFlo Select Alignment Kit 7310020 

    
  

       
 
 

Four aligning posts  
(PN 7310524) for elevating the  
Bio-Stack to the correct height and 
for seating in the aligning plate. 

Four aligning caps  
(PN 7170527) for elevating the MicroFlo 
Select to the correct height and for 
seating in the aligning plate. 

  

 
MicroFlo Select aligning plate  
(PN 7172125) for preventing the 
instrument from sliding around and 
being misaligned with the Bio-Stack. 

 
Bio-Stack aligning plate  
(PN 7312052) for attachment to the 
MicroFlo Select aligning plate.  

Includes two each of mounting 
hardware: pan head screws (PN 12028), 
lock washers (PN 16017), and flat 
washers (PN 16068). 
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Attach the Aligning Posts and Caps   

 

L 
Important!  When attaching the four aligning posts (“feet”) 
to the Bio-Stack™, do not over-tighten the posts! 
Finger-tighten only! 

To avoid scratches to the Bio-Stack or to the MicroFlo™ 
Select, place a towel down before laying the instrument on 
its side or back. 

 

� Bio-Stack barcode scanner: If you have installed the barcode 
scanner on the Bio-Stack (for operation with a PowerWave or Synergy 
reader or Precision instrument), lay the Bio-Stack on the opposite side 
of the scanner. Note that the scanner must be installed on the left side 
of the Bio-Stack for proper alignment with the MicroFlo. See Appendix 
B, Bio-Stack Barcode Scanner for more information.    

Perform these steps to attach the aligning posts to the Bio-Stack and the aligning 
caps to the MicroFlo Select (refer to Figure 40 on the following page):  

1. Turn off the Bio-Stack. 

2. Carefully lay the Bio-Stack on its side so the bottom is facing you. 

3. Screw in all four aligning posts as shown. Return the Bio-Stack to the 
upright position. 

4. Turn off the MicroFlo and disconnect the power supply cord from the 
dispenser. 

5. Carefully lay the MicroFlo on its back so the bottom is facing you. 

6. Remove the four rubber feet on the Dispenser.  

7. Screw in all four aligning caps as shown. Return the MicroFlo to the upright 
position. 
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   Figure 40: Attaching the Aligning Posts to the Bio-Stack™ and the Aligning Caps  
to the MicroFlo™ Select 
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Seat the Instruments in the Aligning Plates  

Perform these steps to seat the Bio-Stack and the MicroFlo Select in the aligning 
plates:   

1. Place the MicroFlo aligning plate on a level surface. 

2. Attach the Bio-Stack aligning plate as follows (see Figure 41 on page 133):  
• Loosely attach the Bio-Stack aligning plate to the MicroFlo aligning 

plate by screwing in the pan head screw, lock washer, and flat washer 
only halfway. 

• Slide the MicroFlo’s two front aligning caps into the slots provided on 
the MicroFlo aligning plate. 

3. Slide the Bio-Stack’s two front aligning posts into the slots provided on the 
Bio-Stack’s plate. 

4. Move both instruments back and forth in their slots until you are satisfied 
that they are positioned correctly next to each other (approximately). 
Ensure that all posts and caps are properly seated (not resting on top of the 
plates), and that the instruments are level. 

Turn on the Bio-Stack™ and Run a Self-Test 

 
Warning! Keep your hands away from the claw/gripper and 
carrier while the Bio-Stack is being powered up. The carrier 
and claw/gripper move quickly during the homing sequence. 

L The Bio-Stack must pass the Self-Test for installation with 
the MicroFlo™ Select. 

 
� The Bio-Stack does not need to be connected to the MicroFlo™ Select 

or to a host computer for this test. 

Locate the Bio-Stack’s power switch and turn on the instrument (see Figure 9 on 
page 36 for the location of the switch). The Bio-Stack will home all axes 
(claw/gripper, carrier, input and output stack lifts) and then perform a system 
Self-Test.   

• If the Self-Test passes, the green light will turn on and remain on.  

• If the Self-Test fails, the green light will flash. If this happens, turn off 
the Bio-Stack and check for any obstructions. Ensure that all of the shipping 
hardware has been removed. If you cannot resolve the problem, contact 
BioTek’s Technical Assistance Center for guidance. 
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Figure 41: Seating the Bio-Stack™ and MicroFlo™ Select in the Aligning Plates 
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Align the Bio-Stack™ with the MicroFlo™ Select 

Perform these steps to align the Bio-Stack with the MicroFlo Select:  

1. Ensure that the Bio-Stack is powered up and homed. If the Bio-Stack is off, 
turn it on to home all axes. 

2. Reconnect the power supply cord to the MicroFlo and turn the instrument 
on. The carrier should be in the “out” (far right) position. Leave the 
MicroFlo powered up. 

3. Turn the Bio-Stack off. 

4. Manually slide the Bio-Stack carrier all the way out and position it below 
the claw assembly. Refer to Figure 42 on the following page. 

5. Place a microplate on the Bio-Stack carrier. 

6. Manually lower the claw assembly down to the microplate and pick up the 
microplate (open the gripper to get around the plate and close it to pick up 
the plate). Raise the claw assembly carefully to ensure that the microplate 
does not change positions in the claw. 

7. Slide the Bio-Stack carrier out of the way. 

8. Lower the claw assembly until the microplate is just above the carrier of the 
MicroFlo.  

9. Manually adjust the Bio-Stack on the tabletop so the microplate can be 
lowered into the carrier of the MicroFlo. The microplate carrier should be 
positioned as if it was just homed by the MicroFlo. If the MicroFlo’s carrier 
or the microplate has been moved, home the instruments, remove the 
microplate from the Bio-Stack claw, then repeat steps 3 through 9. 

10. When you are satisfied with the microplate positioning relative to the 
carrier of the MicroFlo (look carefully at the top-down drawing in  
Figure 42 on the next page, to see how the plate should fit in the carrier),  
finger-tighten the aligning plate locking hardware in both places. 

11. Repeat all of the steps a couple of times to ensure that the microplate does 
not change positions and that it rides smoothly in and out of the carriers. 
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Figure 42: Aligning the Bio-Stack™ with the MicroFlo™ Select 
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Install the Plate Stacks 

Locate the stack locks on the side of the Bio-Stack™.  Make sure the locks are both 
in the “unlocked” position. Install the stacks as shown in Figure 43 below and 
then close the stack locks. 

 

 

 Figure 43: Installing the Plate Stacks 
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Instrument Control of the Bio-Stack and MicroFlo Select (Pages 
137 through 143) 

L If using instrument control of the Bio-Stack™ and MicroFlo™ Select 
via the MicroFlo keypad: 

• Perform the steps in the sections below and on pages 138 
through 143.  

 
If using PC control of the Bio-Stack and MicroFlo Select via the Liquid 
Handling Control™ (LHC) Software: 

• Perform the steps in the sections on pages 144 through 151. 

Connect the Bio-Stack™ to the MicroFlo™ Select 

� The Bio-Stack Alignment Kit for the MicroFlo includes two serial 
cables: a 9-pin to 9-pin male/male cable and 9-pin to 25-pin 
male/female cable, a USB cable, and USB driver software CD. The USB 
cable may only be used for connection of the Bio-Stack to a host 
computer, for instance, if you will be using the Liquid Handling Control 
(LHC) Software to control the Bio-Stack and MicroFlo. 

Perform these steps to connect the serial cable between the Bio-Stack and the 
MicroFlo Select: 

1. Make sure that the Bio-Stack and MicroFlo are turned off. 

2. Attach one end of the appropriate serial cable to the serial port on the rear of 
the Bio-Stack (refer to Figure 9 on page 36 for an illustration of the serial 
port on the Bio-Stack). 

3. Attach the other end of the cable to the serial port on the side of the 
MicroFlo. 

4. Tighten the securing screws on both ends of the cable. 
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Run the Checksum Test for the MicroFlo™ Select 

Perform these steps to run the Checksum Test and record the basecode software 
versions for the MicroFlo Select: 

� For your convenience, Software Data Sheets are provided in Chapter 5, 
Instrument Qualification, for recording the software versions for the 
MicroFlo. 

1. Turn on the MicroFlo and allow its self-test to complete. After the initial 
powerup screen is displayed, the main menu screen will appear if the  
self-test passes: 

( 9 6 )  C A S S ( 5 )  V O L : 0 0 1 0 u l  

P R I M E  P U R G E  u P L A T E     - -  >  

2. From the main menu select - - > twice. The Dispenser Action Menu screen 
will appear:  

 D I S P E N S E R  A C T I O N  M E N U      

D E F I N E  U T I L   S E T U P           

3. Select UTIL > CHKSUM. The Version Checksum Info screen will appear with 
the three options as shown below: 

V E R S I O N  C H E C K S U M  I N F O :    

  U I       M C    S T K R             

• UI displays basecode software and checksum information for the User 
Interface processor. The UI processor communicates with the computer 
(during PC control of the MicroFlo), keyboard, display, and Bio-Stack.  

• MC displays basecode software and checksum information for the Motor 
Controller processor. The MC processor is responsible for driving the 
motors on the instruments and working directly with the hardware.  

• STKR displays basecode and checksum information for the Bio-Stack, if 
the Bio-Stack is connected to the MicroFlo and the dispenser’s operating 
mode has been set to BIOSTACK (as instructed in the following section 
Configure the MicroFlo for the Bio-Stack.)   

� If the dispenser’s operating mode is set at MANUAL, an error 
will be displayed when the STKR option is selected from the 
Version Checksum Info screen. 
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4. Select UI. Record the basecode software version (X.XX) and checksum 
(XXXX) information: 

7 1 7 0 2 0 0   V E R S I O N  X . X X      

C O D E   C H E C K S U M :     ( X X X X  )

Press the ENTER or Previous Screen key to return to the Version Checksum 
Info screen.   

5. Select MC. Record the basecode software version (X.XX) and checksum 
(XXXX) information: 

7 1 7 0 2 0 0   V E R S I O N  X . X X      

C O D E   C H E C K S U M :     ( X X X X  )

� Note: You will run the Checksum Test for the Bio-Stack in 
the section Test Communication with the Bio-Stack™ 
on the following page. 

6. Press the Previous Screen key until you return to the Dispenser Action 
Menu.  

7. Record the MicroFlo serial number (listed on the instrument).  

 

Bio-Stack Operator's Manual  



140  | Chapter 3: Installation 

Configure the MicroFlo™ Select for the Bio-Stack™ 

Perform these steps to configure the MicroFlo Select to recognize the Bio-Stack: 

1. From the Dispenser Action Menu, select SETUP > BIOSTACK > CONF > 
BIOSTACK.  

2. When the selection sequence is complete, the RE-STACK? screen will appear. 

3. Press the Main Menu key.   

Test Communication with the Bio-Stack™ 

 
Warning! Keep your hands away from the claw/gripper and 
carrier while the Bio-Stack is being powered up. The carrier 
and claw/gripper move quickly during the homing sequence. 

Perform these steps to test communication between the Bio-Stack and the  
MicroFlo™ Select and (optionally) to record the software versions for the 
Bio-Stack: 

� For your convenience, Software Data Sheets are provided in 
Chapter 5, Instrument Qualification, for recording the software 
versions for the Bio-Stack. 

1. Important: Turn off the MicroFlo. 

2. Turn on the Bio-Stack and allow its self-test to complete. 

3. Turn on the MicroFlo and allow its self-test to complete. 

4. From the MicroFlo main menu, select - - > twice to get to the Dispenser 
Action Menu.     

5. Select UTIL > CHKSUM > STKR.    

The following screen should appear if the instrument is able to 
communicate with the Bio-Stack: 

B I O - S T A C K :  X . X X ,  X . X X       

C O D E   C H E C K S U M :     ( X X X X ) 

6. If communication is successful, record the Bio-Stack basecode software 
version (the first X.XX), the interface definition version (the second X.XX), 
and the checksum. Record the serial number listed on the Bio-Stack. 

7. If the MicroFlo cannot communicate with the Bio-Stack, an error code will 
be displayed, with “Stacker Error” shown in the first line of the display. 
Consult Chapter 7, Troubleshooting and Error Codes for guidance. 
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Align the Claw/Gripper with the MicroFlo Select Plate Carrier 

The Bio-Stack’s claw/gripper mechanism must now be aligned vertically with the 
microplate carrier on the MicroFlo™ Select. The MicroFlo has an on-board 
Instrument Alignment Utility for this task.  

Perform these steps to align the Bio-Stack™ claw/gripper with the MicroFlo 
microplate carrier: 

1. From the MicroFlo main menu, select - - > twice to get to the Dispenser 
Action Menu. 

2. Select SETUP > BIOSTACK > ALIGN > C-POS. 

3. The FIND CLAW INTERFACE POS menu will appear on the display with 
the following four selections:   

            -/+             +1             +20          +400 

4. Use the four softkeys on the MicroFlo keypad to position the Bio-Stack’s 
claw/gripper mechanism to the desired height relative to the plate carrier 
on the MicroFlo. To help in this activity, place a microplate on the carrier of 
the MicroFlo (optional). Lower the mechanism so that the gripper’s 
“fingers” rest approximately 50-60 thousandths of an inch (1.3-1.5 mm) 
below the plate bottom or carrier surface (see Figure 44 on the next page).  

� If the Bio-Stack and MicroFlo are located on an uneven surface, the 
gripper’s fingers should rest below the lowest point of the plate 
bottom, to ensure proper plate delivery. 

• To avoid collision of the gripper with the carrier on the MicroFlo, press 
the +20 key first, to see how far that goes, before pressing the +400 
key. Use the 1/20/400 softkeys to gradually lower the claw/gripper 
mechanism to the desired height.  

• If you go too far, press the -/+ softkey to step up a bit. 

� If the alignment is interrupted, and you receive an error code such as 
2500, the Bio-Stack will have to be homed to resolve the error. To 
home the Bio-Stack, press the Previous Screen key until you return 
to the Alignment Utility screen. Select HOME > BIOSTACK, then 
repeat steps 1 through 4 above.  

5. When you are satisfied with the position, press the Previous Screen key 
until you return to the Alignment Utility screen and select SAVE.   

6. At the OK TO SAVE LOCATION? screen, press YES, and then ENTER. 

7. Remove the plate from the carrier on the MicroFlo. 

Bio-Stack Operator's Manual  



142  | Chapter 3: Installation 

 

 

Figure 44: Position of the Bio-Stack’s Gripper Fingers Below the Plate Bottom 
(on the MicroFlo™ Select Plate Carrier) 

BioTek Instruments, Inc. 



Install the Bio-Stack™ with the MicroFlo™ Select  |  143 

Verify the Alignment 

Perform the following test to verify alignment of the Bio-Stack™ with the 
MicroFlo™ Select: 

1. Ensure that both instruments are turned on. 

2. Place a dry microplate in the Bio-Stack’s input stack. 

3. From the Dispenser Action Menu, select SETUP > BIOSTACK > VERIFY. 
Press the ENTER key.  

4. Watch closely to confirm the following behavior (the claw/gripper will 
pause periodically; this is the expected behavior): 

• The Bio-Stack will transfer the plate from the input stack to the 
Bio-Stack plate carrier, and then eject the plate carrier. 

• The claw/gripper will pick up the plate, lower it toward the MicroFlo’s 
plate carrier, and then smoothly place the plate on the carrier. 

� If the plate drops onto the carrier, the claw interface position is set too 
high. Repeat the instructions in Align the Claw/Gripper with the 
MicroFlo Select Plate Carrier on page 141. 

• The claw/gripper will come up a short distance. The gripper will then 
power-down, allowing its spring mechanism to tighten the gripper 
“fingers.”  

� If the gripper fingers catch on the top of the microplate, the claw 
interface position is set too low. An error code will display on the 
MicroFlo. Repeat the instructions in Align the Claw/Gripper with the 
MicroFlo Select Plate Carrier on page 141.  

• If the gripper fingers did not catch on the plate, the MicroFlo will 
display VERIFY PLATE PLACEMENT. Press ENTER to continue. 

• The claw/gripper will lower, pick up the plate, place the plate on the 
Bio-Stack’s plate carrier, and then store the plate in the output stack. 

• The MicroFlo will display BIOSTACK UTILITIES. From here you can 
select VERIFY to run the program again, or press Main Menu. 

5. If the alignment verification completed successfully and you have 
determined that the gripper fingers are positioned correctly, return to the 
instrument’s main menu. 

• If the gripper fingers are not positioned correctly, repeat the instructions 
in Align the Claw/Gripper with the MicroFlo Select Plate Carrier, 
and then re-run the Verify Test. 

� The Verify Test must pass before the Bio-Stack can be used to transfer 
microplates. 
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PC Control of the Bio-Stack and MicroFlo Select (Pages 144 
through 151)  

L 
For computer control of the Bio-Stack™ and MicroFlo™ Select using the 
Liquid Handling Control™ (LHC) Software, you will need appropriate 
versions of the MicroFlo™ Select Interface Software, dispenser basecode 
software, Bio-Stack™ PC Control Software, and Bio-Stack basecode 
software. Note: Any version of the LHC Software may be used to control 
the Bio-Stack and MicroFlo.  

Refer to Appendix D, Required Software Versions, or contact BioTek 
for more information on required software versions. 

During PC control of the Bio-Stack and MicroFlo Select, both instruments are 
controlled by BioTek’s Liquid Handling Control (LHC) Software running on a host 
computer. The LHC Software uses the MicroFlo Select Interface Software to control 
all functions of the MicroFlo, and uses a component of the Bio-Stack PC Control 
Software to control all functionality of the Bio-Stack.  

� The LHC Help system contains a detailed description of the LHC 
Software, and how it interacts with the MicroFlo Select Interface Software 
and Bio-Stack PC Control Software to control the instruments.   

Perform the instructions below and on the following pages, for computer control of 
the Bio-Stack and MicroFlo using the LHC Software. 

Prerequisites 

• Verify that the host PC meets the minimum system requirements specified 
in the Liquid Handling Control Software Installation Guide and  
Bio-Stack PC Control Software Installation Guide.    

• Verify Administrator privileges. BioTek software requires the user who is 
installing the software application to have Administrator privileges for the 
Windows® 2000/XP/Vista systems. If a user with restricted access attempts 
to install the application, errors may occur. Contact your organization’s 
system administrator if you are uncertain about your privileges. 
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Connect the Host Computer to the Bio-Stack™ and MicroFlo™ 
Select 

L For operation of the Bio-Stack with the MicroFlo Select: 
The host computer must be equipped with at least two 
communication (COM) ports: one serial port and a second 
serial or USB port. 

  

� The Bio-Stack Alignment Kit for the MicroFlo includes two RS-232 
serial cables (a 9-pin to 9-pin male/male cable and 9-pin to 25-pin 
male/female cable), a USB cable, and USB driver software CD. The USB 
cable may be used instead of a serial cable for connection of the  
Bio-Stack to the host computer. 

� The shipping accessories for the MicroFlo include a USB cable and USB 
driver software CD. Use the USB cable for connection of the MicroFlo to 
the host computer.  

Perform these steps to connect the host computer to both the Bio-Stack and the 
MicroFlo Select (refer to Figure 9 on page 36 for an illustration of the serial and 
USB ports): 

1. If the Bio-Stack is on, turn it off. 

2. Place the computer in a location adjacent to the Bio-Stack and the MicroFlo. 

3. Connect the computer to the Bio-Stack™  and MicroFlo, using the serial and 
USB cables. 

� A standard 9-pin to 9-pin male/female serial cable may be used 
to connect the MicroFlo to the PC. 

Connect the serial cable: 

• Using the appropriate serial cable, attach one end of the cable to a serial 
port on the computer. 

• Attach the other end of the cable to the serial port on the Bio-Stack or 
MicroFlo. 

• Tighten the securing screws on both ends of the cable. 

Connect the USB cable and install the USB driver: 

• Attach one end of the supplied USB cable to a USB port on the 
computer. Attach the other end of the cable to the USB port on the  
Bio-Stack or MicroFlo. 

• Turn the computer on. 
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• Place the USB Virtual COM Driver Software CD in the computer’s CD 
ROM drive. 

• Turn on the Bio-Stack or MicroFlo. Instructions should appear on the 
screen for performing the installation. 

• If necessary, using Microsoft® Explorer or other file management 
software, find the installation guide appropriate for your computer’s 
operating system (e.g., WXPInstall.pdf). Follow the directions provided 
within the document to install the driver software. 

� In the section Test Communication on page 147, you will need to 
know which COM number is associated with the USB port on your 
computer. You’ll select this number in the Liquid Handling Control™ 
(LHC) Software port selection dialog for the MicroFlo™ Select or  
Bio-Stack™. The COM port can be customized to use any number 
port that is not currently defined by the System. For customization 
instructions, consult the ComPortGuide.doc or ComPortGuide.pdf 
file on the USB driver CD. 

Install the Liquid Handling Control (LHC) Software 

� A CD containing the Liquid Handling Control™ Software and an 
installation guide are included in the LHC Software package  
(part number LHCMFS) for the MicroFlo™. The package also includes a 
CD containing version 1.01.0 or greater of the MicroFlo™ Select 
Interface Software and instructions for installing the software. 

� MicroFlo basecode software PN 7170200, version 1.04.0 or greater, is 
required for use of the LHC Software.    

There is a certain sequence of events that must be followed to ensure that the 
Liquid Handling Control Software is properly installed and configured on the host 
PC. You will also need to install the MicroFlo Select Interface Software on the PC.   

Please follow the instructions provided in the Liquid Handling Control™ 
Software Installation Guide to install and configure the Liquid Handling 
Control Software and any other necessary software components.  Record the serial 
number listed on the software package. 
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Install the Bio-Stack™ PC Control Software 

� A CD containing version 2.00.10 or greater of the Bio-Stack PC 
Control Software and an installation guide are included in the  
Bio-Stack™ Alignment Kit for the MicroFlo™ Select (PN 7310020). 
Version 2.00.10 (or greater) is required for compatibility with the 
Liquid Handling Control™ Software.         

There is a certain sequence of events that must be followed to ensure that the  
Bio-Stack PC Control Software is properly installed and configured on the host PC. 
Please follow the instructions provided in the Bio-Stack PC Control Software 
Installation Guide to install the software. Record the serial number listed on the 
software package. 
 

Test Communication  

Perform these steps to test communication between the LHC Software and the  
instruments: 

1. Turn the MicroFlo and Bio-Stack on. 

2. Launch the LHC Software. 

3. Test communication between the LHC Software and the MicroFlo: 

• When the LHC main screen opens, click Name in the Instrument 
field. The ‘MicroFlo Select Communications’ dialog will appear. 

� If more than one instrument’s interface software is found on your 
PC by the LHC Software, clicking Name will open the ‘Installed 
Instruments’ dialog. Select MicroFlo Select and click OK. The 
‘MicroFlo Select Communications’ dialog will then appear.   

• Select the correct COM Port for the serial or USB cable connection to the 
MicroFlo, and then click Test Communications. 

If the test passes, click OK. The ‘MicroFlo Select Settings’ dialog will 
appear. If the test fails, check the serial/USB cable connections or try a 
different COM port. 

• At the ‘MicroFlo Select Settings’ dialog, select the correct Instrument 
model:  MFS or MFS1536, and then click OK.   

4. Test communication between the LHC Software and the  
Bio-Stack: 

• Click the Bio-Stack box. 

• Click Port to open the ‘Bio-Stack Communications’ dialog. Select the 
correct COM Port for the serial or USB connection to the Bio-Stack, and 
then click Test Communications. 

If the test passes, click OK. If the test fails, check the serial/USB cable 
connections or try a different COM port. 
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Run the Checksum Test for the MicroFlo™ Select 

� The Checksum Test for the MicroFlo allows you to obtain checksum 
values for the User Interface (UI) Processor and Motor Controller (MC) 
Processor.  
 
The UI processor communicates with the computer (during PC control 
of the MicroFlo), keyboard, display, and Bio-Stack.  
 
The MC processor is responsible for driving the motors on the 
instruments and working directly with the hardware. 

Perform these steps to run the Checksum Test and record the software versions for 
the Liquid Handling Control™ Software and for the MicroFlo: 

� For your convenience, Software Data Sheets are provided in 
Chapter 5, Instrument Qualification, for recording the MicroFlo 
software versions. 

1. Make sure that the dispenser is powered on, the dispenser UI (User 
Interface) is at the main menu, and the serial or USB cable connected from 
the PC to the dispenser. 

2. At the LHC Software’s main screen, select Help > About Liquid 
Handling Control. 

3. The ‘Help About’ dialog will open. Record the Liquid Handling Control 
Build Version and Installation Version. 

4. Click Close to return to the main screen. 

5. Select Tools > Instrument Utilities.  The ‘MicroFlo Select Utilities’ 
screen will open.  

6. Click Test Communications. If software version information is displayed 
and no errors occurred, the Checksum Test completed successfully.  

7. Record the MicroFlo Select Interface Software Version and Data Version, 
and the MicroFlo Select Basecode Software Version and Data Version, and 
the Checksums for the UI Processor and the MC Processor. Record the 
dispenser’s serial number (listed on the MicroFlo).  

8. Click Exit to close the MicroFlo Select Utilities screen. 

9. Close the LHC Software. 
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Run the Checksum Test for the Bio-Stack 

Perform these steps to test communication between the Bio-Stack PC Control 
Software and the Bio-Stack, run the Checksum Test, and record the software 
versions for the Bio-Stack™ PC Control Software and for the Bio-Stack™: 

� For your convenience, Software Data Sheets are provided in 
Chapter 5, Instrument Qualification, for recording the Bio-Stack 
software versions. 

1. Make sure that the Bio-Stack is powered on, and the serial or USB cable 
connected from the PC to the Bio-Stack. 

2. Launch the Bio-Stack PC Control Software. 

3. Click the Configure Instruments button. 

4. Set the COM Port and click Test Communications. If the test fails, check 
the cable and/or try another Com port. Return to the main screen. 

5. From the top menu bar in the Bio-Stack PC Control Software, select  
Help > About Bio-Stack. The ‘About Bio-Stack Software’ dialog will open. 

6. Record the Bio-Stack PC Software Versions for the Installation CD, 
StackerContainer.exe, and BTIAutoStackerActiveX. Record the serial 
number listed on the Bio-Stack PC Control Software package. 

7. Click Get On-board values now. If software version information is 
displayed and no errors occurred, the Checksum Test completed 
successfully. 

8. Record the Bio-Stack onboard software versions for the basecode software, 
interface definition, and checksum. Record the Bio-Stack’s serial number 
listed on the Bio-Stack. 

9. Close the Bio-Stack PC Control Software. 
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Align the Claw/Gripper with the MicroFlo™ Select Plate Carrier 

The Bio-Stack’s claw/gripper mechanism must now be aligned vertically with the 
microplate carrier on the MicroFlo Select. The Liquid Handling Control™ Software 
has an Instrument Alignment Utility for this task. 

Perform these steps to align the Bio-Stack™ claw/gripper with the MicroFlo 
microplate carrier: 

1. Start the LHC Software and select Tools > Bio-Stack Utilities. 

2. Click Alignment Utility. 

3. From the ‘Bio-Stack Instrument Alignment Utility,’ use the drop-down 
arrow in the Selected Instrument field to select the µFill Dispenser. 

� For the purpose of alignment only, the user must select ‘µFill 
Dispenser’ for the MicroFlo, since the MicroFlo uses the same Bio-Stack 
alignment scheme as the µFill. 

4. To configure the alignment of the Bio-Stack to the MicroFlo, begin with the 
Home the Bio-Stack function. 

5. After all axes have been homed on the Bio-Stack, place a microplate on the 
MicroFlo’s plate carrier. Then use the Re-alignment Control buttons to 
position the Bio-Stack’s claw/gripper so that the gripper “fingers” rest 
approximately 50-60 thousandths of an inch (1.3-1.5 mm) below the plate 
bottom or carrier surface: click Begin. 

The gripper’s fingers open. (See Figure 44 on page 142.) 

� If the Bio-Stack and MicroFlo dispenser are located on an uneven 
surface, the gripper’s fingers should rest below the lowest point of the 
plate bottom, to ensure proper plate delivery. 

• Begin with the Down radio button selected. To avoid collision of the 
gripper with the carrier on the MicroFlo, click the 20 Steps button first, 
to see how far that goes, before clicking the 400 Steps button. Use the  
400 Steps, 20 Steps, and 1 Step buttons to gradually lower the 
claw/gripper to the desired height. 

• If you have moved the gripper too far below the plate bottom, click the 
Up radio button and step up a bit. 

� If the alignment is interrupted, and you receive an error code such as 
2500, the Bio-Stack will have to be homed to resolve the error. Click 
the Home the Bio-Stack button to home all axes on the Bio-Stack, 
then repeat step 5 above. 

6. When you’re satisfied with the positioning of the gripper, click Save 
Position. 

7. Remove the microplate from the dispenser’s carrier. 
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Verify the Alignment 

Perform the following test to verify alignment of the Bio-Stack™ with the 
MicroFlo™ Select: 

1. Place a dry microplate in the Bio-Stack’s input stack. 

2. At the Liquid Handling Control™ Software’s main screen, select Tools > 
Bio-Stack Utilities. 

3. Click Alignment Utility. 

4. From the ‘Bio-Stack Instrument Alignment Utility,’ click the Verify button. 

5. Watch closely to confirm the following behavior (the claw/gripper will 
pause periodically; this is the expected behavior): 

• The Bio-Stack will transfer the plate from the input stack to the  
Bio-Stack plate carrier, and then eject the plate carrier. 

• The claw/gripper will pick up the plate, lower it toward the MicroFlo’s 
plate carrier, and then smoothly place the plate on the carrier. 

� If the plate drops onto the carrier, the claw interface position is set 
too high. Repeat the steps in the preceding section, Align the 
Claw/Gripper with the MicroFlo Select Plate Carrier. 

• The claw/gripper will come up a short distance. The gripper will then 
power-down, allowing its spring mechanism to tighten the gripper 
“fingers.” 

� If the gripper fingers catch on the top of the microplate, the claw 
interface position is set too low. An error code will be displayed in the 
LHC Software. Repeat the steps in the preceding section. 

• If the gripper fingers did not catch on the plate, the LHC Software issues 
a “Verify plate placement” message and delays the Bio-Stack’s 
movement to give you time to observe the action. Click OK to continue. 

• The claw/gripper will lower, pick up the plate, place the plate on the 
Bio-Stack’s plate carrier, and then store the plate in the output stack. 

• If the gripper fingers are not positioned correctly, repeat the steps in the 
preceding section and then re-run the Verify Test. 

6. Click OK, then Exit to return to the main screen. 

� The Verify Test must pass before the Bio-Stack can be used to 
transfer microplates. 
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Repackaging and Shipping 

If you need to ship the Bio-Stack™ to BioTek for service or repair, be sure to use the 
original packaging materials. Other forms of commercially available packaging are not 
recommended and can void the warranty. 

If the original packaging materials have been damaged or lost, contact BioTek to order 
PN 7313002 for the packaging materials, PN 7313001 for the microplate stacks 
shipping materials, and PN 7310014 for the shipping hardware. See Product 
Support & Service in Chapter 1 for contact information. 

The following tables list the materials that are included in the part numbers referenced 
above.   

 

Packaging materials included in PN 7313002 PN’s 

Outer shipping container 7112063 

Inner shipping container 7112064 

Foam shipping blocks (8) 7112197  

Inner sleeve  7312082 

Plywood shipping panel   7112067 

 Stacks shipping materials included in PN 7313001 PN’s 

Shipping container  6022002 

Shipping end caps (2) 7312081 

  Shipping hardware included in PN 7310014 PN’s 

Shipping panel mounting screws, flat washers (4)  12185, 17057 

Shipping panel handles (2) 44285 

Rubber feet for shipping panel (4) 49064 

Screws, lock washers, and flat washers for handles (4) 12121, 16016, 
17054 

Shipping block 7312080 

Shipping block mounting screws (4) 12189 

Carrier shipping screw 19513 

  

� Part numbers are subject to change over time. Please contact BioTek Customer 
Care if you have any questions. 

� The instrument’s packaging design is subject to change over time. If the 
instructions in this section do not appear to apply to the packaging materials 
you are using, please contact BioTek’s Technical Assistance Center for guidance. 
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Before Repackaging the Instrument 

 

 
Warning! If the Bio-Stack™ has been exposed to potentially 
hazardous material, decontaminate it to minimize the risk to all who 
come in contact with the instrument during shipping, handling, and 
servicing. Decontamination prior to shipping is required by the U.S. 
Department of Transportation regulations. 

L Important! Perform the following steps in the order presented 
before repackaging the instrument for shipment. 

L 
Important! The shipping panel and block, mounting screws, and 
carrier shipping screw must be re-attached to the Bio-Stack before 
the instrument can be shipped. 

 

1. Turn the Bio-Stack off and disconnect the power supply cord. 

2. Remove all alignment hardware and the microplate stacks. 

� The microplate stacks do not have to be returned with the 
Bio-Stack unless a problem has occurred with plates in the stacks. 

3. Decontaminate the Bio-Stack as necessary. Refer to the 
Decontamination section in Chapter 6, Preventive Maintenance, for 
complete instructions. 

4. (Optional) If the Bio-Stack barcode scanner is installed, remove the scanner 
according to the instructions in Appendix B, Bio-Stack Barcode Scanner.  

� The optional barcode scanner does not have to be returned with 
the Bio-Stack unless there is a problem with the scanner. 

5. Replace all shipping hardware and repackage the instrument as described 
on the following pages. Failure to comply with these packaging 
instructions can void the instrument’s warranty. 

6. Obtain a Return Materials Authorization (RMA) number from BioTek’s 
Technical Assistance Center through BioTek’s website, fax, or e-mail 
address listed in Chapter 1.  

When obtaining the RMA, explain whether the Bio-Stack requires 
calibration, cleaning, periodic maintenance, warranty work, and/or repair. 
Make a note of any error messages that were displayed on the controlling 
PC or on the controlling instrument, and their frequency. 

Provide BioTek with the name and contact information of a person who 
may be contacted if questions arise. 
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Attach the Shipping Hardware   

1. Place the Bio-Stack™ upright on a flat surface (see Figure 45), connect the 
power supply, and power up the instrument to home all axes. The claw 
assembly must be at its full height in order to mount the shipping block.  

� If power cannot be applied, manually raise the claw to full height 
and hold it in that position while installing the top shipping block 
mounting screw in step 2 below. 

2. Power down the instrument and disconnect the power supply. 
Loosely install the shipping block so the top shipping block mounting 
screw is protruding out below the claw assembly screw block.    

3. Tighten the two bottom shipping block mounting screws, then loosen them 
by one-quarter turn.  

4. Tighten the two top mounting screws and then the two bottom screws.  

5. Slide the carrier back to the position shown; install the carrier shipping 
screw.  

 
 

 Figure 45: Attaching the Shipping Block and Mounting Screws 
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6. Carefully lay the Bio-Stack™ on its side, with the bottom of the instrument 
facing you and flush against the edge of the work surface (see Figure 46). 

7. Remove the four aligning posts/legs. Keep the posts with the accessories 
package. 

8. Install the shipping panel with the accompanying mounting screws and 
washers. (Note the orientation of the panel to the unit.) 

9. Lift the instrument until it is resting upright on the work surface. 
 

 

Figure 46: Attaching the Shipping Panel 
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Repackage the Bio-Stack™  

1. Grasp the shipping handles and carefully lower the Bio-Stack into the inner 
shipping box (see Figure 47 below).  

2. Lower the inner sleeve into the inner shipping box as shown. 

3. Optional barcode scanner: If you are returning the Bio-Stack’s barcode 
scanner, repackage the scanner and installation kit components using the 
original shipping materials (plastic bag and small shipping box). Place the 
box in the inner sleeve. 

 
 

 

Figure 47: Repackaging the Bio-Stack 
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4. Ensure that all the foam shipping blocks are attached to the inner shipping 
container; reattach if necessary. 

5. Close the top of the inner shipping container and tape it shut. 

6. Lower the inner shipping container into the outer shipping container (see 
Figure 48 below). 

7. Close the top of the outer shipping container and tape it shut. 

8. Write “RMA” and the RMA number in large, clear letters on the outside of 
the shipping container. 

9. Insure the Bio-Stack™ for full value and ship the instrument to the BioTek 
address provided in the Product Support & Service section of Chapter 1.  

 
 

 

Figure 48: Preparing the Outer Shipping Container 
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Repackage the Microplate Stacks  

1. Place the microplate stacks into their shipping end caps as shown in Figure 
49  below. 

2. Lower the stacks into their shipping container. 

3. Close the top of the shipping container and tape it shut. 

4. On the outside of the container, write “RMA” and the same RMA number 
that you wrote on the shipping container for the Bio-Stack. 

5. Ship the stacks with the Bio-Stack™ to BioTek. 
 
 
 

Figure 49: Repackaging the Microplate Stacks 
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Chapter 4 

Operation 

This chapter includes instructions for operating the Bio-Stack™ with 
compatible Bio-Stack Instruments. 

Before You Start ......................................................................162 
Operate the Bio-Stack™ with the PowerWave™ or Synergy™ Readers

........................................................................................169 
Operate the Bio-Stack™ with the Precision™/XS...........................171 
Operate the Bio-Stack™ with the µFill™ ......................................175 
Operate the Bio-Stack™ with the ELx405™ (Instrument Control) ....187 
Operate the Bio-Stack™ with the ELx405™ (PC Control)................199 
Operate the Bio-Stack™ with the NanoQuot™ ..............................203 
Operate the Bio-Stack™ with the MicroFlo™ Select (Instrument 

Control) .............................................................................205 
Operate the Bio-Stack™ with the MicroFlo™ Select (PC Control) .....215 
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Before You Start 

L Important! The Bio-Stack™ must be installed with the interfacing 
instrument as instructed in Chapter 3, Installation, before you 
can operate the instruments! Review the Installation Qualification 
(IQ) checklist (provided in Chapter 5, Instrument Qualification), 
to ensure that every installation task/test has been successfully 
performed. 

If the instruments have been moved since installation, perform 
the Verify Test to verify alignment. Check all serial/USB cable and 
power cord/power supply connections to ensure that they have 
not become loose. 

Ensure that all components of the interfacing instruments have 
been installed according to the installation sections of their 
operator’s manuals.  

 

Review Principles of Operation 

Please take a few minutes to review the following principles of operation of the 
Bio-Stack: 

1. The input stack lifter picks up a plate from the input stack and places it 
on the carrier. 

2. The carrier transfers the plate to the claw/gripper, which picks up the 
plate and places it on the interfacing instrument for processing.  

� If the optional barcode scanner is installed on the Bio-Stack, the 
scanner automatically scans the barcode label on a microplate at 
the Bio-Stack’s extended carrier position during plate transfers 
between the Bio-Stack and reader or Precision instrument.  

3. Once the plate has been processed, the claw/gripper picks up the plate and 
places it back on the carrier, which moves it to the output stack.  

Because there is no on-board keypad or user interface to allow an 
operator to control the Bio-Stack directly, the Bio-Stack is either 
computer-controlled (via the Bio-Stack™ PC Control Software, Precision 
Power™ Software, or Liquid Handling Control™ Software) or 
instrument-controlled by the µFill™, NanoQuot™, ELx405™, or 
MicroFlo™ Select. 

� ELx405 or MicroFlo Select:  The Bio-Stack with the ELx405 or 
MicroFlo Select may be either computer controlled using the Liquid 
Handling Control (LHC) Software, or instrument controlled using the 
keypad on the ELx405 or MicroFlo. 
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Instructions for operating the Bio-Stack™ with the interfacing instruments are 
located in this chapter as follows: 

• Operate the Bio-Stack™ with the PowerWave™ or Synergy™ Readers: 
page 169  

• Operate the Bio-Stack™ with the Precision™/XS:  page 171  

• Operate the Bio-Stack™ with the µFill™:  page 175 

• Operate the Bio-Stack™ with the ELx405™ (Instrument Control):  
page 187 

• Operate the Bio-Stack™ with the ELx405™ (PC Control): page 199 

• Operate the Bio-Stack™ with the NanoQuot™:  page 203 

• Operate the Bio-Stack™ with the MicroFlo™ Select (Instrument 
Control): page 205  

• Operate the Bio-Stack™ with the MicroFlo™ Select (PC Control): page 
215 

Review Microplate Requirements    

Please review the following microplate requirements to ensure that the plates you 
will be using meet specifications (refer also to the Specifications section in 
Chapter 1, Installation). 

• The microplates must be robot-compatible, stackable plates of single-piece 
construction. 

• Use Society for Biomolecular Screening (SBS) standard-height 96- and 
384-well microplates or other laboratory microplates that conform to the 
following standardized dimensions: 

¾ Width:   3.365” (85.48 mm) ± 0.020” (0.5 mm) 

¾ Length:  5.030” (127.76 mm) ± 0.020” (0.5 mm) 

¾ Height:  0.565” (14.35 mm) ± 0.030” (0.76 mm)  

� Shorter profile plates: 1536-well and low volume 384-well 
microplates are shorter than standard-height plates, and can be 
processed in the Bio-Stack. These plates have a minimum height of 
0.400” (10.16 mm).  
 
The maximum rim height for plates with an overall height that is 
less than 0.450” (11.43 mm) is 0.100” (2.54 mm). 
 
To run plates shorter than 0.565” (14.35 mm), you will need 
Bio-Stack basecode software version 1.25.1 or greater installed in 
the Bio-Stack.  
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� Half-height plates: Some half-height plates may require Bio-Stack 
basecode version 1.27.1 or greater, as well as reconfiguration of 
the Bio-Stack. One microplate known to require this reconfiguration 
is MJ Research’s Hard-Shell 384-well PCR plate. See Appendix C, 
Reconfiguration of the Bio-Stack for more information. 

• The microplates must “nest” or stack easily with each other. Some brands 
or models of plates that have ribs or other small, sharp edges on their base 
may not stack easily, and may “catch” when moving down the stack.  

� Plastic “flash” (burrs and extra plastic) on the edges of plates, and 
strip plates that are not as rigid or flat, may also cause problems.  

Perform the following simple test to determine whether a particular brand 
of plates will nest easily:   

¾ Stack one plate on top of another, then check to see if the top plate is 
slightly (1 mm or 1/16”) off to the side or front-to-back. If this is the case, 
the plates may “catch” when moving down the stack. 

• If you will be attaching barcode labels to microplates for use with the  
Bio-Stack’s optional barcode scanner, use plates with flat, vertical 
sidewalls so that the labels will lie flat upon the surface (see Appendix B, 
Bio-Stack Barcode Scanner). 

 

Load the Microplates into the Input Stack  

L Important! Ensure that when the microplates are stacked, 
the wells are not overfilled with fluid. If the wells are 
overfilled, the plates may stick together due to suction, and 
they will not separate for processing. 

 
Before starting a program with the Bio-Stack™, load all of the microplates you 
plan to process into the input stack.  

� You can load up to 30 of the standard-height 96- and 384-well plates 
or at least 40 of the shorter profile plates. 

You can designate either one of the stacks as the input stack, since, mechanically, 
they are identical. However, whichever one you choose should be placed onto the 
Bio-Stack in the input stack position (rear), as indicated on the labels attached to 
both stack locks (see Figure 50 on the next page). 

A plate-stacking pedestal (PN 7312083) is included in your Bio-Stack package 
contents for ease in loading and unloading the plates, however, you may also stack 
the plates without using the pedestal.  
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Figure 50: Close-Up View of the Input/Output Label on the Stack Lock 
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Load the Plates Using the Plate-Stacking Pedestal   

� If you are loading 30 of the standard-height 96-/384-well plates or 40 of the 
shorter profile plates into the input stack while using the pedestal, the last couple 
of plates will be resting above the top of the input stack. This should not be a 
problem, since 1) the plates should be stackable, and 2) when you lift the input 
stack off the pedestal, the complete stack is lowered down onto the dogs. 

1. Place the pedestal upright (legs up) on a flat surface.   

2. Unlock the stack locks on the sides of the Bio-Stack™ and lift out the 
input stack (see Figure 50 on the previous page). 

3. Place the input stack over the top of the pedestal, and lower it until the 
stack completely covers the pedestal and is resting on the surface (see 
Figure 51 on the next page). 

4. Taking one or more microplates, lower them from the top of the stack 
down to the bottom, resting the bottom plate on the pedestal legs.  

As you are lowering the plates, it is recommended that your hand/arm 
be on the opposite side of the stabilizing bracket located at the top of 
the stack. 

5. After you have loaded all of the plates that you plan to process, gently 
lift the input stack off the pedestal. The stack of plates should lower 
smoothly onto the stack dogs.  

6. Lower the input stack back into position on the Bio-Stack and close the 
stack locks. 

Load the Plates without the Plate-Stacking Pedestal 

BioTek recommends that you perform the following instructions using empty 
microplates first, until you are comfortable with the process of loading and 
unloading the plates into the stacks. 

1. Unlock the stack locks on the sides of the Bio-Stack (see Figure 50 on 
the previous page). Lift out the input stack and place the stack on a flat 
surface.  

2. Taking one or more plates, lower them from the top of the stack down 
to the bottom, resting the bottom plate on the two dogs at the side of 
the stack.  

3. As you are lowering the plates, it is recommended that your hand/arm 
be on the opposite side of the stabilizing bracket located at the top of 
the stack. It is also recommended that you not touch the bottoms of the 
plates.  

4. When you have finished loading all of the plates that you plan to 
process, lower the input stack back into position on the Bio-Stack and 
close the stack locks. 
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Figure 51: Pedestal for Loading/Unloading Plates in the Stacks 
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Operate the Bio-Stack™ with the PowerWave™ or 
Synergy™ Readers 

 
Warning! Keep your hands away from the claw/gripper and carrier 
while the Bio-Stack is being powered up. The carrier and claw/gripper 
move quickly during the homing sequence. 

L 
Important! If you are using half-height plates and the Bio-Stack is 
passing multiple plates at once from the input stack to the Bio-Stack 
carrier, the instrument may need to be reconfigured to accommodate 
your microplates. Refer to Appendix C, Reconfiguration of the 
Bio-Stack, for more information. 

 
During operation of the Bio-Stack with the PowerWave/XS or Synergy HT/ 
Synergy 2/Synergy 4 readers, the Bio-Stack™ PC Control Software controls all 
functionality of the Bio-Stack™ and runs Gen5™ or KC4™ software in the background 
to control the PowerWave/XS or Synergy HT/Synergy 2/Synergy 4.   

� Gen5 is required for the Synergy 2 and Synergy 4 readers (KC4 does 
not support the Synergy 2/Synergy 4). 

When operating the Bio-Stack with the reader, you will run Gen5 or KC4 as a 
stand-alone application  

• initially, when creating KC4 protocols or Gen5 protocols and possibly Gen5 
experiments, and  

• later, when reviewing plate results, or manually exporting results. 

However, during the actual processing of plates, the Bio-Stack PC Control Software is 
your primary operating software and it automatically runs Gen5 or KC4 in OLE mode 
to send serial commands to the reader, while sending its own set of serial commands to 
the Bio-Stack to control plate transfers. 

� You may also create Gen5 experiments in the Bio-Stack PC Control 
Software, however, protocols must be predefined in Gen5. 

� When the Bio-Stack PC Control Software is running Gen5 experiments, 
it is not recommended that you also run Gen5 in standalone mode in 
order to modify or delete the experiments. 

� When the Bio-Stack PC Control Software first initiates the KC4 
software as an automatic background task, you will be able to see the 
KC4 application running, but it will be as if KC4 is running in 
“read-only” mode, since you will not be able to modify anything during 
that sequence of the program. Also, you should not modify any reader 
protocol while that protocol may be in-process under the Bio-Stack 
operation. 
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Figure 52 below shows the relationship between the PC and its software (i.e., 
Bio-Stack™ PC Control Software and Gen5™ or KC4™) and the Bio-Stack™ and the 
microplate readers. The Bio-Stack PC Control Software sends the necessary RS-232 
serial commands to control the physical plate transfers. To control the reader, the PC 
software “calls” various Gen5 or KC4 functions running in the background. 

For a complete description of the Bio-Stack PC Control Software and its operation, 
please refer to its online Help system by selecting Help > Help Topics from the main 
menu. Refer also to the Help system for complete instructions for using the Bio-Stack 
barcode scanner.  

� The Bio-Stack PC Control Software is primarily in control of the user 
interface, except in the case of processing errors that Gen5 or KC4 catch. 

� If you have both Gen5 and KC4 applications and two readers connected to 
a PC, you may run Gen5 in stand-alone mode to control one reader, at the 
same time that the Bio-Stack PC Control Software uses KC4 to control 
another reader. 

� When referring to the software configuration illustrated in Figure 52 below, 
remember that KC4 does not support the Synergy™ 2/Synergy™ 4. 
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Operate the Bio-Stack™ with the Precision™/XS   

 
Warning! Keep your hands away from the claw/gripper and carrier 
while the Bio-Stack is being powered up. The carrier and claw/gripper 
move quickly during the homing sequence. 

L 
Important! If you are using half-height plates and the Bio-Stack is 
passing multiple plates at once from the input stack to the Bio-Stack 
carrier, the instrument may need to be reconfigured to accommodate 
your microplates. Refer to Appendix C, Reconfiguration of the 
Bio-Stack, for more information. 

 

BioTek’s Precision Power™ Software controls all functions of the Precision™ XS 
Microplate Sample Processor and Precision™ Microplate Pipetting System, and uses a 
component of the Bio-Stack™ PC Control Software to control all functionality of 
the Bio-Stack. 

Using Precision Power, the operator may configure the Bio-Stack to interface with the 
desired supply platform stations on the Precision, and up to two Bio-Stacks may be 
simultaneously used with a Precision for high throughput plate processing. 

Figure 53 on the next page shows the relationship between the PC and its software 
(i.e., Precision Power) and the Bio-Stack and a Precision.  

Figure 54 on page 173 illustrates the same relationship with two Bio-Stacks. 

For a complete description of the Precision Power software and its operation, please 
refer to the Precision Power User’s Guide or the online Help system by selecting  
Help > Help Topics from the main menu. Refer also to the Help system for complete 
instructions for using the Bio-Stack barcode scanner. 
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In Figure 53 below, the Precision Power™ software uses   

• one serial or USB port to control the Bio-Stack™ instrument plate transfers (via 
a component of the Bio-Stack™ PC Control Software); and  

• one serial port to control all functionality of the interfacing instrument. 
 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

RS-232 Serial or USB Cables 

Precision™ XS or 
Preci latesion™ Microp

Pipetting System 

Host PC 

Precision Power 
Software 

Bio-Stack 

Bio-Stack 
PC Control 
Software 

Figure 53: Bio-Stack/Precision Power Software Architecture (with One Bio-Stack) 
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In Figure 54 below, the Precision Power™ software uses  

• two serial or USB ports to control instrument plate transfers on two Bio-Stack™ 
instruments (via a component of the Bio-Stack™ PC Control Software); and  

• one serial port to control all functions of the interfacing instrument. 
 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

RS-232 Serial or USB Cables 

Bio-Stack Bio-Stack 

Host PC 

Precision Power 
Software 

Bio-Stack 
PC Control
Software 

Precision™ XS or 
Precision™  

Microplate Pipetting 
System 

Bio-Stack 
PC Control
Software 

Figure 54: Bio-Stack/Precision Power Software Architecture (with Two Bio-Stacks) 
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Operate the Bio-Stack™ with the µFill™  

 
Warning! Keep your hands away from the claw/gripper and carrier 
while the Bio-Stack is being powered up. The carrier and claw/gripper 
move quickly during the homing sequence. 

L 
Important! If you are using half-height plates and the Bio-Stack is 
passing multiple plates at once from the input stack to the Bio-Stack 
carrier, the instrument may need to be reconfigured to accommodate 
your microplates. Refer to Appendix C, Reconfiguration of the 
Bio-Stack, for more information. 

 

The µFill™ Microplate Dispenser uses RS-232 serial commands to control the 
Bio-Stack and displays all Bio-Stack-related information, including error codes.  

� The one exception to this is when the Bio-Stack is first powered up, 
and is not yet under the control of the µFill. At this point, it will run a 
series of self-test homing operations. The LED on the Bio-Stack will 
flash if there is a failure during this sequence. If a failure occurs, you 
may turn the µFill on, and it will determine the status of the Bio-Stack 
and display any errors (ensure that the serial cable is connected). 

Perform the following steps to power up the µFill and Bio-Stack: 

1. Ensure that the Bio-Stack is correctly positioned next to the µFill and that the 
alignment hardware and serial cable are attached. See Install the Bio-Stack 
with the µFill or ELx405, in Chapter 3, Installation.  

2. Power up the Bio-Stack first before turning on the µFill. If the claw/gripper is 
not homed before the µFill is powered up, the Bio-Stack self-test will home the 
mechanism. Ensure that the claw/gripper has risen to its full height.  

3. Power up the µFill. Before performing the self-test, the µFill will attempt to 
establish communication with the Bio-Stack. If communication is successful, 
and the Bio-Stack has passed its own self-test, the µFill will proceed with its 
self-test. If the Bio-Stack has failed the self-test, or communication could not be 
established, then the dispenser’s self-test will fail, and the instrument will beep 
and display an error code (e.g., B-8306). Refer to Chapter 7, Troubleshooting 
and Error Codes for a listing of all error codes associated with the Bio-Stack 
that may be displayed on the µFill.  

4. Once the Bio-Stack has been turned on, its LED will remain constantly on if the 
instrument is operating correctly. If the LED is off or flashing, an error has 
occurred. If the µFill is on, running, and properly connected, an error code may 
be displayed. 
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� By default, the µFill™ is configured as a stand-alone instrument. The 
µFill must be configured for Bio-Stack™ operation by using the 
Bio-Stack’s Configuration utility. See Bio-Stack™ Utilities Screen on 
page 177. 

Startup Screens 

� The screens listed below and on the following pages appear as menu 
selections in the bottom (second line) of the keypad LCD of the µFill™. 
To make a selection, press the SoftKey below the menu function. To 
move to a previous menu, press the Previous Screen key. Refer to 
your µFill Operator’s Manual for a detailed illustration of the keypad 
and description of its functions. The µFill Manual currently contains 
instructions for running the µFill as a stand-alone instrument, whereas 
this manual describes the Bio-Stack™ specific operation. 

When the µFill is powered up, the following two screens are displayed, and the 
microplate carrier is homed: 

 

P O W E R U P  S E Q U E N C E  V X . X X     

I N I T I A L I Z I N G . . .             

 

U F I L L   R E A G E N T  D I S P E N S E R   

S Y S T E M   S E L F - T E S T . . .         

 

The above screen is displayed while communication with the Bio-Stack is being 
established and the self-test has begun. If no communication occurs after 30 
seconds, a timeout results and error B-8306 is displayed. Press ENTER to display 
the Main Menu. If the self-test and homing sequence is successful, the µFill main 
menu screen appears: 

 

U F I L L   R E A G E N T  D I S P E N S E R   

R U N     D E F I N E   M A I N T   U T I L 

 

� If the communication fails, the µFill software will display its Main 
Menu, but will not perform its homing sequence. This is to prevent 
collision of the µFill carrier with the claw/gripper. Hence, once the 
serial communication problems are corrected, it is recommended that 
the µFill be repowered so it can run its own homing sequence. 
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Bio-Stack™ Utilities Screen 

To access the Bio-Stack Utilities screen and configure the µFill™ for proper 
Bio-Stack operation, follow the screens below:   

• Select UTIL from the main menu screen. The Select Utility screen will 
appear: 

 

S E L E C T   U T I L I T Y :             

T E S T S   S E T U P       A U T O P R M 

 

• Select SETUP. The Edit Setup screen will appear: 
  

E D I T   S E T U P :                 

L A N G       M A N   B I O S T A C K        

 

• Select BIOSTACK. The Bio-Stack Utilities screen will appear with the three 
utilities as described below: 

 

B I O S T A C K  U T I L I T I E S :         

C O N F     A L I G N   V E R I F Y         

 

1. CONF:  The Configuration utility is used to describe the Bio-Stack operating 
mode. 

2. ALIGN:  The instrument Alignment utility is used to align the claw/gripper 
of the Bio-Stack to the carrier of the µFill (i.e., the z-height alignment). 

3. VERIFY: The Verify utility is used to verify the z-height alignment. 
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Configuration Utility 

• Select CONF first. The Configuration screen gives you the options of 
running the µFill™ either as a stand-alone instrument or with the 
Bio-Stack™. The default mode is to run the µFill by itself (i.e., in 
Manual mode). 

 

O P E R A T I N G  M O D E :       M A N 

M A N U A L   B I O S T A C K         

 

MAN in the upper right corner indicates the instrument is set for manual 
operation. If MANUAL is selected, the Bio-Stack Utilities screen will be 
re-displayed.  

• Select BIOSTACK to indicate that the µFill will be operated with the 
Bio-Stack. (The next time this screen is displayed, BIO will appear in the 
upper right corner.) The Re-Stack screen will then appear: 

 

R E - S T A C K ?             Y E S 

  Y E S        N O                  

 

Use this screen to indicate whether plates residing in the output stack at the 
end of a run shall be automatically re-stacked into the input stack. 

• Select YES or NO. After a brief pause, the Bio-Stack Utilities screen will 
appear. 
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Instrument Alignment Utility 

� Ensure that the instrument alignment plate has already been mounted 
(per the instructions in Chapter 3, Installation) and the x and y 
positioning of the Bio-Stack™ to the µFill™ has been performed before 
proceeding with the z-height (vertical) alignment.  

To align the z-height of the claw/gripper on the Bio-Stack with the carrier of 
the µFill, select ALIGN on the Bio-Stack Utilities screen. The Alignment screen 
will appear: 

  

A L I G N M E N T  U T I L I T Y :          

H O M E     C - P O S   S A V E           

 

The instrument’s Alignment Utility has three selections: 

1. HOME: This allows you to home all axes for either the Bio-Stack or the 
µFill. 

2. C-POS: This allows you to “step” the claw/gripper down to the µFill’s 
carrier to find the proper interface position (the z-height). 

3. SAVE: When the interface position has been found, the Save function is 
used to tell the Bio-Stack to save the z-height for proper plate seating. 

 

Home Selection 

� Select HOME. The following screen will appear with the two options 
of homing all axes for either the µFill or for the Bio-Stack. Select 
BIOSTACK to home all its axes, then press the PREVIOUS SCREEN 
key on the keypad to return to the Alignment Utility Screen. 

 

H O M E   A L L :                   

u F i l l     B I O S T A C K             
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C-POS Selection 

� Select C-POS. At this point, if the claw is not fully homed, it will rise 
to its full height (its home position) and the gripper will spread out 
to its full width. The Find Claw Interface Pos screen will then 
appear: 

 

F I N D   C L A W  I N T E R F A C E  P O S : 

  - / +       + 1     + 2 0    + 4 0 0   

 

� The goal of this utility is to align the claw so that the gripper fingers 
are resting approximately 50-60 thousandths of an inch below the 
plate bottom or carrier surface. See Figure 34 in Chapter 3, 
Installation, for an illustration of proper alignment of the 
claw/gripper with the plate.  
 
To help in this activity, place a microplate on the carrier of the 
µFill™ (optional). To avoid collision of the gripper with the plate or 
carrier on the µFill, press the +20 key first to see how far that goes, 
before pressing the +400 key. Use the +1/+20/+400 softkeys to 
gradually lower the claw/gripper to the precise location (i.e., .05” or 
.06” below the plate bottom or carrier surface). 

� The C-POS measurement-to-inch ratios are: 1 = 0.001875", 
20 = 0.0375", and 400 = 0.75". 

�  If you have moved the gripper too far below the carrier, press the  
-/+ key to change direction. 

Save Selection 

� If you are satisfied with the alignment, press the PREVIOUS SCREEN 
key to return to the Alignment screen and select SAVE. At the 
following screen, select YES, and then press the ENTER key. 

 

O K   T O   S A V E  L O C A T I O N ?  Y E S 

  Y E S        N O                  

 

At this point, the claw will home, the grippers will close, and the setting will be 
saved in the flash memory of the Bio-Stack™. After a brief wait, the Bio-Stack 
Utilities screen will appear. 
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Verify Utility 

� Remove the microplate (if one was used) from the µFill™ carrier before 
proceeding with the Verify sequence below, otherwise the plate that 
the claw gripper retrieves from the input stack to place on the carrier 
will collide with the plate in the carrier! Also, ensure that there is at 
least one plate in the input stack.  

• At the Utilities screen, select VERIFY. The following screen will appear: 
 

P L A C E   P L A T E  I N  I N - S T A C K   

< E N T E R >  K E Y  T O  C O N T I N U E   

 

• Place a plate in the input stack. 

• Press ENTER. The claw will pick up a plate drawn from the input stack 
and place it onto the µFill carrier, with several delays during the place 
sequence. Watch to ensure that the gripper picks up the plate and 
gently sets it down in the carrier.  

Two possible problems can occur at this point: 

1. The gripper fingers are too low, so that after the gripper has 
released the plate, it will rise an inadequate distance before closing the 
gripper, thus catching the top of the plate. An error code will be 
displayed in this instance. 

2. The gripper fingers are too high, in which case the gripper will 
drop the plate a little further than it should, possibly causing fluid in 
the microwells to spill. 

If no error codes were displayed, the following screen will appear: 

 

V E R I F Y   P L A T E  P L A C E M E N T     

< E N T E R >  K E Y  T O  C O N T I N U E   

 

• Press ENTER. The claw will pick up the plate and place it on the 
Bio-Stack™ carrier for transfer to the output stack. Ensure that the claw 
performs this correctly. After a brief pause, the Utilities screen will 
appear. Press the Main Menu key to return to the µFill main menu 
screen.  

Bio-Stack Operator's Manual  



182  | Chapter 4: Operation 

� Moving the Bio-Stack™, inserting a new µFill™ Dispenser, etc. can 
potentially change the alignment. If this is the case, you may have to 
repeat the x, y, and z alignment steps in Chapter 3, Installation. 

Running Programs 

To run Dispense and Link programs, refer to your µFill Operator’s Manual for 
instructions. 

The following sections contain examples of screens that will appear on the µFill 
display during sample Dispense and Link programs when the µFill is operated 
with the Bio-Stack, in contrast to screens that appear on the µFill when it is used as 
a stand-alone. 

� The Prime and Maintenance programs can only be run on the µFill 
when used without the Bio-Stack. You can run Dispense and Link 
programs whether the µFill is operated with or without the Bio-Stack.  

Starting Dispense/Link Programs 

After indicating that you want to run a program and have selected the 
program type, one of the following screens is displayed. Pressing the START or 
the ENTER key will initiate the program. 

With the Bio-Stack: 

 

P L A C E  P L A T E S  O N  B I O S T A C K 

P R E S S   < S T A R T >  K E Y           

 

Without the Bio-Stack: 

 

I N S E R T   M I C R O P L A T E           

P R E S S   < S T A R T >  K E Y           

 

In-Process Programs   

While a program is being processed, you will see one of the following screens. 
When the Dispense/Link Program Running screen is displayed, you may press 
the STOP key, if necessary, to stop the execution of the program.  
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With the Bio-Stack™:  

 

P L A T E   # #  R U N N I N G . . .         

P R E S S   < S T O P >  K E Y  T O  Q U I T 

 

Without the Bio-Stack: 

 

D I S P E N S E  P R O G R A M  R U N N I N G 

P R E S S   < S T O P >  K E Y  T O  Q U I T 

 
 

L I N K   P R O G R A M  R U N N I N G        

P R E S S   < S T O P >  K E Y  T O  Q U I T 

 

In either instance, if you press the STOP key while a plate is being processed on 
the µFill™, the µFill will abort the program and the Home All Axes screen will 
appear, as described in the Abort Actions section on the following page. 
Although the plate currently being processed will be aborted, the sequence 
described in the Abort Actions section not only provides a way to home all 
axes, but, if the Bio-Stack™ is being used, allows the remainder of the plates in 
the Bio-Stack to be run. 

If you are using the Bio-Stack and you press the STOP key while the plate is 
being transferred to or from the Bio-Stack, the Bio-Stack will complete the 
transfer and the system will pause. The Abort/Proceed screen will appear: 

 

                                  

A B O R T   P R O C E E D               

 

This pause gives you the chance to add more plates to, or remove some plates 
from the Bio-Stack, without aborting the currently processing plate. Select 
PROCEED to resume program operation, or ABORT to abort the whole run. 

Completing the Program  

At the completion of the selected program, if you are running the µFill with the 
Bio-Stack and have selected the Re-Stack option (see page 178), you will see the 
following display after the program has been run for all plates:  
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R E - S T A C K I N G                 

P L E A S E   W A I T                 

 

After 1) re-stacking is done, or, 2) if no re-stack was requested, or, 3) if you are 
running without the Bio-Stack™, one of the following screens will be 
displayed, once the program is complete: 

With the Bio-Stack: 

 

# #   P L A T E S  C O M P L E T E          

  N E W     R E P E A T                

 

Without the Bio-Stack:  

 

D I S P   P R O G R A M  C O M P L E T E .     

  N E W     R E P E A T                

 
 

L I N K   P R O G R A M  C O M P L E T E .     

  N E W     R E P E A T                

 

Abort Actions 

When the STOP key is pressed during execution of the Dispense or Link 
programs, the program immediately halts and the following screen is 
displayed: 

With the Bio-Stack: 

 

H O M E   A L L  A X I S ?        Y E S 

  Y E S       N O                

 

Without the Bio-Stack: 
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P R E S S   < E N T E R >  K E Y           

T O  H O M E  A L L  A X I S         

 

When you select YES or press ENTER, all motor axes will home while 
displaying the following message: 

 

With the Bio-Stack™: 

 

R U N N I N G  S T O P  P R O T O C O L       

                               

 

Without the Bio-Stack: 

 

R U N N I N G  S T O P  P R O T O C O L       

P L E A S E   W A I T . . .           

 

At this point, if operating with the Bio-Stack, you have the option of homing 
the Bio-Stack and running the remainder of the plates: 

 

H O M E   T H E  B I O - S T A C K ?   Y E S 

  Y E S       N O                

 
 

R U N   R E S T  O F  P L A T E S ?   Y E S 

  Y E S       N O                

 

Ensure that you remove the aborted plate from the µFill™ before selecting YES. 
The program will then continue to run and will display the count of the plate 
in process (-1 for the aborted plate). 
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Operate the Bio-Stack™ with the ELx405™ 
(Instrument Control) 

 
Warning! Keep your hands away from the claw/gripper and carrier 
while the Bio-Stack is being powered up. The carrier and claw/gripper 
move quickly during the homing sequence. 

 
The ELx405 Microplate Washer (all models except the Magna) uses RS-232 serial 
commands to control the Bio-Stack and it displays all Bio-Stack related information, 
including error codes.  

� The one exception to this is when the Bio-Stack is first powered up, 
and is not yet under the control of the washer. At this point, it will run 
a series of self-test homing operations. The LED on the Bio-Stack will 
flash if there is a failure during this sequence. If a failure occurs, you 
may turn the ELx405 on, and the washer will determine the status of 
the Bio-Stack and display any errors (ensure that the serial cable is 
connected). 

Perform the following steps to power up the ELx405 and Bio-Stack: 

1. Ensure that the Bio-Stack is correctly positioned next to the washer and that the 
alignment hardware and serial cable are attached. See Install the Bio-Stack with 
the µFill or ELx405 in Chapter 3, Installation.  

2. Power up the Bio-Stack first before turning on the ELx405. If the claw/gripper is 
not homed before the ELx405 is powered up, the Bio-Stack self-test will home the 
mechanism. Ensure that the claw/gripper has risen to its full height. 

3. Power up the ELx405. Before performing the self-test, the washer will attempt to 
establish communication with the Bio-Stack. If communication is successful, and 
the Bio-Stack has passed its own self-test, the washer will proceed with its self-test. 
If the Bio-Stack has failed the self-test, or communication could not be established, 
then the ELx405 self-test will fail, and the washer will beep and display an error 
code. Refer to Chapter 7, Troubleshooting and Error Codes, for a listing of all 
error codes associated with the Bio-Stack that are displayed on the ELx405. 

4. Once the Bio-Stack has been turned on, its LED will remain constantly on if the 
instrument is operating correctly. If the LED is off or flashing, an error has 
occurred. If the ELx405 is on, running, and properly connected, an error code may 
be displayed.  

� By default, the ELx405 is configured for operation as a stand-alone 
instrument. The washer must be configured for Bio-Stack operation by 
using the Bio-Stack’s Configuration utility. See Bio-Stack™ Utilities 
Screen on page 189. 
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Startup Screens 

� The screens listed below and on the following pages appear as menu 
selections in the bottom (second line) of the keypad LCD on the 
ELx405™. To make a selection, press the SoftKey below the menu 
function. To move to a previous menu, press the Previous Screen 
key. Refer to your ELx405 Operator’s Manual for a detailed illustration 
of the keypad and description of its functions. The ELx405 Manual 
contains instructions for running the washer as a stand-alone 
instrument, whereas this manual describes the Bio-Stack™ specific 
operation. 

When the ELx405 is powered up, the following two screens are displayed, and the 
carrier is homed: 

 

P O W E R U P  S E Q U E N C E  V X . X X     

I N I T I A L I Z I N G . . .             

 

B I O - T E K  E L x 4 0 5              

S E L F - T E S T . . . . .              

 

The above screen is displayed while communication with the Bio-Stack is being 
established and the self-test has begun. If no communication occurs after 30 
seconds, a timeout will result and error B-8306 is displayed. Press ENTER to 
display the main menu. If the self-test and homing sequence is successful, the 
ELx405 main menu screen will appear: 

 

B I O - T E K  E L x 4 0 5              

R U N     D E F I N E   M A I N T   U T I L 

 

� If the communication fails, the ELx405 software will display its Main 
Menu, but will not perform its homing sequence. This is to prevent the 
ELx405 carrier from colliding with the claw/gripper. Therefore, it is 
recommended that once the serial communication problems are 
corrected, that the ELx405 be turned off/on so it can run its own 
homing sequence. 

BioTek Instruments, Inc. 



Operate the Bio-Stack™ with the ELx405™ (Instrument Control)  |  189 

Bio-Stack™ Utilities Screen 

To access the Bio-Stack Utilities screen and configure the ELx405™ for proper 
Bio-Stack operation, follow the screens below:   

• Select UTIL from the main menu screen.  The Select Utility screen will 
appear: 

 

S E L E C T   U T I L I T Y :             

T E S T S   S E T U P       A U T O P R M 

 

• Select SETUP.   
 

E D I T   S E T U P :                 

R S 2 3 2   S E N S O R  A D J S T  * M O R E 

 

• Select *MORE: 
 

E D I T   S E T U P :                 

P A R K     B I O S T A C K      * M O R E 

 

• Select BIOSTACK.  
 

B I O S T A C K  U T I L I T I E S :         

C O N F     A L I G N   V E R I F Y         

The Bio-Stack Utilities screen will appear with the three utilities as described 
below: 

1. CONF:  The Configuration utility is used to describe the Bio-Stack operating 
mode. 

2. ALIGN:  The instrument Alignment utility is used to align the claw/gripper 
of the Bio-Stack to the carrier of the ELx405 (i.e., the z-height alignment). 

3. VERIFY:  The Verify utility is used to verify the z-height alignment. 
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Configuration Utility 

• Select CONF first. The Configuration screen provides the options of 
running the ELx405™ either as a stand-alone instrument or with the 
Bio-Stack™. The default mode is to run the ELx405 by itself (i.e., in 
Manual mode). 

 

O P E R A T I N G  M O D E :       M A N 

M A N U A L   B I O S T A C K         

 

MAN in the upper right corner indicates the instrument is set for manual 
operation. If MANUAL is selected, the Bio-Stack Utilities screen will be 
re-displayed.  

• Select BIOSTACK to indicate that the ELx405 will be operated with the 
Bio-Stack (the next time this screen is displayed, BIO will appear in the 
upper right corner). The Re-Stack screen will then appear: 

 

R E - S T A C K ?             Y E S 

  Y E S        N O                  

 

The Re-Stack screen indicates whether plates residing in the output stack at the 
end of a run shall be automatically re-stacked into the input stack. 

• Select YES or NO. After a brief pause, the Bio-Stack Utilities screen will 
reappear. 
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Instrument Alignment Utility 
 

� Ensure that the instrument alignment plate has already been mounted 
(per the instructions in Chapter 3, Installation) and the x and y 
positioning of the Bio-Stack™ to the ELx405™ has been performed 
before proceeding with the z-height (vertical) alignment.  

To align the z-height of the claw/gripper on the Bio-Stack with the carrier of 
the ELx405, select ALIGN on the Bio-Stack Utilities screen. The Alignment 
Utility screen will appear: 

  
 

A L I G N M E N T  U T I L I T Y :          

H O M E     C - P O S   S A V E           

 

The instrument Alignment Utility has three selections: 

1. HOME:  This allows the operator to home all axes for either the Bio-Stack 
or the ELx405. 

2. C-POS: This allows the operator to “step” the claw/gripper down to the 
ELx405’s carrier to find the proper interface position (the z-height). 

3. SAVE: When the interface position has been found, the Save function is 
used to tell the Bio-Stack to save the z-height for proper plate 
transferring. 

Home Selection 

�  Select HOME. The following screen will appear with the two options 
of homing all axes for either the ELx405 or for the Bio-Stack. Select 
BIOSTACK to home all its axes, then press the PREVIOUS SCREEN 
key on the keypad to return to the Alignment Utility screen. 

 

H O M E   A L L :                   

E L x 4 0 5    B I O S T A C K            
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C-POS Selection 

� Select C-POS. At this point, if the claw is not fully homed, it will 
rise to its full height (its home position) and the gripper will spread 
out to its full width. The Find Claw Interface Pos screen will then 
appear: 

 

F I N D   C L A W  I N T E R F A C E  P O S : 

  - / +       + 1     + 2 0    + 4 0 0   

 

� The goal of this utility is to align the claw so that the gripper fingers 
are resting approximately 50-60 thousandths of an inch below the 
plate bottom or carrier surface. See Figure 34 in Chapter 3, 
Installation, for an illustration of proper alignment of the 
claw/gripper with the plate.  

� To help in this activity, place a microplate on the carrier of the 
ELx405™.  To avoid collision of the gripper with the plate or carrier 
on the washer, press the +20 key first to see how far that goes, 
before pressing the +400 key. Use the +1/+20/+400 softkeys to 
gradually lower the claw/gripper to the precise location (i.e., .05” or 
.06” below the plate bottom or carrier surface). 

� The C-POS measurement-to-inch ratios are: 1 = 0.001875", 
20 = 0.0375", and 400 = 0.75".  

� If you have moved the gripper too far below the carrier, press the  
-/+ key to change direction. 

 

Save Selection 

� If you are satisfied with the alignment, press the PREVIOUS SCREEN 
key to return to the Alignment screen and select SAVE. At the 
following screen, press YES, and then the ENTER key. 

 

O K   T O   S A V E  L O C A T I O N ?  Y E S 

  Y E S        N O                  

 

� At this point, the claw will home, the grippers will close, and the 
setting is saved in the flash memory of the Bio-Stack™. After a brief 
wait, the Bio-Stack Utilities screen will appear. 
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Verify Utility 

� Remove the microplate (if one was used) from the ELx405™ carrier 
before proceeding with the Verify sequence below, otherwise the plate 
that the claw gripper retrieves from the input stack to place on the 
carrier will collide with the plate in the carrier! Also, ensure that there 
is at least one plate in the input stack.  

• At the Bio-Stack™ Utilities screen, select VERIFY. The following screen 
will appear: 

 

P L A C E   P L A T E  I N  I N - S T A C K   

< E N T E R >  K E Y  T O  C O N T I N U E   

 
• Place a plate in the input stack. 

• Press ENTER. The claw will pick up a plate drawn from the input stack 
and place it onto the ELx405 carrier, with several delays during the 
place sequence. Watch to ensure that the gripper picks up the plate and 
gently sets it down in the carrier.  

Two possible problems can occur at this point: 

1. The gripper fingers are too low, so that after the gripper has 
released the plate, it will rise an inadequate distance before closing the 
gripper, thus catching the top of the plate. An error will be displayed in 
this instance. 

2. The gripper fingers are too high, in which case the gripper will 
drop the plate a little further than it should, possibly causing fluid in 
the microwells to spill. 

If no errors are displayed, the following screen will appear: 

 

V E R I F Y   P L A T E  P L A C E M E N T     

< E N T E R >  K E Y  T O  C O N T I N U E   

 

• Press ENTER. The claw will pick up the plate and place it on the 
Bio-Stack carrier for transfer to the output stack. Ensure that the claw 
performs this correctly. After a brief pause, the Bio-Stack Utilities screen 
will appear. Press the Main Menu key to return to the ELx405 main 
menu screen and the Run, Define, Maint or Util options.  
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� Moving the Bio-Stack™, inserting a new ELx405™ washer, etc. can 
potentially change the alignment. If this is the case, you may have to 
repeat the x, y, and z alignment steps in Chapter 3, Installation. 

Running Programs 

To run Wash, Dispense, Aspirate, and Link programs, refer to your ELx405 
Operator’s Manual for instructions. 

The following sections contain sample screens that will appear on the ELx405 
display during Wash, Dispense, Aspirate and Link programs when the washer is 
operated with the Bio-Stack, in contrast to screens that appear on the ELx405 when 
it is used as a stand-alone. 

� The Prime, Soak, and Maintenance programs can only be run on the 
ELx405 without the Bio-Stack. You can run ELx405 Wash, Dispense, 
Aspirate, and Link programs whether the washer is operated with or 
without the Bio-Stack.  

Starting Programs 

After indicating that you want to run a program and have selected the 
program type, one of the following screens is displayed. Pressing the START or 
the ENTER key will initiate the program.  

With the Bio-Stack: 

 

P L A C E  P L A T E S  O N  B I O S T A C K 

A N D   P R E S S  < S T A R T >  K E Y       

 

Without the Bio-Stack: 

 

P L A C E   P L A T E  I N  C A R R I E R     

A N D   P R E S S  < S T A R T >  K E Y       

 

In-Process Programs 

While a program is being processed, you will see one of the following screens. 
When the Wash, Dispense, Aspirate or Link Program Running screen is 
displayed, you may press the STOP key, if necessary, to stop the execution of 
the program.  
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With the Bio-Stack™:  

 

P L A T E   # #  R U N N I N G . . .         

P R E S S   < S T O P >  K E Y  T O  Q U I T 

 

Without the Bio-Stack: 

 

W A S H   P R O G R A M  R U N N I N G . . .   

P R E S S   < S T O P >  K E Y  T O  Q U I T 

 
 

D I S P E N S E  P R O G R A M  R U N N I N G 

P R E S S   < S T O P >  K E Y  T O  Q U I T 

 
 

A S P I R   P R O G R A M  R U N N I N G       

P R E S S   < S T O P >  K E Y  T O  Q U I T 

 
 

L I N K   P R O G R A M  R U N N I N G        

P R E S S   < S T O P >  K E Y  T O  Q U I T 

 

In either instance, if you press the STOP key while a plate is being processed on 
the ELx405™, the washer will abort the program and the Home All Axes 
screen will appear, as described in the Abort Actions section on page 197. 
Although the plate currently being processed will be aborted, the sequence 
described in the Abort Actions section not only provides a way to home all 
axes, but, if the Bio-Stack is being used, allows the remainder of the plates in 
the Bio-Stack to be run. 

If you are using the Bio-Stack and you press the STOP key while the plate is 
being transferred to or from the Bio-Stack, the Bio-Stack will complete the 
transfer and the system will pause. The Abort Continue screen will appear: 

 

                                  

A B O R T   C O N T I N U E              
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This pause gives you the chance to add more plates to, and remove some plates 
from, the Bio-Stack™ without aborting the currently processing plate. Select 
CONTINUE to resume program operation, or ABORT to abort the whole run. 

Completing the Program  

At the completion of the selected program, if you are running the ELx405™ 
with the Bio-Stack and have selected the Re-Stack option (see page 190), you 
will see the following display after the program has been run for all plates:  

 

R E - S T A C K I N G                 

P L E A S E   W A I T                 

 

After 1) re-stacking is done, or, 2) if no re-stack was requested, or, 3) if you are 
running without the Bio-Stack, one of the following screens will be displayed, 
once the program is complete: 

With the Bio-Stack: 

 

# #   P L A T E S  C O M P L E T E          

P R E S S   < E N T E R >  K E Y           

 

Without the Bio-Stack:  

 

W A S H   P R O G R A M  C O M P L E T E       

P R E S S   < E N T E R >  K E Y           

 

D I S P   P R O G R A M  C O M P L E T E       

P R E S S   < E N T E R >  K E Y           

 

A S P I R   P R O G R A M  C O M P L E T E     

P R E S S   < E N T E R >  K E Y           
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L I N K   P R O G R A M  C O M P L E T E       

P R E S S   < E N T E R >  K E Y           

Abort Actions 

When the STOP key is pressed during execution of the Wash, Aspirate, 
Dispense or Link programs, the program immediately halts and the following 
screen is displayed: 

With the Bio-Stack™: 

 

H O M E   A L L  A X I S ?        Y E S 

  Y E S       N O                

 

Without the Bio-Stack: 

 

P R E S S   < E N T E R >  K E Y           

T O  H O M E  A L L  A X I S         

 

When you select YES or press ENTER, all motor axes will home while 
displaying one of the following messages: 

With the Bio-Stack: 

 

R U N N I N G  S T O P  P R O T O C O L       

                               

 

Without the Bio-Stack: 

 

R U N N I N G  S T O P  P R O T O C O L       

P L E A S E   W A I T . . .           
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At this point, if operating with the Bio-Stack™, you have the option of homing 
the Bio-Stack and running the remainder of the plates: 

 

H O M E   T H E  B I O - S T A C K ?   Y E S 

  Y E S       N O                

 
 

R U N   R E S T  O F  P L A T E S ?   Y E S 

  Y E S       N O                

 

Ensure that you remove the aborted plate from the ELx405™ before selecting 
YES. The program will then continue to run and will display the count of the 
plate in process (-1 for the aborted plate). 
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Operate the Bio-Stack™ with the ELx405™ (PC 
Control) 

 
Warning! Keep your hands away from the claw/gripper and carrier 
while the Bio-Stack is being powered up. The carrier and claw/gripper 
move quickly during the homing sequence. 

 

BioTek’s Liquid Handling Control™ (LHC) Software uses the ELx405™ 
Interface Software to control all functions of the ELx405, and uses a component of 
the Bio-Stack™ PC Control Software to control all functionality of the Bio-Stack.  

Using LHC, the operator may configure the Bio-Stack to interface with the microplate 
carrier on the ELx405, and up to two Bio-Stacks may be simultaneously used with two 
ELx405 washers for high throughput plate processing. 

Figure 55 on the next page shows the relationship between the PC and its software  
(i.e., LHC) and the Bio-Stack and an ELx405.  

Figure 56 on page 201 illustrates the same relationship with two Bio-Stacks and two 
ELx405 washers. 

For a complete description of the LHC Software and its operation, please refer to the 
Liquid Handling Control Software Installation Guide or the online Help system by 
selecting Help > About Liquid Handling Control from the software’s main menu. 
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In Figure 55 below, the LHC™ software uses   

• one serial or USB port to control the Bio-Stack™ instrument plate transfers (via 
a component of the Bio-Stack™ PC Control Software); and  

• one serial port to control all functionality of the ELx405 washer (via the 
ELx405™ Interface Software). 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

RS-232 Serial or USB Cables 

ELx405   

Bio-Stack 

Host PC 

ELx405 
Interface 
Software 

Bio-Stack 
PC Control 
Software 

LHC Software

Figure 55: Bio-Stack/LHC Architecture (with One Bio-Stack and One Washer) 
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In Figure 56 below, the LHC™  software uses  

• two serial or USB ports to control instrument plate transfers on two Bio-Stack™ 
instruments (via a component of the Bio-Stack™ PC Control Software); and  

• two serial ports to control all functions of the two ELx405 washers (via the 
ELx405™ Interface Software). 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

RS-232 Serial or USB Cables 

ELx405   
Bio-Stack 

ELx405   
Bio-Stack 

Host PC 

LHC 

ELx405  
Interface 
Software 

Bio-Stack 
PC Control 
Software 

ELx405  
Interface 
Software 

Bio-Stack 
PC Control 
Software 

LHC 

Figure 56: Bio-Stack/LHC Architecture (with Two Bio-Stacks and Two Washers) 
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Operate the Bio-Stack™ with the NanoQuot™  

 
Warning! Keep your hands away from the claw/gripper and carrier 
while the Bio-Stack is being powered up. The carrier and claw/gripper 
move quickly during the homing sequence. 

 
Warning! Pressure Hazard! Before operating the Bio-Stack with 
the NanoQuot, ensure that the inlet pressure on the Dispenser’s 
compressor does not exceed 30 psi and the pressure to the 
NanoQuot’s supply bottle does not exceed 15 psi! Pressures outside 
the specified limit may cause the bottle to burst and result in possible 
injury.   

L 
Important! If you are using half-height plates and the Bio-Stack is 
passing multiple plates at once from the input stack to the Bio-Stack 
carrier, the instrument may need to be reconfigured to accommodate 
your microplates. Refer to Appendix C, Reconfiguration of the 
Bio-Stack, for more information. 

 

The NanoQuot Microplate Dispenser uses RS-232 serial commands to control the 
Bio-Stack, when the Dispenser is in Bio-Stack mode (selected via the Mode rocker 
switch on the Dispenser).    

Perform the following steps to power up the Bio-Stack and NanoQuot: 

1. Ensure that the Bio-Stack is correctly positioned next to the NanoQuot and that 
the alignment hardware and serial cable are attached between the two 
instruments. See Install the Bio-Stack with the NanoQuot, in Chapter 3, 
Installation. 

2. Power up the Bio-Stack first before turning on the NanoQuot. If the claw/ 
gripper is not homed before the Bio-Stack is powered up, the Bio-Stack self-test 
will home the mechanism. Ensure that the claw/gripper has risen to its full 
height. 

3. Power up the NanoQuot and allow the self-test to complete.    

4. Once the Bio-Stack has been turned on, its LED will remain constantly on if the 
instrument is operating correctly. If the LED is off or flashing, an error has 
occurred.   

To display error codes, you will need to temporarily disconnect the Bio-Stack 
from the NanoQuot, then connect the Dispenser to a host computer that has 
the NanoQuot™ PC Control Software installed. Refer to Chapter 7, 
Troubleshooting and Error Codes in this manual, for instructions for 
retrieving error codes that occur during operation of the Bio-Stack with the 
NanoQuot. 
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Run Plates 

1. Prime the NanoQuot™, if necessary, before running plates with the  
Bio-Stack™. (Refer to Chapter 3, Operation, in the NanoQuot Operator’s 
Manual for instructions for running a Prime program.) 

2. Place the number of plates you wish to run into the Bio-Stack’s input stack. 

3. Set the Mode rocker switch on the Dispenser to Bio-Stack.  

4. Set the program parameters using the NanoQuot’s rocker switches, 
thumbwheels and keypad: 

• Select a Liquid Profile (only necessary when changing liquids):   

¾ Use the Plate/Liquid Profile rocker switch to select the desired Liquid 
Profile (LP1, LP2, or LP3).   

¾ Press and hold the Cal key until the Alert light repeatedly flashes. The 
Alert light will then verify the Liquid Profile selected by blinking once 
for LP1, twice for LP2, and three times for LP3. The carrier will then 
home. 

• Set a desired volume with the Volume thumbwheels. 

• Set the ending column number with the Cols thumbwheels. 

� The starting column is pre-defined as column 1. Starting 
columns cannot be changed when operating the NanoQuot via 
the Dispenser’s keypad.   

• Select the plate type with the plate type (96, 384, 1536) rocker switch. 

5. Ensure that the pressure setting is not above 15 psi for the Dispenser’s supply 
bottle. The generally recommended pressure setting is 12.5 psi; however, the 
actual pressure should correspond with that set when the liquid profile was 
defined. 

6. Press the Start/Run key on the NanoQuot to begin processing. All plates in 
the input stack will be processed then stacked in the output stack. 

Restack Plates 

To restack plates that have been processed, press the Cal/Restack key on the 
Dispenser. The Bio-Stack will move all of the plates that are stacked in the output 
stack back into the input stack. 

Home the Bio-Stack 

To home the Bio-Stack, press the Home key on the NanoQuot. The Bio-Stack will 
home all axes. 
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Operate the Bio-Stack™ with the MicroFlo™ Select 
(Instrument Control) 

 
Warning! Keep your hands away from the claw/gripper and carrier 
while the Bio-Stack is being powered up. The carrier and claw/gripper 
move quickly during the homing sequence. 

 
The MicroFlo Select Dispenser uses RS-232 serial commands to control the Bio-Stack 
and it displays all Bio-Stack related information, including error codes.  

� The one exception to this is when the Bio-Stack is first powered up, 
and is not yet under the control of the dispenser. At this point, it will 
run a series of self-test homing operations. The LED on the Bio-Stack 
will flash if there is a failure during this sequence. If a failure occurs, 
you may turn the MicroFlo on, and the dispenser will determine the 
status of the Bio-Stack and display any errors (ensure that the serial 
cable is connected). 

Perform the following steps to power up the MicroFlo and Bio-Stack: 

1. Ensure that the Bio-Stack is correctly positioned next to the dispenser and that the 
alignment hardware and serial cable are attached. See Install the Bio-Stack with 
the MicroFlo Select in Chapter 3, Installation. 

2. Power up the Bio-Stack first before turning on the MicroFlo. If the claw/gripper is 
not homed before the MicroFlo is powered up, the Bio-Stack self-test will home the 
mechanism. Ensure that the claw/gripper has risen to its full height. 

3. Power up the MicroFlo. Before performing the self-test, the dispenser will attempt 
to establish communication with the Bio-Stack. If communication is successful, and 
the Bio-Stack has passed its own self-test, the dispenser will proceed with its 
self-test. If the Bio-Stack has failed the self-test, or communication could not be 
established, then the MicroFlo self-test will fail, and the dispenser will “chirp” and 
display an error code. Refer to Chapter 7, Troubleshooting and Error Codes, for 
a listing of all error codes associated with the Bio-Stack that are displayed on the 
MicroFlo. 

4. Once the Bio-Stack has been turned on, its LED will remain constantly on if the 
instrument is operating correctly. If the LED is off or flashing, an error has 
occurred. If the MicroFlo is on, running, and properly connected, an error code 
may be displayed. 

� By default, the MicroFlo is configured for operation as a stand-alone 
instrument. The dispenser must be configured for Bio-Stack operation 
by using the Bio-Stack’s Configuration utility. See Bio-Stack™ 
Utilities Screen on page 207. 
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Startup Screens 

� The screens listed below and on the following pages appear as menu 
selections in the bottom (second line) of the keypad LCD on the 
MicroFlo™ Select. To make a selection, press the SoftKey below the 
menu function. To move to a previous menu, press the Previous 
Screen key. Refer to your MicroFlo Select Operator’s Manual for a 
detailed illustration of the keypad and description of its functions. The 
MicroFlo Operator’s Manual contains instructions for running the 
dispenser as a stand-alone instrument, whereas this manual describes 
the Bio-Stack™ specific operation. 

When the MicroFlo is powered up, the following screen is displayed, and the 
carrier is homed: 

 

      M i c r o F l o  S e l e c t          

7 1 7 0 2 0 0  V e r s i o n  X . X X        

 

The above screen is displayed while communication with the Bio-Stack is being 
established and the self-test has begun. If no communication occurs after 30 
seconds, a timeout will result and error B-8306 is displayed. Press ENTER to 
display the Main Menu. If the self-test and homing sequence is successful, the 
MicroFlo Main Menu screen will appear: 

 

( 9 6 )   C A S S ( 5 )  V O L : 0 0 1 0 u l   

P R I M E   P U R G E  u P L A T E   - -  >   

 

� If the communication fails, the MicroFlo software will display its Main 
Menu, but will not perform its homing sequence. This is to prevent the 
MicroFlo carrier from colliding with the claw/gripper. Therefore, it is 
recommended that once the serial communication problems are 
corrected, that the MicroFlo be turned off/on so it can run its own 
homing sequence.  
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Bio-Stack™ Utilities Screen 

To access the Bio-Stack Utilities screen and configure the MicroFlo™  Select for 
proper Bio-Stack operation, follow the screens below: 

• At the MicroFlo main menu screen, select - - > twice. The Dispenser Action 
Menu screen will appear: 

 

D I S P E N S E R  A C T I O N  M E N U       

D E F I N E   U T I L   S E T U P          

 
• Select SETUP. 

 

S E T U P   O P T I O N S :              

C A L       C A S S   B I O S T A C K  - - > 

 

• Select BIOSTACK.  
 

B I O S T A C K  U T I L I T I E S :         

C O N F     A L I G N   V E R I F Y         

The Bio-Stack Utilities screen will appear with the three utilities as described 
below: 

1. CONF:  The Configuration utility is used to describe the Bio-Stack operating 
mode. 

2. ALIGN:  The instrument Alignment utility is used to align the claw/gripper 
of the Bio-Stack to the carrier of the MicroFlo (i.e., the z-height alignment). 

3. VERIFY:  The Verify utility is used to verify the z-height alignment. 
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Configuration Utility 

• Select CONF first. The Configuration screen provides the options of 
running the MicroFlo™  Select either as a stand-alone instrument or 
with the Bio-Stack™. The default mode is to run the MicroFlo by itself 
(i.e., in Manual mode). 

 

O P E R A T I N G  M O D E :       M A N 

M A N U A L   B I O S T A C K         

 

MAN in the upper right corner indicates the instrument is set for manual 
operation. If MANUAL is selected, the Bio-Stack Utilities screen will be 
re-displayed.  

• Select BIOSTACK to indicate that the MicroFlo will be operated with the 
Bio-Stack (the next time this screen is displayed, BIO will appear in the 
upper right corner). The Re-Stack screen will then appear: 

 

R E - S T A C K ?             Y E S 

  Y E S        N O                  

 

The Re-Stack screen indicates whether plates residing in the output stack at the 
end of a run shall be automatically re-stacked into the input stack. 

• Select YES or NO. After a brief pause, the Bio-Stack Utilities screen will 
reappear.  
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Instrument Alignment Utility 
 

� Ensure that the instrument alignment plate has already been mounted 
(per the instructions in Chapter 3, Installation) and the x and y 
positioning of the Bio-Stack™ to the MicroFlo™ Select has been 
performed before proceeding with the z-height (vertical) alignment.  

To align the z-height of the claw/gripper on the Bio-Stack with the carrier of 
the MicroFlo, select ALIGN on the Bio-Stack Utilities screen. The Alignment 
Utility screen will appear: 

  

A L I G N M E N T  U T I L I T Y :          

H O M E     C - P O S   S A V E           

 

The instrument Alignment Utility has three selections: 

1. HOME:  This allows the operator to home all axes for either the Bio-Stack 
or the MicroFlo. 

2. C-POS: This allows the operator to “step” the claw/gripper down to the 
MicroFlo’s carrier to find the proper interface position (the z-height). 

3. SAVE: When the interface position has been found, the Save function is 
used to tell the Bio-Stack to save the z-height for proper plate 
transferring. 

Home Selection 

�  Select HOME. The following screen will appear with the two options 
of homing all axes for either the dispenser or for the Bio-Stack. 
Select BIOSTACK to home all its axes, then press the Previous Screen 
key on the keypad to return to the Alignment Utility screen. 

 

H O M E   A L L :                   

D I S P     B I O S T A C K              
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C-POS Selection 

� Select C-POS. At this point, if the claw is not fully homed, it will 
rise to its full height (its home position) and the gripper will spread 
out to its full width. The Find Claw Interface Pos screen will then 
appear: 

 

F I N D   C L A W  I N T E R F A C E  P O S : 

  - / +       + 1     + 2 0    + 4 0 0   

 

� The goal of this utility is to align the claw so that the gripper fingers 
are resting approximately 50-60 thousandths of an inch below the 
plate bottom or carrier surface. See Figure 44 in Chapter 3, 
Installation, for an illustration of proper alignment of the 
claw/gripper with the plate.  

� To help in this activity, place a microplate on the carrier of the 
MicroFlo™.  To avoid collision of the gripper with the plate or 
carrier on the dispenser, press the +20 key first to see how far that 
goes, before pressing the +400 key. Use the +1/+20/+400 softkeys 
to gradually lower the claw/gripper to the precise location (i.e., .05” 
or .06” below the plate bottom or carrier surface). 

� The C-POS measurement-to-inch ratios are: 1 = 0.001875", 
20 = 0.0375", and 400 = 0.75".  

� If you have moved the gripper too far below the carrier, press the  
-/+ key to change direction. 

 

Save Selection 

� If you are satisfied with the alignment, press the Previous Screen 
key to return to the Alignment Utility screen and select SAVE. At the 
following screen, press YES, and then the ENTER key. 

 

O K   T O   S A V E  L O C A T I O N ?        

  Y E S        N O                  

 

� At this point, the claw will home, the grippers will close, and the 
setting is saved in the flash memory of the Bio-Stack™. After a brief 
wait, the Bio-Stack Utilities screen will appear.  
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Verify Utility 

� Remove the microplate (if one was used) from the MicroFlo™ Select 
carrier before proceeding with the Verify sequence below, otherwise 
the plate that the claw gripper retrieves from the input stack to place 
on the carrier will collide with the plate in the carrier! Also, ensure that 
there is at least one plate in the input stack.  

• At the Bio-Stack™ Utilities screen, select VERIFY. The following screen 
will appear: 

 

P L A C E   P L A T E  I N  I N - S T A C K   

< E N T E R >  T O  C O N T I N U E         

 
• Place a plate in the input stack. 

• Press ENTER. The claw will pick up a plate drawn from the input stack 
and place it onto the MicroFlo carrier, with several delays during the 
place sequence. Watch to ensure that the gripper picks up the plate and 
gently sets it down in the carrier.  

Two possible problems can occur at this point: 

1. The gripper fingers are too low, so that after the gripper has 
released the plate, it will rise an inadequate distance before closing the 
gripper, thus catching the top of the plate. An error will be displayed in 
this instance. 

2. The gripper fingers are too high, in which case the gripper will 
drop the plate a little further than it should, possibly causing fluid in 
the microwells to spill. 

If no errors are displayed, the following screen will appear: 

 

V E R I F Y   P L A T E  P L A C E M E N T     

< E N T E R >  T O  C O N T I N U E         

 

• Press ENTER. The claw will pick up the plate and place it on the 
Bio-Stack carrier for transfer to the output stack. Ensure that the claw 
performs this correctly. After a brief pause, the Bio-Stack Utilities screen 
will appear. Press the Main Menu key twice to return to the MicroFlo 
main menu screen.  

� Moving the Bio-Stack™, inserting a new MicroFlo™ Select, etc., can 
potentially change the alignment. If this is the case, you may have to 
repeat the x, y, and z alignment steps in Chapter 3, Installation. 
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Running Dispense Programs 

The MicroFlo Select allows you the flexibility of running either a “Quick Dispense” 
or a Dispense protocol. To run Dispense programs, refer to your MicroFlo Select 
Operator’s Manual for instructions. 

The following section contains sample screens that will appear on the MicroFlo 
display during a Dispense program when the MicroFlo is operated with the  
Bio-Stack. 

Starting Dispense Programs 

After you have selected (and, if applicable, created/edited) the Dispense 
program you wish to run, one of the following screens is displayed. Pressing 
the START or the ENTER key will initiate the program.  

With the Bio-Stack: 

 

P L A C E  P L A T E S  O N  B I O S T A C K 

P R E S S   < S T A R T >  K E Y           

 

Without the Bio-Stack: 

 

I N S E R T   M I C R O P L A T E           

P R E S S   < S T A R T >  K E Y           

 

In-Process Dispense Programs 

While a Dispense program is being processed, you will see the following 
screen. You may press the STOP key, if necessary, to stop the execution of the 
program.  

With or without the Bio-Stack: 

 

D I S P E N S I N G . .  C A S S :  X u L     

P R E S S   < S T O P >  K E Y  T O  Q U I T 
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If you press the STOP key while a plate is being processed on the MicroFlo™ 
Select, the dispenser will pause the dispense operation and you will have the 
option to Cancel or Resume: 

 

                                   

C A N C E L   R E S U M E               

 

Cancel will discontinue the dispense operation and the dispenser will be 
homed. Resume will continue execution where the instrument left off and 
complete the dispense operation.   

If you press the STOP key while the plate is being transferred to or from the 
Bio-Stack, the Please Wait screen will be displayed until the Bio-Stack has 
completed its action. At that point, the Cancel or Resume screen will be 
displayed: 

 

                                  

P L E A S E   W A I T . . .              

 

                                   

C A N C E L   R E S U M E               

 

Cancel will discontinue the dispense operation, and the dispenser will be 
homed. Resume will continue execution where the instrument left off and 
complete the dispense operation. 

Completing the Dispense Program  

The following screen will be displayed, once the Dispense program is 
complete: 

 

D I S P E N S E  P R O G  C O M P L E T E     

  N E W     R E P E A T                
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Operate the Bio-Stack™ with the MicroFlo™ Select 
(PC Control) 

 
Warning! Keep your hands away from the claw/gripper and carrier 
while the Bio-Stack is being powered up. The carrier and claw/gripper 
move quickly during the homing sequence. 

 

BioTek’s Liquid Handling Control™ (LHC) Software uses the MicroFlo™ Select 
Interface Software to control all functions of the MicroFlo Select, and uses a 
component of the Bio-Stack™ PC Control Software to control all functionality of 
the Bio-Stack.  

Using LHC, the operator may configure the Bio-Stack to interface with the microplate 
carrier on the MicroFlo. 

Figure 57 on the next page shows the relationship between the PC and its software  
(i.e., LHC) and the Bio-Stack and a MicroFlo.  

For a complete description of the LHC Software and its operation, please refer to the 
Liquid Handling Control Software Installation Guide or the online Help system by 
selecting Help > About Liquid Handling Control from the software’s main menu. 
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In Figure 57 below, the LHC™ software uses   

• one serial or USB port to control the Bio-Stack™ instrument plate transfers  
(via a component of the Bio-Stack™ PC Control Software); and  

• one USB port to control all functionality of the MicroFlo Select dispenser  
(via the MicroFlo™ Select Interface Software). 
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RS-232 Serial or USB Cables 
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e 57: Bio-Stack/LHC Architecture (with Bio-Stack and MicroFlo Dispenser) 
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Overview 

Equipment qualification of the Bio-Stack™ involves two activities:  

• Qualification of installation and setup 

• Qualification of routine capability 
 

This chapter refers to these activities as Installation Qualification (IQ) and 
Operational Qualification (OQ).  

� An instrument qualification package (PN 7310530) for the Bio-Stack is 
available for purchase. The package contains thorough procedures for 
performing Installation/Operational Qualification (IQ/OQ) and Preventive 
Maintenance (PM). Extensive Checklists and Logbooks are included for 
recording results. Contact your local dealer for more information. 

Qualification tasks and tests for the Bio-Stack include installing the Bio-Stack with the 
interfacing instrument, and running the System Self-Test, Checksum Test, 
Instrument Alignment Utility, and Verify Test. If the optional barcode scanner 
has been installed, a test is performed to verify proper installation. 

• The System Self-Test verifies the Bio-Stack’s system components, such as the 
input and output stack lifters, carrier, and claw/gripper.  

• The Checksum Test verifies the basecode software of the Bio-Stack or 
interfacing instrument against internal checksum values to ensure that no 
corruption has occurred.  

If the Checksum Test is run manually, the version numbers and checksum for 
the basecode are displayed  

¾ on the computer during operation of the Bio-Stack with the 
PowerWave™/XS, Synergy™ HT/Synergy™ 2/Synergy™ 4, 
Precision™/XS, NanoQuot™,  ELx405™, or MicroFlo™ Select; or  

¾ on the display of the µFill™, ELx405, or MicroFlo Select.  (The assay 
configuration software information will also be displayed on the 
ELx405.)  

� Bio-Stack with NanoQuot: To obtain basecode software 
information for the Bio-Stack and NanoQuot, you will need a host 
computer that has the Bio-Stack™ PC Control Software and 
NanoQuot™ PC Control Software installed, respectively. Note: The 
NanoQuot basecode software information includes a part number 
and version only; there is no Checksum. 

� Bio-Stack with ELx405 or MicroFlo Select: The Bio-Stack and 
ELx405 or MicroFlo may be instrument controlled via the keypad on 
the ELx405 or MicroFlo, or PC controlled via the Liquid Handling 
Control™ (LHC) Software.  
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• An Instrument Alignment Utility is provided in the 

¾ Bio-Stack™ PC Control Software for aligning the claw/gripper with 
the height of the carrier on the PowerWave™/XS and Synergy™ HT/ 
Synergy™ 2/Synergy™ 4 readers and NanoQuot™ Dispenser  

¾ Precision Power™ Software for aligning the claw/gripper with the 
height of the selected supply station on the Precision™/XS 

¾ Liquid Handling Control™ (LHC) Software for aligning the 
claw/gripper with the height of the carrier on the ELx405™ or 
MicroFlo™ Select during PC control of the Bio-Stack and ELx405 or 
MicroFlo 

¾ basecode software of the µFill™, ELx405, or MicroFlo for aligning the 
claw/gripper with the height of the carrier on these instruments 

• The Verify Test confirms whether or not the Bio-Stack’s claw/gripper has 
been properly aligned with the interfacing instrument’s carrier or supply 
station (Precision/XS).  
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Qualification Schedule 

The following schedule defines BioTek’s recommended intervals for qualification task 
and tests. The risk factors associated with your tests may require that the Operational 
procedures be performed more or less frequently than shown below. 

 

 IQ OQ 

TASKS/TESTS Initially Every 
3 months 

Install/set up Bio-Stack™ and its components 9  

Attach alignment hardware 9   

Run Self-Test 9 9 

Align Bio-Stack with interfacing instrument 9  

Install microplate stacks 9  

PC Control: Connect host computer to Bio-Stack 
and interfacing instrument, install software, and test 
communication  

9  

Instrument Control: Connect Bio-Stack to 
interfacing instrument 

9  

Run Checksum Tests 9 9 

Run Instrument Alignment Utility 9 If Verify Test 
fails 

Run Verify Test 9 9 

Readers and Precision™ instruments only: 

(Optional) Install Bio-Stack barcode scanner and run 
Scanner Test  

9 9 

   

� The Instrument Alignment Utility and Verify Test should also be performed 
whenever the instruments are moved from one location to another within the 
laboratory. 
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Installation Qualification (IQ) 

Installation Qualification confirms that the Bio-Stack™ and its components have 
been supplied as ordered, and ensures that they are assembled and configured 
properly for your lab environment. 

• The recommended IQ procedure consists of setting up the Bio-Stack, and 
performing the Self-Test, Checksum Test, Instrument Alignment Utility, and 
Verify Test as described in Chapter 3, Installation. If applicable, the IQ 
procedure also consists of setting up the Bio-Stack’s optional barcode scanner 
(Readers and Precision instruments only), and performing the Scanner Test as 
described in Appendix B, Bio-Stack Barcode Scanner.   

• When performing the Checksum Test, record the software versions in the 
Software Data Sheets at the end of this chapter. 

• The IQ procedure should be performed initially (before the Bio-Stack is used for 
the first time). Some of the IQ steps should be performed if the instruments are 
moved from one location to another within the laboratory.  

• The successful completion of the IQ procedure verifies that the instruments 
and their components are installed correctly.   

 
 

Operational Qualification (OQ) 

Operational Qualification confirms that the Bio-Stack’s onboard software is 
operating properly and verifies the claw/gripper-to-instrument carrier alignment 
(even if the instruments have not been moved). 

• The recommended OQ procedure consists of performing the Self-Test, 
Checksum Test, and Verify Test, as described in Chapter 3, Installation. The 
Instrument Alignment Utility should be run if the Verify Test fails. If 
applicable, the OQ procedure also consists of performing the Scanner Test as 
described in Appendix B, Bio-Stack Barcode Scanner. 

• The OQ procedure should be performed every three months. It should also be 
performed after any major repair or upgrade to the hardware or software. 

• The successful completion of the OQ procedure confirms that the Bio-Stack is 
operating correctly. 
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IQ Procedure/Checklist 

Date: ___________________             Bio-Stack™ Serial Number: _______________________ 
 

All instruments: 

  Unpack and inspect the Bio-Stack 

  Check required and optional components 

  Select an appropriate location  

  Remove the shipping hardware 

  Connect the power supply  

PowerWave™/XS or Synergy™ HT/Synergy™ 2/Synergy™ 4  

  Attach the aligning posts and aligning caps 

  Seat the instruments in the aligning plates 

  Turn on the Bio-Stack and run a Self-Test 

  Align the Bio-Stack with the reader 

  Install the plate stacks 

  Connect the host PC to the Bio-Stack and reader 

  Install software on the host PC/test communication (run Checksum Tests)  

  Align the claw/gripper with the reader’s carrier (run Instrument Alignment Utility) 

  Verify the alignment by running a Verify Test 

  (Optional) Install the Bio-Stack barcode scanner and perform the Scanner Test  

Precision™/XS: 

  Attach the aligning posts, aligning caps, and roller extensions for the supply platform  

  Seat the instruments in the aligning plates 

  Turn on the Bio-Stack and run a Self-Test 

  Connect the host PC to the Bio-Stack and Precision/XS 

  Install software on the host PC/test communication (run Checksum Tests)/configure 
      Precision Power ™  

  Align the Bio-Stack with the Precision/XS 

  Install the plate stacks 

  Align the claw/gripper with Precision supply station (run Instrument Alignment Utility) 

  Verify the alignment by running a Verify Test 

  (Optional) Install the Bio-Stack barcode scanner and perform the Scanner Test  
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IQ Procedure/Checklist, Cont’d 

µFill™ or ELx405™ - Instrument Control: 

  Attach the aligning posts and aligning caps   

  Seat the instruments in the aligning plates 

  Turn on the Bio-Stack™ and run a Self-Test 

  Align the Bio-Stack with the µFill or ELx405 

  Install the plate stacks 

  Connect the Bio-Stack to the µFill or ELx405 

  Run the Checksum Test 

  Configure the µFill or ELx405 for the Bio-Stack 

  Test communication (run Checksum Test again) 

  Align the claw/gripper with the µFill or ELx405 plate carrier (run Instrument  
      Alignment Utility) 

  Verify the alignment by running a Verify Test 

ELx405™ - PC Control: 

  Attach the aligning posts and aligning caps   

  Seat the instruments in the aligning plates 

  Turn on the Bio-Stack™ and run a Self-Test 

  Align the Bio-Stack with the ELx405 

  Install the plate stacks 

  Connect the host PC to the Bio-Stack and ELx405 

  Install software on the host PC and, if necessary, upgrade basecode software on the ELx405 

  Test Communication 

  Run Checksum Tests 

  Align the claw/gripper with the ELx405 plate carrier (run Instrument Alignment Utility) 

  Verify the alignment by running a Verify Test 
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IQ Procedure/Checklist, Cont’d 

NanoQuot™:    

  Attach the aligning posts  

  Seat the instruments in the aligning plates 

  Turn on the Bio-Stack and run a Self-Test 

  Align the Bio-Stack with the NanoQuot 

   Install the plate stacks 

   Connect the host PC to the Bio-Stack 

   Install the Bio-Stack PC Control Software  

   Run the Checksum Test for the Bio-Stack  

  Align the claw/gripper with the NanoQuot plate carrier (run Instrument  
      Alignment Utility) 

  Verify the alignment by running a Verify Test 

  Connect the host PC to the NanoQuot 

  Install the NanoQuot PC Control Software 

  Obtain software information for the NanoQuot  

  Connect the Bio-Stack to the NanoQuot 

  Test communication   

 

BioTek Instruments, Inc. 



IQ Procedure/Checklist, Cont’d  |  225 

IQ Procedure/Checklist, Cont’d 

MicroFlo™ Select - Instrument Control: 

  Attach the aligning posts and aligning caps   

  Seat the instruments in the aligning plates 

  Turn on the Bio-Stack™ and run a Self-Test 

  Align the Bio-Stack with the MicroFlo 

  Install the plate stacks 

  Connect the Bio-Stack to the MicroFlo 

  Run the Checksum Test 

  Configure the MicroFlo for the Bio-Stack 

  Test communication (run Checksum Test again) 

  Align the claw/gripper with the MicroFlo plate carrier (run Instrument Alignment Utility) 

  Verify the alignment by running a Verify Test 

MicroFlo Select - PC Control: 

  Attach the aligning posts and aligning caps     

  Seat the instruments in the aligning plates 

  Turn on the Bio-Stack™ and run a Self-Test 

  Align the Bio-Stack with the MicroFlo 

  Install the plate stacks 

  Connect the host PC to the Bio-Stack and MicroFlo 

  Install software on the host PC  

  Test Communication 

  Run Checksum Tests 

  Align the claw/gripper with the MicroFlo plate carrier (run Instrument Alignment Utility) 

  Verify the alignment by running a Verify Test 
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OQ Procedure/Checklist 

Date: ___________________             Bio-Stack™ Serial Number: _______________________ 

 

  Perform the Self-Test 
  Perform the Checksum Test 
  Perform the Verify Test 

If the Verify Test fails: 

  Run the Instrument Alignment Utility  
  Repeat the Verify Test 

Readers and Precision™ instruments only: 

  (Optional) Perform the Scanner Test 

Software Data Sheets 

Record Bio-Stack and interfacing instrument software/serial number information in 
the appropriate data sheet: 

• PowerWave™/XS, page 227 

• Synergy™ HT/Synergy™ 2/Synergy™ 4, page 228 

• Precision™/XS, page 229 

• µFill™, page 230 

• ELx405™ 

¾ Instrument Control, page 231 

¾ PC Control, page 232 

• NanoQuot™, page 233  

• MicroFlo™ Select 

¾ Instrument Control, page 234 

¾ PC Control, page 235 
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PowerWave/XS Software Data Sheet 

Check one:  PowerWave  �   PowerWave XS  � 

Gen5™ Software                                    Serial #: _________________ 

Installation Version:  

Build Version:  

Reader Control Version:  

(Optional) Diagnostics Version:                      

KC4™ Software                                      Serial #: _________________ 

Version:    Revision:                 

PowerWave™/PowerWave™ XS            Serial #: _________________ 

  Basecode Software Part Number:  

                                   Version:  

Checksum:               

Bio-Stack™ PC Control Software           Serial #: _________________ 

Installation CD Version:    

StackerContainer.exe Version:    

BTIAutoStacker ActiveX Version:    

Bio-Stack™                                             Serial #: _________________ 

Basecode Software Version:    

Interface Definition Version:         

Checksum:       
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Synergy HT/Synergy 2/Synergy 4 Software Data Sheet 

Check one:  Synergy HT  �   Synergy 2  �   Synergy 4  � 

Gen5™ Software                                     Serial #: ________________ 

Installation Version:  

Build Version:  

Reader Control Version:  

(Optional) Diagnostics Version:                      

KC4™ Software                                       Serial #: ________________ 

Version:    Revision:                 

Synergy™ HT/Synergy™ 2/Synergy™ 4  Serial #: _______________   

  Basecode Software Part Number:  

                                   Version:  

Checksum:   

Bio-Stack™ PC Control Software            Serial #: ________________ 

Installation CD Version:    

StackerContainer.exe Version:      

BTIAutoStacker ActiveX Version:    

Bio-Stack™                                              Serial #: ________________ 

Basecode Software Version:    

Interface Definition Version:    

Checksum:    
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  Precision/XS Software Data Sheet 

Check one:  Precision  �   Precision XS  � 

Bio-Stack™ PC Control Software           Serial #: _________________ 

Installation CD Version:   

StackerContainer.exe Version:   

BTIAutoStacker ActiveX Version:      

Bio-Stack™                                             Serial #: _________________ 

Basecode Software Version:   

Interface Definition Version:    

Checksum:   

Precision Power™ Software                  Serial #: _________________ 

Installation CD Version:     

PrecisionPower#.exe Version:   

BTIAutoDispenserActiveX 
Version: 

    

Precision™/Precision™ XS                    Serial #: _________________ 

Basecode Software Part Number:                

Function Version:              

Structure Version:  
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µFill Software Data Sheet 

µFill™                                                     Serial #: _________________ 

  Basecode Software Part Number:  

Version:  

Checksum:   

Bio-Stack™                                             Serial #: _________________ 

Basecode Software Version:    

Interface Definition Version:    

Checksum:    
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ELx405 Software Data Sheet 

(Instrument Control) 

ELx405™                                                Serial #: _________________ 

               Basecode Software Part Number: 

Version:  

Checksum:          

  Assay Configuration Part Number: 

Version:  

Bio-Stack™                                             Serial #: _________________ 

Basecode Software Version:   

Interface Definition Version:    

Checksum:    
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ELx405 Software Data Sheet 

(PC Control) 

LHC™ Software                                      Serial #: _________________ 

Build Version:     

Installation Version:   

ELx405™ Interface Software                 Serial #: _________________ 

Interface Software Version:  

Interface Functional Version:  

ELx405™                                                Serial #: _________________ 

Basecode SW Version:  

Basecode SW Checksum:          

Bio-Stack™ PC Control Software           Serial #: _________________ 

Installation CD Version:   

StackerContainer.exe Version:   

BTIAutoStacker ActiveX Version:      

Bio-Stack™                                             Serial #: _________________ 

Basecode Software Version:   

Interface Definition Version:    

Checksum:   
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NanoQuot Software Data Sheet 

Bio-Stack™ PC Control Software           Serial #: _________________ 

Installation CD Version:   

StackerContainer.exe Version:   

BTIAutoStacker ActiveX Version:      

Bio-Stack™                                             Serial #: _________________ 

Basecode Software Version:   

Interface Definition Version:    

Checksum:   

NanoQuot™ PC Control Software          Serial #: _________________ 

Version:     

BTINanoQuotClassLibrary 
Version: 

 

BTICommonMessagesClassLibrary 
Version: 

 

BTICommunicationsClassLibrary 
Version: 

 

NanoQuot™                                            Serial #: _________________ 

  Basecode Software Part Number: 

Version:  
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MicroFlo Select Software Data Sheet 

(Instrument Control) 

MicroFlo™ Select                                     Serial #:_________________ 

              Basecode Software Part Number: 

                                   Version:  

UI:          Checksums: 

MC: 

Bio-Stack™                                             Serial #: _________________ 

Basecode Software Version:   

Interface Definition Version:    

STKR Checksum:    
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MicroFlo Select Software Data Sheet 

(PC Control) 

LHC™ Software                                      Serial #: _________________ 

Build Version:     

Installation Version:   

MicroFlo™ Select Interface Software    Serial #:_________________ 

Interface Software Version:  

Data Version:  

MicroFlo™ Select                                    Serial #: _________________ 

Basecode Software Version:  

Data Version  

UI: Checksums: 

MC: 

Bio-Stack™ PC Control Software           Serial #: _________________ 

Installation CD Version:   

StackerContainer.exe Version:   

BTIAutoStacker ActiveX Version:      

Bio-Stack™                                            Serial #: _________________ 

Basecode Software Version:   

Interface Definition Version:    

Checksum:   
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Preventive Maintenance 

This chapter describes how to clean, decontaminate, and maintain 
the Bio-Stack™. 
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Overview  

Preventive Maintenance (PM) represents a set of procedures that should be 
performed regularly to maintain equipment in top condition. For example, during 
normal operation, debris and dust from plate wear can accumulate on the microplate 
stacks, carrier surface and other plate transport components.  

Preventive maintenance of the Bio-Stack™ is the responsibility of the user and is 
required for continuous problem-free operation. Adherence to the Recommended 
Maintenance Schedule below reduces problems caused by dust and debris, 
maximizes running time, and extends the life of the Bio-Stack. 

This chapter includes instructions for the following: 

• Routine Cleaning Procedure 

• Decontamination 

• Cleaning and Lubrication of the Linear Ways 
 

 

 

Recommended Maintenance Schedule 

The following chart recommends preventative maintenance tasks, the frequency with 
which each task should be performed, and where to find more information.   

 

MAINTENANCE 

TASK 
Daily/ 

as needed 
Monthly Every 6 

months 

Before 
Storage or 
Shipment 

Clean plate carrier, stacks, and all 
exposed surfaces, p. 241 

9   9 

Decontaminate the instrument, 
and, if applicable, the barcode 
scanner, p. 242  

 9  
9 

Clean and lubricate linear ways, 
p. 244   

  9 9 
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Required Materials 

• Mild detergent 

• Deionized or distilled water 

• Clean, lint-free cotton cloths or towels 

• 70% isopropyl alcohol (or ethanol) 

• Safety glasses 

• Surgical mask 

• Protective gloves 

• Lab coat 

• Biohazard trash bags 

• 125 ml beakers 

• Cotton swabs or paper towels 

• Toothbrush 

• BioTek grease kit (PN 7110017)   

Optional barcode scanner: 

• Lens cleaning agent  

• Tissue or soft cloth  
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Warnings & Precautions 

Please read the following before performing any maintenance procedures. 

 

 
Important! Do not immerse the instrument, spray it with liquid, 
or use a “wet” cloth. Do not allow water or other cleaning solution 
to run into the interior of the instrument. If this happens, contact 
BioTek’s Technical Assistance Center. 

 

Warning! Internal Voltage. Turn off and disconnect the 
Bio-Stack™ from its power supply for all cleaning and 
decontamination operations. 

 

Warning! Wear prophylactic gloves when handling contaminated 
instruments.  Gloved hands should be considered contaminated at 
all times; keep gloved hands away from eyes, mouth, nose, and 
ears.  Eating and drinking while decontaminating instruments is 
not advised. 

 

Warning! Mucous membranes are considered prime entry routes 
for infectious agents. Wear eye protection and a surgical mask 
when there is a possibility of aerosol contamination. Intact skin is 
generally considered an effective barrier against infectious 
organisms; however, small abrasions and cuts may not always be 
visible. Wear protective gloves when handling contaminated 
instruments. 

 

Caution: Barcode scanner. The Bio-Stack’s optional barcode 
scanner is housed in a protective cover. Do not allow cleaning 
solution to seep into the narrow opening in the cover, where it may 
come into contact with the scanner. Be very careful not to scratch 
or damage the mirror during cleaning!   
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Routine Cleaning Procedure 

 Important! Turn off the Bio-Stack™ and disconnect it from the 
power supply for the cleaning procedure. 

Purpose 

A daily cleaning regimen is recommended to keep the instrument free of debris 
and dust from plate wear. Exposed surfaces may be cleaned (not decontaminated) 
with a cloth moistened (not soaked) with water or water and a mild detergent.  

Procedure   

Perform these steps daily and before storage or shipment to clean the carrier surface 
and microplate stacks, all other exposed surfaces, and, if applicable, the barcode 
scanner: 

1. Turn off and disconnect the Bio-Stack.   

2. Remove the microplate stacks for cleaning:  locate the stack locks on the 
side of the Bio-Stack, open the locks, and lift the stacks out. 

3. Moisten a clean cotton cloth with water, or with water and mild detergent. 
Do not soak the cloth. 

4. Wipe the inside and outside of the stacks and the plate-stacking pedestal  
(if used).  

5. Wipe the carrier surface, lifts, claw/gripper, and all other exposed surfaces 
of the Bio-Stack. 

6. If the optional barcode scanner is installed:  

� Do not allow solution to come into contact with the 
scanner:  Ensure that cleaning solution does not seep into the 
narrow opening in the cover that protects the scanner.  

� Lens cleaning solution and lens tissue may also be used to 
clean the mirror. Be very careful not to scratch or damage 
the mirror! 

• Gently wipe the external surface of the scanner assembly, including the 
scanner’s protective cover, mounting bracket, cable, and mirror.  

7. If detergent (or lens cleaning solution on the scanner) was used, wipe all 
surfaces with a cloth moistened with water. 

8. Use a clean, dry cloth to dry all wet surfaces. 

9. Reinstall the stacks and then close the stack locks. 
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Decontamination 

Purpose 

Any laboratory instrument that has been used for research or clinical analysis is 
considered a biohazard and requires decontamination prior to handling.  

Decontamination minimizes the risk to all who come into contact with the 
instrument during shipping, handling, and servicing. Decontamination is required 
by the U.S. Department of Transportation regulations. 

Persons performing the decontamination process must be familiar with the basic 
setup and operation of the instrument. 

 
Important!   BioTek Instruments, Inc. recommends the use of the 
following decontamination solutions and methods based on our 
knowledge of the instrument and recommendations of the Centers 
for Disease Control and Prevention (CDC). Neither BioTek nor 
the CDC assumes any liability for the adequacy of these solutions 
and methods. Each laboratory must ensure that decontamination 
procedures are adequate for the Biohazard(s) they handle. 

 

 Important! Turn off the Bio-Stack™ and disconnect it from the 
power supply for the decontamination procedure. 

 

Procedure 

Perform these steps monthly and before storage or shipment: 

1. Turn off the Bio-Stack and disconnect it from the power supply. 

2. Remove the microplate stacks: locate the stack locks on the side of the 
Bio-Stack, open the locks, and then lift the stacks out. 

3. Moisten a clean cotton cloth with 70% alcohol. Do not soak the cloth. 

4. Wipe the inside and outside of the stacks and plate-stacking pedestal  
(if used).  

5. Wipe the carrier surface, lifts, claw/gripper, and all other exposed surfaces 
of the Bio-Stack. 
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6. If the optional barcode scanner is installed:  

� Do not allow solution to come into contact with the 
scanner: Ensure that decontamination solution does not seep 
into the narrow opening in the cover that protects the scanner.  

� Lens cleaning solution and lens tissue may also be used to 
clean the mirror. Be very careful not to scratch or damage 
the mirror! 

• Gently wipe the external surface of the scanner assembly, including the 
scanner’s protective cover, mounting bracket, cable, and mirror.  

7. Wait 20 minutes. Moisten a cloth with deionized or distilled water and 
wipe all surfaces of the instrument and barcode scanner that have been 
cleaned with the alcohol. 

8. Use a clean, dry cloth to dry all wet surfaces. 

9. Discard the used gloves and cloths using a Biohazard trash bag and an 
approved Biohazard container. 

10. Reinstall the stacks and then close the stack locks. 
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Cleaning and Lubrication of the Linear Ways 

Purpose 

Periodic cleaning and lubrication of the linear ways and screws on the two stack 
lifters and the plate carrier is necessary to ensure optimum performance of these 
components during all plate transfer operations.  

A grease kit (PN 7110017) has been included in your Bio-Stack™ package 
contents.  Use a clean towel, rubber gloves, a toothbrush and cotton swabs or 
paper towels (moistened with alcohol to assist the process), and the lubricant 
contained in the kit when performing the following procedure. Refer to Figure 58 
on the next page for an illustration of the Bio-Stack’s linear ways. 

Procedure 

Perform these steps every six months and before storage or shipment: 

1. Turn off the Bio-Stack and disconnect it from the power supply. 

2. Gently turn the instrument onto its side so that the bottom of the Bio-Stack 
is facing you. If the optional barcode scanner is installed, turn the 
Bio-Stack on the side without the scanner. 

3. Using cotton swabs or paper towels, remove old, possibly contaminated 
grease from the three linear ways (see Figure 58). 

4. Allow these parts to dry completely. 

5. Apply a small amount of new lubricant to all surfaces of the linear ways 
and screws, spreading thin layers and working the grease into the surfaces 
with a toothbrush.  

� Ensure that you lubricate the sides of the linear ways, since ball 
bearings travel on these surfaces. 

6. Return the Bio-Stack to its upright position and connect it to the power 
supply. 

7. Turn on the Bio-Stack and run a Verify Test to confirm that moving the 
Bio-Stack did not compromise its alignment with the interfacing 
instrument. Perform the appropriate set of instructions in Chapter 3, 
Installation. 

• If the Verify Test passes, the Bio-Stack is ready to resume normal 
operation. 

• If the Verify Test fails, you may need to re-align the claw/gripper with 
the plate carrier. Perform the appropriate set of instructions in  
Chapter 3 and run the Verify Test again. If the test still fails, contact 
BioTek’s Technical Assistance Center. 
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Figure 58: Lubrication of the Bio-Stack’s Linear Ways 
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Troubleshooting and Error 
Codes 

This chapter contains instructions for obtaining software versions 
and describes the error codes that may appear in the Bio-Stack™ 
PC Control Software, Precision Power™ Software, NanoQuot™ PC 
Control Software, Liquid Handling Control™ Software, or on the 
µFill™, ELx405™, or MicroFlo™ Select instrument display, during 
operation with the Bio-Stack™.  
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Overview 

 

Warning! Crush/Pinch Hazard. Moving parts during operation of 
the instrument can present crushing or pinching hazards. Always 
turn off and disconnect the instrument from the power supply 
for all hands-on troubleshooting procedures. 

 
Every effort has been made to ensure that the Bio-Stack™ Microplate Stacker is 
extremely reliable and easy to use. If you encounter problems during operation of the 
Bio-Stack, however, you will need to obtain software versions for the Bio-Stack 
and interfacing instrument, and note any error codes that may be displayed.  

This information will be needed by BioTek’s Technical Assistance Center (TAC) for 
troubleshooting any problems. 

• For instructions on obtaining software versions, refer to the following 
sections: 

¾ PowerWave™ or Synergy™ readers:  page 249 

¾ Precision™/XS:  page 250 

¾ µFill™:  page 251 

¾ ELx405™ (Instrument Control):  page 252  

¾ ELx405™ (PC Control): page 253  

¾ NanoQuot™: page 254 

¾ MicroFlo (Instrument Control): page 255 

¾ MicroFlo (PC Control): page 256 

• For descriptions of the different error code types that may be displayed 
during Bio-Stack operation, refer to the following sections: 

¾ PowerWave or Synergy readers:  page 257 

¾ Precision/XS:  page 259 

¾ µFill or ELx405 (Instrument Control):  page 261 

¾ ELx405 (PC Control): page 262  

¾ NanoQuot: page 264 

¾ MicroFlo (Instrument Control): page 266 

¾ MicroFlo (PC Control): page 267 

• For lists of the error codes, refer to Error Code Tables on page 269 and to 
the error code tables that follow. 
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Obtain Software Versions for PowerWave™ or 
Synergy™ Readers 

Bio-Stack Software  

Perform the following steps to obtain software versions for the Bio-Stack™ PC 
Control Software and for the Bio-Stack™ onboard software: 

1. From the top menu in the Bio-Stack PC Control Software, select Help > 
About Bio-Stack.  

2. Record the Bio-Stack PC Control Software versions for the Installation CD, 
StackerContainer.exe, and BTIAutoStackerActiveX (the Gen5™ or KC4™ 
Software version and revision number are also available on this screen). 

3. Click Get On-Board Values Now. 

4. Record the Bio-Stack onboard software versions for the basecode software, 
interface definition, and checksum. 

Gen5 Software and Reader Software 

Perform the following steps to obtain software versions for Gen5™ Software and 
for the reader’s basecode version and checksum: 

1. At Gen5’s main screen, select Help > Gen5. 

2. Record Gen5’s Installation Version, Build Version, Reader Control Version, 
and Diagnostics Version (if the Diagnostics Utility was installed). 

3. Return to the main menu and select System > Reader Control, then 
click the appropriate reader to open the ‘Reader Control’ dialog. 

4. At the Reader Control dialog, select the Information tab to display the 
reader’s basecode software information. 

5. Record the reader’s basecode part number, version number, and checksum.  

KC4 Software and Reader Software 

Perform the following steps to obtain software versions for KC4™ Software and 
for the reader’s basecode version and checksum: 

1. At KC4’s main screen, select About > KC4. 

2. Record KC4’s version and revision numbers. 

3. Return to the main menu and select System > Reader Control. 

4. Record the reader’s basecode part number, version number, and checksum. 

� KC4 does not support the Synergy™ 2/Synergy™ 4 reader. 
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Obtain Software Versions for Precision™/XS   

Bio-Stack Software  

Perform the following steps to obtain software versions for the Bio-Stack™ PC 
Control Software and for the Bio-Stack™ onboard software: 

1. From the top menu in the Bio-Stack PC Control Software, select Help > 
About Bio-Stack.  

2. Record the Bio-Stack PC Control Software versions for the Installation CD, 
StackerContainer.exe, and BTIAutoStackerActiveX. 

3. Click Get On-Board Values Now. 

4. Record the Bio-Stack onboard software versions for the basecode software, 
interface definition, and checksum. 

 

Precision Power Software and Precision/XS Software 

Perform the following steps to obtain software versions for Precision Power™ 
Software and for the Precision/XS: 

1. At Precision Power’s main screen, select Help > About Precision Power. 

2. Record the Precision Power software versions for the Installation CD, 
Precision Power#.exe and BTIAutoDispenserActiveX. Click OK to return to 
the main screen. 

3. Select Instrument > Precision Series Configuration > Test Comm, 
then select ActiveX/Instrument Versions > Instrument Version. 

4. Record the Precision instrument’s basecode software part number, Function 
Version, and Structure Version. 
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Obtain Software Versions for µFill™  

Perform the following steps to obtain software versions for the µFill and Bio-Stack™. 

1. At the µFill’s Main Menu select UTIL > TESTS > CHKSUM.  

2. Record the µFill basecode software part number, version number, and 
checksum, as shown in the first screen: 

 

X X X X X X X  V E R S I O N  X . X X        

C O D E   C H E C K S U M :  ( X X X X )    

 

3. The second screen will display the following information, which does not 
need to be recorded: 

 

 D E F A U L T  C O N F I G  D A T A      

           

4. If the µFill is not running with the Bio-Stack, the SELECT UTILITY screen will 
then appear. If the µFill is running with the Bio-Stack, wait while the third 
screen is displayed: 

  

           

P L E A S E  W A I T . . .      

 

� If the µFill cannot communicate with the Bio-Stack, an error 
message will be displayed.  

5. Record the Bio-Stack basecode software version, interface definition version, 
and checksum, as shown in the fourth screen: 

 

B I O - S T A C K :  X . X X ,  X . X X    

C O D E   C H E C K S U M :  ( X X X X )    

Bio-Stack Operator's Manual  



252  | Chapter 7: Troubleshooting and Error Codes 

Obtain Software Versions for ELx405™ (Instrument 
Control)  

Perform the following steps to obtain software versions for the ELx405 and 
Bio-Stack™. 

1. At the ELx405’s Main Menu, select UTIL > TESTS > CHKSUM.  

2. Record the ELx405 basecode software part number, version number, and 
checksum, as shown in the first screen: 

 

X X X X X X X  V E R S I O N  X . X X       

C O D E   C H E C K S U M :  ( X X X X )    

 

3. Record the assay configuration software part number and version number, as 
shown in the second screen:  

 

 X X X X X X X  V E R S I O N  X . X X    

           

 

4. If the ELx405 is not running with the Bio-Stack™, the SELECT UTILITY screen 
will then appear. If the ELx405 is running with the Bio-Stack, wait while the 
third screen is displayed: 

 

           

P L E A S E  W A I T . . .      

 

� If the instrument cannot communicate with the Bio-Stack™, an 
error message will be displayed.  

5. Record the Bio-Stack basecode software version, interface definition version, 
and checksum, as shown in the fourth screen:  

 

B I O - S T A C K :  X . X X ,  X . X X    

C O D E   C H E C K S U M :  ( X X X X )    
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Obtain Software Versions for ELx405™ (PC Control)  

Bio-Stack Software  

Perform the following steps to obtain software versions for the Bio-Stack™ PC 
Control Software and for the Bio-Stack™ onboard software: 

1. Make sure that the Bio-Stack is powered on, and the cable is connected 
between the PC and the Bio-Stack. 

2. From the top menu in the Bio-Stack PC Control Software, select Help > 
About Bio-Stack.  

3. Record the Bio-Stack PC Control Software versions for the Installation CD, 
StackerContainer.exe, and BTIAutoStackerActiveX. 

4. Click Get On-Board Values Now. 

5. Record the Bio-Stack basecode software version, interface definition 
version, and checksum. 

 

Liquid Handling Control™ (LHC) Software and ELx405™ Software 

Perform the following steps to obtain software versions for the LHC Software and 
for the ELx405: 

1. Make sure that the washer is powered on, and the cable is connected 
between the PC and the washer. 

2. At the LHC Software’s main screen, select Help > About Liquid 
Handling Control. 

3. The ‘Help About’ dialog will open. Record the Liquid Handling Control 
Build Version and Installation Version.  

4. Click Close to return to the main screen. 

5. Select Tools > Instrument Utilities.  The ‘ELx405 Washer Utilities’ 
screen will open. 

6. Record the ELx405 Interface Software Version, Interface Functional 
Version, Basecode SW Version, and Basecode SW Checksum.  
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Obtain Software Versions for NanoQuot™ 

L In order to obtain software information for the Bio-Stack™ and 
NanoQuot, you will need the Bio-Stack™ PC Control Software 
and NanoQuot™ PC Control Software installed on a host 
computer.  

   Bio-Stack™ Software  

� For the following instructions, ensure that the Bio-Stack has been 
disconnected from the NanoQuot, and is connected to the host computer 
via one of the two serial cables that are included with the Bio-Stack: a 
9-pin to 9-pin male/male cable or 9-pin to 25-pin male/female cable. 

Perform the following steps to obtain software versions for the Bio-Stack PC 
Control Software and for the Bio-Stack onboard software: 

1. Open the Bio-Stack PC Control Software. From the top menu in the 
Bio-Stack PC Control Software, select Help > About Bio-Stack.  

2. Record the Bio-Stack PC Control Software versions for the Installation CD, 
StackerContainer.exe, and BTIAutoStackerActiveX. 

3. Click Get On-Board Values Now. 

4. Record the Bio-Stack basecode software version, interface definition 
version, and checksum. 

NanoQuot Software  

� For the following instructions, ensure that the NanoQuot has been 
disconnected from the Bio-Stack, and is connected to the host computer 
via the 9-pin to 9-pin female/male serial cable that is included with the 
NanoQuot. 

Perform the following steps to obtain software versions for the NanoQuot™ PC 
Control Software and for the NanoQuot onboard software: 

1. Open the NanoQuot PC Control Software. From the software’s main screen, 
select Help > About NanoQuot PC Software.  

2. Record the NanoQuot PC Control version as well as the three Component 
Software versions, then click OK to close the dialog. 

3. Record the NanoQuot’s Instrument Software (basecode part number 
and version) and Serial No. Note: The NanoQuot basecode software does 
not include a checksum. 
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Obtain Software Versions for MicroFlo™ Select 
(Instrument Control)  

Perform the following steps to obtain software versions for the MicroFlo Select 
Dispenser and Bio-Stack™. 

1. At the dispenser’s Main Menu, select - - > twice to get to the Dispenser Action 
Menu. 

2. Select UTIL > CHKSUM. The Version Checksum Info screen will appear: 

V E R S I O N  C H E C K S U M  I N F O :     

  U I        M C    S T K R             

3. Select UI to display basecode and checksum information for the User Interface 
processor: 

7 1 7 0 2 0 0   V E R S I O N  X . X X       

C O D E   C H E C K S U M :     ( X X X X  ) 

Record the basecode software version (X.XX) and checksum (XXXX) 
information. Press the ENTER or Previous Screen key to return to the Version 
Checksum Info screen. 

4. Select MC to display basecode and checksum information for the Motor 
Controller processor:  

7 1 7 0 2 0 0   V E R S I O N  X . X X       

C O D E   C H E C K S U M :     ( X X X X  ) 

Record the basecode software version (X.XX) and checksum (XXXX) 
information. Press the ENTER or Previous Screen key to return to the Version 
Checksum Info screen. 

5. Select STKR to display basecode and checksum information for the Bio-Stack: 

� If the instrument cannot communicate with the Bio-Stack™, an 
error message will be displayed. 

B I O - S T A C K :  X . X X ,  X . X X       

C O D E   C H E C K S U M :     ( X X X X ) 

Record the Bio-Stack basecode software version (first X.XX), interface 
definition version (second X.XX), and checksum (XXXX).  
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Obtain Software Versions for MicroFlo™ Select (PC 
Control)  

Bio-Stack Software  

Perform the following steps to obtain software versions for the Bio-Stack™ PC 
Control Software and for the Bio-Stack™ onboard software: 

1. Make sure that the Bio-Stack is powered on, and the cable is connected 
between the PC and the Bio-Stack. 

2. From the top menu in the Bio-Stack PC Control Software, select Help > 
About Bio-Stack.  

3. Record the Bio-Stack PC Control Software versions for the Installation CD, 
StackerContainer.exe, and BTIAutoStackerActiveX. 

4. Click Get On-Board Values Now. 

5. Record the Bio-Stack basecode software version, interface definition 
version, and checksum. 

 

Liquid Handling Control™ (LHC) Software and MicroFlo™ Select 
Software 

Perform the following steps to obtain software versions for the LHC Software and 
for the MicroFlo: 

1. Make sure that the dispenser is powered on, the dispenser UI is at the main 
menu, and the cable is connected between the PC and the dispenser. 

2. At the LHC Software’s main screen, select Help > About Liquid 
Handling Control. 

3. The ‘Help About’ dialog will open. Record the Liquid Handling Control 
Build Version and Installation Version.  

4. Click Close to return to the main screen. 

5. Select Tools > Instrument Utilities.  The ‘MicroFlo Select Utilities’ 
screen will open. 

6. Record the MicroFlo Select Interface Software Version and Data Version, 
and the MicroFlo Select Basecode Software Version, Data Version, and 
Checksum.  
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Errors During Operation of Bio-Stack™ with 
PowerWave™ or Synergy™ Readers 

The Bio-Stack™ PC Control Software controls all functionality of the Bio-Stack and 
uses Gen5™ or KC4™ Software in OLE mode to control the readers. All errors are 
displayed in the Bio-Stack PC Control Software on the controlling PC.  

• Errors generated when the Bio-Stack PC Control Software is driving the 
Bio-Stack include serial communication errors and Bio-Stack instrument 
errors. 

• Errors generated when the Bio-Stack PC Control Software is driving the reader 
via Gen5 include Gen5 function call errors and reader instrument errors.  

• Errors generated when the Bio-Stack PC Control Software is driving the reader  
via KC4 include KC4 function call errors and reader instrument errors. 

The following sections contain brief descriptions of each error code type. 

Serial Communication Errors 

Errors detected by the portion of the Bio-Stack PC Control Software responsible for 
performing the serial communications with the Bio-Stack are displayed as negative 
value error codes, for example: -1, -401. Serial communication errors include 
errors found when sending messages to the instrument, and receiving messages 
back from the instrument, as well as timer-based errors when waiting for a 
response. 

• Refer to Table 1 on page 269 for a list of serial communication errors. 

Bio-Stack Instrument Errors 

Errors detected by the Bio-Stack basecode software that are related to operation of 
the Bio-Stack hardware during the self-test or plate transfers are displayed as 4-
digit hexadecimal codes, along with some textual description.  

� These error codes are prefixed with a B- to distinguish them from 
similar hexadecimal reader instrument error codes. For example, 
B-0200 indicates a 0x0200 error generated by the Bio-Stack, rather 
than by a reader. 

• Refer to Table 2 on page 272 for a list of Bio-Stack instrument errors. 

• Refer to Table 3, Table 4, and Table 5 on pages 278 to 280 for lists of the 
sensors, motors, and interfacing instruments referenced in Table 2. 
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Gen5™ Function Call Errors 

Errors detected by Gen5 Software following calls to Gen5 functions by the 
Bio-Stack™ PC Control Software are displayed in a negative value format, for 
example: -8, -100, -2010. These errors can occur when Gen5 is requested to open 
an invalid Gen5 experiment file, during serial communication between Gen5 and 
the reader, or during post-reading activities performed by Gen5, including data 
reduction and results exporting. 

• Refer to Table 6 on page 281 for a list of Gen5 function call errors. 

KC4™ Function Call Errors 

Errors detected by KC4 Software following calls to KC4 functions by the 
Bio-Stack™ PC Control Software are displayed as negative value 4-digit codes. 
These errors can occur when KC4 is requested to open an invalid KC4 protocol file, 
during serial communication between KC4 and the reader, or during post-reading 
activities performed by KC4, including data reduction and results exporting.   

• Refer to Table 7 on page 297 for a list of KC4 function call errors. 

Reader Instrument Errors 

Errors detected by the reader's basecode software and transmitted back to 
Gen5/KC4 (and, ultimately, to the Bio-Stack PC Control Software), which are 
related to operation of the reader's hardware are displayed as 4-digit hexadecimal 
error codes, along with some textual description. These errors can occur during 
self-test, plate reading, drawer opening/closing, barcode scanning, etc. 

� As noted in the previous section on Bio-Stack Instrument Errors, in 
order to distinguish reader error instrument error codes from 
Bio-Stack instrument error codes, the Bio-Stack™ codes are prefixed 
with a B-. 

• Refer to the PowerWave™/XS or Synergy™ HT/Synergy™ 2/ 
Synergy™ 4 Operator's Manuals for lists of reader error codes. 
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Errors During Operation of Bio-Stack™ with 
Precision™/XS 

Precision Power™ Software controls all functionality of the Precision/XS 
instruments, and uses a component of the Bio-Stack™ PC Control Software to control 
the Bio-Stack. All errors are displayed in Precision Power on the controlling PC.  

• Errors generated when Precision Power is driving the Bio-Stack, via a 
component of the Bio-Stack PC Control Software, include serial 
communication errors and Bio-Stack instrument errors. 

• Errors generated when Precision Power Software is driving the Precision 
instrument include program validation errors and Precision/XS 
instrument errors. 

 Serial Communication Errors 

Errors detected by the Bio-Stack PC Control Software during serial communication 
between the host PC and the Bio-Stack are displayed as text messages (in English). 
Serial communication errors include errors found when sending messages to the 
instrument, and receiving messages back from the instrument, as well as  
timer-based errors when waiting for a response. 

� Occasionally an error code may appear without the text; these codes 
are always in a negative value format, for example: -3, -401.  

• Refer to Table 1 on page 269 for a list of serial communication errors (refer 
also to the Precision/XS Operator's Manuals). 

Bio-Stack Instrument Errors 

 
Errors detected by the Bio-Stack basecode software that are related to operation of the 
Bio-Stack hardware during self-test or plate transfers are displayed as text messages 
(in English).  

� Occasionally an error code may appear without the text; these codes 
are displayed in four-digit format, for example: 1000, and are 
sometimes preceded by 0x, as in 0x1000.  

• Refer to Table 2 on page 272 for a list of Bio-Stack instrument errors (refer 
also to the Precision/XS Operator’s Manuals). 

• Refer to Table 3, Table 4, and Table 5 on pages 278 to 280 contain lists of 
the sensors, motors, and interfacing instruments referenced in Table 2. 
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Program Validation Errors 

Program validation errors detected by the Precision™/XS basecode software and 
transmitted back to Precision Power™ Software, occur when a fluid-transfer 
program fails to meet internally programmed validation criteria. These errors are 
displayed as four-digit codes beginning with the number 4, and may include 
additional information, such as program name and command, loop and run 
numbers. 

• Refer to the Precision Power User’s Guide or help system for lists of 
program validation errors. 

Precision/XS Instrument Errors 

Errors detected by the Precision/XS basecode software and transmitted back to 
Precision Power Software, which are related to operation of the Precision 
instrument’s hardware are displayed as 4-digit hexadecimal error codes. These 
errors can occur during self-test, dispense or aspiration, pick-up of tips, etc. 

• Refer to the Precision/XS Operator’s Manuals for lists of Precision 
instrument run time errors. 
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Errors During Operation of Bio-Stack™ with µFill™ 
or ELx405™ (Instrument Control) 

Error codes that appear on the displays of the µFill Dispenser and ELx405 Washer 
during instrument control of the Bio-Stack can include 

• Communication errors between the Bio-Stack and the µFill or ELx405 

• Bio-Stack instrument errors  

• µFill or ELx405 instrument errors 

Communication Errors 

Communication errors during instrument control of the Bio-Stack by the µFill or 
ELx405 are displayed as 4-digit error codes, and may be generated by the Bio-Stack 
itself, or by the interfacing instrument.  

� Error codes generated by the Bio-Stack are prefixed by a B- to 
distinguish them from codes generated by the µFill or ELx405. 

• Refer to Table 8 on page 304 for a list of communication error codes. 
 

Bio-Stack Instrument Errors 

Errors detected by the Bio-Stack basecode software that are related to operation of 
the Bio-Stack hardware during self-test or plate transfers are displayed as 4-digit 
hexadecimal codes.  

� Bio-Stack instrument error codes are prefixed with a B- to distinguish 
them from similar hexadecimal error codes generated by the µFill or 
ELx405. For example, B-0200 indicates a 0x0200 error generated by 
the Bio-Stack, rather than by the µFill or ELx405. 

• Refer to Table 2 on page 272 for a list of Bio-Stack instrument errors. 

• Refer to Table 3, Table 4, and Table 5 on pages 278 to 280 for lists of the 
sensors, motors, and interfacing instruments referenced in Table 2. 

 

µFill™ or ELx405™ Instrument Errors 

Errors detected by the µFill or ELx405 basecode software, that are related to 
operation of the µFill or ELx405 hardware are displayed as 4-digit hexadecimal 
error codes. These errors can occur during self-test, dispense, aspiration, etc. 

• Refer to the µFill Operator’s Manual or ELx405 Operator's Guide for a 
list of these codes. 
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Errors During Operation of Bio-Stack™ with 
ELx405™ (PC Control) 

Liquid Handling Control™ (LHC) Software uses a component of the Bio-Stack™ 
PC Control Software to control the Bio-Stack, and the ELx405 Interface Software to 
control all functionality of the ELx405. All errors are displayed in LHC on the 
controlling PC.  

• Errors generated when LHC Software is driving the Bio-Stack, via a component 
of the Bio-Stack PC Control Software include serial communication errors 
and Bio-Stack instrument errors. 

• Errors generated when LHC Software is driving the ELx405 washer, via the 
ELx405 Interface Software include serial communication errors and 
ELx405 instrument errors. 

 Serial Communication Errors 

Errors detected by the Bio-Stack PC Control Software during serial communication 
between the host PC and the Bio-Stack, or as detected by the ELx405 Interface 
Software during serial communication between the host PC and the ELx405 
washer, are displayed as text messages (in English). Serial communication errors 
include errors found when sending messages to the instrument, and receiving 
messages back from the instrument, as well as timer-based errors when waiting for 
a response. 

� Occasionally an error code may appear without the text; these codes 
are always in a negative value format, for example: -3, -401.  

• Refer to Table 1 on page 269 for a list of serial communication errors. 

Bio-Stack Instrument Errors 

Errors detected by the Bio-Stack basecode software that are related to operation of 
the Bio-Stack hardware during self-test or plate transfers are displayed as text 
messages (in English).  

� Occasionally an error code may appear without the text; these codes 
are displayed in four-digit format, for example: 1000, and are 
sometimes preceded by 0x, as in 0x1000.  

• Refer to Table 2 on page 272 for a list of Bio-Stack instrument errors. 

• Refer to Table 3, Table 4, and Table 5 on pages 278 to 280 contain lists of 
the sensors, motors, and interfacing instruments referenced in Table 2. 
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ELx405 Instrument Errors 

Errors detected by the ELx405 basecode software and transmitted back to the LHC 
Software, which are related to operation of the ELx405 washer’s hardware are 
displayed as 4-digit hexadecimal error codes, along with a textual message. 

• Refer to the ELx405 Operator’s Manual for examples of ELx405  
instrument errors. 
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Errors During Operation of Bio-Stack™ with 
NanoQuot™ 

Errors that occur during instrument control of the Bio-Stack by the NanoQuot may be 

• Communication errors between the Bio-Stack and the NanoQuot 

• Bio-Stack instrument errors  

• NanoQuot instrument errors 

Error codes may be displayed by connecting the NanoQuot to a host computer that has 
the NanoQuot™ PC Control Software installed (see Display Error Codes on the next 
page). The NanoQuot PC Control Software will identify whether the errors are 
NanoQuot errors (which includes communication errors detected by the NanoQuot 
when trying to communicate with the Bio-Stack), or if they are Bio-Stack errors. 

Communication Errors 

Communication errors during instrument control of the Bio-Stack by the 
NanoQuot are displayed in the NanoQuot PC Control Software as NanoQuot 
4-digit hexadecimal codes. There will also be a textual description of the error. 

Serial communication errors that are detected by the Bio-Stack™ PC Control 
Software during computer control of the Bio-Stack (e.g., when running the 
Instrument Alignment Utility), are displayed in the Bio-Stack PC Control Software 
as negative value error codes, for example: -504, -506.  

• Refer to Table 1 on page 269 for a list of serial communication errors.   

Bio-Stack Instrument Errors 

Errors detected by the Bio-Stack basecode software that are related to operation of 
the Bio-Stack hardware during self-test or plate transfers are displayed in the 
NanoQuot PC Control Software as 4-digit hexadecimal codes. There will also be a 
textual description of the error.   

• Refer to Table 2 on page 272 for a list of Bio-Stack instrument errors. 

• Refer to Table 3, Table 4, and Table 5 on pages 278, 279, and 280 for lists 
of the sensors, motors, and interfacing instruments referenced in Table 2.  
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NanoQuot™ Instrument Errors 

Errors detected by the NanoQuot basecode software, that are related to operation 
of the NanoQuot hardware are displayed in the NanoQuot™ PC Control Software 
as 4-digit hexadecimal error codes, along with a textual description. These errors 
can occur during self-test, dispense, etc. 

• Refer to the NanoQuot Operator’s Manual for a list of these codes. 

Display Error Codes 

L Important! You will need a host computer that has the 
NanoQuot PC Control Software installed for the following 
instructions.  

 
� Two serial cables are supplied with the Bio-Stack™: a 9-pin to 9-pin 

male/male serial cable and a 9-pin to 25-pin male/female serial cable. 
The DB9M to DB9M serial cable must be used to connect the Bio-Stack 
to the NanoQuot. 

� A 9-pin to 9-pin female/male serial cable is shipped with the 
NanoQuot, for connecting the Dispenser to a computer. The DB9M 
end of the cable must be connected to the NanoQuot. 

To display errors that occur during operation of the Bio-Stack with the NanoQuot: 

1. Turn off the Bio-Stack and NanoQuot, then disconnect the DB9M to DB9M 
serial cable between the two instruments. 

2. Turn off the computer. Connect the DB9F end of the DB9F to DB9M serial 
cable to a serial port on the computer. 

3. Connect the DB9M end of the serial cable to a serial port on the rear of the 
NanoQuot. Refer to Chapter 2, Installation, in the NanoQuot Operator’s 
Manual (on CD part number 7151008) for a photo of the serial port on the 
Dispenser.  

4. Open the PC Software, and at the main screen, click the Get System 
Status button to retrieve any current error codes. The dialog displayed 
will show both NanoQuot instrument errors as well as Bio-Stack 
instrument errors. 

5. Click OK to clear the error stored on the NanoQuot. Also, refer to Table 2, 
Bio-Stack Instrument Errors, in this chapter to identify the cause and 
remedy for any Bio-Stack error. (For NanoQuot instrument errors, refer to 
the tables in Appendix A, Error Codes, of the NanoQuot Operator’s 
Manual.) 

6. Disconnect the serial cable between the NanoQuot and computer, then 
reconnect the DB9M to DB9M cable between the Bio-Stack and Dispenser. 
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Errors During Operation of Bio-Stack™ with 
MicroFlo™ Select (Instrument Control) 

Error codes that appear on the display of the MicroFlo Select during instrument control 
of the Bio-Stack can include 

• Communication errors between the Bio-Stack and the MicroFlo 

• Bio-Stack instrument errors  

• MicroFlo instrument errors 

Communication Errors 

Communication errors during instrument control of the Bio-Stack by the MicroFlo 
are displayed as 4-digit error codes, with “Stacker Error” in the first line of the 
display. These errors may be generated by the Bio-Stack itself, or by the MicroFlo.   

� Error codes generated by the Bio-Stack are prefixed by a B- to 
distinguish them from codes generated by the MicroFlo.   

• Refer to Table 8 on page 304 for a list of communication error codes. 
 

Bio-Stack Instrument Errors 

Errors detected by the Bio-Stack basecode software that are related to operation of 
the Bio-Stack hardware during self-test or plate transfers are displayed as 4-digit 
hexadecimal codes, with “Stacker Error” in the first line of the display. 

� Bio-Stack instrument error codes are prefixed with a B- to distinguish 
them from similar hexadecimal error codes generated by the MicroFlo. 
For example, B-0200 indicates a 0x0200 error generated by the  
Bio-Stack, rather than by the MicroFlo. 

• Refer to Table 2 on page 272 for a list of Bio-Stack instrument errors. 

• Refer to Table 3, Table 4, and Table 5 on pages 278 to 280 for lists of the 
sensors, motors, and interfacing instruments referenced in Table 2. 

 

MicroFlo Select Instrument Errors 

Errors detected by the MicroFlo Select basecode software, that are related to 
operation of the MicroFlo hardware are displayed as 4-digit hexadecimal error 
codes. These errors can occur during self-test, dispense, etc. 

• Refer to the MicroFlo Select Operator's Manual for a list of these codes. 
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Errors During Operation of Bio-Stack™ with 
MicroFlo™ Select (PC Control) 

Liquid Handling Control™ (LHC) Software uses a component of the Bio-Stack™ 
PC Control Software to control the Bio-Stack, and the MicroFlo™ Select Interface 
Software to control all functionality of the MicroFlo Select. All errors are displayed in 
LHC on the controlling PC.  

• Errors generated when LHC Software is driving the Bio-Stack, via a component 
of the Bio-Stack PC Control Software include serial communication errors 
and Bio-Stack instrument errors. 

• Errors generated when LHC Software is driving the MicroFlo dispenser, via 
the MicroFlo Select Interface Software include serial communication errors, 
MicroFlo instrument errors, and MicroFlo Select Interface Software 
errors. 

 Serial Communication Errors 

Errors detected by the Bio-Stack PC Control Software during serial communication 
between the host PC and the Bio-Stack, or as detected by the MicroFlo Select 
Interface Software during serial communication between the host PC and the 
MicroFlo dispenser, are displayed as text messages (in English). Serial 
communication errors include errors found when sending messages to the 
instrument, and receiving messages back from the instrument, as well as  
timer-based errors when waiting for a response. 

� Occasionally an error code may appear without the text; these codes 
are always in a negative value format, for example: -505, -506.  

• Refer to Table 1 on page 269 for a list of serial communication errors. 

Bio-Stack Instrument Errors 

Errors detected by the Bio-Stack basecode software that are related to operation of 
the Bio-Stack hardware during self-test or plate transfers are displayed as text 
messages (in English).  

� Occasionally an error code may appear without the text; these codes 
are displayed in four-digit format, for example: 1000, and are 
sometimes preceded by 0x, as in 0x1000.  

• Refer to Table 2 on page 272 for a list of Bio-Stack instrument errors. 

• Refer to Table 3, Table 4, and Table 5 on pages 278 to 280 contain lists of 
the sensors, motors, and interfacing instruments referenced in Table 2. 

Bio-Stack Operator's Manual  



268  | Chapter 7: Troubleshooting and Error Codes 

MicroFlo™ Select Instrument Errors 

Errors detected by the MicroFlo Select basecode software and transmitted back to 
the LHC Software, which are related to operation of the MicroFlo dispenser’s 
hardware are displayed as 4-digit hexadecimal error codes, along with a textual 
message. 

• Refer to the MicroFlo Select Dispenser’s Operator’s Manual for 
examples of MicroFlo instrument errors. 

MicroFlo™ Select Interface Software Errors 

Errors generated by the MicroFlo Select Interface Software are displayed in the 
LHC Software as 4-digit hexadecimal error codes, along with a textual message. 
These errors include program validation errors (when a dispense 
program/protocol fails to meet programmed validation criteria) and serial 
communication errors. 

• Refer to the Table 9 on page 305 for examples of errors generated by the 
MicroFlo Select Interface Software. 
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Error Code Tables 

Table 1 

Serial Communication Errors  

 
Serial communication errors are displayed in the Bio-Stack™ PC Control Software during 
Bio-Stack™ operation with the PowerWave™/XS or Synergy™ HT/Synergy™ 2/ 
Synergy™  4 Readers, in Precision Power™ Software during Bio-Stack operation with the 
Precision™/XS, and in Liquid Handling Control™ (LHC) Software during Bio-Stack 
operation with the ELx405™ or MicroFlo™ Select.  Serial communication errors may also be 
displayed in the Bio-Stack PC Control Software during installation of the Bio-Stack with the 
NanoQuot™, when the PC Software’s Instrument Alignment Utility is used to align the  
Bio-Stack’s claw/gripper with the NanoQuot’s plate carrier.  

� Precision errors usually are displayed as text messages (in English), 
and occasionally as an error code without the text. 

 

Code Probable Causes 

-1 

 

General failure in talking to instrument driver software. 

This error indicates that something is not correct with the driver software, or with 
the communications. 

• Try closing the application and restarting. If this has no effect, try 
re-booting the PC. 

-3 Operation cancelled by user. 

There is a problem with the driver software or with the communications. 

• Try closing the application and restarting. If this has no effect, try 
re-booting the PC. 

-4 

  

Unable to start delay timer associated with waiting for message response 
from instrument. 

This error indicates that there may be too many applications using timers on the PC 
(there are only 8 timers available), or the delay timer is already set. 

• Close the application and try again.  

• Close one or more other applications that may be using timers.   

-5 Invalid request. 

The Bio-Stack is not in the correct mode for handling this request. 

• Re-start the Bio-Stack.  
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Table 1 (Cont’d) 
  

Code Probable Causes 

-6 Unable to process request. 

The Bio-Stack™ is not in the correct mode for handling this request. 

Re-start the Bio-Stack.  

-401 

  

Object doesn’t exist. 

This error indicates that the driver software has somehow lost information on the 
instrument it is trying to communicate with. 

• Re-start the application. 

-504 Unable to open a serial port. 

This error indicates that either another application is using the serial port, or the 
port was opened either by another application or by the Bio-Stack™ PC Control 
Software, but was not closed properly.  

• Close the other application. 

• If that doesn’t work, close the Bio-Stack PC Control software and re-start it. 

• Lastly, re-boot the PC. 

-505 Unable to write all of the serial data. 

• Try re-starting the application. 

-506 Timeout while reading in serial data, or incorrect number of serial 
characters were read in. 

• Check the serial cable connection to ensure it is not loose. 

• Check to see if any other application is very CPU intensive. 

• Try re-starting the application. 

-507 Checksum error with the serial data read in. 

• Attempt the operation again. 

• Try re-starting the application. 
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Table 1 (Cont’d) 
  

Code Probable Causes 

-508 When attempting to talk to the instrument, the instrument basecode 
software returned a NAK, indicating it did not recognize the request. 

• Attempt the operation again. 

• Try re-starting the instrument. 

• Try re-starting the application. 

-509 PC software received back more data than it was expecting. 

• Unlikely to be seen. It is expected that a –506 would be sent instead. 

• Try re-starting the application. 

-510 Invalid message object. 

This error indicates that either the instrument basecode software or the PC software 
doesn’t recognize the message sent. This is unlikely to be seen, but could possibly 
happen if the software fell out-of-sync with the characters sent back and forth. 

• Try re-starting the application and the instrument. 

-511 Invalid message body size. 

This error indicates that either the instrument basecode software or the PC software 
received an invalid count of expected characters for a specific message. This is 
unlikely to be seen, but could possibly happen if the software fell out-of-sync with 
the characters sent back and forth. 

• Try re-starting the application and the instrument. 

-512 Serial message timeout waiting for response from the instrument. 

• Check the instrument to ensure it has been powered-up correctly and is in a 
good operational state (i.e., the light is on, but NOT flashing). 

• Check the cable connections and the cable itself. 

• Try re-starting the application. 

 

Bio-Stack Operator's Manual  



272  | Chapter 7: Troubleshooting and Error Codes 

Table 2 

Bio-Stack Instrument Errors 

 

Bio-Stack™ instrument errors are displayed in the Bio-Stack™ PC Control Software, 
Precision Power™ Software, NanoQuot™ PC Control Software, Liquid Handling Control ™ 
(LHC) Software, and on the displays of the µFill™ , ELx405™, or MicroFlo™ Select. 

� In Precision Power, these errors usually are displayed as text messages 
(in English), and occasionally as an error code without the text (e.g., 
1000 or 0x1000). Refer also to the Precision/XS Operator’s 
Manuals for a list of Bio-Stack™ instrument errors (“operational 
errors”). 

 

Code Probable Causes 

020# 

(#=sensor) 

Refer to Table 3 
on page 278 for 
a list of sensor 
numbers. 

Couldn't find opto sensor. 

This error indicates that a sensor was not tripped. 

• Plates sticking because wells are overfilled, causing a jam. 

• Plate not seated properly, causing a jam. 

• Plate stack not installed properly. 

• Shipping block still installed. 

• Plate dimensions are incompatible with Bio-Stack. 

030# 

(#=motor) 

Refer to Table 4 
on page 279 for 
a list of motor 
numbers. 

Jig contact not made in required steps.  

This error indicates that the autocalibration jig is either not installed 
properly, or the gold contacts have a film on them that is not 
allowing the current to transfer. 

• Verify that the autocalibration jig is installed properly.  

• Clean the contacts with alcohol.   

  
� Calibration errors (“Jig contact not made in required steps”) will 

normally be displayed only during calibration or repair of the 
instrument by BioTek TAC. 
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Table 2 (Cont’d) 
  

Code Probable Causes 

040# 

(#=motor) 

Refer to Table 4 
on page 279 for 
a list of motor 
numbers. 

Failed positional verify. 

This error indicates that an axis failed its positional verify test. After 
moving a predefined number of steps from a home position, the 
motor should return to the home position in the proper amount of 
time and steps. If the axis moves back to its home position in the 
wrong amount of time, or uses too few or too many steps, the test 
fails. 

A belt may be slipping due to incorrect tension, a loose motor pulley, 
or a loose belt clamp. This can also be caused by a defective motor 
drive circuit. 

0600 Necessary configuration data missing. 

• The basecode software and/or assays may need to be  
re-downloaded. Contact BioTek Technical Assistance Center 
(TAC). 

0700 Failed configuration checksum test. 

This error indicates that the internal software may be corrupted. 

• Turn the instrument off/on. If the error persists, contact 
BioTek TAC. 

080# 

(#=motor) 

Refer to Table 4 
for motor 
numbers. 

Not homed successfully. 

This error is usually only seen during the autocalibration sequence. 
See the probable causes for 020# on the preceding page. 

0900 Memory allocation failure. 

This error indicates that the memory has failed or is corrupt. Contact 
BioTek TAC. 

1000 Autocalibration data checksum failed at power-up. 

• Turn the instrument off/on. If the error persists, contact 
BioTek TAC. 

  

� Calibration errors (“Autocalibration data checksum failed at power-up”) 
will normally be displayed only during calibration or repair of the 
instrument by BioTek TAC. 
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Table 2 (Cont’d) 
 

Code Probable Causes 

1300 Timeout sending or receiving serial data. 

• Cable not connected, or loose. 

• Incorrect cable. 

• ELx405™, µFill™, NanoQuot™, or MicroFlo™ Select not set up 
properly. 

• Gen5™, KC4™, Bio-Stack™ PC Control Software, Precision Power™, 
NanoQuot™ PC Control Software, or Liquid Handling Control™ (LHC) 
Software not set up properly. 

1600 Failed attempted plate transfer from output stack to input stack. 

This error indicates that no plate was found on the Bio-Stack™ carrier after 
attempted plate retrieval from the output stack. 

• Plate stack not installed properly. 

• Plate dimensions are incompatible with Bio-Stack. 

1601 Failed attempted plate transfer from instrument carrier to output 
stack.  

This error indicates that no plate was found on the Bio-Stack carrier after 
transfer from claw to carrier. 

• Plate stack not installed properly. 

• Plate dimensions are incompatible with Bio-Stack. 

• Need realignment between Bio-Stack and interfacing instrument. 
Run the Instrument Alignment Utility. 

• Plate is sticking to carrier or claw. 

1602 Failed attempted plate transfer from input stack to Bio-Stack 
carrier.  

This error indicates that no plate was found on the carrier after attempted 
plate retrieval from the input stack. 

• Plate dimensions are incompatible with Bio-Stack. 

• Plates are sticking because wells are overfilled. 

• Plate stack not installed properly. 
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Table 2 (Cont’d) 
 

Code Probable Causes 

1700 Failed attempted plate transfer from Bio-Stack carrier to instrument.  

This error indicates that no plate was found in the gripper after attempted 
plate retrieval from the carrier. 

• Plates are sticking because wells are overfilled. 

• Plate dimensions are incompatible with the Bio-Stack™. 

• Instrument needs calibration. 

1701 Failed attempted plate transfer from instrument to output stack.  

This error indicates that no plate was found in the gripper after an attempted 
plate retrieval from the instrument. 

• Plates are sticking because wells are overfilled. 

• Need realignment between Bio-Stack and interfacing instrument. Run 
the Instrument Alignment Utility. 

• Plate dimensions are incompatible with the Bio-Stack. 

180# 

(#=motor) 

Refer to 
Table 4 on 
page 279 for 
a list of 
motor 
numbers. 

Undefined. 

• Turn the instrument off/on.  If the error persists, contact BioTek TAC. 

1900 Plate found in gripper during power-up. 

• Power down the Bio-Stack and remove the plate. 

1901 Failed attempted plate transfer from carrier to instrument.  

This error indicates that a plate was still in the gripper after move. 

• Plates are sticking because wells are overfilled. 

• Plate dimensions are incompatible with the Bio-Stack. 

2000 Plate found on carrier during power-up. 

• Power down the Bio-Stack and remove the plate. 
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Table 2 (Cont’d) 
 

Code Probable Causes 

2001 Failed attempted plate transfer from output stack to input stack.  

This error indicates that the sensor check failed. 

• Plate in instrument. 

• The Bio-Stack’s shipping block is still installed. 

2002 Failed attempted plate transfer from output stack to input stack.  

This error indicates that the plate was left on the carrier after retrieval 
from the output stack. 

• Power down the Bio-Stack™ and remove the plate. 

2003 Failed attempted plate transfer from instrument to output stack.  

This error indicates that the plate was left on the carrier after retrieval 
from the instrument. 

• Power down the Bio-Stack and remove the plate. 

210# 

(#=motor) 

Refer to Table 4 
on page 279 for a 
list of motor 
numbers. 

Requested motor axis is unknown to the Bio-Stack. 

• Turn the instrument off/on.  If the error persists, contact BioTek 
TAC. 

220# 

(#=instrument) 

Refer to Table 5 
on page 280 for a 
list of instrument 
numbers. 

Instrument set to interface with is unknown to the Bio-Stack. 

The instrument is not an ELx405™, µFill™, MicroFlo™ Select, 
PowerWave™/PowerWave™ XS, Synergy™ HT/Synergy™ 2/ 
Synergy™ 4, Precision XS™ Microplate Sample Processor, or Precision™ 
Microplate Pipetting System. 

 

2300 Gripper width saved is outside allowed range. 

• Incorrect measurement entered. 

• Incorrect units. 
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  Table 2 (Cont’d) 
 

Code Probable Causes 

2500 Invalid alignment. 

• Z-alignment (vertical alignment) is incomplete or incorrect. 
Rerun the Instrument Alignment Utility to clear the error. 

• Incorrect instrument type is selected. 

2600 Claw/instrument interface error.  

• Rerun the Instrument Alignment Utility to clear the error. 

2700 Error attempting to run the barcode scanner SET command. 

• A response returned from the scanner is invalid.  

2701 Error attempting to run the barcode scanner SET command. 

• The command message is calling out an invalid barcode 
location. Valid numbers are 1-4.  

2702 Error attempting to get barcode scanner information regarding 
one of the barcode types. 

• The barcode type returned by the scanner is not one of those 
expected. See Appendix B, Bio-Stack Barcode Scanner for 
required barcode types. 

2703 Barcode type is not supported. 

• One of the four default barcode types is not supported by the 
scanner. See Appendix B, Bio-Stack Barcode Scanner for 
required barcode types. 

2704 Error disabling start/stop character transmission. 

• While attempting to tell the scanner to disable the transmission 
of start and stop characters along with the barcode value for the 
Codeabar barcode type, an error occurred. 

2800 Out of range error. 

• An attempt was made to set a configuration parameter, using 
an out-of-range value. 

3200 Error running serial (or USB) port test. 

• Incorrect cable. 

• Cable loose. 
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Table 3 

Bio-Stack™ Sensor Numbers Referenced in Table 2 

 

Sensor Number 

Claw Home 0 

Output Stack Cam1 Home 1 

Output Stack Lift Home 2 

Input Stack Cam1 Home 3 

Input Stack Lift Home 4 

Input Stack Cam2 Home 5 

Output Stack Cam2 Home 6 

Gripper Home 7 

Carrier Home 8 

Autocalibration 9 

Plate Present A 

Carrier Out B 

Input Stack Lift Up C 

Output Stack Lift Up D 
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Table 4 

Bio-Stack™ Motor Numbers Referenced in Table 2 

 

Motor Number 

Claw 0 

Output Stack Cam1 1 

Output Stack Lift 2 

Input Stack Cam1 3 

Input Stack Lift 4 

Input Stack Cam2 5 

Output Stack Cam2 6 

Gripper 7 

Carrier 8 
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Table 5 

Interfacing Instrument Numbers Referenced in Table 2 

 

Instrument Number 

PowerWave™/XS 0 

Synergy™ HT/Synergy™ 2/ 
Synergy™ 4 

1 

ELx405™ 2 

µFill™ 3 

Precision™/XS  4 

Reserved for specific customer 5 

Custom instrument 6 

Custom instrument 7 

Custom instrument 8 

 
 

� If you are operating the Bio-Stack™ with the NanoQuot™, the 
interfacing instrument number will be 0, since the NanoQuot uses 
the same Bio-Stack alignment scheme as the PowerWave. 

� If you are operating the Bio-Stack™ with the MicroFlo™ Select, 
the interfacing instrument number will be 3, since the MicroFlo 
uses the same Bio-Stack alignment scheme as the µFill. This is 
true when operating the Bio-Stack from the dispenser’s keypad or 
from the Liquid Handling Control™ Software. 
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Table 6 

Gen5™ Function Call Errors  
 

Gen5 function call error codes are displayed in the Bio-Stack™ PC Control Software during 
Bio-Stack™ operation with the PowerWave™/XS or Synergy™ HT/Synergy™ 2/ 
Synergy™  4. 

� Gen5 Function Call Errors are usually only seen by software developers when 
using BioTek’s ActiveX component or serial programming to control the 
Bio-Stack. If the information provided in this table does not help you resolve the 
problem, contact BioTek TAC for assistance.  

� The Label column is for use by robotic application developers, and corresponds 
to the labels found in the BTIStatusCodes.h file that is included with the Gen5 
installation (if “Custom Installation” was selected to install Gen5’s OLE 
Automation tool). These labels may also be beneficial to the developers of the 
Bio-Stack PC software, to troubleshoot problems associated with Bio-Stack PC 
software/Gen5 operations. 

   

Code Label Probable Cause 

-8 BTI_UNKNOWN_CHARACTERISTIC_ID There are no values associated with the 
characteristic ID used. 

-100 BTI_FILE_DOES_NOT_EXIST The system cannot find the file specified. 

-101 BTI_UNABLE_TO_OPEN_FILE Unable to open the file. 

-102 BTI_FILE_ALREADY_EXISTS File already exists. 

-103 BTI_FILE_READ_ONLY Read file only. 

-104 BTI_INVALID_PATHNAME The path name is invalid. 

-105 BTI_FILE_LOCKED Unable to access the file because another 
process has locked the file. 

-106 BTI_FILE_SHARING_VIOLATION Unable to access the file because it is being 
used by another process. 

-107 BTI_FILE_WRITE_ERROR Error writing a file. 

-108 BTI_FILE_READ_ERROR A system error occurred while reading from 
the file. 

-109 BTI_READ_FROM_FILE_EOF_ERROR The end of the file was reached before all 
needed data was read. 

-110 BTI_READ_FROM_FILE_TIME_STAMP_
NOT_FOUND 

The import file does not contain a valid 
timestamp. 

-200 BTI_INVALID_RECORD_FORMAT Invalid record format. 
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Code Label Probable Cause 

-201 BTI_INVALID_PARAMETER_LIST Invalid parameter list. 

-202 BTI_UNKNOWN_RECORD_TYPE Unknown record type. 

-300 BTI_INVALID_FIELD_OPTION Invalid field option. 

-301 BTI_FIELD_BELOW_MIN_RANGE Field below minimum range. 

-302 BTI_FIELD_ABOVE_MAX_RANGE Field above maximum range. 

-303 BTI_FIELD_TOO_LONG Field too long. 

-304 BTI_FIELD_TOO_SHORT Field too short. 

-400 BTI_OBJECT_CREATION_ERROR Object creation error. 

-401 BTI_OBJECT_DOES_NOT_EXIST Object does not exist. 

-402 BTI_INSUFFICIENT_FIELDS Insufficient fields. 

-403 BTI_NAME_REQUIRED Name required. 

-450 BTI_DEVICE_PROXY_CREATION_ 
ERROR 

Device proxy creation error. 

-451 BTI_DEVICE_MGR_NO_AVAIL_ 
READERS 

Device manager: no available reader. 

-500 BTI_BAUD_RATE_INVALID Invalid baud rate. 

-501 BTI_DATA_BITS_INVALID Invalid number of data bits. 

-502 BTI_STOP_BITS_INVALID Invalid number of stop bits. 

-503 BTI_PARITY_INVALID Invalid parity setting. 

-504 BTI_SERIAL_PORT_ERROR Serial port error. 

-505 BTI_SERIAL_WRITE_ERROR Serial write error. 

-506 BTI_SERIAL_READ_ERROR Serial read error. 

-507 BTI_CHECKSUM_ERROR Checksum error. 

-508 BTI_SERIAL_NAK_ERROR Serial NAK error. Message not 
acknowledged. 

-509 BTI_EXCESS_DATA_RECEIVED Excess serial data received. 

-510 BTI_INVALID_MSG_OBJECT Invalid serial message object. 
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Code Label Probable Cause 

-511 BTI_INVALID_MSG_BODY_SIZE Invalid serial message body size. 

-512 BTI_PURGE_COMM_FAILURE Failure purging the COM port. 

-513 BTI_PORT_NOT_OPEN COM port not open failure. 

-514 BTI_PORT_HANDLE_ERROR COM port handle error. 

-515 BTI_SERIAL_STREAM_ERROR The reader output was not in the correct 
format. 

-516 BTI_SEND_CMD_HEADER_ERROR Communication output failure. Reader may 
not be attached or turned on. 

-517 BTI_SEND_CMD_BODY_ERROR Command body error with the sent 
message. 

-518 BTI_RECEIVE_CMD_BODY_ERROR Command body error with the received 
message. 

-519 BTI_RECEIVE_CMD_STATUS_ERROR Request sent to reader, but no response 
received. 

-520 BTI_RECEIVE_BODY_SIZE_ 
MISMATCH 

Received serial message body size 
mismatch. 

-521 BTI_RECEIVE_STATUS_SIZE_ 
MISMATCH 

Received serial message status size 
mismatch. 

-522 BTI_COM_PORT_ALREADY_IN_USE COM port already in use. Please select 
another. 

-523 BTI_SET_TIMEOUT_ERROR Error setting timeout. 

-524 BTI_SET_DCB_BLOCK_FAILURE DCB block failure with serial communication. 

-525 BTI_CREATE_FILE_HANDLE_ERROR Error creating file handle. 

-526 BTI_CREATE_FILE_NO_PORT_ERROR The specified COM port does not exist. 

-527 BTI_CREATE_FILE_PORT_IN_USE The specified COM port is in use by another 
application. 

-528 BTI_COULD_NOT_MATCH_BAUD_ 
RATE 

Attempted, but could communicate with 
reader. Please cycle power to the reader and 
try again. 

-529 BTI_READER_NOT_CONNECTED Communication output failure. Reader may 
not be attached or turned on. 
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-600 BTI_UNKNOWN_READER Unknown reader type. 

-601 BTI_READER_STATUS_ERROR Reader status error. 

-602 BTI_READER_NO_ACKNOWLEDGE Reader failed to acknowledge request 

-603 BTI_TEMP_RANGE_NOT_FOUND Temperature range not found. 

-605 BTI_GEOMETRY_INVALID Invalid plate geometry. 

-606 BTI_READ_TIMEOUT_ERROR The current process timed out before 
receiving a reader response. 

-607 BTI_ABS_READER_DATA_NEW_ 
ERROR  

New error on reader absorbance data. 

-608 BTI_READER_INV_WAVELENGTH Invalid reader wavelength. 

-609 BTI_READER_INV_NUM_FILTER_SETS Invalid number of reader filter sets. 

-610 BTI_FLUOR_READER_DATA_NEW_ 
ERROR 

New error on reader fluorescence data. 

-611 BTI_READER_COMMANDS_NULL Reader commands are empty (NULL). 

-612 BTI_SPECTRAL_SCAN_DATA_NEW_ 
ERROR 

New error on reader spectrum scan data. 

-613 BTI_EVENT_MISMATCH_IN_DATA_ 
RESPONSE 

Plate and well synch modes expected event 
did not match event of data from reader. 

-614 BTI_SPECTRAL_SCAN_DATA_STATE_
ERROR 

State error on reader spectrum data. 

-615 BTI_AREA_SCAN_DATA_NEW_ERROR New error on reader area scan data. 

-616 BTI_LINEAR_SCAN_DATA_NEW_ 
ERROR 

New error on reader linear scan data. 

-617 BTI_AREA_LINEAR_SCAN_DATA_NEW
_ERROR 

New error on reader area scan or linear scan 
data. 

-618 BTI_READER_VERSION_NOT_ 
SUPPORTED 

Gen5 does not support the version of the 
firmware installed on this reader. Please 
contact BioTek Service for assistance. 

-619 BTI_READ_TYPE_NOT_VALID Invalid read type for Absorbance detection 
method. 

BioTek Instruments, Inc. 



Error Code Tables  |  285 

Table 6 (Cont’d)  
 

Code Label Probable Cause 

-620 BTI_GET_SENSITIVITY_INVALID_ 
FILTER_SET 

Invalid filter set for get sensitivity command. 

-621 BTI_SET_PROBE_HEIGHT_INVALID_ 
HEIGHT 

Invalid set probe height value. 

-622 BTI_SET_PROBE_HEIGHT_INVALID_ 
SELECTION 

Invalid selection for set probe height. 

-623 BTI_INCUBATION_TEMP_INVALID The temperature specified in the procedure 
is outside the range of the instrument. 

-624 BTI_INCUBATION_NOT_SUPPORTED Temperature control is not supported by this 
reader 

-625 BTI_FLUOR_LUMIN_S_CMD_RSP_ 
DATA_ERR 

Error with response data associated with 
luminescence or fluorescence ‘S’ command. 

-626 BTI_CFLUORESCENCEREADERDATA_ 
ERROR 

’C’ command fluorescence reader data error. 

-627 BTI_FLUOR_LUMIN_DATA_ 
CHECKSUM_ERROR 

Fluorescence or luminescence data 
checksum error. 

-628 BTI_SYSTEM_TEST_NOT_SUPPORTED System test not supported. 

-629 BTI_SYSTEM_TEST_TIMER_READ_ 
DATA_FAIL 

System test timer read data failure. 

-630 BTI_MSG_DIALOG_START_TIMER_ 
FAILED 

Message dialog start timer failed. 

-631 BTI_TIMEOUT_ERROR Timeout error. 

-632 BTI_ABORT_ERROR Abort error. 

-633 BTI_NO_ENDPOINT_DATA_PRESENT No endpoint data is available. 

-634 BTI_ABSORBANCE_DATA_CHECKSUM
_ERROR 

Absorbance data checksum error. 

-635 BTI_NO_SPECTRAL_SCAN_DATA_ 
PRESENT 

No spectrum scan data present. 

-636 BTI_UNDEFINED_SPECTRAL_VALUE Undefined spectral value. 

-637 BTI_SPECTRAL_DATA_CHECKSUM_ 
ERROR 

Spectral data checksum error. 
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-638 BTI_SPECTRAL_DATA_COMMAND_ 
ERROR 

Spectral data command error. 

-639 BTI_NO_AREA_SCAN_DATA_PRESENT No area scan data present. 

-640 BTI_READER_IN_USE The reader is in use and the operation 
selected is not available. 

-641 BTI_EXECUTE_READ_PARAM_TRY_ 
CATCH 

Software exception on an execute read 
command. 

-642 BTI_NO_MONITOR_WELL_DATA_ 
PRESENT 

No monitor well data present. 

-643 BTI_AUXILIARY_DATA_PRESENT       Auxiliary data found (BioCell, Pathlength 
Correction, etc) and should be empty. 

-644 BTI_AUXILIARY_DATA_TRY_CATCH Software exception on auxiliary data read. 

-645 BTI_NO_AUXILIARY_DATA_PRESENT No auxiliary data present. 

-646 BTI_NO_WELL_DATA_PRESENT No well data present. 

-647 BTI_READER_DATA_PRESENT Data found when list should be empty. 

-648 BTI_NO_SENSITIVITY_VALUE_MATCH Could not find match for auto sensitivity 
value. 

-649 BTI_EDIT_READ_PARAM_TRY_CATCH Software exception on edit read parameters 
attempt. 

-650 BTI_RDR_NO_ABSORBANCE_ 
SUPPORT 

Absorbance detection not supported by 
reader 

-651 BTI_RDR_NO_FLUORESCENCE_ 
SUPPORT 

Fluorescence detection not supported by 
reader 

-652 BTI_RDR_NO_LUMINESCENCE_ 
SUPPORT 

Luminescence detection not supported by 
reader 

-653 BTI_RDR_MIN_WAVELENGTH_ 
EXCEEDED 

Wavelength must be between value 1 and 
value 2 

-654 BTI_RDR_MAX_WAVELENGTH_ 
EXCEEDED 

Wavelength must be between value 1 and 
value 2 

-655 BTI_RDR_NO_INCUBATION_SUPPORT Incubation not supported by this reader. 

-656 BTI_RDR_MIN_TEMP_EXCEEDED Temperature must be between value 1 and 
value 2 
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-657 BTI_RDR_MAX_TEMP_EXCEEDED Temperature must be between value 1 and 
value 2 

-658 BTI_RDR_NO_SHAKE_SUPPORT Shaking is not supported by this reader 

-659 BTI_FEATURE_NOT_IMPLEMENTED The feature has not been implemented at 
this time. 

-660 BTI_PROBE_HEIGHT_OUT_OF_RANGE The probe height is out of range for the 
current plate type. 

-661 BTI_RDR_REQUIRES_SPECIFIC_ 
PROTOCOL 

The reader requires a specific protocol. 

-662 BTI_PROTOCOL_REQUIRES_SPECIFIC
_RDR 

The protocol requires a specific reader. 

-663 BTI_RDR_NO_SPECTRUM_SCAN_ 
SUPPORT 

The reader does not support spectrum 
scanning. 

-664 BTI_RDR_NO_AREA_SCAN_SUPPORT The reader does not support area scanning. 

-665 BTI_RDR_NO_LINEAR_SCAN_ 
SUPPORT 

The reader does not support linear scanning. 

-666 BTI_RDR_NO_DISPENSER_SUPPORT The reader does not support dispensing. 

-667 BTI_RDR_MAX_DISPENSERS_ 
EXCEEDED 

The maximum dispensers supported for the 
reader has been exceeded. 

-668 BTI_RDR_NO_WELL_MODE_SUPPORT The reader does not support well mode. 

-669 BTI_RDR_WELL_MODE_READS_ 
EXCEEDED 

The maximum well mode reads has been 
exceeded. 

-670 BTI_RDR_WELL_MODE_SHAKES_ 
EXCEEDED 

The maximum well mode shake cycles have 
been exceeded. 

-671 BTI_RDR_WELL_MODE_DISPENSES_ 
EXCEEDED 

The maximum well mode dispenses have 
been exceeded. 

-672 BTI_RDR_NO_SYNC_PLATE_MODE_ 
SUPPORT 

The reader does not support plate mode. 

-673 BTI_RDR_SYNC_PLATE_MODE_ 
READS_EXCEEDED 

The maximum synchronized plate mode 
reads have been exceeded. 

-674 BTI_RDR_SYNC_PLATE_MODE_ 
SHAKES_EXCEEDED 

The maximum synchronized plate mode 
shake cycles have been exceeded. 
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-675 BTI_RDR_SYNC_PLATE_MODE_ 
DISPNS_EXCEEDED 

The maximum synchronized plate mode 
dispenses have been exceeded. 

-676 BTI_RDR_SYNC_PLATE_MODE_ 
STEPS_EXCEEDED 

The maximum synchronized plate mode 
steps have been exceeded. 

-677 BTI_RDR_NO_PATHLEN_ 
CORRECTION_SUPPORT 

The reader does not support pathlength 
correction. 

-678 BTI_DATA_FORMAT_ERROR The expected data has not been received.  
Possible reasons are: Your computer is not 
able to retrieve the data in a timely fashion. 
Your reader cable is loose or damaged. 
(Press Help for more information) 

-679 BTI_KINETIC_DURATION_LESS_THAN
_INTERVAL 

The kinetic read time must exceed the 
kinetic interval. 

-697 BTI_RDR_MIRROR_NOT_DEFINED The required mirrors are not defined on the 
reader. 

-700 BTI_NO_PLATE_TYPE_DEFINED The Plate Type specified is invalid or the 
definition no longer exists. 

-701 BTI_UNSUPPORTED_READ_PARAM_ 
STEP 

The read parameter step is invalid or not 
currently supported. 

-702 BTI_INVALID_ORDER_PAUSE_STEP Invalid order for a pause step. 

-703 BTI_INVALID_ORDER_INCUBATE_ 
STEP 

Invalid order for an incubate step. 

-704 BTI_INVALID_ORDER_CARRIER_IN_ 
OUT_STEP 

Invalid order for a carrier in/out step. 

-705 BTI_INVALID_ORDER_READ_STEP Invalid order for a read step. 

-706 BTI_INVALID_ORDER_KINETIC_END_
STEP 

The Kinetic End step is missing or is in an 
invalid order. 

-707 BTI_NO_READ_PARAMETERS No read parameters. 

-708 BTI_INVALID_RESUME_INDEX The Resume index is invalid for the current 
read parameters. 

-709 BTI_INSUFFICIENT_KINETIC_READ_ 
PARAMS 

Illegal kinetic read structure defined. 

-710 BTI_NO_KINETIC_SCANS_ALLOWED Kinetic reads of Spectrum, Linear and Area 
scanning are not supported. 
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-711 BTI_AUTOSENSITIVITY_ERROR Error during determination of Auto 
Sensitivity value. 

-712 BTI_STOP_RESUME_LAST_STEP_ 
ERROR 

A Stop/Resume step cannot be the last step 
in the sequence. 

-713 BTI_STOP_RESUME_NEXT_STEP_ 
ERROR 

Error obtaining Resume step number. 

-714 BTI_ILLEGAL_PRODUCT_ 
DELINEATION_SETTING 

An illegal product delineation setting was 
sent to the ActiveX. 

-715 BTI_READER_CONFIG_NOT_ 
SUPPORTED_PD 

Reader configuration not supported. 

-716 BTI_DISPENSE_MEASURE_NOT_ 
SUPPORTED 

Dispense measure not supported. 

-717 BTI_INVALID_MESSAGE_RESP_SIZE Invalid message response size. 

-718 BTI_E_COMMAND_CHECKSUM_ 
FAILURE 

’E’ command checksum failure. 

-719 BTI_E_COMMAND_RATES_ 
SUPPORTED_ERROR 

’E’ command rates supported error. 

-720 BTI_INVALID_ORDER_MODE_END_ 
STEP 

Invalid order for a mode End step. 

-721 BTI_MAX_G_COMMAND_TOTAL_ 
EVENTS_EXCEEDED 

The maximum number of events in a mode 
block has been exceeded. 

-722 BTI_MAX_G_COMMAND_SHAKE_ 
EVENTS_EXCEEDED 

The maximum number of shake events in a 
block has been exceeded. 

-723 BTI_MAX_G_COMMAND_READ_ 
EVENTS_EXCEEDED 

The maximum number of read events in a 
mode block has been exceeded. 

-724 BTI_MAX_G_COMMAND_DISPENSE_ 
EVENTS_EXCEEDED 

The maximum number of dispense events in 
a mode block has been exceeded. 

-725 BTI_ILLEGAL_STEP_TYPE_FOUND_ 
IN_BLOCK 

An illegal step type was found within the 
current block. 

-726 BTI_G_COMMAND_MISMATCH_ 
RESPONSE_SIZE 

The length of the response from the 'G' 
command did not match the expected 
length. 

-727 BTI_G_COMMAND_CHECKSUM_ 
FAILURE 

’G’ command checksum failure. 
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-728 BTI_INVALID_ORDER_MONITOR_ 
WELL_END_STEP 

Invalid order for a monitor well step. 

-729 BTI_DISPENSER1_NOT_PRIMED Dispenser 1 is not primed. Please prime 
before running protocol. 

-730 BTI_DISPENSER2_NOT_PRIMED Dispenser 2 is not primed. Please prime 
before running protocol. 

-731 BTI_INVALID_WELL_MODE_EVENT_ 
TYPE 

An invalid event type for well mode was 
detected when creating the 'G' command 
request body. 

-732 BTI_INVALID_PLATE_MODE_EVENT_ 
TYPE 

Invalid plate mode event type. 

-733 BTI_WELL_MODE_DATA_ERROR Well mode data error. 

-734 BTI_WELL_MODE_EVENT_MISMATCH
_ERROR 

The event number in the data stream did 
not match the expected event number. 

-735 BTI_WELL_MODE_END_OF_WELL_ 
ERROR 

Error with the end of well data stream from 
the reader. 

-736 BTI_WELL_MODE_HEADER_ERROR Error in header of well mode response. 

-737 BTI_WELL_MODE_DELAY_FROM_ 
START_ERROR  

Delay step is not long enough. Increase the 
Delay step prior to action step number # 
within the Well Mode Block. Action steps are 
Read, Shake and Dispense. 

-738 BTI_AREA_SCAN_PROBE_SIZE_ 
CHANGED 

The Probe size used in the area scanning 
calculations has changed since the Read 
Step was last modified. To correct this 
situation, have the desired reader connected 
and in a ready state, then edit the Read 
Step that has Area Scanning specified.  The 
Area Scanning matrix will be re-evaluated 
based on the reader's limitations, current 
probe size, and plate type. 

-739 BTI_AREA_SCAN_SPACING_SIZE_ 
CHANGED 

The Spacing size used in the area scanning 
calculations has changed since the Read 
Step was last modified. To correct this 
situation, have the desired reader connected 
and in a ready state, then edit the Read 
Step that has Area Scanning specified.  The 
Area Scanning matrix will be re-evaluated 
based on the reader's limitations, current 
probe size, and plate type. 
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-740 BTI_AREA_SCAN_MATRIX_SIZE_ 
CHANGED 

The Matrix size used in the area scanning 
calculations has changed since the Read 
Step was last modified. To correct this 
situation, have the desired reader connected 
and in a ready state, then edit the Read 
Step that has Area Scanning specified. The 
Area Scanning matrix will be re-evaluated 
based on the reader's limitations, current 
probe size, and plate type. 

-741 BTI_BIOCELL_READ_FROM_FILE_ 
ERROR 

Error reading the BioCell=x.xxxx value from 
the data file. 

-742 BTI_Y_COMMAND_CHECKSUM_ 
FAILURE 

’Y’ command checksum error. 

-743 BTI_UNKNOWN_DETECTION_ 
METHOD 

Unknown detection error. 

-744 BTI_BLOCK_MODE_DELAY_ERROR Delay step error. Delay steps are not 
allowed inside a kinetic loop or in sequence 
back to back. 

-746 BTI_ABS_KINETIC_INTERVAL_ERROR 

 

The kinetic interval is too short for the 
defined parameters. 

-747 BTI_FLUORLUMIN_KINETIC_ 
INTERVAL_ERROR 

The kinetic interval is too short for the 
defined parameters. 

-748 BTI_WELL_MODE_KINETIC_INTERVAL
_ERROR  

The kinetic interval is too short for the 
defined parameters. 

-754 BTI_DISPENSERS_NOT_PRIMED Neither dispenser 1 or 2 is primed. Please 
prime both before running protocol. 

-755 BTI_WELL_MODE_DELAY_TOO_ 
SHORT 

Well mode Delay step is too short. 

-756 BTI_USER_OVERRIDE_SET_ 
TEMPERATURE 

The temperature had not reached the 
setpoint when the user chose to override. 

-757 BTI_INVALID_READER_TYPE The assigned reader type is unknown and 
cannot be configured. 

-758 BTI_LUMINESCENCE_DATA_FORMAT_
ERROR 

Luminescence data format error. 

-759 BTI_NO_WELL_MODE_SIMULATION Well mode simulation is not supported. 
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-760 BTI_NO_PLATE_SYNCH_MODE_ 
SIMULATION 

Plate synchronous mode simulation is not 
supported. 

-761 BTI_EVENT_START_TIME_EXCEEDS_ 
LIMIT 

The start time of one of the steps inside the 
'Mode' block exceeds the limit of 16:39.99 
mm:ss.msec in well mode or 27:46:39 
hh:mm:ss in plate mode. 

-762 BTI_WELL_MODE_KINETIC_INTERVAL
_EXCEEDED 

The well mode kinetic interval cannot exceed 
1:39.99 m:ss.msec. 

-763 BTI_PLATE_MODE_KINETIC_ 
INTERVAL_EXCEEDED 

The plate mode kinetic interval cannot 
exceed 02:46:39 hh:mm:ss. 

-764 BTI_STAND_ALONE_SHAKE_NOT_ 
SUPPORTED 

The current order of the shake step is illegal. 
The reader does not support stand alone 
shake steps. 

-765 BTI_MONITOR_WELL_ILLEGAL_ 
DEFINITION 

A Monitor well sequence must contain one 
read step. An optional shake step before the 
Monitor Well loop or before the read step 
inside the Monitor Well loop is allowed for 
absorbance and luminescence reads. 

-766 BTI_NO_APPEND_IN_MULTIMODE_ 
BLOCK 

When two or three read steps are in a 
Kinetic loop, appending kinetic data is not 
supported. 

-767 BTI_FLUORESCENCE_DATA_ 
TERMINATOR_INVALID 

Invalid fluorescence data stream termination 
character found. 

-768 BTI_MULTI_MODE_KINETIC_ 
INTERVAL_EXCEEDED 

The kinetic interval is too small for the read 
steps defined. 

-769 BTI_OLD_STATUS_FORMAT The reader attached only supports an old 
style status format. Any error produced 
should have been displayed by the reader. 

-772 BTI_SYNERGY_WELL_SYNCH_NUM_ 
KINETIC_READS 

The Synergy in plate or well synch mode is 
limited to 999 reads in a kinetic read step. 

-773 BTI_SYNERGY_PLATE_SYNCH_NUM_ 
KINETIC_READS 

The Synergy in plate or well synch mode is 
limited to 999 reads in a kinetic read step. 

-774 BTI_MULTI_MODE_NUM_KINETIC_ 
READS_ERROR 

Luminescence and Multi-Mode kinetics are 
limited to 999 reads. 

-775 BTI_FLUORESCENCE_KINETIC_ 
READS_ERROR 

Fluorescence kinetic reads area limited to 
300 reads. 
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-776 BTI_ABSORBANCE_KINETIC_READS_
ERROR 

Absorbance kinetic reads error. 

-777 BTI_KINETIC_DURATION_VS_ 
INTERVAL_ERROR 

The kinetic read time must exceed the 
kinetic interval. 

-778 BTI_ERROR_DETECTED_DURING_ 
BULB_WARMUP 

Error detected during bulb warmup. 
Excitation filter cartridge removal is the 
most likely cause. 

-780 BTI_FINAL_STATUS_ERROR Status was not received after completion of 
read step. This could be due to an error that 
should be displayed on the reader. 

-781 BTI_CONTINUOUS_SHAKE_ 
MULTIMODE_ERROR 

Continuous shake option is not allowed in a 
kinetic block with multiple read steps. 

-782 BTI_PLATE_MODE_DELAY_FROM_ 
START_ERROR  

Delay step is not long enough. Increase the 
Delay step prior to action step number # 
within the Plate Mode Block. Action steps are 
Read, Shake and Dispense. 

-2010 BTI_AUTM_DOCUMENT_ALREADY_IN_
MEMORY 

Automation error: Experiment already in 
memory. 

-2011 BTI_AUTM_INVALID_INDEX Automation error: Invalid index. 

-2012 BTI_AUTM_DATABASE_GENERIC_ 
ERROR 

Automation error: Generic database error. 

-2013 BTI_AUTM_FILE_GENERIC_ERROR Automation error: Generic file error. 

-2014 BTI_AUTM_FILE_FILE_NOT_FOUND Automation error: File not found. 

-2015 BTI_AUTM_FILE_BAD_PATH Automation error: Bad file pathname. 

-2100 BTI_AUTM_APP_NEW_EXP_GENERIC_
ERROR 

Automation error: Application object, 
Generic error creating new experiment. 

-2101 BTI_AUTM_APP_OPEN_EXP_GENERIC
_ERROR 

Automation error: Application object, 
Generic error opening experiment. 

-2120 BTI_AUTM_APP_SET_CLIENT_ 
WINDOW_GENERIC_ERROR 

Automation error: Application object, Error 
setting client window. 

-2130 BTI_AUTM_APP_BROWSE_FOR_FILE_
GENERIC_ERROR 

Automation error: Application object, 
Generic error browsing for a file. 

-2140 BTI_AUTM_APP_BROWSE_FOR_ 
FOLDER_GENERIC_ERROR 

Automation error: Application object, 
Browse for folder generic error. 
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Code Label Probable Cause 

-2145 BTI_AUTM_APP_READER_OPERATION
_READER_NOT_CONFIGURED 

Automation error: Application object, Reader 
not configured. 

-2150 BTI_AUTM_APP_CONFIGURE_OLE_ 
READER_GENERIC_ERROR 

Automation error: Application object, OLE 
reader configuration failed. 

-2160 BTI_AUTM_APP_CONFIGURE_COM_ 
READER_GENERIC_ERROR 

Automation error: Application object, COM 
reader configuration failed. 

-2161 BTI_AUTM_APP_CONFIGURE_COM_ 
READER_INVALID_READER_TYPE 

Automation error: Application object, Invalid 
COM reader type. 

-2162 BTI_AUTM_APP_CONFIGURE_COM_ 
READER_INVALID_COM_PORT 

Automation error: Application object, Invalid 
COM port. 

-2163 BTI_AUTM_APP_CONFIGURE_COM_ 
READER_INVALID_BAUD_RATE 

Automation error: Application object, Invalid 
baud rate. 

-2170 BTI_AUTM_APP_CARRIER_IN_ 
GENERIC_ERROR 

Automation error: Application object, Carrier 
in generic error. 

-2175 BTI_AUTM_APP_CARRIER_OUT_ 
GENERIC_ERROR 

Automation error: Application object, Carrier 
out generic error. 

-2180 BTI_AUTM_APP_GET_LAST_READER_ 
ERROR_GENERIC_ERROR 

Automation error: Application object, Get 
last reader error generic error. 

-2300 BTI_AUTM_EXP_PLATES_GENERIC_ 
ERROR 

Automation error: Experiment object, plates 
generic error. 

-2310 BTI_AUTM_EXP_SAVE_GENERIC_ 
ERROR 

Automation error: Experiment object, save 
generic error. 

-2320 BTI_AUTM_EXP_SAVE_AS_GENERIC_
ERROR 

Automation error: Experiment object, save 
as generic error. 

-2330 BTI_AUTM_EXP_CLOSE_GENERIC_ 
ERROR 

Automation error: Experiment object, close 
generic error. 

-2331 BTI_AUTM_EXP_EXPERIMENT_IS_ 
CLOSED 

Automation error: Experiment object, 
experiment is closed error. 

-2400 BTI_AUTM_PLATES_GET_PLATE_ 
GENERIC_ERROR 

Automation error: Plates object get plate 
error. 

-2410 BTI_AUTM_PLATES_ADD_MULTI_ 
PLATE_ASSAY_PROTOCOL 

Automation error: Plates object, the addition 
of plates is not supported in a multi-plate 
assay protocol. 

   

BioTek Instruments, Inc. 



Error Code Tables  |  295 

Table 6 (Cont’d)  
 

Code Label Probable Cause 

-2420 BTI_AUTM_PLATES_ADD_GENERIC_ 
ERROR 

Automation error: Plates object, add generic 
error. 

-2500 BTI_AUTM_PLATE_START_READ_ 
GENERIC_ERROR 

Automation error: Plate object start read 
error. 

-2501 BTI_AUTM_PLATE_RESUME_READ_ 
READ_NOT_PAUSED 

Automation error: Plate object, resume read 
error. 

-2502 BTI_AUTM_PLATE_READ_FROM_FILE_
INVALID_SEPARATOR 

Automation error: Plate object, read from 
file error – invalid separator. 

-2503 BTI_AUTM_PLATE_BARCODE_ 
GENERIC_ERROR 

Automation error: Plate object, barcode 
generic error. 

-2504 BTI_AUTM_PLATE_ID_GENERIC_ 
ERROR 

Automation error: Plate object, plate ID 
generic error. 

-2505 BTI_AUTM_PLATE_NAME_GENERIC_ 
ERROR 

Automation error: Plate object, plate name 
generic error. 

-2506 BTI_AUTM_PLATE_PLATE_TYPE_ 
GENERIC_ERROR 

Automation error: Plate object, plate type 
generic error. 

-2507 BTI_AUTM_PLATE_READ_STATUS_ 
GENERIC_ERROR 

Automation error: Plate object, read status 
generic error. 

-2510 BTI_AUTM_PLATE_ABORT_READ_ 
GENERIC_ERROR 

Automation error: Plate object, abort read 
error. 

-2511 BTI_AUTM_PLATE_ABORT_READ_ 
READ_NOT_IN_PROGRESS 

Automation error: Plate object, abort called 
while plate was not being read. 

-2520 BTI_AUTM_PLATE_DELETE_GENERIC_
ERROR 

Automation error: Plate object, delete 
generic error. 

-2521 BTI_AUTM_PLATE_DELETE_MULTI_ 
PLATE_ASSAY_PROTOCOL 

Automation error: Plate object, the deletion 
of plates is not supported in a multi-plate 
assay protocol. 

-2522 BTI_AUTM_PLATE_DELETE_PLATE_IS
_CALIBRATE 

Automation error: Plate object, the deletion 
of calibration plates is not supported. 

-2523 BTI_AUTM_PLATE_DELETE_LAST_ 
PLATE 

Automation error: Plate object, the last plate 
of the experiment cannot be deleted. 

-2524 BTI_AUTM_PLATE_PLATE_IS_ 
DELETED 

Automation error: Plate object, plate has 
been deleted. 
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Code Label Probable Cause 

-2525 BTI_AUTM_PLATE_READ_IN_ 
PROGRESS 

Automation error: Plate object, read in 
progress. 

-2530 BTI_AUTM_PLATE_POWER_EXPORT_ 
GENERIC_ERROR 

Automation error: Plate object, Power Export 
generic error. 

-2531 BTI_AUTM_PLATE_POWER_EXPORT_ 
NOT_DEFINED 

Automation error: Plate object, Power Export 
not defined. 

-2540 BTI_AUTM_PLATE_FILE_EXPORT_ 
GENERIC_ERROR 

Automation error: Plate object, file export 
generic error. 

-2541 BTI_AUTM_PLATE_FILE_EXPORT_NOT
_DEFINED 

Automation error: Plate object, file export 
not defined. 

-2550 BTI_AUTM_PLATE_PRINT_REPORT_ 
GENERIC_ERROR 

Automation error: Plate object, print report 
generic error. 

-2551 BTI_AUTM_PLATE_PRINT_REPORT_ 
NOT_DEFINED 

Automation error: Plate object, print report 
not defined. 

-2560 BTI_AUTM_PLATE_IMPORT_SAMPLE_ 
IDS_GENERIC_ERROR 

Automation error: Plate object, import 
sample IDs generic error. 

-2561 BTI_AUTM_PLATE_IMPORT_SAMPLE_ 
IDS_FILE_CONTAINS_EXTRA_IDS 

Automation error: Plate object, import file 
contained more sample IDs than the plate. 

-2562 BTI_AUTM_PLATE_DISCONTINUOUS_
KINETIC_GENERIC_ERROR 

Automation error: Plate object, 
discontinuous kinetic generic error. 

-2563 BTI_AUTM_PLATE_DISCONTINUOUS_
KINETIC_ INTERVAL_ GENERIC_ 
ERROR 

Automation error: Plate object, 
discontinuous kinetic interval generic error. 

-2564 BTI_AUTM_PLATE_DISCONTINUOUS_ 
KINETIC_RUNTIME_GENERIC_ERROR 

Automation error: Plate object, 
discontinuous kinetic runtime generic error. 
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Table 7 

KC4™ Function Call Errors  
 

KC4 function call error codes are displayed in the Bio-Stack™ PC Control Software during 
Bio-Stack™ operation with the PowerWave™/XS or Synergy™ HT. 

� If there are problems with a protocol, launch KC4 in standalone mode, open the 
protocol, and try to read a plate. Refer to the KC4 User’s Guide or Help System 
for more information. If you cannot resolve the problem, contact BioTek TAC for 
assistance. 

� KC4 does not support the Synergy™ 2/Synergy™ 4 readers. 

 

Code Probable Cause 

-1000 Generic error when opening the KC4 protocol file. 

• Close the application and try to open the protocol in KC4 under 
manual mode, then retry. 

-1001 Either a plate or a protocol was already open in the KC4 memory, 
when a new plate or protocol was to be opened. 

• Close the plate or protocol and retry. 

-1002 Incompatible reader type defined in the KC4 protocol. 

• Correct the reader type in the protocol, or create a new protocol for 
the correct reader type. 

-1003 Incorrect protocol or plate file extension. 

• Correct the file extension. 

-1004 Plate or protocol file not found. 

• Select a different plate or protocol. 

-1050 Generic error when opening new KC4 plate file 

• Close the application and try to open the protocol in KC4 under 
manual mode, then retry. 

-1086 Expected response never received 

• Check the cable connection to the reader; re-boot the reader if 
necessary. 

-1087 Out of range parameter during read 

• Correct the parameter in the protocol. Launch KC4 and review the 
protocol parameters. Initiate a plate read via KC4 to test the protocol. 
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Code Probable Cause 

-1088 Defective reader connected 

• Replace or repair the reader. 

-1089 Checksum error during read operation 

• Check the protocol and reader to make sure they are compatible, and 
retry. 

-1090 Unexpected response during read operation 

• Close the application and retry. 

-1091 Software error message during read operation 

• Close the application and retry. 

-1092 Reader error during read operation 

• Check the reader. Re-boot if necessary. 

-1093 Negative acknowledgement during read operation 

• Check the connection to the reader; re-boot the reader if necessary. 

-1095 Abnormal error during read operation 

• Check the reader. Re-boot if necessary. 

-1096 Reading pending 

• Check the reader. Re-boot if necessary. 

-1097 Communication port busy 

• Make sure no other application has the port open. Close the 
application and retry. 

-1098 Communication port error 

• Close the application and retry. 

-1099 Reading stopped 

• Check the reader. Re-boot if necessary. 

-1100 No response from reader 

• Check the connection to the reader; re-boot the reader if necessary. 

-1150 No plate in memory during read operation 

• Close the application and retry. 
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Code Probable Cause 

-1151 No protocol in memory during read operation 

• Close the application and retry. Make sure a valid KC4™ protocol is 
selected. 

-1152 Plate already read 

• Select a different plate. 

-1153 Can’t read reader’s filter table 

• Close the application and see if a plate with the same protocol can be 
read via KC4 manually, then retry. 

-1154 Filter table mismatch 

• Correct the protocol to match the reader’s filter table. 

-1155 Filter not found in filter read table 

• Correct the protocol to match the reader’s filter table. 

-1156 Incorrect filter selection 

• Correct the protocol to match the reader’s filter table. 

-1157 Kinetic read interrupted 

• Check the reader. Re-boot if necessary. 

-1158 Abnormal end to kinetic read 

• Check the reader. Re-boot if necessary. 

-1159 Reading parameters not supported 

• Correct the protocol. 

-1160 Monitor well not supported 

• Correct the protocol (disable well monitoring in protocol). 

-1161 Probe size error 

• Correct the protocol. 

-1163 Auto save failed 

• Launch KC4 manually, then open the protocol and try to read a plate. 
If there are problems with the protocol or with the reader, KC4 will 
display prompts to fix the problems. 
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Table 7 (Cont’d) 
 

Code Probable Cause 

-1199 Generic error during read operation 

• Check the reader. Re-boot if necessary. 

-1200 Generic error during plate closing 

• Check the reader. Re-boot if necessary. 

-1201 Invalid plate file name during plate closing 

• Correct the plate file name. If the file name is to be created using a 
barcode value, make sure the barcode does not have illegal file name 
characters.  

-1250 Generic error during file export operation 

• Correct the export file name in the KC4™ protocol. 

-1251 No plate in memory during file export operation 

• Check the protocol to see if it is set up correctly for exporting. 

-1252 No protocol in memory during export operation 

• Check the protocol to see if it is set up correctly for exporting. 

-1253 Nothing to export 

• Close the application and attempt to run a plate with the same 
protocol via KC4 manually, then retry. 

-1254 File creation error during export operation 

• Check the protocol to see if it is set up correctly for exporting, and 
that there is a valid export filename. 

-1300 Generic error during protocol closing 

• Check the protocol. 

-1350 Unable to start KC4 via Bio-Stack™ software 

• Make sure that KC4 has been installed, and that there is not another 
instance of KC4 already running. 

-1400 Generic error during file importing 

• Correct the import filename. 

-1401 No plate in memory during file importing 

• Check the protocol to see if it is correct for importing. 
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Code Probable Cause 

-1402 Invalid filename for file importing 

• Correct the filename. 

-1403 File not found for file importing 

• Check the protocol to see if it is correct for importing. 

-1404 Invalid parameter format during file importing 

• Check the protocol to see if it is correct for importing. 

-1450 Generic error during plate opening 

• Correct the plate file name. 

-1451 Plate already in memory during plate opening 

• Close the application and retry. 

-1452 No protocol in memory during plate opening 

• Close the application and retry. 

-1453 Protocol already in memory during plate opening 

• Close the application and retry. 

-1454 Incorrect file extension for plate opening 

• Correct the file extension. 

-1455 File not found during plate opening 

• Correct the filename or file path. 

-1456 Incompatible reader during plate opening 

• Correct the reader type called out in the protocol or select a different 
protocol. 

-1457 Incompatible reading parameter during plate opening 

• Correct the protocol. 

-1500 Error getting the plate barcode value – either because the scanning 
failed, or because there is no scanner 

• If there is a scanner, make sure that there is a valid, readable barcode 
on the plate, in the correct location and orientation. See Appendix B, 
Bio-Stack Barcode Scanner, for required barcode types and proper 
position on the microplates. 
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Table 7 (Cont’d) 
 

� For data reduction errors (–1600 to –1613), launch KC4™ in 
standalone mode, open the plate and protocol, and initiate a plate 
read to determine why the error occurred. Refer to the KC4 User’s 
Guide and Help System for more information. 

 

Code Probable Cause 

-1600 Calculation error  

• Correct the protocol.   

-1601 Log axis incompatibility 

• Correct the protocol’s curve-fitting parameters.   

-1602 Curve could not be not calculated 

•  Correct the protocol. 

-1603 Curve is ambiguous 

•  Correct the protocol. 

-1604 Not enough valid standards on the plate 

• Re-try the test, or modify the protocol’s plate layout in the location 
specified in the protocol. See note above. 

-1605 Archived curve not loaded 

• Make sure the archived curve is available. 

-1606 Data to interpolate not available 

• Correct the protocol; make sure the read was properly performed. 

-1607 Cut-off values not calculated 

• Correct the protocol; make sure the read was properly performed. 

-1608 Cut-off values not in increasing order 

• Correct the protocol; make sure the read was properly performed. 

-1609 Single plate transfer data is not available 

• Correct the protocol; make sure the read was properly performed. 

-1610 Kinetic calculation data to process is not available 

• Correct the protocol; make sure the read was properly performed. 
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Code Probable Cause 

-1611 Validation condition failure 

• This is probably a valid failure. 

-1612 4-parameter curve-fit not converging 

• Correct the protocol; make sure the read was properly performed. 

-1613 Multi-plate transfer data is not available 

• Correct the protocol; make sure the read was properly performed. 

-4000 Generic database error 

• Close the application and attempt to run the plate and protocol in 
KC4™ manually. Refer to the KC4 User’s Guide for database 
troubleshooting information. 

 
 

� Warning codes indicate that the data might be questionable because 
something went wrong, but KC4 didn’t have enough information to 
accept or reject the results. 

 

Warning 
Code 

Warning Code Description 

1000 Expected incubation temperature not reached 

• Make sure expected incubation temperature has been reached on 
the reader before starting the processing of plates. 

1001 Barcode read failure 

• Make sure that the barcode reader is working properly, and that 
the plate has a valid barcode label, which is properly positioned 
on the microplate. See Appendix B, Bio-Stack Barcode 
Scanner, for required barcode types and proper position on the 
microplates. 
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Table 8 

Communication Errors Displayed on the µFill™, ELx405™,  
or MicroFlo™ Select 

 
Communication errors appear on the displays of the µFill, ELx405, or MicroFlo Select during 
operation with the Bio-Stack™, and indicate that the software may be corrupted. Contact 
BioTek TAC if you receive these errors. 

� When communication errors are generated by the Bio-Stack, the error 
code appears on the display of the µFill, ELx405, or MicroFlo Select 
prefixed with a B-. “Stacker Error” also appears in the first line of the 
display of the MicroFlo. 

  

Code Probable Cause 

8300    An invalid password was sent to the Bio-Stack during a protected operation. This 
error can only occur when the Bio-Stack is under serial control, using a software 
program other than the Bio-Stack™ PC Control Software. 

8301   The Bio-Stack was requested to send some configuration data to the controlling 
software, and the Bio-Stack did not know about the requested data. 

8302   A checksum was generated following a code download, which did not match what 
was expected. Turn the µFill, ELx405, or MicroFlo off then on, and re-try the 
operation. 

8303   The Bio-Stack is in an invalid mode for receiving a message. Turn the µFill, 
ELx405, or MicroFlo off then on again, and re-try the operation. 

8304   The Bio-Stack didn’t properly acknowledge a message sent to it. Turn the µFill, 
ELx405, or MicroFlo off then on again, and re-try the operation. 

8305   An invalid message response was received from the Bio-Stack. Turn the µFill, 
ELx405, or MicroFlo off then on again, and re-try the operation. 

8306   The serial communications timed out. Turn the µFill, ELx405, or MicroFlo off then 
on again, and re-try the operation. 

 
 

BioTek Instruments, Inc. 



Error Code Tables  |  305 

Table 9 

MicroFlo™ Select Interface Software Errors Displayed  
in the LHC™ Software 

 
MicroFlo Select Interface Software errors are displayed in the Liquid Handling Control 
Software during Bio-Stack™ operation with the MicroFlo Select Dispenser. 

 

Code Probable Cause 

6000 General communication error during download. 

6001 COM port created by USB converter no longer active. 

6010 The data is invalid or out-of-range. 

6012 This step type can not be downloaded. 

6014 Illegal characters in protocol name; valid characters are letters, numbers, spaces, 
or symbols (_ - % &). 

6016 The protocol name length must be 16 characters or less.  

6018 A 1536 well plate is not supported by this instrument. 

6020 The specified volume exceeds the cassette maximum limit. 

6022 The Volume is out-of-range. 

6024 Invalid Flow rate. 

6026 Invalid number of pre-dispenses. 

6028 Invalid Horizontal dispense position. 

6030 Invalid dispense height. 

6032 Invalid plate clear height. 

6034 Invalid column selection value (must be 0 or 1). 

6036 Invalid protocol step type. 

6038 The Definition String contains invalid data. 

6040 Invalid baud rate 

6041 Invalid data bits selection 

6042 Invalid stop bits selection 

6043 Invalid parity selection 
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Code Probable Cause 

6044 Serial port error 

6045 Serial write error 

6046 Serial read error 

6047 Checksum error 

6048 Serial NAK error 

6049 Excess data, or not enough data, received 

6050 Invalid message header 

6051 Invalid message object 

6052 Invalid message body size 

6053 Serial message timeout 

6054 Port handle error 

6055 Read timeout value is invalid 

6056 Unauthorized to open the COM port 

6057 Out of range parameter for the open port function 

6058 Unable to open the COM port 

6059 Unable to clear the transmission buffer 

6060 Unable to close the port 

6061 Port is no longer available 
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Appendix A 

Computer Control 

This appendix describes how to obtain the information necessary to 
serially control the Bio-Stack without using the Bio-Stack™ PC 
Control Software, Precision Power™ Software, or Liquid Handling 
Control™ (LHC) Software. 
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Computer Control 

If you wish to serially control a Bio-Stack™ instrument without using the Bio-Stack™ 
PC Control Software, Precision Power™ Software, or Liquid Handling Control™ 
Software, you will need to write your own application to control the Bio-Stack. BioTek 
recommends using one of the following two methods: 

• Write a container application to interface with the Bio-Stack ActiveX 
component (recommended for a Microsoft® Windows™ operating system). 
The Bio-Stack ActiveX, which is included with the Bio-Stack PC Control 
Software installation, handles all of the low-level serial communication, 
providing higher-level methods and properties for a container application to 
access.   

Refer to the Bio-Stack ActiveX Programmer’s Reference Guide for 
details, by selecting Start > All Programs > BioTek Instruments > 
Bio-Stack > Developer.    

• Write an application to directly control serial communication, 
without using the Bio-Stack ActiveX (recommended for a non-Windows 
operating system).  To do this, you will need to learn about the serial message 
protocol recognized by the instrument software.  

Refer to the Bio-Stack User Guide to Serial Programming for details, by 
selecting Start > All Programs > BioTek Instruments > Bio-Stack > 
Developer.  
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Appendix B 

Bio-Stack™ Barcode 
Scanner 

This appendix contains instructions for installing the Bio-Stack’s 
optional barcode scanner, and the specifications for barcode label 
format and position on the microplate. 
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 Purchase or Create Labels to Specifications .............................316 
Step 3: Verify Installation – Perform Scanner Test........................319 
    Scanner Test for Bio-Stack™ with Readers...............................320 
    Scanner Test for Bio-Stack™ with Precision™ Instruments .........328 
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Step 1: Install the Bio-Stack™ Barcode Scanner   

 
Warning! Laser Radiation. Do not look directly into the laser beam 
during operation of the scanner. Serious eye injury may occur if you 
stare directly into the beam. Please note the warning label on the 
outside of the scanner’s protective cover. 

L Be very careful not to scratch or damage the mirror when unpacking 
or installing the barcode scanner!   

L Ensure that you have performed all of the instructions for installation 
of the Bio-Stack with the interfacing instrument before you install 
the Bio-Stack barcode scanner (see Chapter 3, Installation).  

 

Overview 

� For operation of the Bio-Stack barcode scanner, your Bio-Stack 
must be equipped with the scanner’s cable connection (on the rear 
panel of the Bio-Stack) and the appropriate basecode software 
version. 
 
You will also need appropriate versions of the Bio-Stack™ PC Control 
Software and Gen5™, KC4™, or Precision Power™ Software. Refer to 
Appendix D for information on required software versions. 

The Bio-Stack barcode scanner is supported when the Bio-Stack is used with the 
following interfacing instruments:   

• PowerWave™/XS and Synergy™ HT/Synergy™ 2/Synergy™ 4 readers  

• Precision™/XS instruments  

The barcode scanner may be installed on either the right side or left side of 
the Bio-Stack (as you are facing the claw/gripper) for operation with the  
Synergy HT/Synergy 2/Synergy 4 readers and Precision instruments. The scanner 
must be installed on the left side of the Bio-Stack for operation with the 
PowerWave/XS readers.  

� The MicroFlo Select Dispenser does not support the Bio-Stack 
barcode scanner. If you wish to alternate use of the Bio-Stack with the 
MicroFlo and with another BioTek instrument that does support the 
barcode scanner, you will need to install the scanner on the left side 
of the Bio-Stack, before you can align the MicroFlo with the Bio-Stack. 

The following sections describe how to install the barcode scanner, which label 
format to use, and how to verify the installation by performing the Scanner Test.    
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Unpack the Barcode Scanner Installation Kit 

 

L Be very careful not to scratch or smudge the mirror when 
unpacking the barcode scanner!  

 
1. Turn off and unplug the Bio-Stack™. 

2. Open the shipping container for the barcode scanner kit, and carefully 
remove the kit (enclosed in a plastic bag). The kit should contain the 
following components: 

• Barcode scanner assembly:  scanner (housed in a protective cover), 
scanner cable, and mirror attached to a removable mounting bracket  

• 2 shoulder screws and washers for attaching the mounting bracket to 
the Bio-Stack™ 

• Cable duct and cable clip for fastening the cable to the Bio-Stack 

• Combination Phillips head/flat head screwdriver  

• Installation instructions   

Install the Scanner on the Bio-Stack 

The barcode scanner is shipped already attached to the mounting bracket for 
installation on the right side of the Bio-Stack, as you are facing the claw/gripper. If 
necessary, the scanner may be removed from the bracket and reassembled for 
installation on the left side of the Bio-Stack.  

• Synergy readers and Precision instruments: Refer to the 
instructions on pages 312 to 313 for right-side installation of the 
scanner. 

• PowerWave/XS and Synergy readers, and Precision 
instruments: Refer to the instructions on pages 314 to 315 for left-side 
installation of the scanner.  

After you have installed the scanner, take a minute to read the “Laser Radiation” 
label (shown below) that is attached to the scanner’s protective cover. This 
warning is to remind you to avoid looking directly at the laser beam during 
operation of the scanner. 
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Mount the Scanner on the Right Side of the Bio-Stack™ 

Refer to Figure 59 for the following instructions. 

1. Align the two holes in the mounting bracket with the two holes on the 
right side of the Bio-Stack, as shown.  

2. Using the screwdriver and the two shoulder screws, attach the bracket 
to the Bio-Stack. 

3. Using lens tissue or a soft cloth moistened with lens cleaner, carefully 
wipe the mirror to remove any dust or particles.  

  
 

 

Figure 59: Installing the Barcode Scanner on the Right Side of the Bio-Stack 
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Set the Dipswitch and Attach the Scanner Cable Hardware 

In order for the Bio-Stack™ to “recognize” the scanner, you must set the 
dipswitch. Refer to Figure 60 for the following instructions. 

1. With the Bio-Stack still turned off, remove the hole plug for the 
dipswitches, and set dipswitch 3 to “OPEN.” Replace the hole plug. 

2. Using a clean, cotton cloth moistened with alcohol, clean the scanner 
cable duct, then remove the adhesive backing from the duct. 

3. Attach the duct to the same side of the Bio-Stack as the scanner’s 
mounting bracket, and center the duct front to back. 

4. Push the scanner cable into the duct. 

5. Remove the adhesive backing on the cable clip and attach the clip to the 
back panel of the Bio-Stack.  

6. Loop the excess cable into the clip, and plug the scanner cable into the 
cable connection on the back panel of the Bio-Stack. 

 
 

 

Figure 60: Setting the Dipswitch and Attaching the Cable Hardware 
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Reassemble the Scanner Bracket for Mounting on the Left Side 

1. Using the supplied screwdriver, remove the two screws and washers 
that attach the scanner assembly to the mounting bracket, as shown in 
Figure 61 and set them aside. 

2. Using a 9/64” hex wrench, remove the scanner from the bracket. Be 
very careful not to scratch or damage the mirror! 

3. Position the scanner on the opposite side of the bracket, as shown in 
Figure 62 and align the mounting holes. 

4. Reassemble, using the two screws and washers. 
 
 

 

 

Figure 61: Removing the Scanner from the Mounting Bracket  
 
 
 

 

 

Figure 62: Reattaching the Scanner to the Mounting Bracket for Left Side Installation 
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Mount the Scanner on the Left Side of the Bio-Stack™ 

Refer to Figure 63 for the following instructions. 

1. Align the two holes in the scanner mounting bracket with the two holes 
on the left side of the Bio-Stack, as shown. 

2. Using the screwdriver and two shoulder screws, attach the scanner to 
the Bio-Stack. 

3. Using lens tissue or a soft cloth moistened with lens cleaner, carefully 
wipe the mirror to remove any dust or particles. 

4. To complete the installation, follow the instructions in Set the 
Dipswitch and Attach the Scanner Cable Hardware on page 313 for 
setting the dipswitch, and for mounting the cable duct and cable clip. 
Ensure that you mount the cable duct on the left side of the Bio-Stack!  

 

 

 

Figure 63: Installing the Barcode Scanner on the Left Side of the Bio-Stack 
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Step 2: Prepare Barcode Labels 

Purchase or Create Labels to Specifications 

Barcode labels are available for purchase from BioTek, or they may be created using 
barcode software and label products that meet the following specifications: 

• Label format (“symbology”): Required formats are: 

¾ Code 39 

¾ Code 128 

¾ Codeabar  

¾ UPC/EAN  

• Industry Standards:  The labels should be made in accordance with 
Automation Identification Manufactures (AIM) uniform symbol specification 
for all codes supported. Label decodability should meet ANSI Specification X2, 
182-199 “Bar-Code Print Quality Guideline” for a rating of A/05/880. 

• Label quality: The labels should be printed on good-quality copier machines 
or laserjet printers. 

BioTek offers pre-printed, self-adhesive barcode labels (PN 7121094), in rolls 
containing 500 labels, which meet the above specifications for format, industry 
standards, and quality. Each label features a perforated section that may be easily 
attached to the side of a 96-, 384- or 1536-well microplate. Figure 64 and Figure 65 on 
the following page are actual-size reproductions of one of the BioTek labels and its 
perforated section.  

Figure 66 on page 318 contains barcode label artwork that may be submitted to a print 
vendor for creation of labels that meet the code symbology and industry standards.   
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Figure 64: Sample of One BioTek Barcode Label from Roll (PN 7121094) 
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Figure 65: Section of Label for Attachment to Microplate 
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Figure 66: Barcode Label Artwork with Recommended Dimensions 
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Step 3: Verify Installation – Perform Scanner Test 

Before using the Bio-Stack™ barcode scanner for the first time, verify the installation 
by performing the Scanner Test, as instructed in the following sections:  

• Scanner Test for Bio-Stack with Readers, page 320.  

• Scanner Test for Bio-Stack with Precision Instruments, page 328.  
 

� Readers: The Bio-Stack™ PC Control Software Help system contains 
complete instructions for using the Bio-Stack barcode scanner, that 
include 
 
-  displaying barcodes that have been scanned next to the input and 
   output stacks in the Bio-Stack PC Control Software main screen,  
 
-  using the barcodes as plate data file names (KC4™ only), and 
 
-  specifying how barcode scanning failures should be processed. 

� Precision instruments: The Precision Power™ Software Help system 
contains complete instructions for using the Bio-Stack barcode 
scanner, that include 
 
-  using the Bio-Stack in a Supply Command, and  
 
-  using the Bio-Stack to build the To-Do List.  
 
Refer also to the Precision Power User’s Guide. 
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Scanner Test for Bio-Stack™ with Readers 

If you are operating the Bio-Stack and barcode scanner with the PowerWave™, 
PowerWave™ XS, Synergy™ HT, or Synergy™ 2/Synergy™ 4 readers, perform 
the instructions in this section for verifying installation of the scanner.  

Prepare Microplates for the Scanner Test 

Refer to Figure 67 on page 321 for the following instructions: 

1. Assemble the required materials: 

� Purchased or custom-made barcode labels that meet label 
requirements and dimensions described in Purchase or Create 
Labels to Specifications on page 316. 

� Three “dry” (empty) 96-, 384-, or 1536-well microplates that meet 
plate specifications described on page 316, and that have flat, 
vertical sidewalls so the labels will lie flat upon the surface. 

2. Place the labels on whichever “short” sides of the microplates that will 
be scanned. See Figure 67; a 384-well plate is shown. The labels should 
not extend above or below the edges of the plate, or the plates may stick 
to one another when they are stacked. 

3. Load the barcode labeled plates into whichever stack you have 
designated as the input stack.   
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Figure 67: Positioning the Barcode Label on the Microplate 

 (for Bio-Stack™ with Readers) 
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Create a Gen5™ Experiment for the Scanner Test 

� Gen5 Software does not need to be configured before creating the following 
experiment for the Scanner Test. However, prior to running the Bio-Stack™ 
PC Control Software with Gen5 on a regular basis, there are several Gen5 
items that must be configured properly while running Gen5 as a stand-alone 
application. These include choosing a file storage mode, setting user 
preferences, etc.  
 
Refer to the Gen5 Getting Started Guide or Help system for more 
information on configuration of Gen5.    

The Bio-Stack™ PC Control Software links each plate in the input stack to a 
previously created and stored Gen5 experiment. Perform the following steps to 
create a simple Gen5 experiment for the Scanner Test: 

1. Launch Gen5. Log in if prompted to do so (Gen5 Secure). 

2. From Gen5’s main menu, select File > New Experiment. 

3. Select the Default Protocol then click OK. Gen5 will open the 
experiment workspace, which includes the New Experiment menu tree 
and the plate screen. 

4. Double-click Protocol in the menu tree to open the Protocol menu. 
Double-click Procedure to open the Procedure dialog. 

� Gen5™ and Gen5™ Secure: If the ‘Instrument Selection’ dialog 
appears, highlight the appropriate reader, then click OK. 

5. Select the appropriate Plate Type for the three microplates that you 
loaded into the input stack in Prepare Microplates for the Scanner 
Test, on page 320. If your particular plate is not in the list, select 96 
WELL PLATE. 

6. Click Read. Keep the default settings for all parameters in the ‘Read 
Step’ dialog. 

7. Click OK > OK to save all settings and return to the main menu. 

8. Select File > Save As, and save the experiment, using a unique name 
(e.g., Scanner Test.xpt). Make a note of the file name and storage 
location. 

� The default storage location is C:\Program Files\BioTek\ 
Gen5\Experiments (if you selected a conventional installation 
of Gen5). 

You will select this file in the Bio-Stack PC Control Software when you 
run the Scanner Test on page 326. 

9. Important! Close Gen5 software. 
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Configure KC4™ Software for the Scanner Test 

Perform the following steps to configure KC4 for the Scanner Test: 

KC4 v3.x (non-Signature) Users: 

1. Launch KC4 v3.x. 

2. Select System > Setup and click the ‘Start-up’ tab. 

3. Check Minimize KC4 when running in OLE mode and then click 
OK. 

4. Select System > Administrator Login, enter the Administrator 
Password, and then click OK. (The default password is admin.) 

5. Select System > Security and click the ‘Files’ tab. 

6. Select a Preferred data file format of .PLA or .GLB, according to 
your site’s assay requirements. (Click the Help button for assistance.) 
Make a note of this selection for use with the Bio-Stack™ PC Control 
Software configuration in Configure Bio-Stack™ PC Control 
Software for the Scanner Test on page 325. 

7. Click OK to return to KC4’s main application window. 

KC4 Signature Users: 

1. Launch KC4 Signature. 

2. When the ‘Login’ dialog appears, enter the Administrator Password 
and click OK. (The default password is admin.) 

3. Select System > Setup and click the ‘Start-up’ tab. 

4. Check Minimize KC4 when running in OLE mode and then click 
OK. 

5. Select System > Security and click the ‘Files’ tab. 

6. Select a Preferred data file format of .PLA or .GLB, according to 
your site’s assay requirements. (Click the Help button for assistance.) 
Make a note of this selection for use with the Bio-Stack PC Control 
Software configuration in Configure Bio-Stack™ PC Control 
Software for the Scanner Test on page 325. 

7. Click OK to return to KC4’s main application window. 
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Create a KC4™ Protocol for the Scanner Test 

The Bio-Stack™ PC Control Software links each plate in the input stack to a 
previously created and stored KC4 protocol. Perform the following steps to 
create a simple protocol for the Scanner Test: 

1. Select Data > New Plate. If prompted to select a protocol, select 
Empty Protocol and click OK. If not prompted, select Protocol > 
New. 

2. Select Protocol > Reading. Define the following parameters in the 
‘Reading’ dialog: 

� (Synergy™ HT only) Select Absorbance for the Detection 
method. 

� Select End Point for the Reading Type. 

� Keep the default Wavelength(s). 

� Select the appropriate Plate Type for the three microplates that you 
loaded into the input stack in Prepare Microplates for the 
Scanner Test on page 320. If your particular plate is not in the list, 
select 96 WELL PLATE. 

� Keep the default settings for all other parameters in the Reading 
dialog. 

� PowerWave™ HT customers: Do not select the Read 
Barcode parameter. The Read Barcode parameter is designed 
specifically for use with the reader’s scanner. 

� Click OK to verify the parameters and return to the main screen. 

3. Select Protocol > Save As and save the protocol. Make a note of the 
file name and storage location. You will select this file in the Bio-Stack 
PC Control Software when you run the Scanner Test. 

4. (Optional) If you wish to specify the storage location for the plate data 
files, select Protocol > Options, and in the Save Directory box, 
enter the path of the folder in which to store the files. 

� If the Save Directory box is left empty, the plate data files will 
be stored in the default KC4 folder, or in the secure database, 
depending on the KC4 license/configuration. 

5. Important! Close KC4 software. 

� If Save changes to New Plate appears, click No. 
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Configure Bio-Stack™ PC Control Software for the Scanner Test 

 
Warning! Keep your hands away from the claw/gripper and 
carrier while the Bio-Stack™ is being powered up. The 
carrier and claw/gripper move quickly during the homing 
sequence. 

Perform the following steps to configure the Bio-Stack PC Control Software for 
the Scanner Test: 

1. Plug in and turn on the Bio-Stack. 

2. Launch the Bio-Stack PC Control Software. 

3. Click on Change Current Settings to open the ‘Settings’ dialog. 

4. At the ‘Plate Identification’ tab, select Auto-generated Plate ID. 
Keep the default Plate_ for the optional prefix, and enter 1 for the 
starting plate #. 

� The Plate ID labels are only used for the Bio-Stack PC Control 
Software stack displays, to make it easier to track a plate within 
the stacks. There is no automatic association between the Plate 
ID defined for a plate in the Bio-Stack software and the usage of 
plate barcode IDs in Gen5™/KC4™, or plate output file names in 
KC4. 

5. At the ‘Run Control’ tab, select Re-stack when processing is done 
and Provide re-try prompt following barcode scanning failures. 

6. At the ‘Display Options’ tab, select Display Barcode Label for both 
Left of Input Stack and Right of Output Stack. 

7. KC4 only: At the ‘KC4 Options’ tab, select KC4 data only (*.PLA) or 
KC4 data and protocol (*.GLB), as appropriate, for the KC4 
preferred output data file format. 

� If you wish to use barcode IDs scanned by the Bio-Stack’s barcode 
scanner as KC4 plate data file names: click Have KC4 write out a 
plate file using Bio-Stack barcode ID for filename. The files 
will be stored in the location you specified in Create a KC4™ 
Protocol for the Scanner Test on the previous page, or (if you did 
not specify a location) in the default KC4 folder or secure database. 

8. Click OK to save and close the Settings dialog. 
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Run the Scanner Test 

  

 
Warning! Laser Radiation. Do not look directly into the 
laser beam during operation of the scanner. Serious eye 
injury may occur if you stare directly into the beam. 
Please note the warning label on the outside of the 
scanner’s protective cover. 

L Ensure that you are not also running Gen5™ or KC4™ 
software in stand-alone mode when performing the 
Barcode Scanner Test.   

Perform the following steps to run the Bio-Stack™ Barcode Scanner test: 

1. At the Bio-Stack™ PC Control Software’s main screen, Add New Plate 
area, open the scanner test file that you created: 

Gen5 

� Click Existing Exper. then click the three-dot button next to 
Exper. to open the ‘Browse for Experiment’ dialog. 

� Search through the folders until you locate the Gen5 experiment file 
you created. 

� Click Open, and the file path will now appear in the Exper. Field. 

KC4

� Click the three-dot button next to Assay to open the ‘Browse for 
Protocol’ dialog. 

� Search through the folders until you locate the KC4 protocol file you 
created. 

� Click Open, and the file path will now appear in the Assay field. 

2. Click Top of Input Stack, then click Add plate to Input Stack 
three times to “add” the three plates that will be scanned. An image of 
each plate will be added to the Input Stack in the Bio-Stack PC 
Control Software. 

3. Under Run Control, click Start. The Bio-Stack PC Control Software 
will run Gen5 or KC4 “in the background,” to process each plate in 
accordance with the Gen5 experiment or KC4 protocol. 
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As the plates are transferred between the Bio-Stack™ and the reader, 
note whether the following activities occur: 

� The red LED on the barcode scanner should flash as the scanner 
reads a barcode on a plate 

¾ during transfer from the input stack to the Bio-Stack’s extended 
carrier position (before the plate is picked up by the claw/gripper 
for transfer to the reader’s carrier), and  

¾ during transfer from the Bio-Stack’s extended carrier position to 
the output stack (after the plate has been processed and 
transferred from the reader’s carrier to the Bio-Stack carrier). 

� A barcode ID should appear 

¾ to the right of the Output Stack in the Bio-Stack™ PC Control 
Software as the claw/gripper is transferring a processed plate 
from the reader’s carrier to the Bio-Stack carrier (for transfer to the 
Output Stack), and 

¾ to the left of the Input Stack in the Bio-Stack PC Control 
Software as a processed plate in the Output Stack is being lowered 
onto the carrier for transfer to the Input Stack. 

4. If a scanning failure occurs, the Bio-Stack will pause while the ‘Barcode 
Scan Failure’ dialog appears with the options to retry the scan, 
manually enter the barcode, ignore the error, or abort the run. 

� If you choose to manually enter the barcode and need to 
remove the plate from the Bio-Stack’s carrier in order to read 
the barcode, ensure that you place the plate back onto the 
carrier. 

� If you choose to ignore the error, the Bio-Stack PC Control 
Software will display a code (e.g., ###NoBarcode##) to the 
right of the Output Stack and to the left of the Input Stack. 

� Check for missing labels, invalid or illegible barcodes, or plates 
loaded into the input stack with the barcode label on the wrong side 
of the plate. 

� Correct the problem, then select Retry Scan. 

� If the test still doesn’t pass, contact BioTek TAC. 

5. Click OK when the “All plates have been completed” dialog appears. 

� Check to ensure that Done appears above Number of Runs in 
the Bio-Stack PC Control Software.  
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Scanner Test for Bio-Stack™ with Precision™ Instruments 

If you are operating the Bio-Stack and barcode scanner with the Precision™ 
Microplate Pipetting System or Precision™ XS, perform the instructions in this 
section for verifying installation of the scanner. 

Prepare Microplates for the Scanner Test 

Refer to Figure 68 on page 329 for the following instructions: 

1. Assemble the required materials: 

� Purchased or custom-made barcode labels that meet label 
requirements and dimensions described in Purchase or Create 
Labels to Specifications on page 316. 

� Three “dry” (empty) 96- or 384-well microplates that meet plate 
specifications described on page 316, and that have flat, vertical 
sidewalls so that the labels will lie flat upon the surface. The plates 
should also be compatible with Precision Power’s Vessel 
Specification files for 96- and 384-well plates. 

2. Place the labels on whichever “short” sides of the microplate that will 
be scanned. See Figure 68 on the next page (a 384-well plate is 
illustrated). The labels should not extend above or below the edges of 
the plate, or the plates may stick to one another when they are stacked. 

3. Write down the barcode IDs for each plate. You will need to enter these 
numbers when you create the plate maps in the section Create Plate 
Maps for the Scanner Test on page 330. 

4. Load the barcode-labeled plates into whichever stack you have 
designated as the output stack.  
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Figure 68: Positioning the Barcode Label on the Microplate  

(for Bio-Stack™ with Precision™ instruments) 
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Create Plate Maps for the Scanner Test 

Perform the following steps in Precision Power™ to create simple plate maps 
that you will use in the Scanner Test: 

1. Launch Precision Power Software. 

2. Click the Unprocessed Maps icon on the toolbar. 

3. At the ‘Unprocessed Maps’ dialog, click the Add button. 

4. In the ‘Add Plate/Rack Map’ dialog: 

� At the Plate/Rack ID field, type the barcode number of the first 
plate that you loaded into the output stack. 

� Select a Vessel Specification File (from the pull-down menu) that 
is compatible with the plates you are using. 

� Click Create to continue setting up a new plate map. 

5. In the ‘Add Map’ dialog: 

� At the When processing is done field, click Leave in 
Unprocessed Folder. 

� Keep the default settings for all other parameters in the Add Map 
dialog, and click Save. 

6. At the Unprocessed Maps dialog: 

� Repeat the instructions in steps 3 through 5 for the other two plates, 
entering the barcode numbers for the plates in the Plate/Rack ID 
fields. 

� Click Exit. 
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Run Scanner Test: Use Bio-Stack™ to Build To-Do List 

 
Warning! Laser Radiation. Do not look directly into the 
laser beam during operation of the scanner. Serious eye 
injury may occur if you stare directly into the beam. Please 
note the warning label on the outside of the scanner’s 
protective cover. 

Perform the following steps to test the scanner, using the Bio-Stack to build the 
To-Do List: 

1. At the Precision Power™ main screen, click on the To-Do List icon on 
the toolbar. 

The ‘Modifying the To-Do List’ dialog will open, and the three barcode 
plate maps that you created and saved in the Unprocessed folder will 
appear in the Available Plate Maps list. 

2. Select the option to Add to To-Do List via Bio-Stack. 

3. Configure the Options as follows: 

� Use the drop-down list in the Bio-Stack Selection field to identify 
the Bio-Stack and supply station. 

� De-select Limit by location count. 

� Select Ignore failures. 

� When the Ignore Failures is not selected and errors occur 
scanning the barcode or locating a matching plate map, 
Precision Power offers multiple options for resolving the error or 
continuing the process. 

4. Click the Generate List button to start the Bio-Stack scanning process. 
The Bio-Stack scanner will scan each barcoded plate as it is moved from 
the output stack to the input stack. 

Note whether the following activities occur: 

� The red LED on the barcode scanner should flash as the scanner 
reads the barcode on the plate at the extended carrier position. 

� Precision Power will look for an Available Plate Map with the 
same Plate ID as the scanned plate. As it finds a match, it moves the 
plate map to the Assigned Plate Maps, i.e., the To-Do List. All 
three barcode plate maps should now appear in the Assigned Plate 
Maps list. 
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If a failure occurs during the process, Precision Power™ puts a 
placeholder in the Assigned list marked with a red error icon. A 
barcode scanning error results in a placeholder name No barcode #. 

� Remove the plate from the carrier, and check for a missing label, 
invalid or illegible barcode, or a barcode label on the wrong side of 
the plate in reference to the position of the scanner. Ensure that the 
barcode ID you entered in Create Plate Maps for the Scanner 
Test on page 330 matches the barcode ID on the plate. 

� Correct the problem, place the plate back onto the output stack, and 
home the Bio-Stack™. Repeat steps 1 through 4. 

� If the test doesn’t pass, contact BioTek TAC.  
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Reconfigure the Bio-Stack™ for Half-Height Plates   

L Important! These instructions configure the Bio-Stack and the 
input/output stacks for use with a specific half-height plate. After 
performing these instructions, if you wish to use a plate type with 
distinctly different dimensions (e.g., a “standard height” plate) you 
must reconfigure the instrument and stacks for the new plate. 
Alternatively, consider purchasing an additional set of input/output 
stacks (PN 7310008S) and configuring them for the new plate type.    

 

Overview 

If you are using half-height plates and the Bio-Stack is passing multiple 
plates at once from the input stack to the Bio-Stack carrier, the instrument may 
need to be reconfigured to accommodate your microplates. One microplate known 
to require this reconfiguration is MJ Research’s Hard-Shell 384-well PCR plate. To 
configure the Bio-Stack to prevent multiple half-height plates from passing to the 
carrier at once, you will perform four steps: 

1. Ensure that the Bio-Stack’s on-board (basecode) software version is at least 
1.27.1.  

� Bio-Stacks manufactured after February 2007 meet this requirement. 

2. “Open” an internal dipswitch. 

3. Make minor adjustments to the input and output stacks. 

4. Run the Bio-Stack in a special test mode with dry plates, to test the adjusted 
stacks. 

Instructions are provided on the following pages.  Please contact BioTek’s 
Technical Assistance Center with any questions or concerns (see Chapter 1 for 
contact information). 

Required Materials 

• 5/64” (2.0 mm) allen wrench 

• 7 of the half-height microplates you are working with 

• Small piece of paper approximately 0.02” (0.5 mm) thick 
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Step 1: Check the Bio-Stack’s Basecode Software Version 

� Refer to Appendix D, Required Software Versions, for more 
information on software versions required for the Bio-Stack™ and 
interfacing instrument. 

To check the Bio-Stack’s basecode software version, refer to the instructions in 
Chapter 3, Installation.    

If you are using the Bio-Stack™ with this instrument: 
Refer to the 

instructions on this 
page in Chapter 3: 

PowerWave™/XS or Synergy™ HT/Synergy 2/ Synergy 4 60 

Precision™/XS 74 

µFill™ 99 

ELx405™ (Instrument Control) 99 

ELx405 (PC Control) 108 

NanoQuot™ 121 

MicroFlo™ Select (Instrument Control) 140 

MicroFlo Select (PC Control) 149 

If the software version is less than 1.27.1, contact BioTek’s Technical Assistance 
Center for upgrade instructions. Do not proceed to step 2 until you have upgraded 
the software. 

Step 2: “Open” Dipswitch #1  

� Perform step 2 only if dipswitch #1 is not already open. If it is already 
open, skip this step and go to step 3. 

1. If the Bio-Stack is on, turn it off. Locate and remove the round dipswitch 
access cover on top of the Bio-Stack, as shown in Figure 69 on the 
following page. Inside the hole you’ll see a small panel with four numbered 
dipswitches. 

2. Switch #1 must be in its OPEN position, as shown in Figure 70 on the 
following page. If the switch is “closed,” use the end of a paper clip to 
move it to the OPEN position.  

L Important! Switch #1 must be moved back to its CLOSED 
position to process standard-height plates.    
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Figure 69: Dipswitch Access Cover 

 

 

Figure 70: Switch #1 in OPEN Position 
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Step 3: Adjust the Input and Output Stacks 

Turn an empty stack upside down and identify its two movable brackets, one on 
each of the short sides of the stack. These are plate-grippers, called “dogs.” In 
Figure 71 below, each arrow points to a stack dog. 

When multiple half-height plates are passing to the carrier at once, the factory-set 
dogs are gripping the plates in the wrong place. The cause is likely the length of 
the plate (slightly longer than standard) combined with the way the plates “nest” 
inside one another in the stack. 

You will adjust the dogs slightly to increase the distance between them, to allow 
the plates to be gripped properly. 

You’ll need a 5/64” (2.0 mm) allen wrench, the microplate you are working 
with, and a small piece of paper that is approximately 0.02” (0.5 mm) thick. 

L Important! The adjustment process may take a few tries. You’ll 
make a slight adjustment to the input and output stacks, and then 
run the Bio-Stack™ in a special test mode with seven empty 
plates to ensure that only one plate at a time passes from the 
stack to the carrier. You may find that the dogs were moved too 
far apart, or not quite far enough, and you’ll have to repeat the 
adjustment/test process. Once the dogs are set properly, you 
should not have to repeat this procedure for this plate type.    

 

 

               Figure 71: Stack “Dogs” 
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To make the adjustments (perform these steps for both the input and output 
stacks): 

1. Turn the empty stack upside down and set it on a flat surface. 

2. Hold the plate right-side up and slide it into the middle of the stack. Move 
it up until the plate’s flange is flush against the bottoms of both dogs, as 
shown in Figure 72: 

 

 

                    Figure 72: Positioning the Plate in the Stack 
 

3. Attempt to slide the paper between the plate and the dog on one side; 
notice that the dog is too tight against the side of the plate to allow the 
paper to slide freely. Set the paper aside for now. 

� Use the photos on the next page to help with the adjustments. 
Each dog is held in position by two set screws, as shown in 
Figure 73. Figures 74 and 75 demonstrate incorrect and 
correct positioning of the dogs in relation to the plate when the 
plate is held in place as in Figure 72. 

4. Using the allen wrench, turn one dog’s set screws clockwise to increase the 
distance between the dog and the side of the plate to approximately  
0.02” (0.5 mm). Repeat for the other dog. When the plate is held as shown 
in Figure 72, each dog should rest on the plate’s flange and you should be 
able to insert and remove the test paper without friction between the dog 
and the side of the plate. 
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  Figure 73:  Turning the Dog’s Set Screws 
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Figure 74:  Incorrect Positioning  
     of the Dogs 

The dog is too high and it 
touches the side of the plate. 

Figure 75a and 75b:  Correct Positionin

The dog rests on the flange and does not 
the plate. A piece of 0.02” (0.5 mm) thick 
between the dog and the plate. 

flange 
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Step 4: Test the Adjusted Stacks 

 
Warning! Keep your hands away from the claw/gripper and 
carrier while the Bio-Stack™ is being powered up. The 
carrier and claw/gripper move quickly during the homing 
sequence. 

As mentioned on page 337 (in the Important! note), you’ll need to test the 
adjusted stacks with seven dry plates, to see if the stacks are set properly or 
require further adjustment. 

1. If the Bio-Stack™ is on, turn it off. 

2. Remove the dipswitch access cover and move switch #4 to the OPEN 
position. 

3. Load the input stack with seven clean, dry microplates. 

4. Install the input and output stacks. 

5. Turn on the Bio-Stack. 

Plates will begin to transfer from the input stack to the carrier and then to 
the output stack. When all plates have been transferred to the output stack, 
they will be transferred back to the input stack. This process will repeat 
until you turn off the Bio-Stack. 

6. Observe the plate transfer process. Plates should pass one-at-a-time to the 
plate carrier. 

If, after several transfers, you are satisfied with the performance, turn off 
the Bio-Stack and restore dipswitch #4 to its closed position. 

If multiple plates continue to pass to the plate carrier, turn off the Bio-Stack 
and attempt to adjust the stacks again. Repeat the adjustment/test process 
until the plates are transferring to your satisfaction. 

 

L Important! When finished, be sure to attach labels 
to the stacks and the Bio-Stack to indicate that they 
are “Configured for <your plate type>.”    
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Appendix D 

Required Software 
Versions  

This appendix lists all software versions required for operation of 
the Bio-Stack™ with the PowerWave™/XS, Synergy™ HT/Synergy™ 
2/Synergy™ 4 readers, Precision™/XS instruments, µFill™, 
NanoQuot™, and MicroFlo™ dispensers, and ELx405™ washer.  

Overview................................................................................342 
Required Software Versions for Bio-Stack™ with PowerWave™ or 

Synergy™ Readers ..............................................................343 
Required Software Versions for Bio-Stack™ with Precision™ 

Instruments .......................................................................345 
Required Software Versions for Bio-Stack™ with µFill™ Dispenser...346 
Required Software Versions for Bio-Stack™ with ELx405™ Washer..347 
Required Software Versions for Bio-Stack™ with NanoQuot™ Dispenser 

........................................................................................348  
Required Software Versions for Bio-Stack™ with MicroFlo™ Select 

Dispenser...........................................................................349 
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Overview   

For operation of the Bio-Stack™ with an interfacing instrument, you will need the 
correct software versions installed on both instruments, and, if applicable, on the 
controlling computer. 

Refer to the tables on the following pages to determine if you have all of the correct 
software versions. (See Chapter 7, Troubleshooting and Error Codes for instructions 
for obtaining software versions for the Bio-Stack and interfacing instruments.) 
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Required Software Versions for Bio-Stack™ with 
PowerWave™ or Synergy™ Readers 

� Software versions are subject to change over time. Contact BioTek 
Instruments for more information.  

Bio-Stack with PowerWave™/XS or Synergy™ HT     

using Gen5™, you will need 
these minimum software 
versions: 

using KC4™, you will need these 
minimum software versions: 

Gen5 Software  

9 1.00.14 with/without barcode 
scanner   

 

KC4 Software 

9 3.3, Rev. 9 without barcode 
scanner 

9 3.4, Rev. 16 with barcode 
scanner 

9 3.4, Rev. 22 to have  
Bio-Stack scanned barcode 
appear in KC4 plate description 
dialog 

Reader basecode 

9 1.21.1 for PowerWave 

9 1.06 for PowerWave XS  

9 2.24 for Synergy HT 

Reader basecode 

9 Any version for PowerWave, 
PowerWave XS, or Synergy HT 

 

Bio-Stack basecode  

9 1.24.1 with/without barcode 
scanner (1- to 384-well 
standard height plates, PCR 
plates) 

9 1.25.1 (1536-well half plates) 

9 1.27.1 (Hard-shell 384-well 
PCR plates) 

Bio-Stack basecode 

9 1.24.1 with barcode scanner 

 

To operate the 
Bio-Stack with the 

PowerWave, 
PowerWave XS,  
or Synergy HT 

 

Bio-Stack™ PC Control 
Software  

9 2.00.x 

Bio-Stack PC Control  
Software  

9 1.02.8 
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Bio-Stack™ with Synergy™ 2 or Synergy™ 4 

� The Synergy 2 and Synergy 4 readers do not support KC4™ Software. 

using Gen5 you will need these minimum software versions: 

Gen5™ Software  

9 1.01.x with/without barcode scanner   

Reader basecode 

9 Any version  

Bio-Stack basecode  

9 1.24.1 with/without barcode scanner (1- to 384-well standard 
height plates, PCR plates) 

9 1.25.1 (1536-well half plates) 

9 1.27.1 (Hard-shell 384-well PCR plates) 

To operate the 
Bio-Stack with the 

Synergy 2   

 

Bio-Stack™ PC Control Software  

9 2.00.3 with/without barcode scanner (96-/384-well plates) 

9 2.00.4 with/without barcode scanner (1536-well plates) 

using Gen5 you will need these minimum software versions: 

Gen5™ Software  

9 1.04.x with/without barcode scanner   

Reader basecode 

9 Any version  

Bio-Stack basecode  

9 1.27.1 with/without barcode scanner (all plate types) 

To operate the 
Bio-Stack with the 

Synergy 4   

 

Bio-Stack™ PC Control Software  

9 2.00.7 or greater with/without barcode scanner (all plate types) 
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Required Software Versions for Bio-Stack™ with 
Precision™ Instruments 

� Software versions are subject to change over time. Contact BioTek 
Instruments for more information.  

you will need these minimum software versions: 

Bio-Stack™ PC Control Software 

9 1.02.8 with/without barcode scanner (all plate types) 

Bio-Stack basecode  

9 1.24.1 with/without barcode scanner (1- to 384-well standard 
height plates; PCR plates) 

9 1.25.1 (1536-well half plates) 

9 1.27.1 (Hard-shell 384-well PCR plates) 

Precision Power™ Software  

9 2 without barcode scanner 

9 2.xx with barcode scanner   

To operate the 
Bio-Stack with the 

Precision or 
Precision XS   
 

Precision instrument basecode 

9 2.14 for Precision Microplate Pipetting System 

9 Any version for Precision XS 
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Required Software Versions for Bio-Stack™ with 
µFill™ Dispenser 

� Software versions are subject to change over time. Contact BioTek 
Instruments for more information.  

� The µFill does not support the Bio-Stack barcode scanner.  

you will need these minimum software versions: 

µFill basecode 

9 1.21.x   

To operate the 
Bio-Stack with the 

µFill   
 

Bio-Stack basecode  

9 1.24.1 (96-/384-well standard height plates) 

9 1.25.1 (1536-well plates) 

9 1.27.1 (Hard-shell 384-well plates) 
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Required Software Versions for Bio-Stack™ with 
ELx405™ Washer 

� Software versions are subject to change over time. Contact BioTek 
Instruments for more information.  

� The Magna model of the ELx405 does not support the Bio-Stack. 

� The ELx405 does not support the Bio-Stack barcode scanner.  

Instrument Control of the Bio-Stack 

you will need these minimum software versions: 

ELx405 basecode 

9 1.88.x   

To operate the 
Bio-Stack with the 

ELx405   

 

Bio-Stack basecode  

9 1.24.1 (96-/384-well standard height plates) 

 

PC Control of the Bio-Stack 

you will need these minimum software versions: 

Liquid Handling Control™ (LHC) Software 

9 Any version 

ELx405™ Interface Software  

9 2.00.4 

ELx405 basecode (PN 7100227) 

9 2.02.1 

Bio-Stack™ PC Control Software 

9 2.00.10 (96-/384-well standard height plates) 

To operate the 
Bio-Stack with the 

ELx405 

using the  

LHC Software 

 

Bio-Stack basecode  

9 1.24.1 (96-/384-well standard height plates) 
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Required Software Versions for Bio-Stack™ with 
NanoQuot™ Dispenser 

� Software versions are subject to change over time. Contact BioTek 
Instruments for more information.  

� The NanoQuot does not support the Bio-Stack barcode scanner.  

� During operation of the Bio-Stack with the NanoQuot, the Bio-Stack is 
directly controlled by the basecode software onboard the NanoQuot. The 
Bio-Stack PC Control Software is used only to obtain Bio-Stack software 
versions or to align the two instruments. The NanoQuot PC Control 
Software is used only to obtain NanoQuot software versions or to 
operate the NanoQuot in PC mode, without the Bio-Stack.  

you will need these minimum software versions: 

NanoQuot™ PC Control Software  

9 1.00.4  

NanoQuot basecode 

9 Any version  

Bio-Stack basecode  

9 1.24.1 (96-/384-well standard height plates) 

9 1.25.1 (1536-well plates) 

9 1.27.1 (Hard-shell 384-well plates) 

To operate the 
Bio-Stack with the 

NanoQuot   
 

Bio-Stack™ PC Control Software  

9 2.00.4 
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Required Software Versions for Bio-Stack™ with 
MicroFlo™ Select Dispenser 

� Software versions are subject to change over time. Contact BioTek 
Instruments for more information.  

Instrument Control of the Bio-Stack 

you will need these minimum software versions: 

MicroFlo basecode 

9 1.04.0 

To operate the 
Bio-Stack with the 

MicroFlo    

 

Bio-Stack basecode  

9 1.24.1   

 

PC Control of the Bio-Stack 

you will need these minimum software versions: 

Liquid Handling Control™ (LHC) Software 

9 Any version 

MicroFlo™ Select Interface Software  

9 1.01.0 

MicroFlo basecode   

9 1.04.0 

Bio-Stack™ PC Control Software 

9 2.00.10   

To operate the 
Bio-Stack with the 

MicroFlo 

using the  

LHC Software 

 

Bio-Stack basecode  

9 1.24.1 (96-/384-well standard height plates) MicroFlo Select models 
MFS and MFS1536 

9 1.25.1  (1536-well standard height plates) MicroFlo Select model  
MFS1536 only 
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